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Preface

The Sentinel Technical documentation is general-purpose operation and reference guide.
This documentation is intended for Information Security Professionals. The text in this
documentation is designed to serve as a source of reference about Sentinel’s Enterprise
Security Management System. There is additional documentation available on the Novell
web portal (http://www.novell.com/documentation/).

Sentinel Technical documentation is broken down into six different volumes. They are:

Volume I — Sentinel Install Guide

Volume Il — Sentinel User Guide

Volume Il — Sentinel Collector Builder User Guide
Volume IV - Sentinel User Reference Guide
Volume V - Sentinel 3" Party Integration

Volume VI — Sentinel Patch Installation Guide

Volume | — Sentinel Install Guide

This guide explains how to install:

= Sentinel Server Collector Builder
= Sentinel Console Collector Manager
= Sentinel Correlation Engine = Advisor

= Sentinel Crystal Reports

Volume Il — Sentinel User Guide

This guide discusses:

= Sentinel Console Operation = Event Configuration for Business
= Sentinel Features Relevance

= Sentinel Architecture = Mapping Service

= Sentinel Communication = Historical reporting

=  Shutdown/Startup of Sentinel = Collector Host Management

» Vulnerability assessment = Incidents

= Event monitoring = Cases

= Event filtering = User management

= Event correlation = Workflow

= Sentinel Data Manager

Volume Il — Collector Builder User Guide

This guide discusses:

= Collector Builder Operation = Collector Host Management
= Collector Manager = Building and maintaining Collectors
= Collectors

Volume IV - Sentinel User Reference Guide

This guide discusses:



= Collector scripting language
= Collector parsing commands
= Collector administrator functions
= Collector and Sentinel meta-tags

Sentinel correlation engine

User Permissions

Correlation command line options
Sentinel database schema

Volume V - Sentinel 3" Party Integration Guide

= Remedy = HP Service Desk
= HP OpenView Operations

Volume VI - Sentinel Patch Installation Guide
= Patching from Sentinel 4.x to 6.0 = Patching from Sentinel 5.1.3 t0 6.0

Feedback

We want to hear your comments and suggestions about this manual and the other
documentation included with this product. Please use the User Comments feature at the
bottom of each page of the online documentation and enter your comments there.

Additional Documentation

The other manuals on this product are available at http://www.novell.com/documentation.
The additional documentation available on Sentinel:

= Sentinel 6.0 Installation Guide
= Sentinel 6.0 Patch Installation Guide
= Sentinel 6.0 Reference Guide

Documentation Conventions

The following are the conventions used in this manual:

= Notes and Warnings

NOTE: Notes provide additional information that may be useful or for
reference.

WARNING:

Warnings provide additional information that helps you identify and stop
performing actions in the system that cause damage or loss of data.

= Commands appear in courier font. For example:
useradd —g dba —d /export/home/oracle —m —s /bin/csh

oracle

= Go to Start > Program Files > Control Panel to perform this action: Multiple actions
in a step.

= References
o For more information, see “Section Name” (if in the same Chapter).

o For more information, see Chapter number, “Chapter Name” (if in the same
Guide).


http://www.novell.com/documentation

o For more information, see Section Name in Chapter Name, Name of the
Guide (if in a different Guide).

Other References

The following manuals are available with the Sentinel install CDs.

Sentinel User Guide

Sentinel Collector Builder User Guide
Sentinel User Reference Guide
Sentinel 3" Party Integration Guide
Release Notes

Contacting Novell

Website: http://www.novell.com

Novell Technical Support:
http://support.novell.com/phone.html?sourceidint=suplnav4_phonesup

Self Support:
http://support.novell.com/support_options.html?sourceidint=suplnav_supportprog
Patch Download Site: http://download.novell.com/index.jsp

24x7 support: http://www.novell.com/company/contact.html.

For Collectors/Connectors/Reports/Correlation/Hotfixes/TIDS:
http://support.novell.com/products/sentinel.
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Sentinel Control Center

The topics included in this chapter:

Topic Page

About Sentinel Control Center 1-1
Log in to the Sentinel Control Center 1-4
Introduction to the User Interface 1-5
Navigating through Sentinel Control Center 1-7
Changing the appearance of Sentinel 1-7
Control Center

Saving User Preferences 1-8
Changing Password 1-9
Hostname updates 1-9

About Sentinel Control Center

Sentinel™ is a Security Information and Event Management solution that receives

information from many sources throughout an enterprise, standardizes it, prioritizes it and
presents it to you to make threat, risk and policy related decisions. The Sentinel Control

Center (SCC) is the main user interface for viewing and interacting with this data.

Sentinel gathers and correlates security and non-security information from across an
organization's networked infrastructure, as well as third-party systems, devices and
applications. Sentinel presents the collected data in a more sensible GUI, identifies

security or compliance issues, and tracks remediation activities, streamlining previously

error-prone processes and building a more rigorous and secure management program.
The Sentinel Control Center includes the following functional tabs and interfaces:

= Active Views

= |ncidents
= [TRAC

= Analysis
= Advisor
=  Admin

= Correlation

Active Views
The Active Views tab presents events in near-real time.
In the Active Views tab, you may:

=  View events occurring in near real-time

» [nvestigate events

= Graph events

= Perform historical queries to collect data for a specified period
= Invoke right-click functions

= [nitiate manual incidents and remediation workflows

Sentinel Control Center
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Incidents

An incident is a set of events that require attention (for example, a possible attack).
Incidents centralize the data and typically comprise a correlated event, the associated
events that triggered a correlation rule, asset details of the affected systems, vulnerability
state of the affected systems and any remediation information, if known. Incidents can be
associated with a remediation workflow in iTRAC, if specified. An incident associated to
an iTRAC workflow allows users to track the remediation state of the incident.

In the Incidents Tab, you may:

» Manage incident views
= View and manage incidents and their associated data
= Switch between existing incident views

ITRAC

iTRAC’s stateful incident remediation workflow capability allows you to incorporate your
organization’s incident response processes into Sentinel.

In the iTRAC tab, you may:

= Create custom workflow templates

= Edit workflow templates

= Create custom activities

= Edit activities

= Associate activities with workflow steps
= Initiate and execute Processes

Analysis

The Analysis tab is the historical reporting interface for Sentinel. Reports are published on
a web server and can be rendered in the analysis tab or in an external browser. You may
also run and save an Offline Query for later quick retrieval of search results.

Advisor

Advisor is an optional module that provides real-time correlation between detected 1DS
attacks and vulnerability scan output in order to immediately indicate increased risk to an
organization.

Admin

1-2

The Admin tab provides you access to perform the administrative actions and
configuration settings in Sentinel.

In the Admin tab, you may configure:

= Archive
= Reports
=  Events

= Global Filters
= Color Filter

= Mapping
=  Menus

= Filters

= Users

= Das Statistics
= Event File Info
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= Reporting Data
With Server View Manager you can monitor (Stop/Start/Restart) the processes that
Sentinel holds.

Correlation

The Correlation tab provides an interface to create and deploy rules to detect suspicious or
malicious patterns of events.

In the Correlation tab, you may:

= Create and edit rules

= Deploy/Undeploy rules

= Add an action and associate it to a rule
= Configure dynamic lists

Event Source Management

The Event Source Management (ESM) interface is available through the Sentinel Control
Center menu. It allows you to manage and monitor connections between Sentinel and its
event sources using Sentinel Connectors and Sentinel Collectors.

In the ESM, you may:

= Import/export Connectors and Collectors from/to the centralized repository available
in ESM

=  Add/edit connections to event sources through the configuration wizards

=  View the real-time status of the connections to event sources

= Monitor data flowing through the Collectors and Connector

Sentinel Collectors

The Collectors parse the data and deliver a richer event stream by injecting taxonomy,
exploit detection and business relevance into the data stream before events are correlated
and analyzed and sent to the database.

Sentinel Connectors

The Connectors use industry standard methods to connect to the data source to get raw
data.
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Log in to the Sentinel Control Center

To Start the Sentinel Control Center on Windows:

1. Go to Start > Programs > Sentinel and select Sentinel Control Center. Sentinel
Login window displays.

E] Sentinel Login E]
€

with iTRAC™

vB
Lsername: |
Pazsward:

@ 1988-2007 Havell, Inc. A0 rghls ressnaed N OvEI I
2. Enter the user credentials you are provided with to log-in to Sentinel Control

Center.

= Username and password, if using SQL Server authentication, OR

= Domain\username and password, if using Windows authentication
3. Click Login.

4. On the first login, the following warning message displays. The user must accept
the certificate in order to securely log in to the Sentinel Control Center

= A
N Warning - Security = [ 2

An untrusted certificate has been detected. Do you R
want to run the application?

Cedificate Type: X504

Issued To: desk.domain.cam
Issued By: desk domain.com
Fingerprint: FEO12:49:41.F5B3:3CC8 601 2:49:41:75:63:3C
I Accept I l Accept Permanemtly ] I Cancel I

5. If you select Accept, this message displays every time you try to open Sentinel on
your system. To avoid this, you may select Accept permanently.

To Start the Sentinel Control Center on Linux and Solaris:
1. Asthe Sentinel Administrator User (esecadm), change directory to:
$ESEC_HOME/bin
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2. Run the following command:
control_center.sh
3. Enter your username and password and click OK.

4. A Certificate window displays, if you select Accept, this message displays every
time you try to open Sentinel on your system. To avoid this, you may select
Accept permanently.

Introduction to the User Interface

In the Sentinel Control Center user interface, you may perform the activities through the
following components:

=  “Menu Bar”
= “Toolbar”

=  “Tabs”

= “Frames”

Sentinel Control Center provides you the “dockable” framework, which allows you to
move the Toolbars, Tabs or Frames from their default location to user-specific locations
for ease-of-use.

N Novell Sentinel Control Center - logged in as esecadm

File Options  Windows  Ewert Source Management Admin - Help

aleiey | @I%‘HI 12 0A&F9Nrd &II

i Active Viguws ™ a Correlation

Mavigator ) Incidents | &

- # Reporting Corfiguration
~# Reporting Data

- @ Evert Configuration

-~ # Global Fiter Carfiguration
- # Color Fiter Configuration
-~ # Mapping Configuration

W Senver View Manager

Starts Auto Restarts Start Time Version

=7 ProcessHestth
= J esecSlestd

® Menu Corfigurstion o Collector_Manager 1 1} 4126107 10:26:40 AM  Running 1h 54:57 6000
% Das Statistics o Correlation_Engine 1 1} 412607 10:26:20 AM  Running 1h&s:17 6000
aije h O DAS_Aggregation 1 1} 412607 10:26:20 AM  Running 1h&s:17 6000

@ vas_Bnary 1 0 42607 10:26:20 AW Running 1h85:17 6000
-] User Corfiguration -Q DAS_Proxy 1 0 4126107 10:2620 AM  Funiing 1h 6647 6000
@ pas_query 1 0 412607 10:26:20 A Running 1h£5:47 6000
@ pas_kr 1 0 412607 10:26:20 A Running 1h£5:47 6000
@ a3 _TRac 1 0 412607 10:26:20 A Running 1h£5:47 6000
@ UND cammunicat.. 1 0 4126/07 10:25:35 A Running 1h56:02 6000
@ Windams Communi... 0 0 NOT_INITIALIZED 60,00

Menu Bar

The menu bar has the menus required to Navigate, perform activities and change the
appearance of Sentinel Control Center.

N Hovell Sentinel Control Center - loggedin as esecadm

File  ©ptiohs  Windows  Event Source Management  Active Wiews  Correlstion  Incidents iTRAC  Analvsis Advizor  ASdmin Help

The File, Options, Event Source Management, Windows and Help menus are always
available. The availability of other menus depends on your location in the console and
permissions.

Toolbar

The Tool Bar allows you to perform the Tab specific functions. There are four system-
wide toolbar buttons that are always displayed. These toolbar buttons are View Sentinel
Help, Cascade All Display Windows, Tile All Display Windows and Save User
Preferences. The availability of other toolbar buttons depends on your location in the
console and permissions.
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System-Wide Toolbar

The system-wide toolbar buttons are:

Reset layout Ornling Help ~ Cascade Al Display Windows

I

Rmrﬂnismggngﬁta@%l@|al_h gi?ereru:es

Eedo Tile &1 Display Windows

Tab Specific Toolbar buttons

Tabs

1-6

Tab-specific toolbar buttons allows you to perform the functions related to each tab.
pve - [E T W]
Correlation || N 5 A 9 i
Incidents |3 @m
ITRAC ped, ::fﬂ
Analysis | i <4 [

amn P RGPS 3 Q)

For more information on Tabs-specific toolbar buttons, see the chapters on each of the
Tabs mentioned in the list above.

L'

Depending on your access permissions, Sentinel Control Center displays the following
tabs.

Active Views™
Correlation
Incidents
iTRAC™
Analysis
Advisor

Admin

For more information about Tabs, see the chapters on each tab.
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Frames

Sentinel provides a dock-able framework which allows you to drag frames on the screen
to place them in user preferred locations. In a frame, you will see the following buttons

which allow you to drag/hide frames.

= Toggle Floating
= Toggle Auto-hide

0
=

Mavicgstar

= _| Active Views
—_I Real Time
S P UELICALL, Severity
- B[] Snap Shat

+_| Histarical Gueries

To drag a frame to any location:

1. Click Toggle Floating icon on the Frame or hold the frame and drag it to the
desired location.

To hide a frame:

1. Click Toggle Auto-hide icon.

NOTE: You may undo dragging or reset to default position using the toolbar
buttons.

Navigating through Sentinel Control Center

To navigate using Toolbar:

1. Click the tab you have to work on.

2. Click the toolbar buttons to perform the actions.
To navigate using Menu bar:

1. Click the tab menu in the Menu bar.
2. Select an action you have to perform.

NOTE: This procedure is generic for all the tabs in Sentinel Control Center.
Navigation specific procedures for tabs are discussed in the relevant chapters.

Changing the appearance of Sentinel Control Center
You can change the Sentinel Control Center’s look by:

= “Setting the Tab Position”

= “Cascading Windows”

= “Tiling Windows”

= “Minimizing and Restoring Windows”
= “Closing all open Windows”

= “Docking or Floating a frame”

= “Showing or Hiding a frame”

Sentinel Control Center
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Setting the Tab Position

To set the tab position:

1. Click Options > Tab Placement.
2. Select either Top or Bottom.

Cascading Windows

To cascade windows:

1. Click Windows > Cascade All. All open windows in the right panel will cascade.
Tiling Windows

To Tile Windows:

1. Click Windows > Tile All.

2. Select from the following to meet your requirement:
= Tile Best Fit
= Tile Vertical
= Tile Horizontal

Minimizing and Restoring Windows

To minimize all windows:

1. Click Windows > Minimize All. All open windows in the right panel will
minimize.

To restore windows to original size:

1. Click Windows > Restore All. All open windows in the right panel will restore to
their original size.

NOTE: Use the Minimize and Restore options provided on the top-right corner
of the tab to minimize individual tabs.

Closing all open Windows

To close all windows:
1. Click Windows > Close All.

Saving User Preferences

If the user has permissions to save their workspace, they may save the following
preferences:

» Permanent windows that are not dependent on data that was available at the time of
their original creation.

Active Views

Summary displays

Window positions

Window sizes, including the application window

Tab positions

Navigator docked or floating and showing or hidden

The following preferences are not saved when the user logs out:

=  Snapshots

1-8 Sentinel User Guide



Historical event queries

Secondary windows opened from one of the primary windows in the Admin
Navigator

Column widths in Active Views

To save your preferences:

1.

. Ll
Click File > Save Preferences or click ..

Changing Password

To change your Sentinel Control Center password:

1.

2.
3.
4

Click Options > Change Password.

Enter the old password.

Enter the new password and matching confirm password.
Click OK.

NOTE: For more information on password security, see Setting Passwords in
Best Practices in Sentinel 6.0 Installation Guide.

Hostname updates

If the hostname of a system is changed, you may need to perform some of the following
actions on the system depending on the Sentinel components installed on it.

IMPORTANT:
Stop Sentinel Service before you perform these actions.

You may have to update all the machines (which have components affected by
the hostname change) before you restart Sentinel service on any machine.

Scenario 1: Change in Sentinel Database Hostname

In this scenario, the affected components are DAS and SDM. So you may need to

Update the DAS
Update SDM

The configuration file enables DAS to connect to the database. So, you have to update the
configuration files to update DAS.

To update DAS:

1.

Login to the machine where DAS is installed as esecadm (on UNIX), or as an
administrator (on Windows).

Stop the Sentinel Services running on the machine.

Go to ESEC_HOME\bin:

= On Unix, type the command cd $ESEC_HOME/bin

= On Windows, type the command cd /d %ESEC_HOME%\bin

Update DAS configuration files on Unix and Windows using the following
commands.

= On Unix, execute ./dbconfig -a ../config -h <new DB hostname>.
»=  On Windows, execute \dbconfig -a ..\config -h <new DB hostname>.
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You require the Database Hostname to login to SDM. To login to SDM, you may have to
update the Database Hostname in SDM login window.

To Update SDM

1. Open Sentinel Data Manager.
2. In the login window, enter the Database, new hostname and other required details.
3. Click Connect.

Scenario 2: Change in Sentinel Communication Server Hostname

1-10

In this scenario, the affected components are Communication Server, DAS, Correlation
Engine, Sentinel Collector Manager and Sentinel Control Center. So you may need to

= Update the Communication Server
= Update DAS, Correlation Engine, Sentinel Collector Manager, Sentinel Control
Center

You may have to re-install the Communication Server to update the Hostname change.

To re-install Communication Server:
1. Login as root (Unix) or administrator (Windows) on the system where the
Communication Server is installed.

2. Run Sentinel Uninstaller. In the Select components to Uninstall window, select
Communication Server and deselect all other options.

Follow instructions in Uninstalling Sentinel in Sentinel 6.0 Installation Guide as
required and complete uninstallation.

3. Click Finish.
4. Insert (and mount, on Solaris/Linux only) the Sentinel Installer CD.

5. Run the setup file. In the Select components to Install window, select
Communication Server only.

Follow the instructions in Installing Sentinel 6.0 in Sentinel 6.0 Installation Guide as
required and complete installation.

6. Reboot the system.
The configuration file that connects the Communication Server and Sentinel processes

needs to be updated. You may have to perform the steps given below on all machines with
DAS, Correlation Engine, Collector Manager, and Sentinel Control Center installed.

To update DAS, Correlation Engine, Collector Manager, and Sentinel Control Center:

1. Goto ESEC_HOME/config/ and edit configuration.xml.

2. Replace the four occurrences of the Communications Server Hostname with the
new Hostname.

3. Save and exit the configuration.xml file.

IMPORTANT:

After the steps mentioned above are performed, restart the Sentinel Services for
the changes to take affect.
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Active Views™ Tab

Topics included in this chapter:

Topic Page

Understanding Active Views 2-1
Viewing Real Time Events 2-4
Sending Messages about Events and Incidents by 2-8
e-Mail

Creating Incidents 2-9
Viewing Events that Triggered Correlated Events 2-11
Investigating an Event or Events 2-11
Managing the Columns in a Snapshot or Visual 2-23
Navigator Window

Adding Events to an Incident 2-24

Understanding Active Views

The Active Views tab presents events in near-real time. In the Active Views tab, you may:

=  View events occurring in near real time

» Investigate events

= Graph Events

= Perform Historical Statistical Analysis

= Invoke right-click functions

= [nitiate manual incidents and remediation workflows

An event represents a normalized log record reported to Sentinel from athird party
security, network, or application device or from an internal Sentinel source. There are
several types of events:

= External Events (event received from a security device), such as:

= An attack detected by an Intrusion Detection System (IDS)
s Asuccessful login reported by an operating system
= A customer-defined situation such as a user accessing a file

= Internal Events (an event generated by Sentinel), including:
s Acorrelation rule being disabled
= Database filling up

You can monitor the events in a tabular form or using several different types of charts,
you can perform queries for recent events.

NOTE: Access to these features can be enabled or disabled for each user. For
more information, see Sentinel Database Users, Roles and Access Permissions in
Sentinel 6.0 User Reference Guide.
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Introduction to the User Interface

2-2

In Active Views, you may see Create Active View and Event Query. You may navigate to
these functions from:

Active Views |

= The Active View menu in the Properties
Menu Bar

Artive Views ‘

Properties

= When you create a filter, The Crete Aclhe Hiew
Active View menu has these \% Evert Query
additional options.

cidents | &7 iTRAC™ | ane

Manicator o &

= _| Active Wiews
- _| Real Time

te ]| Shap Shot
= The Navigation Tree in the =1~ Histarical Gueries

Navigation Pane tee | Everts
e ] Correlsted Everts
----- [ ] Investigate

Create Active View ~uapshot

FRNET

Event Query Ianage Columns

=  The Toolbar Buttons

AL LE]

Active Views provides two types of views which display the events in Tables and Graphs.

Table Format displays the variables of the events as columns in a table. You can sort the
information in the grid by clicking on the column name.
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Severity Evert Time Everithlams EventlDr SourcelD Collector
@ 55507 12:35:31 PM DhiSpacelow  |B30E4443-DAEI-1029-900A-00123. . |A6 C459 CO0-DABI-1029-9F5C-001 23F9...
@ 54507 12:35:31 PM DhSpacelow  |B30E4443-DAEI-1029-9005-00123... |A6C459C0-DABI-1029-9F5C-001 23F9...
@ 54507 12:35:31 PM DhiSpacelow  |B30E4443-DAEI-1029-9004-00123... |A6C459 C0-DABI-1029-9F5C-001 23F9...
@ 5/5/07 12:33:31 PM DhSpacelow  |B3I0E4443-DABEI-1029-9001-00123... |A6C459C0-DABI-1029-9F5C-001 23F9...
Graphical Format displays events as Graphs. You can change the chart types to display
other chart types.
..... " i 1
) Filter PUBLIC:Internal_Events, Attribute Resource o
- ) Cconecto...
18 Minute;30 Second Intervals )
' B - |:|Mapp|ngS...
3 Ouserauth...
5 - ls |[CJusersess...
) ErealTime...
g H ++ (IDBSpace
=
a Ceventsub...
5]
2 3 m 2 (Mcore
a
2 W Healthia...
2 - L2
Oeventsou...
[ -<others
14 H1
L o e s B oo o e e LI B mes m s e S S o e B B B L e
12:35.. 123730 PM 124000 PM  12:42:30 PM  12:45:00 M 12:47:30 PM
Time
4 >

A near Real Time Event Table with graphical presentation and Snapshot are the two types
of Active Views.

Near Real Time Event Table:

= Holds up to 750 events per 30-second period. If there are more than 750
events, the events are displayed in the following priority order: correlated

events, events that are sent to the GUI only using a global filter, and all
remaining events.

= By default, the client maintains a 24-hour period of cached events. This is

configurable through “Active View Properties”.

s By default, the smallest possible display interval of an active view will be 30

seconds. This is represented by a gray line in the event table.

3 |2005.06.21 { OR:34:38 EDT Threshold_e
@  2005.06.21 06:34:38 EDT 6. 158.21.6 192.166.10.1 Password_e
@  |2005.06.21 ] 063425 EDT 190.168.12.21 190,168.12.21 Program_exg

In the event when there are more than 750 per 30-second time period, a red
separation line will appear indicating that there are more events than what is
displayed.

3) 2005.06.21 § 07:07:00 EDT 172.16.112,50 172,16.0,65 unsuccessiy
i3} e005.06.21 f 07:07:00 EDT 172.16.112,50 172.16.0,65 suspicious-fil
3) 2005.06.21 § 07:06:58 EDT 172.16.112.50 172.16.0,65 successful-3

= Onsaving user preferences, system will continue to collect data for 4 days.

For instance, if you save your preferences, log out and log back in the

following day, your Active View displays data as if you never logged off.

o |f an Active View is created and not saved, it will continue to collect data for
an hour. Within that hour time frame if an identical Active View is created,

the Active View displays data for the last hour.
Snapshot: Time-stamped views of a Real Time Event View table.

The following is what makes an Active View unique.

Filter assigned to an Active View

Active Views™ Tab
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= The z-axis attribute
=  The security filter assigned to a user

The Active Views Tab allows you to:

= “Reconfigure Total Display Time” = “Send messages about Events by

= “Add Events to an incident” e-mail”

= “Close a Snapshot or Visual = “Show or Hide Event Details”
Navigator Window” = “Snapshot of a Visual Navigator

= “Create an Incident” Window”

= “Custom Menu Options with Events” = “View Events that triggered a correlated

= “Investigate Event Query" event”

= “Investigate Graph Map” = “View Vulnerability Visualization”

= “View Advisor Data” = “View Asset Data”

= “Manage Columns” = “Ticketing System Integration”

You can change values (column names) to display logical names and have it populate
throughout the system. You can apply attributes to the event stream that are relevant to
your business. For more information, see Chapter 11 “Sentinel Data Manager” and the
Sentinel 6.0 Collector Builder User Guide.

Reconfiguring Total Display Time

Active View Properties allows you to configure the cached time in each client. The default
cache time value in an Active View is 24 hours.

To configure Maximum Total Display Time:

1. Click the Active Views tab.
2. Click Active Views > Properties.
3. Make your changes. Click OK.

I

i
Active Views Properties f'5__<|

N |
This walue will not take effect until wou restart Sentinel Control Center.

NOTE: The new values will not take effect until you restart the Sentinel Control
Center.

"Maximum Total Dizplay Time

Viewing Real Time Events

To View Real Time Events:

1. Click the Active Views tab.
2. Click Active Views > Create Active View or click Create Active View icon.

e
i
SR

3. Inthe Event Visualization Wizard window, click the down arrows to select your
Z-axis, Filter and to Display Events (Yes or No).
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NOTE: In the filter selection window you can build your own filter or select one
of the already built filters. Selecting the All filter will allow all events to appear in
your window. When creating an Active View, if the filter assigned to the Active
View is changed or deleted after creation of the Active View, the Active View is

unaffected.

Active Yiews™ Wizard _ .

Step 1. Event Collection Parameter Setup

x|
Define the dizplay properies by selecting the Event Attribute to uze onthe '-"i"'lll'll"“"\r
Axiz of the chart, the fiter to apply and whether or not to dizplay events.

~Ewvent Attribute (£ Axis)

ISe\-'erit\_.r LI
Fitter =
| [~
Dizplay Events?y
I‘r‘es LI
< Back, | Mext = Firis

After making your selection, you can click Next or Finish. If you select Finish, the
following default values will be chosen:

Display Interval and Refresh rate of 30 seconds

Total Display Time of 15 minutes

Y-axis as Event Count

Chart type: Stacked Bar 2D

If you click Next, click the down arrows to select your:
Display Interval and Refresh rate:

= Display Interval is the Time interval to display events.
o Refresh Rate is the rate at which Active Views should refresh.

Total Display Time: Amount of time to display the chart
Y-axis: Either total Event Count or Event Count per Second

Click Next.

5.

Select your chart type from the drop-down list and click Finish.
Chart type: Stacked Bar 2D, Bar 3D, Line and Ribbon

Your graph will look similar to:

Active Views™ Tab
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] PUBLIC: High_Severity, Severity ! E E I
o Filter PUBLIC High_Severity, Attribute Severity TopWalues for Last 5 Minutes
15 Minute; 30 Second Intervals 6:08:00 AM - 6:13:00 AW
Rank | Severty I Courit/Rate |
= e [mE] 410
= 2 [ 210
o 3 4 147
=
2
w
5:58:.. 6:00:00 AM 0:02:00 A G:0400 AWM 6:00:00 AW 6:08:00 A 6:10:00 AWM 6:12:00 ...
Time
ﬂ L‘ Interval Values Top Walues
A Severity | DateTine I SourcelP DestinationlP EvertMarne | “ulherahbility J‘
(0] 61405 B:12:52 A 206.155.21.6 19016512 21 Failed_login-administrator o AI
3 61406 6:12:52 AM 206.152.25.22 19016612 24 apache-chunked-sncoding-bo [1 —
LE] 61408 612,52 A 208.152.25.22 1901651224 xlight-pass-ho o
3 614405 B:12:52 A 208.152.25.22 1901651224 Reject o
. E14008 B:12:52 AW 1891651022 189168 10 23 Attempted_telnet 0
& 614405 612,52 A 199.165.10.25 199.165.11.22 Repeated_login_faiures 1]
[ ] 6144065 B:12:52 AM 206.158.21.6 199.165.10.25 Failed_su o
[ ] B/1406 B6:12:52 AM 199.168.10.22 199.168.10 22 Failed_su ]
[ 641406 6:12:52 AM 206.156.21 6 199166 .10 22 Repeated_login_failures 1]
. ) 61405 B:12.52 Ak 206.158.21.6 199.165.10.25 Reneated loain failures o LILI
2451 of 2451 !_Ipdate' 6#14/06 6:13:00 AM Receivec: 87 (of 87) Displaying: 87

The five buttons to the left of the chart perform the following functions:

0 = Lock/Unlock the Chart: Used when performing a drill-down, zoom in,
zoom out, zoom to selection and saving a chart as an html file.

= |Increase Display Interval: Increases the display time interval for
incoming events

= Decrease Display Interval: Decreases the display time interval for

incoming events

a2 = Increase Display Time: Increase the time interval along the x-axis

3 = Decrease Display Time: Decreases the time interval along the x-axis

When you click the Lock button, additional available buttons are:

q = Lock/Unlock the Chart: Used when performing a drill-down, zoom in,
. zoom out, zoom to selection and saving a chart as an html file.

= = Zoom In: Zooms in without changing any of the time settings of the
chart

5 = Zoom Out: Zooms out without changing any of the time settings of the
chart

= Zoom to Selection: Zooms in on a selection of time intervals of events.

= Snapshot Active View: Save as an html file with chart as images and
events in a tabular format.

To Reset Parameters and Chart Type of an Active View

When viewing an Active View, you can reset your chart parameters, change your chart
type.

To Reset Parameters and Chart Type of an Active View:

1. Within an Active View displaying a chart, right-click and select Properties.
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=T TSR r

o8 Dril Down to Event £ Active Views™ Properties

Jd Bar 3D Chart
rTimne Irteryal

fig Stacked Bar 20 chart
| Display Interval 30 Secand w
[ Line Chart

= Refresh Rate 30 Second L
i:l Ribbon Chart Total Display Time 2 Hour v
_,y" Properties D};izard i YWalue:

e S e e e e L
¥ Axis Euert Court b

Under the Parameters tab, you can set:

= Display Interval: Time between each interval

= Refresh Rate: Number of seconds for event rate to be updated
= Total Display Time: Amount of time to display the chart

» Y-axis: Either total Event Count or Event Count per Second

Under the Chart Types tab, you can set your chart to Stacked Bar2D, Bar 3D, Line or
Ribbon.

£ Active Views™ Properties fgl

Parameters | Chart Types |

—Chart Property

Type: | Stacked Bar 20 v

Stacked Bar 20

Line
Rikbon

Rotating a 3D Bar or Ribbon Chart

To rotate a 3D bar or ribbon chart:

1. Click anywhere on the chart and hold the mouse button.
2. Reposition the chart as desired by moving the mouse while holding the button.
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Showing and Hiding Event Details

To show event details:

1. InaReal Time Event Table of the Visual Navigator or Snapshot, double-click or
right-click an event and click Show Details. An event details displays in the left
panel of the Real Time Event Table.

Property Walug : Severity DateTime Eventhame SourcelP
= ~ (s} /2007 12:26:32 PM e
Severity 3 3)  [36207 12:25:20 PM PortScan 192.166.1.20
Diate Timne: 302/07 12:25:20 PM (3 [3r2007 12:25:20 PM PortScan 172161155
EwentMame PaortScan 12 3 P PortScan
SourcelP 17216113105 o P ;
DestingtionlP 207.121.188.105 o [ l[O] shombetws | 192.168.1 20
EventiD POCOAR 3-A35C-1023 D [s07i . 172161155
-B2 CAND1SF EGSGEANE 0] 5007 1 “igw in Active Browser 1987 248153
SaurcelD ?f;:fjﬂ’;;’“gg’;;ﬁg B a0 Investigate » 152.166.1.20
WizardPort arada 3 [3r071 anahyze ) 17216114148
Wizardsgent sront O <l Tir | 192.168.1.20
SensorTyne N O =TT 192.168.1.20
Protocol iep D [se071 Ennail 172.16.114.169
(5 [3ro71 ) 192165120
Eigﬁ,ﬂ:pm :gzs B [me07a Cesiclicient 17216116154
SID=11711; (2 32007 1 Add To Incidert 1947 248153
Extendedinforma... PortscanType=portsca !, 32007 1 plng— 17216114143
n2 2 [3r071 197.218.177.69
Product Mame IDS¥%_GNUX_SMRT ;,' 3207 1 nzlookup 192.168.1 20
(zhp_portscan) 3 |30 eETEE 194.7 248153
Portscan detected from (2 |37 1 ) 17216113105
Message 17216113106:6 0]} %2007 1 hois? 19573151 50
targets 6 ports in 33 3 |a20712:2520 PM FortScan 195.115.218.108
Do ftackame Z:ftos!:iz () (36207 12:25:20 PM PortScan 17216114148
Xl 2TNT A EN DR DArtSran 428 2 RN 127
4 bl | B2
B53 of 653 Update: 3207 12:27:00 PM Received: 0 (of 0) Displaying: 0

To hide an event detail:

1. Inan Real Time Event Table of the Visual Navigator or Snapshot, with event
details displayed in the left panel, right-click an event and click Show Details.
The event details window will close.

Sending Messages about Events and Incidents by e-

Mail

2-8

Ability to send emails is set in the execution.properties file during installation. This file
can be edited after installation. This file is located:

For Windows:
%ESEC_HOME%\config

For UNIX:
$ESEC_HOME/config

For more information on configuring email, see the section Configuring Sentinel email in
Chapter 12 “Utilities”.

To send an event message by e-mail:

1. InaReal Time Event Table of the Visual Navigator or Snapshot, select an event
or a group of events, right-click and select Email.

Sentinel User Guide



2.

3.

Email Events E x|

-Selected Events: 10 ]

10 I Resource Message | |
&7FF1066-ZEFS-1026-. ., FRWL_Res udp drop detected FR.., :l |
S37FEE73A-2EF3-1026-.., FRWL_Res udp drop detected FR...
G70B3324-2EF3-1026-,,, FRWL_Res tcp drop detected FR...
S7DSADDE-2EFS-1026. .. FRWL_Res udp drop detected FR...
S7AE7E24-ZEFS-1026-... FRWL_Res tcp drop detected FR... |

|lr7aFcrRn FFR-1N7%  [FRWA Rec v Aron detected FR LI |

-Email Camposition

Email Address: | =1

Email Subject: I

Email Message:

Ok Cancel

Enter the following information:
= Email Address

=  Email Subject

= Email Message

Click OK.

To e-mail an Incident:

1.
2.

After you save your incident, click the Incidents tab, Incidents > Incidents View.

Click All Incidents option in the Switch View drop down list located at the bottom
right corner.

Double-click an Incident.
Click Email Incident.

E
Enter:

=  Email Address
=  Email Subject

»  Email Message

Click OK. The e-mail message will have html attachments that address incident
details, events, assets, vulnerabilities, advisor information, attachment
information, Incident Notes and incident history.

Creating Incidents

NOTE: To perform this function you must have user permission to create
Incident(s).

Active Views™ Tab 2-9
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This is useful in grouping a set of events together as a whole representing something of
interest (group of similar events or set of different events that indicate a pattern of interest
such an attack).

NOTE: If events are not initially displayed in a newly created Incident, it is most
likely due to a lag in the time between display in the Real Time Events window
and insertion into the database. If this occurs, it may take a few minutes for the
original events to finally be inserted into the database and display in the incident.

To create an incident:

1. InaReal Time Event Table of the Visual Navigator or a Snapshot Real Time
Event Table, select an event or a group of events and right-click and select Create

Incident.
N PUBLIC:ALL @ 3/9/07 12:30:05 P Snapshot
Sewverity Reporter Marne Dt Tirme EwertMarmne SourcelP
4 B 164 — vertsihBoundary ..

(2)  |saritha.applabs.net 319007 12 e DEEl b
@ ezecSlestd 359007 12 iew in Active Browser gjer Stopped
(2)  |saritha.applabs.net 359007 12 b
3)  |esecSlesed 3807 12 lnvestiate U | et
2)  |esecSlesfd 30907 12 Analyze ¥ idin
(2)  |esecSlestd 359007 12 ion
D] ezecSlestd 359007 12 ol Cut
(3 |esecSlesgd 3/I07 12 Email hing Existing Data
(2 esecSleshd 39007 12 ; din
(2)  |esecSlestd 359007 12 ) ion
3)  |esecSlessd 30907 12 () D (R dout
(2)  |esecSlestd 359007 12 ping Data
(7] 3/9007 11
2 esecSlesd 39007 11 EMEEI BoLrce
@ 3907 11 traceroute

(3)  |esecSles6d 39007 11 Whois? or

2. Inthe New Incident Window, you may find the following tabs:
= Events: Shows which events make up the incident
= Assets: Show affected assets
= Vulnerability: Show related asset vulnerabilities
= Advisor: Asset attack and alert information
* iTRAC: Under this tab, you may assign a WorkFlow (iTRAC)
= History: Incident history

= Attachments: You may attach any document or text file with pertinent
information to this incident

= Notes: You may enter any general notes you would need to refer regarding
this incident.

3. Inthe Create Incident dialog box, enter:

= Title

= State

= Severity
»  Priority

= Category

= Responsible
= Description
* Resolution

4. Click Create. The incident is added under the Incidents tab of the Sentinel
Control Center.
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Viewing Events that Triggered Correlated Events

You must right-click a correlated event in order to view the events that triggered the
correlated event. In the event table from which you are selecting the event, look in the

summary display panel on the right for an event that has a property of SensorType with a
Value of C (C: correlated event).

To view events that triggered a correlated event:

1.

In a Real Time Event Table of the Visual Navigator or Snapshot, or an Event
Query table, right-click a correlated event and select View Trigger Events. A
window opens showing the events that triggered the rule and the name of the

Correlation Rule.

M Correlated Events For SFE1FEZC-4630-10256-BEOF-0B0020ADE =10 %]
Evert ld: Carrelaton ik Befch size. - a
[oFBFE2C-4530-1026-6E0F-0B0020A0B488 | [ auich 1 fioo =] Q| X
b DekeTime | severty | Everthisme SowceP | DestinatioriP
2004 02 26 f08:38:53 EST ] @) Fasswiord_scpired 61581 & [192 168101
| j
{7}, Search complete. Court: 1

Investigating an Event or Events

This function allows you to:

= Perform a Event Query for the last hour on a single event for:
= Destination IP addresses
o Source IP addresses
o Event Name

NOTE: You cannot perform a query on a null (empty) field.

= Graphically display the source fields (IP, port, event, sensor type, Collector)

mapped to the destination fields (IP, port, event, sensor type, Collector name) of the

selected events.

Below is an illustration of source IP addresses mapped to destination IP addresses.

Active Views™ Tab
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P [=1 E3

N Graph Mapper

Aoply Layout |LelderTl

142 ! ’4’
1000749 1 ,‘}5 -
i /'000254 10.0.0.80 ’+v
)}S 1 1 L 10.0.0.48
100. 0135

y/u 0.
10.0.0.82
10.0.0.242
10.0.0.248 10.0.0.164
10.0.0.122 /1'009133 10.0.0.155
/u ojo.a
1 A
PR
i 10.0.0.206
10.0.0.238 "},
]
10.0.0.66
Investigate — Graph Mapper
To create a graph map:
1. In Real Time Event Table right-click an event or events and select
Investigate>Show Graph.
Severity Event Time SourcelP - Destination|P EweritMame
JET) P L PRGN L R T | TU.LT. TULT .30 TEST Cwern
@) [522i07 12:47:04 AM 10.0.0.2 10,0070 Test Event
3
3
£
4
G Show Details
Wies in Active Browser
E
. Irvestigate » | Show Graph...
gnalyze D Show More Events to this target
g :E;E; 13:1223 im 0 VR BVt Show Maore Everts from this source
| @  [5/22007 12:40:38 AM Erail ihiat are the target objects of this ewvert?
2. You will need to enter the From and To IPs and click Finish. The graph mapper

2-12

window display.

The following is a graphic depiction of Sensor Name to Event Name of severity 5 in

an organic format. You can view a graphic mapping in the following formats:

= Circular = Organic
= Hierarchical = Orthogonal

Sentinel User Guide
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N Graph Mapper(1) -

ajlalla]ls )

PUANN
£ & X X

EngineP erform damEimenfes | Tim e Sum nEaeedEhabug hpullapbitgd P ersistentlapsStatus

N\
. +

UpdateDataObject  RiChartCreated

pad

Apply Layout | Hierarchial | ALL W

4 >

Investigate — Event Query
This function allows you to perform Event Query within the last hour.

To perform an Event Query using the Investigate function:

1. Ina Visual Navigator or Snapshot window, right-click an event>Investigate>
<select one of three options below>

Option Function
| Show More Events to thistarget | Destination IP address
| Show More Events to this source | Source IP address .
What are the target objects of this event? Event Name

Historical Event Query

You can query the database for the past events through Historical Event Query. The
events can be queried according to the filter and severity criteria in required batch size.
You can export the results in HTML or CSV file format.

To query events in Historical Event Query window:

1. Inthe Active Views tab, select Active Views > Event Query. Historical Event
Query Window displays. You can also open Historical Event Query window by
clicking Historical Query Icon on the toolbar. Click Filter.
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2.
3.

N Historical Event Queny

JQ Query &
itter: Severity: B From: B Ta: Batch size:
v| < 105307 11:2021 aM v 103007 113521 aM v 100 v| Q| & | oy v .
T : Destination P Sewerity Source|P EwertTime Ewent Mamne Mezzage
€3 | £ >

3(\ Erter search criteris.

In Filter Selection window, select a filter from the list of available filters.
Click Severity Icon. Select Severity values window displays.

oo

Select Al Clear &l

[#o
[#]1

[¥]2
[¥]3
[+] 4
[V =

Select Severity/s and click OK.

You will need to select From and To Date and Time from From and To drop-

down. The Time you select corresponds your system time.

Select a batch size from the Batch size drop down. The events queried displays in
the batch size you enter.

If you select a batch size of 100, the first 100 events will be displayed in the window
first. After the query is processed, the Begin Searching icon will change to More
results icon. You can see next 100 events along with the previous events by clicking
More results icon.

Click Begin Searching Icon. The query is processed. You can stop/cancel the

search by clicking Cancel search icon.

N Historical Event Query

- '-39 Cuery Q Active Browser
Fitter: Severity: B From: B Ta: Biatch size:
| | A | | [ 100 v| = | G| g oML -
Pr: Destination|P Sewerity SourcelP Ewert Time Eventilame Messane
202167215 Ly 1002007 12:2... [CombinedPersisterthda... Total 7 persistent maps with OKE in 9 entries; t »
202167215 EJ 1052007 12:2... Sin;IePersistemMaIpSt... Customer Dim 01<B in 2 entries w
HIE | 3
& Batch received, click More for additional resuts. Complete through 10/2/07 12:29:16 PM Courit: 100
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TIP:
Select HTML or CSV from the drop-down list to export query results.

Active Browser

You can view the selected events in the Active Views in active browser. You can perform
all the right-click activities that are available in Active Views in Active Browser too.
When you open the Active Browser using Analysis > Offline Query and click Browse
against a specific offline query, the events table will be displayed only when the number
of events are less than or equal to1000.

The events are grouped according to the metatags. In these metatags various sub-
categories are defined. The numbers in the parentheses against these sub-categories
display the total number of event counts corresponding to the value of the metatag.

To view events in Active Browser:
1. Inthe Active Views tab, highlight the event/s you want to view in Active
Browser.

2. Right-click event/s and select View in Active Browser. The selected event/s
display in the Active Browser window.
Or

1. Inthe Active Views tab, select Active Views > Event Query. Historical Event
Query Window displays.

2. Inthe Historical EventQuery window, run a Query and click Active Browser tab.
The selected Query displays in the Active Browser window.

NOTE: The Active Browser tab will be enabled only if the Query results in
atleast one event display.

To view events in Active Browser in Analysis tab:

1. Inthe Analysis tab, highlight the Query you want to view in Active Browser.
2. Click Browse. The selected Query result displays in the Active Browser window.

N Active Browser

Total: 989

Active Browser
= Eventlame

AddProcessDefintion (101)
Createlncident  (343)
Deletelncident (221)
Getincident  (41) All Data
GetProcessDefintion (2 1
Savelncident  (3)
SaveProcessDefinition (1)
UpdateData Okject (1)
Select Muttiple Values.

Event Count

= Resource

Ectivity (1)
IncidertService  (12)

WorkflowServices  (4)

T T T d T
Select Mutipls Valuss & & & & & & & &
§ & A £ ¥ & ® )
™ S 3 o ™ S 3 LS
= SensorType Time
A07) Pri : Sewerity | EvertTime SourcelP Destination|P
@ o7 z2rzapm 172188138 A
= Severity @ 53007 3:26:56 PM 172168138
@ 50732657 PM 72168138
147) @ 5307 32630 PM 172168138
@ 50732508 PM 7216838
@ RanT 2oana 0w R PT PR
= SourcelP t 8 M BN
—
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To search in Active Browser:

1. Enter the value or text you wish to search for in the Search field
2. Press Enter or click the Search icon against the search field to search.

NOTE: You can move between the various searches by using the Forward and

Backward button above the search field.

To add attributes in Active Browser:

1. Click Add an attribute for categorization icon as shown below:

N Historical Event Queny(2)

‘.{3 Quep/va Active Browser

i

Search

2. Select an attribute in the Add an attribute for categorization window that

displays.

gl Choose the attribute name

BeginTime
Collectar
Collectorid
Collector Manager Id
Connectorid
ContralMonitar
Cartrol Pack
Criticality

ZH w

I Ok ] ’ Cancel ]

i
Add an attribute for categorization r'5__<|

Click OK.

Viewing Advisor Data

Advisor provides a cross-reference between real-time DS attack signatures and Advisor's
knowledge base of vulnerabilities. Advisor feed has an alert and attack feed. The alert feed
contains information about vulnerabilities and viruses. The attack feed lists the exploits

2-16

associated with vulnerabilities.

The supported Intrusion Detection Systems are:

= Cisco Secure IDS .
= Enterasys Dragon Host Sensor .
= Enterasys Dragon Network Sensor .
= |SS BlackICE PC Protection =
= ISS RealSecure Desktop "
= |SS RealSecure Network .

Sentinel User Guide

ISS RealSecure Server Sensor
ISS RealSecure Guard
Snort/Sourcefire

Symantec ManHunt
Symantec Intruder Alert
McAfee IntruShield



The IDS Collector populates the DeviceAttackName (rt1) field of an event. Advisor uses
this information to generate attack and vulnerability information. Some examples of
vulnerabilities are:

FINGER: Cfinger Search Probe

SMTP: SmartServer3 MAIL FROM Buffer
Overflow

HTTP: Dragon Fire IDS Web Interface Remote
Execution

FTP:MKDIR-DOS

hp-printer-flood

To View Advisor Data:

1.

= whOOt-backdoor

= nt-telnet

= FINGER / execution attempt
= tellurian-tftpdnt-filename-bo
= FTP MKD Stack Overflow

In a Real Time Event Table of the Visual Navigator or Snapshot, right-click an
event or a series of selected events>Analyze>Advisor Data. If the

DeviceAttackName field is properly populated, a

report similar to the one below

will appear. This example is for a WEB-MISC amazon 1-click cookie theft.

Advisor Summary

Attack Attack ID Alert IDs
WEE-MISC amazon 1-click cookie theft 2931272, 1087, 1194, 8835, 9010
WEB-MISC armazon 1-click cookie theft 2992801 1194, 8835, 2010

Advisor Report
Microsoft Excel XLM Arbitrary Macro Execution (id 9991272) top

3 4 taicrosoft Excel contains a flaw that may allow a malicious user to ru
Urgency Severity warning the user, The issue is triggered when a malicious user creat

Excel macro commands, and embed comrmands in a spreadsheet that
launch the macro without asking the user for permission. If may be |
user to persuade the user to launch the file containing embedded ma

loss of integrity andfor availability of data.

Scenario:

Impact:
Loss of Integrity

Safeguards

Viewing Asset Data

This function allows you to view and save your view as an HTML file of your Asset
Report. You must run your asset management Collector to view this data. The available
data for viewing are:

Hardware

= MAC Address = Value

= Name = Criticality
= Type = Sensitivity
= Vendor = Environment
= Product = | ocation

= Version

Network

= |P Address = Hostname
Software

= Name = Product

= Type = Version

= Vendor

Contacts

= Order = Email

= Name = Phone Number
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= Role

Location

= Room = Address
= Rack

To view Asset Data:

1. InaReal Time Event Table of the Visual Navigator or Snapshot window, right-
click an event or events>Analyze>Asset Data. Window similar to the one below

will appear.
Asset
Report
Hardware MAC Address  04:23:A3:44:65:87
Name Value LINKNOWN
Type DESKTOP Criticality LINKNOWN
Vendor LIRKNOW R Sensitivity LINKROW R
Product Environment  UNKNOWH
Version Location LINKNOWHN
Network IP Hostname
192.168.0.10
devbox10
Software Name Type Vendor Product Version
Contacts Order  Mame Role Email Phone Number
OwnerFirsthame 10 QuwnerLastName 10 ASSET_OWNER OwnerEmailld OwherPhoneMumber 10

MaintainerFirsthame10

o ASSET_MAINTAINERMaintainerEmail10 MaintainerPhoneNumber10
MaintainerLastMame 10
BusinessUnit10 BUSINESS_UNIT
Line0fBusiness 10 LINE_OF_BUSIMESS
Division10 DIVISION
Department 10 DEPARTMENT
Location Room ok
Rack 10
Address HQ
1921 Gallows Rd
Suite 700
Wienna WA 22182 USA
Hardware MAC Address  04:23:A3:44:65:78
Name Value Assetialue
Type DESKTOP Criticality Criticality
Vendor Wendor Sensitivity Sensitivity
Product ProductName Environment Environmentldentity
Version ProductWersion Location Networkldentity
Network IP Hostname
192.168.0.1

Viewing Vulnerabilities

Vulnerability Visualization provides a textual or graphical representation of the
vulnerabilities of selected destination systems. VVulnerabilities for the selected destination
IPs can be seen for the current time or for the time of the selected events.

Vulnerability Visualization requires that a vulnerability collector is running and adding
vulnerability scan information to the Sentinel database. The Novell web site
(http://support.novell.com/products/sentinel/collectors.html) provides Collectors for
several industry-standard vulnerability scanners, and additional vulnerability collectors
can be written using Collector Builder.

NOTE: Vulnerability Collectors are distinct from Event Collectors and use
different commands.

There are several Vulnerability Visualization views:

= HTML

= Graphical
s Circular
= Organic

o Hierarchical
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http://support.novell.com/products/sentinel/collectors.html

s Orthogonal

The HTML view is a report view that lists relevant fields, depending on which
vulnerability scanner you have:

=P
. Host

*  Vulnerability
= Port/protocol

Vulnerabllbty Summary

172460123 10

124601 49
1726003 18
126071 43

P Hoat Yulnerabililies Pork/Protozol

O ¢ TCR, 21 (Ftp) TCR, 21 (Fp) TCR, 21(Ftp) TCR, 23 (sch| ITER, Z2{ssh])/TeR, 22|sch) TCR, 23{telnet| SToP, 23[telnet)/ TCR,
Z5{smtp| ITCR, 25{smip| FTCR, 25{srtp| ITCR, 687 ITCR, 587
1291 |nessus| FTCP, 3306 (mysql)#ToF

QNIETCR, QTR 21 (Ap)d TCP, 21 (fp)/ TCP, 22 (ssh) ¢ TCP, 23(telnat)/ TCR, 23 |talnet) TEP, 23 (tlnet)/ TR, 25 |smip)/ TCP,
ZE(sPtp| STCR, 25(skip| ITCR, ZE(stAbp| STCR, 25 |sttp) TR, 26 [skatp) TCR, 25 |smip) TCR, 26 [smip) TCR, 25(smtp) TCR,
25{smtp| ITCP, 25{srip| TR, S0(dnels)# TCR, 50 {insix| FTCP, 90fdnslx) T CP, 50(dnst) FTCP, S0fdnsix) TCP, 90|dnsia) TR,
l?D[dnsbt].f'rl:P. a0 |dns i) F TGP, IH[sunrpc]fTCP, ||1|sunrpc]{TCP. 161 |snmp]fUDP, 512 (gec]|/TCP, 513[logln]JTCP. 514|shaII|JTCF,

ITCR, 587 i ITCR, 55T TCF, 587 TCP, 57| i TCP, &
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The graphical display is a rendering of vulnerabilities that link them to an event through
common ports. Below are the examples of the four available views:

ftp
20/TCR

1901661224
telnet
199.168.10°

23TCP

1991681023

dhsix 189168.10.22 Habeanieri
ansTCP ﬁ
@ 199.158.11.22\A
dnsix
1691661023 i
190,168 42 21
sometimes-rpc21 ﬁz
2TTATCR
ftn
217CP
Organic
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Orthogonal

In the graphical display there are four panels. They are:

= Graph panel
=  Tree panel
= Control panel
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= Details/events panel

The graph panel display associates vulnerabilities to a port/protocol combination of a
resource (IP address). For example, if a resource has five unique port/protocol
combinations that are vulnerable, there will be five nodes attached to that resource. The
resources are grouped together under the scanner that scanned the resources and reported
the vulnerabilities. If two different scanners are used (ISS and Nessus), there will be two
independent scanner nodes that will have vulnerabilities associated with them.

NOTE: Event mapping takes place only between the selected events and the
vulnerability data returned.

The tree panel organizes data in same hierarchy as the graph. The tree panel also allows
users to hide/show nodes at any level in the hierarchy.

The control panel exposes all the functionality available in the display. This includes:

=  Four different algorithms to display
= Ability to show all or selected nodes which have events mapped to them
= Zooming in and out of selected areas of the graph

In the Details/Events panel, you have two tabs. When in the Details tab, clicking on a
node will result in displaying node details. When in the Events tab, clicking on an event
associated with a node the node displays in tabular form as in a Real Time or Event Query
window.

To run a Vulnerability Visualization:

1. Inan Real Time Event Table of the Visual Navigator or Snapshot, right-click an
event or a series of selected events and click:

= Analysis
s Current Vulnerability: Queries the database for vulnerabilities that are
active (effective) at the current date and time.

= Event Time Vulnerability: Queries the database for vulnerabilities that were
active (effective) at the date and time of the selected event.

N PUBLIC:Correlation @ 3/23/07 7:16:17 P Snapshot

SourcelP Destination|P

Show Details

Wiew in Active Browser

Investigate 4

Analyze 4

Wiew Trigger Events Aaset Data

Ermail Current Yulnerakitty:
Create Ihcident Ewent Time Wulnerahitty
Addd To Incidert

nslookup
ping

traceroute

bz

2. At the bottom the vulnerability results window, click either:
= Event to Vulnerability Graph
= Vulnerability Report
3. (For Event to Vulnerability Graph) Within the display, you can:
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= move nodes and their labels
= use one of four different layout algorithms to display the graph
= show all nodes or only those nodes that have events mapped to them

= in-line tree filtering in the event that a large number of resources are returned
as vulnerable

= zoom in and out of selected areas

Ticketing System Integration

Novell provides optional integration modules for HP Service Desk or BMC Remedy that
allows you to send events from any display screen to one of these external ticketing
systems.

You can also send incidents and their associated information (asset data, vulnerability
data, or attached files) to Service Desk or Remedy. Updates in Service Desk and Remedy
will then be sent back to the Sentinel Control Center so Sentinel users know when the
issue’s status changes.

For more information about sending incidents and events to an external ticketing system,
see the 3rd Party Integration Guide.

NOTE: The permission to create Service Desk or Remedy incidents is controlled
by the administrator on a user-by-user basis.

Using Custom Menu Options with Events

To use a custom menu option with an event:

2-22

1.

In an existing Real Time Event Table of the Visual Navigator or Snapshot, right-
click an event and select a menu option. The default custom menu options are as
follows:

= ping

= nslookup
= tracert

= Whois?

You can further assign user permission to View Vulnerability and to perform HP
Actions. You can add options using the Menu Configuration window that’s available
in the Admin tab.
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: Severity DrsteTime

SourcelP

N PUBLIC:Correlation @ 3/23/07 ¥:16:17 EM Snapshot

DestinstionlP

Show Details

Ewent Mame:

Wiew in Active Browser

Inwestigate ]
Analyze ]
Wiew Trigger Events

Email
Create Incidert
Add Ta Incidert

nslookup
ping
traceroute

Whais?

Managing the Columns in a Snapshot or Visual
Navigator Window

To select and arrange columns in a Snapshot or Visual Navigator:

1. With a Snapshot or Visual Navigator window open, click Active View > Event

Real Time > Manage Columns or click the Manage Columns of Real Time Event

Table.

Use the Add and Remove buttons to move column titles between the Available
Columns list and the Show these columns in this order list. The Insert button can
be used to insert an available column item into a specific location. For example,

in the illustration below clicking Insert will place Attackld above DateTime.

Available columns: Show these columns in this order:
CEVENTY =
(CorrelakedEventUuids M
iCk1 SourcelP
CES CrestinationIP
(Customeryarl Add we | Eventhiame
Cushomerar10 Wulnerability ;l
(Custarner'ar 100 Insert me | Criticality
(Custameriar1l = EventID Ll
Custameriar12 ﬂl SourcelD
Cuskomeryarls WizardPort
(Custorneriar14 Wizarddgent
(Customeryar15 Resource
ickameriiar1f ¥ SubResource
ir I LI—I Sensorflame Li
O, | Cancel |

Use the Up and Down arrow buttons to arrange the order of the columns as you want
them to display in the Real Time Event Table. The top to bottom order of column

titles in the Manage Column dialog box determines the left to right order of the

columns in the Real Time Event Table.

Active Views™ Tab
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3. Inthe Manage Column dialog box, click OK.

4. If you want your columns to display the next time you open the Sentinel Control
Center, click File > Save Preferences or click Save User Preference icon.

oH

Taking a Snapshot of a Visual Navigator Window

To perform this function you must have user permission Snapshot.

This is useful to study events of interest since the Visual Navigator refreshes
automatically and the alert or alerts of interest may scroll off the screen. Also, within a
snapshot, you can sort by column.

To take a snapshot of a Real Time Event Table:

1. With a Visual Navigator window open, click Active View > Event Real Time >
Snapshot or click Snapshot Event Real Time Table icon

-

A Snapshot window opens and is added to the Snap Shots folder list under Active
Views in the Navigator. The graphical display will not be part of the snapshot.

Sorting Columns in a Snapshot

To sort columns in a Snapshot:

1. Click any column header once to sort by ascending value and twice to sort by
descending value.

Closing a Snapshot or Visual Navigator

To close a Snapshot or a Real Time Event Table:

1. With a Snapshot or Visual Navigator open, close by using the Close button (upper
right corner in Windows or upper right corner in Windows/SUSE Linux/Red Hat
Linux or upper left corner in Solaris).

NOTE: The view or snapshot will not redisplay when you close and reopen the
Sentinel Control Center.

Adding Events to an Incident

To perform this function you must have user permissions to Modify Incident(s) and Add
to existing Incident(s).

To add events to an incident:

1. InaReal Time Event Table or a Snapshot, select an event or a group of events
and right-click. Click Add To Incident.

2. Inthe Add Events To Incident dialog box, click Browse to list the available
incidents.
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~&dd Events To Incidert

Severity |

DateTime

SourcelP

2] |2006.04.17 ] 135125 EOT

[t0.0.20.5

1K

Selected Incident:

Browse |

il

ok | Cancel |

3. Select Incident window displays. Click Search to view a list of incidents. List of

incidents of selected criteria displays.

NOTE: You can define your criteria to better search for a particular incident or

incidents in Select Incident window.

—Select Data
Severity | DateCrested | Priarity |Cr'rtiu:al'rt\_.r Fa...| Severity Rat...
redium 04f17 12006 .., [Mone 0.0 0.0
redium 04f17 /2006 ... [Mone 0.0 0.0
Kl B
Search Add | Cancel |

showy itemms that natch these criteria:

Add criteria from below to this list-

Remaoye |

~Define more criteria;

Relations

INu:une LI

Field Condition Walue
INDne j INDne j I

Add o List |

4. Highlight an incident and click Add.
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5. Click OK. The event or events selected are added to the incident in the Incidents
Navigator.

NOTE: If events are not initially displayed in a newly created Incident, it is most
likely due to a lag in the time between display in the Real Time Events window
and insertion into the database. If this occurs, it may take a few minutes for the
original events to finally be inserted into the database and display in the incident.
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Understanding Correlation

Sometimes, an event viewed in the system may not necessarily draw your attention. But,
when you correlate a set of similar or comparable events in a given period, it may lead you
to an alarming event. Sentinel helps you correlate such events with the rules you create
and deploy in the Correlation engine and take appropriate action to mitigate any alarming
situation.

Correlation adds intelligence to security event management by automating analysis of the
incoming event stream to find patterns of interest. Correlation allows you to define rules
that identify critical threats and complex attack patterns so that you can prioritize events
and initiate effective incident management and response. Starting with Sentinel 6.0, the
correlation engine is built with a pluggable framework, which will allow the addition of
new correlation engines in the future.

Correlation rules define a pattern of events that should trigger, or fire, a rule. Using either
the correlation rule wizard or the simple RuleLG language, you can create rules that range
from simple to extremely complex, for example:

= High severity event from a finance server

= High severity event from any server brought online in the past 10 days

= Five failed logins in 2 minutes

=  Five failed logins in 2 minutes to the same server from the same username

= [ntrusion detection event targeting a server, followed by an attempted login to root
originating from that same server within 60 seconds

Two or more of these rules can be combined into one composite rule. The rule definition
will determine the conditions under which the composite rule will fire:

= All subrules must fire
= A specified number of subrules must fire
= The subrules must fire in a particular sequence

After the rule is defined, it should be deployed to an active Correlation Engine, and one or
more actions can be associated with it. Once the rule is deployed, the Correlation Engine
will process events from the real-time event stream to determine whether they should
trigger any of the active rules to fire.

NOTE: Events that are sent directly to the database or dropped by a Global Filter
will not be processed by the Correlation Engine.
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When a rule fires, a correlated event is sent to the Sentinel Control Center, where it can be
viewed in the Active Views.

N Novell Sentinel Control Center - logged in as esecadm
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The correlated event may also trigger actions, such as sending an email with the correlated
event’s details or creating an incident associated with an iTRAC workflow.

Technical Implementation

3-2

All correlation is done in-memory on the machine (or machines) that host the correlation
engine. This model allows for fast, distributed processing that does not contend with
database operations such as inserting events into the database.

For environments with large numbers of correlation rules or extremely high event rates, it
may be advantageous to install more than one correlation engine and redeploy some rules
to the new correlation engine. The ability to deploy multiple correlation engines provides
the ability to scale as the Sentinel system incorporates additional data sources or as event
rates increase.

Sentinel’s correlation is near real-time and depends on the timestamp for the individual
events. To synchronize time, you may use an NTP (Network Time Protocol) server to
synchronize the time on all devices on your network, or you may rely on the time on the
Collector Manager servers and synchronize only those few machines.

Correlation relies on the data that is collected, parsed, and normalized by the Collectors,
so a working understanding of the data is necessary to write rules. Many Novell
correlation rules rely on an event taxonomy that ensures that a “failed login” and an
“unsuccessful logon” from two devices are classified the same.

In the Correlation tab, you have the ability to:

= Create/Modify Correlation rules and rule folders
= Deploy Correlation rules on Correlation Engine
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= Create and associate an action to a role
= Configure Dynamic lists

NOTE: Access to the correlation functions can be enabled by the
administrator on a user-by-user basis.

Introduction to the User Interface

In Correlation, you may see the Correlation Rule Manager, Correlation Engine Manager,
Correlation Action Manager and Dynamic Lists.

You may navigate to these functions from:

Carrelstion |

w Carrelation Fule Manager
= The Correlation menu in g Correlation Engine Manager

the Menu Bar
‘ii Carrelztion Action Manager

j Dyhamic Lists

Mavigastor o &
= The Navigation Tree in the - * Correlation Rule Manager
Navigation Pane . # Correlation Engine Manager

------ # Correlation Action Manager
Lo Dynamic Lists

Correlation Eule Manager Correlation &etion Ilanager

4 4
= The Toolbar Buttons | h @ ¢ 1’ m

Drymarnie Lists
Correlation Engirle Mlanager

Correlation Rules

Correlation Rules are created, modified, renamed, deployed/undeployed in the Correlation
Rule Manager. Correlation Rules are organized into Rule Folders, which can also be
managed in the Correlation Rule Manager.

NOTE: There is no limit to the number of users that can access Correlation
Rules. When more than one user is editing the same rule, the last person to save
will overwrite all previous saves.

Opening the Correlation Rule Manager

To open the Correlation Rules Manager:

1. Click the Correlation tab.

2. Inthe navigator, click Correlation Rules Manager. Alternatively, click
Correlation Rules Manager button in the Tool Bar. The following window
displays.
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N Correlation Rule Manager

E,']J Aded - Folder: | Correlation Rules % Lizt correlation rules in subsfolders  Manage Folders

wr

Wi Edit Undeploy Rule

Ready L@‘ Refrezh| Refreshed & : 44807 11:14:45 A

Creating a Rule Folder

To create a Rule Folder:

1. Open the Correlation Rules window and click Manage Folder.
2. Highlight and right-click a folder and select Add Folder.
3. Type in the Rule Folder name.

Renaming a Rule Folder

To rename a Rule Folder:

1. Open the Correlation Rules window and click Manage Folder.
2. Select a folder and click Rename. Change the name of the folder.

To delete a Rule Folder:

1. Open the Correlation Rules window and click Manage Folder.
2. Select a folder and click Delete. Click Yes when the system asks for confirmation.

Renaming a Correlation Rule

To rename a Correlation Rule:

NOTE: You must undeploy a rule before you rename or delete the rule.

1. Open the Correlation Rules window and select the rule you want to rename.
If the rule is deployed, click Undeploy Rule link to undeploy the rule.

3. Click View/Edit link. In the General Description tab change the name of the
Correlation Rule.

4, Click OK.
To delete a Correlation Rule:

1. Open the Correlation Rules window and select the rule you want to rename.
2. If the rule is deployed, click Undeploy Rule link to undeploy the rule.
3. Click Delete link. Click Yes when the system asks for confirmation.

Moving a Correlation Rule

To move a Correlation Rule:

1. Open the Correlation Rules window and click Manage Folder.
2. Click and drag a correlation rule from one folder to another.
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Creating a Correlation Rule

To create a Correlation Rule:

1. Open the Correlation Rules window and select a folder from the Folder drop-
down list to which this rule will be added.

2. Click Add button located on the top left corner of the screen.

3. The Rule Wizard opens. Select one of the following rule types and follow the
steps for that particular rule type:

= Simple

= Composite

= Aggregate

= Sequence

= Custom/Freeform

4. Define the update criteria for the rule. If you select “Continue to perform actions
every time this rule fires”, the rule will fire every time the criteria is met. If you
select “Do not perform actions every time this rule fires for the next (t) time,” the
events will fire only once as per user-defined time period. All the other events
that match the correlation rule within the specified time will be grouped together
with this correlated event. This user-defined time period may be a certain number
of seconds, minutes, or hours.

Click Next.

Enter the rule name. The syntax of the rule is checked at the time it is created.
Under Namespace, select a correlation rule folder in which to store the rule.
Type the description of the rule.

Click Next. The rule is created and displays in the Correlation Rules window.

10. Select Yes if you want to create another rule or No if you do not want to create
another rule. Click Next.

© o N o

The rule types and the steps to create them are described below.

Correlation Rule Types

Correlation rules may be defined in the Correlation Rule Wizard by walking through the
wizard or by choosing the Custom/Freeform option to write the rule in the proprietary
RuleLG language. All rule definitions are stored in the database in RuleLG.

Correlation rules may be defined based on any populated event field.

NOTE: While creating a Rule, you may add a dynamic list to it. For more
information, see “Associating Dynamic List with Correlation Rule”.

Simple Rule

A simple rule is defined by specifying which events can trigger the rule to fire (For
example, firewall events, firewall events of severity 3 or higher). The filter criteria may be
intersected (using the “all”option in the GUI or the “AND” operator in RuleLG) or the
filter criteria may be unioned (using the “any” option in the GUI or the “OR” operator in
RuleLG).

For example, a rule might be defined so that it fires anytime an event takes place on a
server that is on the critical list. Another rule might be defined to fire anytime an event of
severity 4 or greater takes place on a server that is on the critical list.
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A simple rule requires only one event in order to fire.

NOTE: For users familiar with the correlation rule language (RuleLG), the
defining operator for a simple rule is the “filter” operator. For more information
about RuleLG, see the Sentinel Correlation Engine RuleLG Language in Sentinel
6.0 User Reference Guide.

NOTE: In Sentinel 6, filter criteria must be defined in the correlation rule wizard.
You cannot use existing public filters.

To create a simple rule:

1. Open the Correlation Rules window and select a folder from the drop-down list to
which this rule will be added.

2. Click the Add button located on the top left corner of the screen. The Correlation
Rule window displays. Select Simple Rule.

Correlation Rule
Simple Rule

Fire if of the following conditions are met:

Aftackld |~
Attackld | |
BeginTime o
Callectar

CollectarScript

Controlkdonitor

ControlPack

CorrelatedEventluids

Criticality (v |

add || Delete |

RuleLg Preview:

[ = Back ” PlEt l ’ Cancel l

3. Inthe Simple Rule window, define a condition for this rule. Select the Property
and Operator values from the drop-down lists and enter data in value field.
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Correlation Rule

Simple Rule

Fire if I:l of the following conditions are met:

- ~E

add || Delete

HulelL g Prewview:

filter{ e Severity =37

| <Back || mext || canca |

Click Add to add additional definitions for this rule.

You can preview the rule in the RuleLG preview window. For example,
filter(e.sev=3). Click Next. The Update Criteria window displays.

Correlation Rule

Update Criteria

After rule fires:

() Cantinue to perfarm actions every time this rule fires

() Do not perform actions every time this rule fires for the next: 1 {C} .

[ <ok | mext || cancel |

Update criteria for the rule to fire and click Next. The General Description
window displays.

Correlation Rule

General Description
MName

Severity

MNamespace

Correlation Rules [v]

Description

| <Back || mest | [ conce |

Enter a name to this rule. You have an option to modify the rule folder.

Enter rule description and click Next.

Correlation Tab
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9. You have an option to create another rule from this wizard. Select your option
and click Next.

Aggregate Rule

An aggregate rule is defined by specifying a subrule and the number of times the subrule
must fire within a specific time window in order to trigger the aggregate rule. For
example, an aggregate rule may require that a subrule fire 10 times within 5 minutes for
the aggregate rule to fire.

Aggregate rules have an optional group by field, which can be any populated field from
the events. For example, an aggregate rule may require that a subrule fire 10 times within
5 minutes where each of the 10 events has the same destination server.

NOTE: For users familiar with the correlation rule language (RuleLG), the
defining operator for an aggregate rule is the “trigger” operator. The trigger
clause may also use the “discriminator” operator to define the group by field. For
more information about RuleL G, see the Sentinel Correlation Engine RuleLG
Language in Sentinel 6.0 User Reference Guide.

To create an aggregate rule:
1. Open the Correlation Rules window and select a folder from the drop-down list to
which this rule will be added.

2. Click the Add button located on the top left corner of the screen. The Correlation
Rule window displays. Select Aggregate Rule.

:
Aggregate Rule

Sub Rules:

T fitter: Severity=2

| viewEdit || Rename || Delste |

For Aggregate Rule to fire:

The pattern should match tirnes within Minutels)

Group hy these event tags in the following order:

RuleLg Preview:
’ﬁlter(e.Seuerit}r ="2" flow trigger( 60)
’ < Back ] [ Mext ] ’ Cancel ]

3. In Aggregate Rule window, you may select a sub-rule to create an aggregate rule.
To select a sub-rule, click Add Rule button. Add Rule window displays.
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9.

10.
11.

=

Add Rule X
Add Saved Rule

Rule Mame:

i | Correlation Rules

el W severity

el | Sewerity

Rule Preview:

Cancel

NOTE: You can select only one sub-rule when creating an aggregate rule.

Select a rule and click OK.
Set parameters for the rule to fire.

To group event tags according to the attributes, Click Add/Edit. The Attribute
Window will open.
=

£ Attribute List

Select Al Clear all

| SourceRackMumber ~
[] sourceRroom

|:| Source Sensitivity

[] sourcestate

|:| SourceThreat Lewvel

|:| SourceUser Cortext

[] sourceUsertame

|:| SourcelipCode

[] subResource

|:| Wendaor Evert Code

[ wiruzstatus

Yulherability bt

[ ik H Cancel ]

Check the attribute as per your requirement. You can preview the rule in the
RuleLG preview window. Click Next. The Update Criteria window displays.

Update the criteria for the rule to fire and click Next. The General Description
window displays.

Enter a name to this rule. You have an option to modify the rule folder.
Enter rule description and click Next.

You have an option to create another rule from this wizard. Select your option
and click Next.

Composite Rule

A composite rule is comprised of 2 or more subrules. A composite rule may be defined so

that all or a specified number of the subrules must fire within the defined timeframe.

Composite rules have an optional group by field, which may be any populated field from
the events.

Correlation Tab
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NOTE: When a subrule is used to create a composite rule, a copy of the subrule
is added to the composite rule’s definition. Because a copy is added, changes to
the original subrule do not affect the composite rule.

To create a composite rule:

1. Open the Correlation Rules window and select a folder from the drop-down list to
which this rule will be added.

2. Click the Add button located on the top left corner of the screen. The Correlation
Rule window displays. Select Composite Rule.

i x|

Composite Rule
Sub Rules:

W fiter: 1P

s

filtker: Begin-End Time:

AddRule - [ viewEdit | [ Rename | | Delete |

For Composite Rule to fire:

O All sub-rules should fire within of each other

® Any 12| sub-rules should fire within 1% | |Minutets) v | of each other

b b

Group by these ewent tags in the following order:

Severity Wulnerahility AddiEdit

RulelLg Preview:

nate(filterie. BeginTime = 1176698624 and e Severity =="1") filter{e. BeginTime = 1176796322 and
e EndTime = 1176882741),any 60,discriminator{e. Severity,e Wulnerability )

[ < Back H Tet H Cancel ]

3. In Composite Rule window, you may select sub-rules to create a composite rule.
To select a sub-rule, click Add Rule button. Add Rule window displays.

4. Select arule or a set of rules (hold control on your keyboard to select a set of
rules) and click OK.

5. Set parameters for the rule to fire.

6. To group event tags according to the attributes, Click Add/Edit. The Attribute
Window displays.

7. Check the attribute as per your requirement. You may preview the rule in RuleLg
preview box. Click Next, the Update Criteria window displays.

8. Update criteria for the rule to fire and click Next.
9. Enter a name to this rule. You have an option to modify the rule folder.
10. Enter rule description and click Next.

11. You have an option to create another rule from this wizard. Select your option
and click Next.

Sequence

A sequence rule is comprised of 2 or more subrules that must have been triggered in a
specific order within the defined timeframe. Sequence rules have an optional group by
field, which may be any populated field from the events.
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NOTE: When a subrule is used to create a sequence rule, a copy of the subrule is
added to the sequence rule’s definition. Because a copy is added, changes to the
original subrule do not affect the sequence rule.

To create a sequence rule:

1. Open the Correlation Rules window and select a folder from the Folder drop-
down list to which this rule will be added.
2. Click the Add button located on the top left corner of the screen. The Correlation
Rule window displays. Select Sequence Rule.
P x|
Sequence Rule
Sub Rules:
ﬁntemp
fitter: Sev=1
| viewEdi || Rename || Delete |
All sub-rules should fire within 1: Minute(s) + | of each other
Group by these event tags in the following order:
Critcality, Severity,yulneratility
RuleLg Preview:
sequenceffilter(e. BeginTime = 1176698624 and e.Severity =="1") filter(e Severity =
"1",60,discriminatorie. Criticality, 2. Sevetity, e Vulnerahility))
[ < Back ] [ Mext ] l Cancel ]
3. In Sequence rule window, you may select a sub-rule to create a sequence rule. To
select a sub-rule, click Add Rule button. Add Rule window displays.
4. Selectarule and click OK.
5. Set parameters for the rule to fire. To group event tags according to the attributes,
Click Add/Edit. The Attribute Window will open.
6. Check the attribute as per your requirement. You may preview the rule in RulelLg
preview box. Click Next, the Update Criteria window displays.
7. Update criteria for the rule to fire and click Next.
8. Enter a name to this rule. You have an option to modify the rule folder.
9. Enter rule description and click Next.
10. You have an option to create another rule from this wizard. Select your option

and click Next.

Custom or Freeform Correlation Rules

The custom or freeform rule option is the most powerful option for creating a correlation
rule. This allows the user to create any of the previous types of rules by typing the RuleLG

correlation rule language directly into the Correlation Rule Wizard.

TIP:

You can select the Functions, Operators and Meta-Tags from the drop-down list

selection. Enter e. or w. in the Correlation Rule section to view the drop-down
lists.

Correlation Tab
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To create a custom or freeform rule:
1. Open the Correlation Rules window and select a folder from the Folder drop-
down list to which this rule will be added.

2. Click the Add button located on the top left corner of the screen. The Correlation
Rule window displays. Select Custom/Freeform Rule.

Custom/Freeform Rule

Correlation Rule

ilter(e BeginTime = 1176698624 and e Severity =="1") flow trigger(1,60)

@ Rule Syntax is valid [ < Back ] [ et ] [ Cancel l .

3. In the Custom/Freeform Rule window, write the condition for the rule and click
Validate to test the validity of the rule.

On successful validation of the rule, click Next, the Update Criteria window
displays.

Update the criteria for the rule to fire and click Next.

5. Enter a name to this rule. You have an option to modify the rule folder.
Enter rule description and click Next.

7. You have an option to create another rule from this wizard. Select your option
and click Next.

>

o

Deploying/Undeploying Correlation Rules

Correlation rules can be deployed or undeployed from the Correlation Engine Manager or
the Correlation Rule Manager. You can undeploy all rules or a single rule.

To deploy Correlation Rules (in Correlation Engine Manager):

1. Open the Correlation Engine Manager window.

2. Highlight and right-click the engine you want to deploy the rule on and select
Deploy Rules.

3. Inthe Rules tab, check the rules you want to deploy.

F

M select Rule

Actions

4

] 24 Corretation Fules
E| [] 1 Mew Foldert
""" |:| _| IMew Folder2
""" |:| _| Mew Folderd
""" [ 1 Mew Folders
""" [ 1 Mew Folders
""" |:| a Severity

[l 1071 Taati

[v

[ Deplay ” Cancel ]
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NOTE: By default, rules deployed are in enabled state.

4. Inthe Actions tab, check the action you want to associate with the rule and click
Deploy.

To deploy Correlation Rules (in Correlation Rule Manager):

1. Open the Correlation Rule Manager window.
2. Highlight a rule and click Deploy rules link. The Deploy Rule window displays.

Select engine to deploy Rule to:

ezeclin2:127.0.0.1 W
Select Actions to be performed when rules fires:

3. Inthe Deploy rule window, select the Engine to deploy the rule from the drop-
down list.

4. [Optional] Select an action or add a new action. If nothing is selected, a
Correlated Event with default values will be created.

5. Click OK.

To Undeploy a Single Rule:

1. Inthe Correlation Engine Manager, right-click the rule and select Undeploy Rule.

2. Alternatively, in the Correlation Rule Manager, highlight the rule and click
Undeploy rule link.

To Undeploy All Correlation Rules:

1. Open the Correlation Engine Manager window.
2. Right-click the Correlation Engine and select Undeploy All Rules.

Enabling/Disabling Rules

To Enable/Disable Rule:

1. Open the Correlation Engine Manager window.

2. Highlight and right-click the rule or set of rules and select Enable Rule or Disable
Rule.

|2 Er;u:at:-led Enable Puls

I Dizabled

[ Enabiled

B> Enabled Undeploy Rule
Action
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Importing a Correlation Rule

To Import a Correlation Rule:

1. Open the Correlation Rules window and click Import/Export Correlation Rule
icon.

2]
The Import Export Rule window displays.

|

=
Import Export Rule E|

Import Export Rules
Irnport Export Rules

Action Cescription
Export Irmport
Irnpport
File Mame
" Erowse ]
Description
[ Mlext ] [ cancel ]

2. Select the Import option from the Action pane. The Description in the Description
pane changes to Import.

3. Click Browse to select the Correlation Rule you want to import. Select the file
and click Import. Click Next. The Import Rule window displays.

r Y

Import Export Rule &|

Import Rule
Import Rule

Select Importing Folder Importing Structure prewiew

9]

_J C 1 BS
EI _A Corr Rule

L el
S P

[ < Back H Finish H Cancel l|

4. Select the folder you want to import the Correlation rule into. Click Finish.

NOTE: While importing a correlation rule in a folder, if the correlation rule with
the same name exists, the system will prompt and will not import the file.

IMPORTANT:

If you import a correlation rule using the inlist operator, the dynamic list aligned
to that rule must exist or you must create the dynamic list with the same name on
the system to it is imported.
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Exporting a Correlation Rule

To Export a Correlation Rule:

1. Open the Correlation Rules window and click Import/Export Correlation Rule
icon. The Import Export Rule window displays.

2. Select the Export option from the Action pane. The Description in the Description
pane changes to Export.

3. Click Browse to export the rule. Enter a file name and click Export. Click Next.
The Export Rule window displays.

F i

Import Export Rule @

Export Rule
Export Rule

|:| J Correlation Rules
+ O] 0 corr Rule
- v

- P

[ < Back H Finizh H Cancel ]

4. Select the Correlation Rule you want to export. Click Finish.

Dynamic Lists

Dynamic Lists are distributed list structures that can be used to store string elements, such
as IP addresses, server names, or usernames. The lists are then used within a correlation
rule for a quick lookup to see whether an incoming event includes an element from the
Dynamic List. Some examples of Dynamic Lists include:

= Terminated user lists

= Suspicious user watchlist

= Privileged user watchlist

= Authorized ports and services list
= Authorized server list

A Dynamic List can be built using the text values for any event metatag. Elements may be
added to the list manually (by an administrator) or automatically whenever a correlation
rule fires. Elements may be removed from a list if manually (by an administrator),
automatically whenever a correlation rule fires, when their time limit expires, or when the
maximum list size is reached.

IMPORTANT:

The Time To Live (TTL) must be between 60 seconds and 90 days and the
maximum list size is 100,000.

Regardless of how the values were added, they may be Persistent (active until manually
removed or until the maximum list size is reached) or Transient (active only for a
specified timeframe after being added to the list, also known as the Time to Live). The
Time to Live can range from 60 seconds to 90 days.
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NOTE: If the Time to Live period is updated on an active Dynamic List, the
change is not retroactive to elements already on the list. Elements that have
already been added to the dynamic list will retain their original Time to Live.

Adding a Dynamic List

To add Dynamic Lists:

1.

3-16

Click Correlation on the Menu Bar and select Dynamic Lists. Alternatively, you
can click the Dynamic Lists button on the Tool Bar.

Click Add button located on the top left corner of the screen. Dynamic List
Properties window displays.

Enter the Name of the List.

Dynam Prope

List Name |

List Elemerts

Guick Fitter: | Q- |

Persistent Walue Expires

Transiert elements life span: II'
Mazzirnurmn nurnber of elernerts: l:|

Click Add. The following windows displays:

r ]

Add Element [X|

|:| Make persiztent

Cancel

Enter name of the Element. To make the Element persistent, check Make
Persistent Check box and Click OK.

NOTE: To make an existing element persistent, select the checkbox before the
element name in the Dynamic Properties window.

Select Transient elements life span. It specify the time the persistent values will
be active in the list

Enter the Maximum Number of Elements. The number defined here will limit the
number of elements in the list.

Click OK.

NOTE: Select a filter type from Quick Filter drop-down list and enter the name
of the element, to filter the available elements.
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Modifying a Dynamic List
To edit a Dynamic List:

1. Click Correlation on the Menu Bar and select Dynamic Lists. Alternatively, you
can click the Dynamic Lists button on the Tool Bar.
2. Select a Dynamic List and click View/Edit link against it.

3. The Dynamic List Properties window displays. Edit the options as required and
click OK.

Deleting a Dynamic List

WARNING:

Do not delete a Dynamic List that is part of a correlation rule or rules.

To delete a Dynamic List:
1. Click Correlation on the Menu Bar and select Dynamic Lists. Alternatively, you
can click the Dynamic Lists button on the Tool Bar.

2. Select a Dynamic List and click Delete link against it. Confirmation message alert
displays.

3. Click Yes to delete.

Removing Dynamic List Elements
There are several ways an element may be removed from a Dynamic List.

= A user may remove it manually

= The element may be removed by a correlation rule action

= The Transient elements life span may expire

= |f the maximum number of elements for a Dynamic List is reached, elements will be
removed from the list to keep the list at or below the maximum list size. The transient
elements will be removed (from oldest to newest) before any persistent elements are
removed.

Using a Dynamic List in a Correlation Rule

Dynamic Lists can be referenced in a Correlation Rule by using the Custom/Freeform
option of the Correlation Rule Wizard. For example:

filter(e.<tagname> inlist <Dynamic List Name>)

where

e.<tagname> represents a metatag in the incoming
event, such as e.shn (Source Host Name) or e.dip
(Destination IP address)

<Dynamic List Name> is the name of an existing Dynamic
List, such as CriticalServerList

To add a Dynamic List to correlation rule:

1. Inthe Dynamic List window, create a dynamic list.

2. Open the Correlation Rules window and select a folder from the drop-down list to
which this rule will be added.
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10.

Click the Add button located on the top left corner of the screen. The Correlation
Rule window displays. Select Custom/Freeform Rule.

In the Custom/Freeform Rule window, write the condition for the rule including
the name of the dynamic list. For example, filter(e.sev inlist Severity) where
Severity is the dynamic list name.

Click Validate to test the validity of the rule.

On successful validation of the rule, click Next, the Update Criteria window
displays.

Update the criteria for the rule to fire and click Next.

Enter a name to this rule. You have an option to modify the rule folder.
Enter rule description and click Next.

You have an option to create another rule from this wizard. Select your option
and click Next.

NOTE: Users must have the permission to Start/Stop Correlation Engine to
perform these actions.

The two states of Correlation engine are Enable @ and Disable [H]

When the Correlation Engine is enabled, it processes active correlation Rules. When in a
disabled state, all its in-memory data is preserved and no new correlation events are
generated. Disabling the Correlation Engine does not affect other parts of the Sentinel
system.

Correlation rules are stored in the Sentinel database. When you activate the Correlation
Engine in Sentinel Control Center, it requests the deployment information and rules from
the database. Changes to a rule will not be reflected in the Correlation Engine until one of
the following things happens:

The rule is undeployed, edited and redeployed.
The rule is freshly deployed

Starting or Stopping Correlation Engine

To Start or to Stop a Correlation Engine:

1.
2.

Open the Correlation Engine Manager window.
Highlight and right-click a Correlation Engine and select Start or Stop Engine.

Stop Engine
Deploy Fule
Undeploy Al Rules

Fename Engine

Renaming Correlation Engine

3-18

A Sentinel system may have one or more Correlation Engines. You can rename the

engines if desired.

To Rename a Correlation Engine:

1.

Open the Correlation Engine Manager window.
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2. Right-click the Correlation Engine and select Rename Engine.
3. Modify the name of the Engine and click OK.

Correlation Action Manager

Correlation Actions allow you to configure repeatable actions that can be associated with
a rule deployment so that one or more of the actions is performed whenever the deployed
correlation rule fires. The Correlation Action Manager allows you to create and configure
these actions.

Correlation Action Types
The Correlation Action Manager allows you to configure the following types of actions:

= Configure a Correlated Event
= Add to Dynamic List

= Remove from Dynamic List
= Execute a Command

= Send an Email

= Create an Incident

Each action type has a set of configurable parameters.

One or more of these action types can be associated with a correlation rule when the
correlation rule is deployed. If none of these action types are selected, a correlated event
will be created by default. When a default correlation event is triggered, it will have the
following values:

Field Name Default Values
Severity 4
Event Name CorrelatedEvent
Message <empty>
Resource Correlation
SubResource <Rule Name>

Correlation Tab
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Configure Correlated Event

N Configure Action E
Action Mame k

Mame Walue

Bl attribute Walues
Severity ]
Everthame
Message
Resource
SubResource
El Action Parameters
Event Options Copy fields from trigger event

co |

Instead of using the default values for a correlated event, an action may be created to
populate the following fields in the correlated event:

= Severity

= Event Name
= Message

= Resource

= SubResource
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Add to Dynamic List

N Configure Action E

Action Mame

Action

[ et to Dynamic List =]
Mame Walue |

El Action Parameters
Element Walues
Element Type Persistent
Dyramic List Mame TerminatedUsers
Atribute Names

co |

This action type can be used to add a constant value or the value of an event attribute

(such as Destination IP or Source User Name) to an existing Dynamic List. Any values
that are repeated across multiple events will only be added to the dynamic list once. The

various parameters available are:

= Element Values: Enter a constant value here.
= Element Type: Persistent or Transient

= Dynamic List Name: Choose an existing Dynamic List from the dropdown menu.

= Attribute Names: For every event that is part of a correlated event, the value or
values of this event attribute will be added to the Dynamic List.

If there are entries for both Element Values and Attribute Names, both will be added to
the Dynamic List when the rule fires. If the Element Value is filled in and the Element
Type is Transient, the timestamp for the element in the Dynamic List will be updated each

time the rule fires.

Correlation Tab
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Remove from Dynamic List

N Configure Action I
Action Mame
Action
IF'.emo\te from Dynamic List ;I
Mame Value |

E Action Parameters
Elemant Walles
Dryramic List Mame Terminatedzers
Atribute Names

oo |

This action type can be used to add a constant value or the value of an event attribute
(such as Destination IP or Source User Name) from an existing Dynamic List. The various
parameters available are:

= Element Values: Enter a constant value here.

= Dynamic List Name: Choose an existing Dynamic List from the dropdown menu.

= Attribute Names: For every event that is part of a correlated event, the value or
values of this event attribute will be deleted from the Dynamic List.
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Execute a Command

M Configure Action I

Action Mame

Action

IExecute a Command LI
Manne Walue |

E Action Parameters
Command
Argurnerits

cos |

This action type can be used to execute a command when a correlated event triggers. You
can set the following parameters:

=  Command

NOTE: For actions that execute a command or run a script, the command or
script must reside in the $ESEC_HOME/config/exec or
%ESEC_HOME\config\exec folder on the Correlation Engine. Symbolic links on
UNIX are not supported.

= Arguments: This can include constants or references to an event attribute in the last
event, the one that caused the rule to fire.

NOTE: References to event attributes must use the values in the metatag column
in [insert reference to ch. 5, Reference Guide] enclosed in % symbols. For
example, Source IP would be %sip%.

Command actions can be created to perform a non-interactive action, such as modifying a
firewall policy, entering a record in a database, or deactivating a user account. For an
action that generates output, such as a command to run a vulnerability scan, the command
should refer to a script that runs the command and then writes the output to a file.
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Create Incident

N Configure Action E
Action Mame
Action
ICreate Inciclerit LI
Mame Walue I
E Action Parameters
Responsible
Title
Cateory DEMIAL OF SERVICE
Severity Mone ()
Priority Marne (1)
State OPEN
iTRAC Process Q ;I

oo |

This action type create an incident whenever a correlated event fires. You can also initiate
an iTRAC workflow process for remediating that incident. For more information about the
values of the following parameters, see Chapter 4 “Incidents Tab”.

= Responsible

= Title

= Category
= Severity
=  Priority

= State

=  JTRAC Process

WARNING:

Do not enable the Create Incident action until the correlation rule has been tuned.
If the rule fires frequently, the system may create more incidents or initiate more
iTRAC workflow processes than desired.

Correlation Action Administration
The Correlation Action Manager allows you to:

= Add Action

= Edit Action: If you edit an action that is associated with a deployed rule, the changes
will take effect the next time the correlation rule fires.

= Delete Action: You cannot delete an action that is associated with a deployed rule.

To add an Action:

1. Click Correlation on the Menu Bar and select Correlation Action Manager.
Alternatively, you can click the Correlation Action Manager button on the Tool
Bar.
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4.
5.

Click Add button located on the top left corner of the screen. Configure Action
window displays.

rm.'?n—:';"-r ire Action Iﬁi

ion Mame

(]
Create Correlated Ewvent i

e Walae
Sewerity 1]
EwentMane
Message
Resource
SubResowrce

| save || concer |

Enter an Action Name. You may select the type of action to be performed on the
correlated batch.

Enter the attribute values for the type of action selected.
Click Save.

To edit an Action:

1.

Click Correlation on the Menu Bar and select Correlation Action Manager.
Alternatively, you can click the Correlation Action Manager button on the Tool
Bar.

Select Correlated Action and click View/Edit link against it.

The Configure Action window diplays. Edit the options as required and click
Save.

To delete an Action:

1.

Click Correlation on the Menu Bar and select Correlation Action Manager.
Alternatively, you can click the Correlation Action Manager button on the Tool
Bar.

Select Correlated Action and click Delete link against it. Confirmation message
alert diplays.

Click Yes to delete.

Correlation Tab
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Incidents Tab

Topics included in this chapter:

Topic Page
Understanding an Incident 4-1
Manage Incident Views 4-3
Adding a View 4-3
Manage Incidents 4-6
Creating Incidents 4-6
Configuring the Attachment Viewer 4-8
Switch between existing Incident Views 4-10

Understanding an Incident

In Sentinel, a set of related events (for example, a possible attack) can be grouped together
form an Incident. An Incident in ‘open’ state alerts you to investigate, resolve, and close
the incident. For example, the resolution to an attack might be to close a port, block a
source IP, or rebuild a machine.

Incidents can be created:

= Manually, by a security analyst monitoring incoming data or querying past data.
= Automatically, as the result of a correlation rule being triggered. For more
information, see Chapter 3 “Correlation Tab”.

In the Incidents Tab, you can:

= Manage Incident Views
= Manage Incidents
= Switch between existing Incident Views

NOTE: You need to have appropriate permissions to access this tab. Only an
Administrator has controls to enable/disable access to the features of Incidents for
a user.

Introduction to User Interface

In the Incidents Tab, you may see the Display Incident View, Create Incident and
Attachment Viewer Configuration.
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You may navigate to these functions from:

Incidents |

= The Incident menu in the
Menu Bar @ Create Incident

@ AMtachment Viewer Configurstion

@ Dizplay Incident View hManager

Manwigator o &

El_l Incident Wiews

= The Navigation Tree in the o ® Ingidert View Manager
Navigation Pane ] Incident Details

----- _| Investigate

----- _| Analysis

b ;I Actions

* The Toolbar Buttons | @ @ @|d

Incident View

In the Incident View, you can view the list of incidents and the parameters you specified
while adding an incident.

To open Incident View Manager:

1. Click Incidents on Menu Bar and select Display Incident Views.or click
Display Incident View button in the Tool Bar.

N Incident ¥Wiew Manager
1 State Severity Priority Id Rezponsible

=[] incidert ~

W OPEM Mone (07 Mone () 330

[ timeautz OPEN Mane (1) Mane (0] 410

2] ke OPEN Mare (0] Mo ([0) 200

- [2] Testinet OPERN Low (2) More (0] 423

- OPEN Mane (0] Mone (0] 360

2] sen OFEN Mare (00 Mok () 702

2] se OPEN Mane (3] More (0] 700

3] s OPEN Mane (3] More (0] 428

rhl hled mnEhl bl fin k't h =, fum [=L N ul b

I a0 of G0 @ Refresh E’I Manage Wiew - E] Sitch Wiew - I

Incident

When you add/edit an incident, you will see the tabs listed below where you may perform
the incident related activities. As you investigate and remediate an incident, additional
information can be added to these tabs. Except for Events and History, entering
information on the tabs is optional.
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N Mew Incident (1)

File  Actions  Options
A @ @ B &

Incident 1ID: NEW

Associated Events:

" Everts | Sssets | Vulnerability | Advisor | iTRAC | History | Attachmerts | Notes | 4 F B

EIEX]

Title:
State: OPEN »
Severity: Mone (0«

Priority: Mone {0} ~

Category: v [:]

Originator: esecadm
Responsible: v

Description:

Resolution:

: Severty DateTime  SourcelP EventMame

Events: Lists events attached to this incident. You may attach events to incidents in
Active Views.

Assets: Lists assets affected by the events of this incident.

Vulnerability: Lists asset vulnerabilities.

Advisor: Displays Asset attack and alert information.

iTRAC: Allows you to add a workflow to incident from iTRAC Tab.

History: Lists activities performed on the current incident.

Attachments: Allows you to add an attachment to the incident created in the system.
Notes: Allows you to add notes to the incident.

Manage Incident Views

Manage View allows you to:

Add Views

Edit Views

Delete Views

Mark a View as default

Adding a View

To add an Incident View:

1.

Click Incidents > Display Incident View Manager. Alternatively, you may click
Display Incident View button on the Tool Bar.

Open the View Options by either:

=  Clicking the down-arrow on the Manage Views button located in bottom right
corner of the window and selecting Add View.
or

= Clicking the down arrow on the Manage Views button located in the bottom
right corner of the window, selecting Manage Views and then clicking the
Add View button.
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N View Options

X

Option Marnme |

Options

Fields...

Group By...

ort

Fitter...

Leaf Atribute.

Category, Created By, Criticality Rati...

Mone

Mone

Crff

Select Mtribwte for display

[save [ cose |

3. Enter a name in the Option Name field. Click each button (listed below) to
specify the options.

= Fields: The variables of the events attached to incidents are displayed as
fields. By default, all the fields are arranged as columns in the Incident View.
In the field options window, you may add or remove columns that display
and arrange the order of the columns by moving the up and down arrows.

F "
N Fields X
Available Columns Show Columnz in this Or
Categaory 3
Created By
Criticality Rating
Add Date Created
- Diate Modified
Descrigtion
w
Mocified By
Pricrity
Rezalution
Sewerity 3
= Group By: You may set rules to group incidents in the display View.

o
N Group By
(Sroup By

X

© ascending
() Descending

Cancel

Clear Al

= Sort By: You may set rules to sort the incidents in the display view.

4-4  Sentinel User Guide



Sort rx |
Sort By —
9| Q ascendins

() Descending
Azcending
Descending Clear &
Azcending

Descending

Azcending
Descending

= Filter: You may set Incident filters. Only the Incidents that match your filter
will display in the View.

M Criteria [zl

aaL || saL |

Show items that match these criteria:

Remowe
Define more criteria:
Field Condition Walue
T A ——
Aoic to List
[ ik ][ Cancel ][ Clear 2l ]

= Leaf Attribute: You may select an attribute from the list which will be
displayed as the first column in the Incident View.

3

'.—-1
N Select Attribute w
Atributes

Category
Crested By
Criticality Fating
Date Created
Diate Modified
Description

Id

Modified By
Friority
Resolution
Sewerity
Sewerity Rating
State "

| >

4. Click Save.
Modifying a View

To edit an Incident View:

1. Click Incidents > Display Incident View or click Display Incident View Manager
button on the Tool Bar.

2. Open aview bhy:
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= Click the down-arrow on the Switch View button in the bottom right corner,
select the view you want to edit. Click the down-arrow on the Manage View
button located in bottom right corner of the screen and select Edit Current
View from the list.
or

= Clicking the down arrow on the Manage Views button located in the bottom
right corner of the window, select Manage Views. Select a view to edit and
click View/Edit.

3. Edit the options as required and click Save.

Deleting a View

To delete an Incident View:
1. Click Incidents > Incident View Manager.or click Display Incident View button
on the Tool Bar.

2. Click the down-arrow on the Manage Views button located in bottom right corner
of the screen and select Manage View from the list. The Manage View window
displays. Select a view and click Delete. A confirmation message alert displays.

3. Click Yes to delete.

Default View

To mark a View as default:
1. Click Incidents > Display Incident View Manager, or click Display Incident View
Manager icon on the Tool Bar.

2. Click the down-arrow on the Manage Views button located in bottom right corner
of the screen and select Manage Views from the list. The Incident View window
displays.

3. Select the incident view you want as default, and click Mark as Default.

Manage Incidents
You can perform the following activities related to Incidents:

= Create an Incident

= Attach Workflows to Incidents
=  Add Attachments to Incidents
= Add Notes to Incidents

= Edit an Incident

= Delete an Incident

Creating Incidents

To create an Incident;

1. Click Incidents > Create Incident, or click Create Incident button on the Tool
Bar. The New Incident window displays.
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N Mew Incident (1) E]E]

File  Actions  Options

| @ 4@ B ®

Incident ID: NEW " Everts | Assets | vulnerabilty | Advisor | ITRAG | History | Atachments | Notes | ¢ B
3 Associated Events:
e : Severty DateTime  SourcelP Destination|P EventMame
State: OPEN »
Severity: Mone (I}«
Priority:|Mone (0} ~
Category: v[:]
Originator: esecadm
Responsible: v
Description:
Resolution:
< >

Enter the following information:

Title: Enter the Title of the Incident.
State: To set state of the incident, select from the drop-down list.

Severity: To mention the severity of the incident, select from the drop-down
list.

Priority: To mention the priority of the incident, select from the drop-down
list.

Category: Specify the category of the Incident.

Responsible: To assign the responsibility to investigate and close the
incident, select from the drop-down list.

Description: Enter the description of the Incident in the text area.
Resolution: Enter the resolution description in the text area.

Click Create. The Incident ID will be automatically generated once you click

c

reate.

NOTE: For more information on creating an incident grouping events, see
Creating Incident in Chapter 2 “Active Views Tab”.

Viewing an Incident

To open an Incident

1.

Click Incidents > Display Incident View Manager or click Display Incident View
Manager button on the Tool Bar.

Open an Incident by:

Selecting a view from the Switch Views button in the bottom right corner.
Double click an incident in the Incident View Manager window.

Incidents Tab
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Attaching Workflows to Incidents

To attach a workflow to an Incident:

1. Open an incident.

2. In the Incident window, click iTRAC Tab.

3. Select an iTRAC process from the drop-down list.
4. Click Save.

NOTE: You can attach only one process to an incident.

Adding Notes to Incidents

To add a note to an Incident:
1. Inthe Incident window, click Notes Tab.
2. Click Add. Add Notes to Incident window displays.
3. Enter your notes and click OK.
4. Click Save.

NOTE: To edit or delete the note, select a note in the Notes tab of the Incident
window, right-click the note and select edit or delete.

Adding Attachments to Incidents

To add an attachment to Incident:

1. Inthe Incident window, click Attachments Tab.

2. Click Add. Add Attachment to Incident window displays.

3. Click Browse, navigate to the attachment, and select it.

4. Enter the following information, or accept the default entries:

= Name

= Description
= Type

= Subtype

Click OK, click Save.

NOTE: Right-click the attachment to view or save.

Configuring the Attachment Viewer

To configure the Attachment Viewer:

1. On the Incident tab, open an incident and double-click an Attachment without
an associated viewer in the Incident window > Attachment Tab. Or click
Incidents > Attachment Viewer Configuration or click Configure Attachment
Viewers button.

The Attachment Viewer Configuration window displays.
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Attachment Viewsrs

Extension Type Subtype Appl
Wbk DEFALLT DEFALLT Ci\Program Files)wi H H
.htrnl ESEC ADVISOR (C:hProgram FilesiInl o
doc DEFALLT DEFAULT C:\Program FilesiMi Edlit |

[Eelete |
£l | |
Ok |

Extension: I|
Type: |DEFALLT
Subbype:  |DEFAULT

[Attachment Wiewear

Application: | Erowse |

Parameters: I%FILE%

2. Click Add. The Attachment Viewer Configuration window displays.

Attachment ldentification -

k. | Cancel |

Enter the extension type (such as .doc, .xls, .txt, .html and so on) and click Browse or
type in the application program to launch the file type (such as notepad.exe for
Notepad).

3.

Click OK.

Modifying Incidents

To edit an Incident:

1.

Click the Incident tab. Click Incidents > Display Incident View.

Alternatively, you may click Display Incident View button on the Tool Bar.

Incident View window displays with the list of incidents.
Right-click the incident you want to edit and select Modify.
Incident window displays. Edit the following information:
Title

State

Severity

Priority

Category

Responsible

Description

Resolution

Click Save.

Incidents Tab
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NOTE: Save button gets active only if you modify any information in Incidents
screen.

Deleting Incidents

To delete an Incident;

1.

2.
3.

Click the Incident tab. Click Incidents > Display Incident View Manager, or
click Display Incident View button on the Tool Bar. The Incident View
window displays.

Right-click the incident you have to delete and select Delete.
Confirmation Message displays. Select Yes.

Emailing an Incident

To email an incident, the administrator must have configured Sentinel to work with a mail
server either during Sentinel installation or later, in the execution.properties file. For more
information, see Chapter 12 “Utilities”.

To email an Incident:

1.

Click the Incidents tab. Click Incidents > Display Incident View or click the

Display Incident View button

2.
3.
4.

Double click an Incident View name.
Double-click an incident.
Click Email Incident button.

2]

Enter:

Email Address
Email Subject

Email Message

Click OK. The e-mail message will have HTML attachments that address
incident details, events, assets, vulnerabilities, advisor attacks, incident
history and attachments.

Switch between existing Incident Views

To switch between Incident views:

1.

2.

Click the down-arrow on the Switch View button on the bottom right corner
of the screen which displays a list of existing views.

Select a view.
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ITRAC™ Workflows

Topics included in this chapter:

Topic
Understanding iTRAC Workflows
Introduction to the User Interface
Template Manager
Creating Templates
Managing Templates
Steps
Adding Steps to a Workflow
Managing Steps
Transitions
Managing Transitions
Activities
Creating Activities
Managing Activities
Process Management
Instantiating a Process
Displaying Status of a Process
Starting or Terminating a Process

Understanding iTRAC Workflows

iTRAC Workflows are designed to provide a simple, flexible solution for automating and

tracking an enterprise’s incident response processes. It leverages Sentinel’s internal

Page
5-1

5-2

5-5
5-6

5-13
5-13
5-16
5-23
5-24
5-25
5-29
5-30
5-31
5-32
5-34

incident system to track security or system problems from identification (through

correlation rules or manual identification) through resolution.

Workflows can be built using manual and automated steps. Advanced features such as
branching, time-based escalation, and local variables are supported. Integration with
external scripts and plug-ins allows for flexible interaction with third-party systems.

Comprehensive reporting allows administrators to understand and fine-tune the incident
response processes.

NOTE: Access to manage iTRAC templates, activities, and processes can be
enabled on a user-by-user basis by any user with the ability to change user

permissions.

The iTRAC system uses three Sentinel objects that may be defined outside the iTRAC

framework:

iTRAC™ Workflows
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= Incident Incidents within Sentinel are groups of events that represent
an actionable security incident, plus associated state and
meta-information.

Incidents are created manually or through correlation rules,
and can, but don’t have to, be associated with a workflow
process. They can be viewed on the Incidents tab.

= Activity An Activity is a pre-defined automatic unit of work, with
defined inputs, command-driven activity, and outputs (For
example, automatically attaching asset data to the incident
or sending an e-mail).

Activities can be used within workflow templates, triggered
by a correlation rule, or executed by a right-click when
viewing events.

= Role Sentinel users can be assigned to one or more Roles.
Manual steps in the workflow processes may be assigned to
a Role.

iTRAC Workflows have four major components that are unique to iTRAC:

= Step A Step is an individual unit of work within a workflow;
there are manual steps, decision steps, command steps, mail
steps, and activity-based steps. Each step appears as an icon
within a given workflow template.

= Transition A Transition defines how the workflow will move from one
state (Activity) to another — this can be determined by an
analyst action, by the value of a variable, or by the amount
of time elapsed. .

=  Templates A Template is a design for a workflow that controls the
flow of execution of a process in iTRAC.

The template consists of a network of manual and
automated Steps. Activities, and criteria for transition
between them.

Workflow templates define how an incident will be
responded to once a process based on that template is
instantiated (see below).

A template may be associated with many incidents.

=  Processes A process is a specific instance of a workflow template that
is actively being tracked by the workflow system. It
includes all the relevant information relating to the
instance, including the current step in the workflow, the
associated incident, the results of Steps, attachments, and
notes.

Each workflow process is associated to one and only one
incident.

Introduction to the User Interface

Within the Sentinel Control Center, you access the iTRAC administrative functions by
selecting the iTRAC tab from the main screen. This tab gives you access to the Activity
Manager (where you define Activities), the Template Manager (where you define
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Templates), and the Process View Manager (where you manage instantiated workflow

Processes).

You may navigate to these functions from:

ITRAC | H

»  TheiTRAC menu in the .,W_E Dizplay Process Manager

Menu Bar 3 Activity Manager

:'J Template Manager

o
£

[Mavigatar
=-__1iTRAC Administration
...... L ity r-,-1ar|:a|1E:r
- # Template Manager
- L) Templates
=I-__1 Process Management
Lo Process View Manager

= The Navigation Tree in
the Navigation Pane

=  The toolbar buttons | qw-é 7 ;4!

Template Manager

The Template Manager can be used to create, view, modify, copy, or delete a Template.

Within the Template Manager you can add, delete, copy, view, and edit templates.
Templates can be sorted into folders for easy management

In the Template Manager, you may:

= Create new workflow Templates
= Edit or copy existing Templates
= Define workflow Steps
= Manual or Automated
= Description of Step or instructions for iTRAC users
= Define transitions between Steps
= Transition type
= Escalation procedures
= Timeout and alert attributes

ac

— \A - il

=\ 4,.! .

M‘.) \_> J@ =

f=-" . . .

Start autoCaollect investigate mail
arr [} tri .

manualCollect

()

End
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Default Templates

iTRAC is shipped with the following templates to use as examples. The process and
activity attributes for these templates have been set to pre-defined values. Users may

modify these to suit their requirements. The default templates are:

= AlertTimeoutExample
»  TwoStepSimpleExample
= ConditionalTransitionExample

= CommandExample

Template Builder Interface

IR
Be process Sep
B 7 oetstz T verisbies (o New Siep B 4dm
_ frocess vrven
- i &
W patchEsists?
83 asmignhepoesk
L
J Notfy CSIRT
2 Sered Rispert
1
Fal -
»823
N bl Sep
s AcsignHelpdesk Marusi Step
2 4 ow Indactior < ® Conmend sizp
W 3—“ & L1 0l Q
| B! ~ - =I o
start GatherDats  AnalhvzeOats IsAttack? . _Altack Detected Malify CSIRT Ferid Repod End
PatchEwists? ! /
. SchEwsts =
Al ApalyPatch
Cudck Eck
(FE]04 | mm | =3 =
=l proc
o [T
] Actites
(T o | Acthties | % O &
Descrighon desigred to
S
T Messnges P Contmrmentaciay
{'\\\ | Derctptan T ] 7 rascmonactivay
()
(Desscrighon)
Frocess Sausd Successhuly
Wistant| (3 B 2 ) <5 [T vovelisentwel Contrdl C... |[ & TRAC Process Bullder_. o (il 10:40Fm

You will see the following panes in the Template Builder window:

5-4  Sentinel

Process Tree: This pane displays the Steps, Transitions and Variables added
to the Template. User can add Steps or Variables, Edit or Remove Steps,
Variables and Transitions.

To perform an action on a Step, Variable or Transition:

o Expand the relevant group in the Tree.
= Select and right-click an existing attribute.
= Select action you want to perform.

Process: This is the main GUI for viewing and creating a Workflow
template. For more information on creating a Workflow Template, see
“Creating Templates”.

Quick Edit: Select a Step or Transition to see its properties. This pane allows
you to edit process attributes.

To edit the details of steps using Quick Edit:

o Click the Process Attribute value in the Quick Edit Pane.
o The attribute values will be highlighted indicating Edit Mode.
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o

Modify the value and click anywhere outside the Quick Edit frame to save
the new value.

= Messages: This pane displays messages if Steps or Transitions are
incomplete. You must resolve any issues listed here before saving the
Template.

= Overview: This pane displays an overview of the entire Template.
= Step Palette: There are four types of Steps in the Step Palette. You can ‘Drag

and

o
o
o
o

Drop’ the Steps into the Process pane.

Decision Step
Mail Step
Manual Step
Command Step

= Activities: The activities added in the Activity Manager are shown in this
pane and can be added to a workflow template. The user can also Add, Edit

and

Remove Activities. For more information, see “Managing Activities”.

WARNING:

Use caution when editing or deleting an Activity that is already in use.

The following icons are used in the Template Builder to represent the Steps:

Icon

Description

4

Start Step: All workflow templates have a Start Step.

Decision Step: This step provides different execution paths depending
on the value of a variable defined in a previous Step.

Mail Step: This step sends a pre-written email.

Manual Step: This step indicates that manual work must be performed,
often outside the Sentinel system (For example, telephoning the owner
of the affected system or analyzing the results of a scan).

Activity Step: This step is a pre-defined set of Activities.

Command Step: This step executes a command or script on the iTRAC
workflow server, usually installed in the same place as the Data Access
Service (DAS). The output of the command can be stored in a string
variable and used as input to a Decision Step.

© #Ba & g«-::-<> v

End Step: This step signifies the completion of a workflow process.

Creating Templates

To create a New Template:

Click the iTRAC tab.
In the navigation pane, click iTRAC Administration > Template Manager.
3. Click Add. The iTRAC Template Builder window displays.

1.
2.
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4. In the Process Details window, enter a name and description (optional) of the
template and click OK.

5. Drag and drop a Step from the Step Palette or an Activity from the Activities pane
into the process window. Or click the New Step drop-down button in the upper
left corner and select one of the following Step types. Or right-click Start step,
select Insert New and select one of the following Step types.

= Decision Step »= Manual Step
= Mail Step = Command Step

6. Add as many Steps and Activities as needed to create the Template.

7. Create transitions between each Step. To create Transitions, right-click the step
after which you need to add transition and click Add Transition.

NOTE: Any step (except for the End step) may have one or more exit transition
lines. A Decision step must have at least two exit lines.

8. Right-click each final step in the Template and click Add End Transition.

NOTE: On the bottom of the iTRAC Template Builder is a message pane that will
list any warnings or errors about incomplete steps during the construction.

9. To save your process, go to File>Save or click the Save button.

Managing Templates
After creating a template, you can modify, copy, delete the Template.
Viewing/Editing Templates
To view/edit an Existing Template:

1. Inthe Navigator, click iTRAC Administration > Template Manager.
2. Highlight a template and click View/Edit. The Template builder will appear.
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Copying Templates

One way to create a new workflow Template is to copy one of the default Templates and
modify it.

To copy a Template:

1. Click the iTRAC tab.
2. Inthe Navigator, click iTRAC Administration > Template Manager.

3. Highlight a template and click Copy. A Template Builder with the copied
template will appear.

4. Enter a new name, save and edit the template as needed.
Deleting Templates

Even if you delete a Template, any instantiated workflow processes that are based on that
Template will still complete normally.

To delete a Template:

1. Click the iTRAC tab.
2. Inthe Navigator, click iTRAC Administration > Template Manager.
3. Highlight a template and click Delete.

Steps

Steps are the basic components of a Template. Every Template must have a Start Step and
an End Step. The Start Step exists by default. You can also add the following types of
Steps to a Template:

=  Manual Step

= Decision Step
= Mail Step

= Command Step
= Activity Step

= End Step
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Start Step

Every workflow template must have one and only one Start step. The transition from a
Start step is always Unconditional.

Manual Steps

=
b

This type of step indicates that manual work must be performed. Every manual step in a
Template must be assigned to a Role. The users in that role are notified through a worklist
item when a instantiated workflow process reaches the Manual Step. When a user accepts
the worklist item, it is removed from the queue of the other users in that Role. For more
information about worklists and stepping through a workflow process, see Chapter 6
“Work Item Summary”.

The description of the step should indicate what work needs to be performed. The user is
expected to perform that work and then acknowledge completion.

A Manual Step includes the following attributes:

= Name of step

= Role

= Variables
o Delete
o Add

= Description
Variables

The user may also be asked to set one or more variables to appropriate values. Four
variable types can be assigned to manual steps: (1) Integer, (2) Boolean, (3) String and (4)
Float. This variable can be set to an explicit default value during the Step definition, or the
user can set the value at run-time as part of the workflow process. The value can be
optional or required.

The value of the variable can be used as part of a Conditional transition to determine the
path the workflow follows. It can also be used later as part of a Conditional Transition
from a Decision step to determine the workflow path.

NOTE: If the value is going to be used later as part of a Decision step, it should
be marked ‘Required’.

For example, an integer variable can be set by the user to hold the event rate. Output
transitions from the Manual Step can be defined so that if the event rate is greater than
500, one path is followed; else another path is followed.

To create a variable:

1. Click the iTRAC tab.
2. Inthe Navigator, click iTRAC Administration > Template Manager.

3. Click the Add button in upper left corner to open a new template or highlight
an existing template, click View/Edit.

4. Right click Variables in the Process Tree and select the type of variable to
add or right-click the variable type and select Add [type] Variable.
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Process

Process
= Steps
------ .;; Wrarkmiarning

------ :?I TimeSensitive'ork
------ :a, Wiork Escalated
..... <;l> Step_lj

Addl BOOLEAN Variable
Add FLOAT Yariahle
Add INTEGER Variahle

Add STRING Variahle

5. Give the variable a name and enter the Default Value, if desired.
Boolean Variable:

Process Yariables

MName  [variablet

Variahle Type IBOOLEAN LI | b
Defaultalue  |True ]|
Description

Ok | Cancel |

Integer Variable:
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Process ¥ariables E2

MName [variablez
Variable Type n
Defaultvalue  [100
Description
Ok | Cancel |
String Variable:
Name [variable3
Wariahle Type ISTRING LI
DefaultWalue |Cr'rtica||
Description
(o174 | Cancel |
Float Variable
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Process Yariables I

Mame  [variabled

Yariahle Type IFLOAT ﬂ _J

Default yalue |55.3|

Description

X Default\falue must be Float oK | cancel |

6. Click OK.

From a Manual Step, you can set Conditional, Unconditional, Timeout, or Alert
transitions.

Decision Steps

D

This type of step selects between exit transitions depending on the values of variables
defined in prior steps. See “Manual Step” for the available variable types. The Decision
Step itself is very simple; you can edit only the step name and description. The workflow
path is determined by the transitions.

From a Decision Step, you can set Conditional and Else transitions. Every Decision Step
must have an Else transition and at least one Conditional transition. The Else transition
leads to a workflow path that is followed if none of the criteria for the Conditional
transitions is met.

Mail Steps

ik
This step sends a pre-written email. A Mail Step includes the following attributes:

= Name of step

= To addressee

»  From addressee
= Subject of email
= Body of email

From a Mail Step, you can set a Conditional, Unconditional, Timeout, Alert, or Error
transition. It is a good practice to always include an Error transition so that errors can be
immediately escalated to someone.
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Command Steps

S

A Command Step is a step in which an operating-system level command or script (shell,
batch, perl, and so on) is executed. The name of the command can be entered explicitly or
set as a string variable, and parameters can be passed in the same manner. Output from the
command can also be placed back into a string variable.

A Command Step includes the following attributes:

= Name of step

= Description

=  Command (May be explicit or variable-driven)
= Arguments (May be explicit or variable-driven)
= Qutput Variable

NOTE: The command (or a batch file or script that refers to the command) must
be stored in the %ESEC_HOME%\config\exec or $ESEC_HOME/config/exec
directory on the iTRAC workflow server, usually the same machine where the
Data Access Server (DAS) is installed. Symbolic links are not supported

Variables

The command output may also used to set a variable to the appropriate values. Command
steps must use String variable types.

The value of the variable can be used as part of a Conditional transition to determine the
path the workflow follows. It can also be used later as part of a Decision step to determine
the workflow path.

For example, a command step may return a value of 0 for failure and 1 for success. This
output can be assigned to a variable, and then a Conditional transition or a Decision step
can use this value to determine which workflow path to take.

The command and its arguments can each be entered explicitly by the person designing
the workflow or be set as a string variable. If either one is set as a string variable, there
must be a previous step in the Template where the variable is set to a string value.

From a Command Step, you can set Conditional, Unconditional, Timeout, or Alert, or
Error transitions. It is a good practice to always include an Error transition so that errors
can be immediately escalated to someone.

Activity Steps

\
An Activity Step is a type of automated step that can be used in a workflow Template.
Activity Steps are created in the Activity Manager and can consist of internal Sentinel
operations or external scripted operations. Once Activity Steps have been created, the user

can select from the library of these Activities and drop them into the workflow. See
“Creating an Activity” for information on creating each type of pre-defined Activity.

An Activity Step includes the following attributes:

= Name
= Description
= Activity Assignment
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From an Activity Step, you can set Conditional, Unconditional, Timeout, or Alert, or Error
transitions. It is a good practice to always include an Error transition so that errors can be
immediately escalated to someone.

End Step

Every workflow template must have an End Step to complete every branch of the
workflow path.

Adding Steps to a Workflow

Steps can be added to a workflow using the Step Palette or using a right-click in the
Process Builder. When adding steps to a workflow, a yellow entry field indicates an
invalid entry.

To add a Step from the Step Palette:
1. Drag and drop a step from the Step Palette.
2. Right-click the step and select Edit Step.
3. Edit the details of the step and click Save.
To add a Step using a Right-Click:
1. Right-click an existing step in the Process Builder and select Insert New.
2. Edit the details of the step and click Save.
3. Select Manual, Decision, Mail, Command or End Step.
4. Edit the details of the step and click Save.
To add an Activity Step:
1. Click and drag an Activity from the Activity Pane to the Process Builder.

To add an End Step:
1. Right-click a Step with no transition and select Add End Transition.

=
G

] Inzert New ¥
hlan Ij -

- oo Edit Step

g Copy Step

w? Delete Step

I:,':',:I Add Transdtion

Fr |E',}| Add End Transition
WorkEscalated

Managing Steps
Steps can be copied, edited, or deleted.
Copying Steps
To copy a Step:
1. Click the iTRAC tab.
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6.

In the Navigator, click iTRAC Administration > Template Manager.

Highlight an existing template, click View/Edit. iTRAC Process Builder window
displays.

Select an existing step, right-click, and select Copy Step.

The step window will open in edit mode with all the attributes of the selected
step. Enter a name to the new step.

Edit step attributes as required. Click OK.

Modifying Steps

To edit a Step:

1.
2.
3.

4.
5.

Click the iTRAC tab.

In the Navigator, click iTRAC Administration > Template Manager.

Highlight an existing template, click View/Edit. iTRAC Process Builder window
displays.

Select an existing step, right-click, and select Edit Step.

Edit the step attributes. Click OK.

To edit a Manual Step:

1.

© N oo

Right-click a Manual Step and select Edit Step.
rMan ual Step Er
Manual Step -

iz azzigned to a role. Varisbles may be associsted with & @ E]
manual step to get input from users

Marne ||

A General | Description

Role v

Azzociate Wariables

= Associate @ B, Preview
Name
Type
Default
# Mame is Invalid.

Enter a Name for the step.

Attach a Role to this step by selecting a Role from the drop-down list. (Roles are
defined on the Admin tab documentation)

Click Associate to associate a Variable; select the variable from the list or create
new variables to be associated. Set a default value as desired.

Check the Read-Only box if this variable is to be forced to the default value.
Click Description tab to provide description for this step.

Click Preview to preview the step you created.

Click OK.
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To edit a Decision Step:
1. Right-click a Decision Step and select Edit Step.

Decision Step

Decision Step E
i= used to create decision points for conditional transitions [E

Marme ||

A General | Description

¥ Mame is Invalid.

2. Enter Name.
3. Click Description tab to provide description for this step.
4. Click OK

To edit a Mail Step:
1. Right-click a Mail Step and select Edit Step.

@ -
Mail Step X

Mail Step ff E
EMail will be sent to configured addresses A E]

Marme ||

" General | Body

To | |

Fram | |

Subject

M Subject shouldn't be em... [¥)

2. Enter Name for the step.

3. Enter To and From mail addresses and Subject in the General Tab.
4. Click Body tab and type the message.

5. Click OK.

To edit a Command Step:
1. Right-click a Command Step and select Edit Step.
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r |
Command Step

Command Step
Command step executes the configured cormmand. The output E E]
of the cormmand may be mapped to process variable

Mame ||

General | Description

|:| Use Variables
Comrand
|:| Use Variables

Argumerts

QutputVariahle v
M Outputvariable not set [¥)

2. Enter a Name for this step.

3. Specify the path and name of the command or script to execute (relative to
the $ESEC_HOME/config/exec or %hESEC_HOME%\config\exec directory)

4. If you wish to run a command or script referenced in a variable that gets
populated during the workflow process, check the Use Variables box.

5. Specify any command-line arguments to pass to the command or script. If
you wish to use the contents of a variable that gets populated during the
workflow process, check the Use Variables box.

6. Specify a variable to hold output from the command or script. Any standard
output is placed into these variables.

7. Click Description tab to enter description for this step.
8. Click OK.

Deleting Steps

To delete a Step:

1. Click the iTRAC tab.

2. Inthe Navigator, click iTRAC Administration > Template Manager.

3. Highlight an existing template, click View/Edit. iTRAC Process Builder window
displays.

4. Select an existing step, right-click, and select Delete Step.

5. On the alert message window, select Yes to delete.

Transitions

5-16

Transitions are used to connect steps. There are several types of transitions:
= Unconditional = Alert
= Conditional = Else
=  Timeout = Error

A Transition can have the following attributes:

=  Name
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= Description

= Destination: Step to which the transition links

= Expression
=  Timeout Values

Different steps have different properties are therefore associated with different transition

types.
Step Type Valid Transitions
= Decision = Conditional
= FElse
=  Manual = Unconditional
=  Timeout
=  Alert
=  Command = Unconditional
=  Mail =  Timeout
= Activity = Alert
= Error

Unconditional Transitions

An unconditional transition must always be used from a Start step. Manual, Command,
Activity, and Mail Steps may also have unconditional transitions. The only parameter for
an unconditional transition is the next step.

This path is taken when the current step is completed (unless a timeout transition is
configured and the timeout period elapses).

To add an Unconditional Transition:

1. Open the Process Builder.

2. Select an existing step, right-click and select Add Transition.
3. Enter a name for the transition.

4. Select the Transition type Unconditional from the list.

Transitions E I

Name  [start

Type Unconditional

&

Source  |start

Description

=] Destination [MamelT =]

5. Click the down arrow for the Destination field and select a step.

Destination [NamelT

ermaillH

StartNOTEPAD

E2

6. Enter a description for this transition and click OK.
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Conditional Transitions

Select an exit path based on an expression using iTRAC variables set in a Manual or
Command step.

NOTE: You can add Conditional Transitions only from a Decision Step to any
other step.

When creating a Conditional Transition, the conditional expressions can be based on
comparing a variable that is populated during the workflow process to a specific value or
to another variable populated during the workflow process. Multiple conditional
expressions can be combined or nested using the AND and OR operator.

To add a Conditional Transition:

1. Open the Process Builder.

2. Select an existing Decision step, right-click and select Add Transition.
3. Enter a name for the transition.

4. Select the Transition type Conditional from the list.

Transitions E |

MHame Idfafweafewafewa

Type | Conditionsl =l -(:
Snurcelm Destination | (EREI
Expression
et |
Clear |
Description

0l | Cancel |

5. Specify the destination Step.
6. Click Set to add an expression. The empty Expression window displays.
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4 Expression

=@ AND 2k OR

Complete Expression

% ecm @ oEL

L6134 | Cancel |

7. Click EXP to add the first expression. The evaluation expression is an
expression that will evaluate to TRUE or FALSE during the workflow
process. Select the appropriate dropdown under Relations to compare a

variable to a constant value (Variables and Values) or to another variable
(Variables and Variables).

Relations

Lttribute

Conclition

Walue

= [ ]

lols | cancel |

8. Select a variable from the Attribute dropdown or add a new one if desired.

9. Select a condition from the Condition dropdown. The condition list will vary
depending on the type of Attribute variable chosen.

String Variable Conditions:

£ Expression

% eom @ DEL

Relations

I‘u’ariables and Values

Atribute

Wallie

I Sample String Variahle

Complate Exprassion

enuals

equals lgnore Case
matches

iz empty

i ot emnpty

Ok | Cancel |

QK | Cancel |
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Integer and Float Variable Conditions:

£ Expression
#EXP B AND 2% OR % eoim @ DEL
Relations
I‘ufariables and Walues il |
Adtribute Condition Walle
ISampIeInteger\fariable LI IiS exactly LI I
Ok | Cancel |
iz <
iz <=
(e
iz ==

Complate Exprassion

Boolean Variable Conditions:

% Expression

#EXP <@ AND 2& OR of e0iT @) DEL

Relations

I\fariables and Yalues i |

Aftribute Condition Walue

ISampIeBoolean‘\fariable LI quuals LI ITrue ﬂ

it equals Ok | Cancel |

Commplets Expressioh

ok | Cancel |

10. Set the Value.
11. Click OK.
12. If a second expression is desired, highlight the root folder.

l..'
g ﬁ

13. Repeat steps 7-12 as needed.

14. By default, all expressions at the root level will be separated by AND
operators. To nest expressions or to use the OR operator, click the
appropriate operator button and drag and drop expressions onto that operator.
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£ Fxpression

£ Exr 8 anD d5 OR = EniT &3 DEL

R

------ .-t Sample StringVariable matches virus

------ .—t Sample ntegeryariable is < 100

QR

.-t SampleFloatVariable is exactly SampleFlostvariakle2
,-t SampleBoaoleanVariable equslz Falze

Complete Expression

ISampleStringvariable matches Mwirus") AND Samplelntegervariable js < 100 AND {SampleFlostVariable s
exacHly SampleFloatVWariable2 O8 SampleBooleanariable sgusls Falzell

Ok | Cancel |

15. When the expression is complete, click OK.

NOTE: You can edit/delete an existing expression using the Edit and Delete
buttons in the Expression window.

16. Click OK. The expressions you entered displays in Transition window under
Expression section.

17. Enter a description for your transition and click OK.

Else Transitions

An Else transition leads to a path that is taken from a Decision Step when the criteria for
the Conditional transitions are not met. This transition only applies to Decision Steps, and
every Decision Step must have an Else transition. The workflow path with the Else
transition is only followed if none of the criteria for the Conditional transitions is met.

NOTE: You can add Else Transitions only from a Decision Step to any other
step.

To add an Else Transition:

1. Open the Process Builder.

Select an existing Decision step, right-click and select Add Transition.
Select the Transition type Else from the list.

Specify the destination Step.

Enter a description for this step and click OK.

o~ D

Timeout Transitions

A Timeout transition leads to a path that is taken when a user-specified amount of time
(minutes, hours or days) elapses after a Base Time, which is either step_activated_time or
step_accepted_time. Step_activated_time is the time that iTRAC activates this step within
the workflow process. Step_accepted_time is the time when a user accepts (or takes
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ownership) of the worklist item for this step. If the timeout time period passes without the
step being completed, control moves to the next step.

Timeout transitions can be set for a Manual Step or a Command Step. Step_accepted_time
is only relevant for Manual Steps and should not be selected for a Command Step.

This transition is represented by a red line.

To add a Timeout Transition:

1. Open the Process Builder.

Select an existing Decision step, right-click and select Add Transition.
Select the Transition type Timeout from the list.

Specify the destination Step.

Click Set to enter the Timeout details. Timeout details window displays.
Specify the timeout value in minutes, hours, or days. Click OK.

Select Base Time.

Enter a description for your transition and click OK.

©NO O AN

Alert Transitions

An Alert transition leads to a path that is taken when a user-specified amount of time
(minutes, hours or days) elapses after step_activated_time or step_accepted_time. At this
point, the workflow process is usually escalated to a user who can intervene and take
action.

Step_activated_time is the time that iTRAC activates this step within the workflow
process. Step_accepted_time is the time when a user accepts (or takes ownership) of the
worklist item for this step.

If the alert time period passes without the step being completed, the workflow process will
branch into two active paths. The original step remains active for user intervention. The
alert path will also be initiated. For example, the alert path may escalate the workflow
process to the attention of a supervisor, while the main path is still open and the original
owner still has the option to complete the worklist item. Another example is that if a
command is taking too long to run, you may want to alert an analyst to investigate the
delay or possibly run the command manually.

Alert transitions can be set for a Manual Step or a Command Step. Step_accepted_time is
only relevant for Manual Steps and should not be selected for a Command Step.

This transition is represented by a yellow line.

To add an Alert Transition:

1. Open the Process Builder.

Select an existing Decision step, right-click and select Add Transition.
Select the Transition type Alert from the list.

Specify the destination Step.

Click Set to enter the Alert details. Alert details window displays.
Specify the Alert time value, in minutes, hours, or days. Click OK.
Enter a description for your transition and click OK.

N o s e
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Error Transition

An Error transition leads to a path that is taken if an automated step cannot successfully
complete. Error transitions can be used for Command, Mail, and Activity Steps (for
example, if a Command Step fails to execute).

Error Transitions should typically lead to some kind of notification. For example, an Error
Transition might lead to a Manual Step in which the user is instructed to manually run.a
process that previously failed.

NOTE: The Error transition will only be taken if the iTRAC call to the
Command, Mail, or Activity Step fails. If there is an internal error with the
Command script or the mail server fails, this does not satisfy the conditions for an
Error transition.

Only the destination Step can be specified, along with a description.

To add an Error Transition:

1. Open the Process Builder.

Select an existing Decision step, right-click and select Add Transition.
Select the Transition type Error from the list.

Specify the destination Step.

Enter a description for this step and click OK.

O W

Managing Transitions
After creating a transition, you can edit or delete the transition.
Modifying Transitions
To edit a Transition:
1. Click the iTRAC tab.

2. Inthe Navigator, click iTRAC Administration > Template Manager.

3. Highlight an existing template, click View/Edit. iTRAC Process Builder window
displays.

4. Double-click an existing transition line. The Transitions window will open.

5. Edit the transition as needed.

6. If you are editing an expression from a decision step, click the *...” button and
double-click the expression.
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Namme  [20 min Timeout

Type  [Timeout | Qf) e
Destination |Tima Ot '! 4 @
Timeout Details

Timeout will fire in 20 minutes after —| 4 @

ACTIMTY ACCEFTED TIME ciear .||

Timeout Details
Descripti |

Source  |Fils name

Time iZD Unit IMinutes e I

Baze Tine lStep Accepted Tire ﬂ

0K | Cancel |

7. Edit as needed.
8. Click OK until you exit the Transitions window.
9. Click Save.

Deleting Transitions

To Delete a Transition:

1. Click the iTRAC tab.

2. Inthe Navigator, click iTRAC Administration > Template Manager.

3. Highlight an existing template, click View/Edit. iTRAC Process Builder window
displays.

4. Select an existing step, right-click, and select Remove Transition.

5. On the alert message window, click Yes.

Activities

An Activity is very similar to a Command Step, except that Activities are reusable and
cannot use input or output variables. The Activities pane shows a library of user-defined,
reusable Activities that can reduce the amount of configuration necessary when building
Templates.

Activities are exported or imported as xml files. These files can be exported or imported
from one system to another.

Activites

Activities v a9 o X
F collectionactivity

3 Cortainrnent Activity

F Eradicationactivity
3 Internaldctivity

Sentinel provides three types of actions that can be used to build Activities:

= |Incident Command Activity
= Incident Internal Activity
» Incident Composite Activity
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Incident Command Activity

An Incident Command Activity enables you to launch a specific command with or without
arguments. The following fields from the incident associated with the workflow process
may be used as input to the command:

= DIP [Destination IP] = SIP [Source IP]
= DIP:Port = SIP:Port
= RT1 (DeviceAttackName) = Text (incident information in name value

pair format)

NOTE: The command (or a batch file or script that refers to the command) must
be stored in the %ESEC_HOME%\config\exec or $ESEC_HOME/config/exec
directory on the iTRAC workflow server, usually the same machine where the
Data Access Server (DAS) is installed.

Incident Internal Activity

An Incident Internal Activity enables you to mail and/or attach information from the
Sentinel database to the incident associated with the workflow process. Each of these
options has a prerequisite:

»  Vulnerability for the Source IP address (SIP) or the Destination IP address
(DIP): This requires that you run a vulnerability scanner and bring the results of the
scan into Sentinel using a VVulnerability (or “information”) Collector

= Advisor attack-related data: This requires the purchase and installation of the
optional Advisor data subscription service.

= Asset data: This requires that you run an asset management tool such as NMAP and
bring the results into Sentinel using an Asset Collector.

Incident Composite Activity

An Incident Composite Activity enables combine one or more existing Command and
Internal activities.

Creating Activities

To create an Activity:

1. Click the iTRAC tab.

2. Inthe Navigator, click iTRAC Administration > Activity Manager or click the
Add button in the Activity Pane.
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Activites

| activities >+ o &

F Collectionactivity

Containment Activity

F Eradicationactivity

3. Highlight an existing activity and click > Add button. Activity Wizard window
displays.

4. Select an Activity type: Command, Internal, or Composite.

5. Enter a name and description for this activity. Click Next.

Activity Wizard
Select Activity Type,Enter Mame and Description.

Usage

Incident Command Activity Inciclent Cormmand Activity
Incidert Composite Activity

Incidert Internal Activity

Mame

Sample Mame
De=cription

Sample descripﬁon|

Back et Cancel |

6. Configure the necessary settings for the type of activity you chose.
» Incident Command Activity

s In the Command Arguments Wizard, enter the Command.
= Enter the Arguments for this command. You may select None, Incident
Output (Values from the Drop-down list), or enter custom values.
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[ ]

Activity Wizard X
Command Arguments Wizard

Provide command name and select required command argument tipe.

Command:

Argurients:
@ Mone

O Incident Output

O Custaom

| >

Dezcription

’ Back ” Mext l’ Cancel ]

s Click Next.

= You can configure an Incident Command Activity to email the output to a
specific address and/or attach the output to the incident associated with the
workflow process in this window.

o Select Mail and enter the To and From email address and Subject.

3

Activity Wizand

Command Activity Mail and Attachment Wizard

Select required sttachment options and provide the necessary mail details.

RE

To: | |

Frari : | exec_activity |

Subject - | |

[ #tach to Incident

Description

[ Back “ Tt l [ Cancel

= Select Attach to Incident, if required.
o Click Next.
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s View and confirm the details you chose in the Summary page and click Finish.
= Incident Internal Activity

@ Inthe Command Arguments Wizard, enter the Command.
s Enter the Arguments for this command. You may select None, Incident
Output (Values from the Drop-down list), or enter custom values.

(& ]
Activity Wizard X]
Internal Activity Mail and Attachment Wizard
Select required mails and attachments.
fail andd Attach
Mail  Attach
1 [ wunershbiity |SIP s
[0 [ advizar Data
Description
’ Back ” et l ’ Cancel
Click Next.

@ Select your options (Mail and attach).
= If you select Mail, you will be prompted to enter To, From email address and
Subject. Enter this information and click Next.
= View and confirm the details you chose in the Summary page and click
Finish.
» Incident Composite Activity
o Select the activities from the list of available activities and click Next.
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(& |

Activity Wizard

X

Composite Activity Wizard
Select required user defined Activities.

Activities

[ cortainmertactivity
[[] Eradicationactivity
W Collection&ctivity

’ Back ” Mext l’ Cancel ]

= View and confirm the details you chose in the Summary page and click
Finish.
Managing Activities
After creating an Activity, you can modify, import or export it.
Modifying Activities
To modify an Activity:

1. Click the iTRAC tab.
2. Inthe Navigator, click iTRAC Administration > Activity Manager.

3. Highlight activity that needs modification and click View/Edit. Edit Activity
window displays.

4. Edit information in General, Arguments and Attachment tabs.
5. Click OK.

Exporting Activities
To export an Activity:

1. Click the iTRAC tab.
2. Inthe Navigator, click iTRAC Administration > Activity Manager.
3. Click Import/Export Activity icon. Import/Export wizard window displays.
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(& ]

Import/Export Wizard E|

Activity Import/Export

Select Impoart or Export action and the file for activities to be imported from or exported into.
Action Dezcription
Export Activity Export Activity|
Irnprort Activity
File Marne
File Path

[ Mext ] [ Cancel

Select Export Activity and click Explore.

Navigate to where you want save your exported file.
Click Next.

Select one or more activities to be exported.

Click Next and click Finish.

N A~

Importing Activities
To import an Activity:

Click the iTRAC tab.
In the Navigator, click iTRAC Administration > Activity Manager.

Click Import/Export Activity icon >, Import/Export wizard window displays.
Select Import Activity and click Explore.

Navigate to your import file. Click Import.

Click Next. You will see a list of activities that will be imported.

Click Next and click Finish.

No ok ow bR

Process Management

5-30

Process Management allows you to view the incident’s progress in the workflow or
terminate a workflow process. Process Management allows you to:

= Display Status of your Process
= Start your Process
= Terminate your Process

Process Execution is the time period during which the process is operational, with process
instances being created and managed.
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When an iTRAC process is executed or instantiated in the iTRAC server, a process
instance is created, managed and eventually terminated by the iTRAC server in
accordance with the process definition. As the process progresses towards completion or
termination it executes various activities defined in the workflow template based on the
criteria for the transitions between them. The iTRAC workflow server processes Manual
and Automatic Steps differently.

An iTRAC process must be created with a single associated incident; there is therefore a
one-to-one match between iTRAC processes and incidents. Not all incidents are
necessarily attached to processes, however.

NOTE: Only one incident may be associated to an iTRAC process instance.

Instantiating a Process

An iTRAC process may be instantiated in the iTRAC server by associating an incident to
an iTRAC process by the following three methods

= Associate an iTRAC process to the incident at the time of incident creation
= Associate an iTRAC process to incident after an incident has been created
= Associate an iTRAC process to an incident through correlation

For more information on association a process to an incident, see Chapter 4 “Incidents
Tab”.

Automatic Step Execution

When the process instance executes an automatic Activity Step, Command Step, or Mail
Step, it executes the associated Activity or command defined in the Template, and stores
the result in process variables. It then transitions to the next Step in the iTRAC template.

For example, an Activity might be defined to ping a server; when this Activity is executed
in a workflow process the Activity will run and attach the results to the associated
incident.

Manual Step Execution

On encountering a Manual Step, the iTRAC server sends out notifications in the form of
work items to the assigned resource. If the Step was assigned to a role then a work item
will be sent to all users within the role. The iTRAC server then waits for the user to
complete the work item before proceeding to the next activity.

For more information, see Chapter 6 “Work Item Summary”.

NOTE: All Manual Steps must be assigned to a Role, or group of users.

Display Status

The Display Status function is to monitor the progress of a process. As the process
instance progresses from one activity the user may track the progress visually by clicking
on the refresh button, the process monitor also provides an audit trail of all the actions
performed by the iTRAC server while executing the process.
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M ALL PROCESSES

BEx

= & iFERUAtime Process

+- Activity Step

- Commiand Step

a

o COmmand
b am COMmand
' - Expression_Boolean
B Testincident
S BR9E07
10.45 At

L@ EC13

45 EC12
; EC 11
+ - Expression_Check

State

terminsted

terminsted

FURNIngG
TLINFng
completedd
completed
completec
completecd

Process Definftion ...

Command Step
Command Step

Expreszion_EBoolean
Expression_Boolean
Expreszsian_Boolean
Expression_EBoolean
Expression_Boolean
Expression_Boolean

Inciclent Cwner

Inciclert I

242
243

s01
401
360
333
332
x|

Lazt Updste Time

121172006 12:08:24
121172006 12:09:23

121572006 122202
121672006 11:19:40
121672006 10051 44
1271472006 12:42.28
121 472006 12:40:52
121 472006 12:36:55

Activities that are running are represented by “¥ and those completed by “& and
terminated by “® icons.

Displaying Status of a Process

To display Status:
1. Click the iTRAC tab.
2.

5. The current step is highlighted in red.

Click the Display Process Manager icon.

e
sk

Click down-arrow on the Switch Views button to select a view or create a new
view.

In the Process Manager Window, highlight and right-click a process and select
Actions > Display Status.

M Processes Wiew I [=] B3

State

I Process Definition Na...I

Incidert Cwner I

Kl

= & W FERurtime..
- Alert TimeoutE

ﬂ'é Sample...

rLirtinG

Mt Tiremm i Fr,

Actions

Start Process

Terminate Process

=

| Ready

|||.§;‘ Refresh| I—T_)I Manage Yiews - EI Switch Wiew -
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M Samplelncident - Alert Timeout Example !IEI E
@. Zoom ot Jj. Zoom Selected Reszet xj' Process Details - History
State: running Owner Name:
Process Definition Name: Inhstance Id: I[J)::Dti[:lf;tsisn
AlertTimeout Example 1_Aert Timeout Example_Alert Timeout Example .
Yersion: 1
ki1
\ -
@ —"‘®
o g - q /
= . Record End
‘v‘) s @ escalate U wk2
start — WorkEscalated
aler
=9
o—D
Wiorkiharning End
Feady Fefresh) | Created || State: running

6. Click the “X” in the upper right corner when done.

Changing Views in Process Manager

To Change the View in the Process View Manager:

1. Click the iTRAC tab.

2. Click the Display Process Manager icon.

3. Click the drop down list in Manage View and select Edit Current View option.
4. In View Option window you may also set your:

o Fields.

= Group by.
Sort.

Filter.

Tree Display.

5. Click Apply and Save

o

o

o

The following is view with Tree Display set to Status (running and not started).
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N Process View Manager

De=cription 1 |ncident o Incidert Cwner Instance Id
B & WFERURtime... ~
E L 11714454 100 1_Te=t1_Testl o
P @ 11720466 350 231 _Templste_to_che . 00 B
.. _ ] _ arnple-warkflow. .. m
L 11720452 405 F07_Activity _chilc_&cti.. O
L 11720466 405 309_Cmd_check_Cm.. 00
L 11720482 410 31 _Timeout _Templ... 00
i L 11720601 42 I3 _Activity _chi_Acti.. O 2
2 b e oo o — - >._
RPeady r:f,:‘ Refresh |=-_7| Manage WView = |=_/'| Switch Yiew -

Starting or Terminating a Process

To Start or Terminate a Process:

1. Click the iTRAC tab.
2. Click the Display Process Manager icon

o

Alternatively, you can select iTRAC > Display Process Manager.
3. Click drop down arrow on the Switch Views button to select a view or create a

new view.

4. In the Process View Manager window, highlight a process, right-click and select

Actions > Start Process or Terminate Process.
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6 Work Items

Topics included in this chapter:

Topic Page
Understanding Work Items 6-1
Processing a Work Item 6-4
Work Item Management - Administration 6-5

Understanding Work Items

A Work Item is a workflow task assigned to a particular user or role in the iTRAC
application. The individual activities to be performed to complete an iTRAC process are
listed as work items in Work Item Summary in the Sentinel Control Center. For more
information on iTRAC processes, see Chapter 5 “iTRAC Workflows”. You may access
the work items from any tab in the Sentinel Control Center.

NOTE: To have access to a work item, you should have it assigned to you or
acquire the work item.

Work Item Summary

The Work Item Summary lists the work items allocated to a user as an individual and as a
member of a group; it can be referred as an incident workflow to-do list for a user who is a
part of the Incident response process. In the Work Item Summary, you may access the
work items and:

»  View the details of a work item
=  Process the work item to complete the task

In the Work Item Summary, work items are grouped by current user and by other users
with similar role. The following example is for a user who is a member of the Admin,
Analyst, Jr Analyst and Admin Asst group.

Work Rem Summary

There are 2 items
owvned by me and 1 D Group

assighed to my groups. D W

Wiewy weotk tems

i m e  Click here to view Work Iterms
min

H“‘-__________.-""f
An alyst |
A Anatt '| J&———— These are Usercreated toles, using Role
Admin Asst | | Ilanagzer in Adrran Tab.

The following is an example of a user who is a member of the Analyst group who has a
process assigned to his role (group).
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Work Hem Summary

There are 0 tems
e
owviied by me and 1 |:| HoUR

assigned to my groups. . b

“iewy work tetns

Analyst |

To access a Work Item:

1. Inthe Work Item Summary, click the yellow or green bar. A work item list for
the group or the current user will appear.
Uset: Iesecadm LI Group: IAnaIyst LI Cryyner; IGroup "I Process: I:AII: *l
% HRO1_ Sept0dd 2006 Procezs: chart_1
Step: HackedORnot
Complete  Acouire View@e’[ails
2. Select work item and click View Details. Work Item Details window displays.
Process Hame : chart_1 Process Id : 1801 _chart_1_chart_1
Incident Hame : NROM _Sept04 2006 Incident Id : 1400
Owner : Performer : Analyst
Incident Owner : esecacm Status
Process Status | Process Details| Description |
@, Foomin G} FoomOut i Zoom Selected Reset (@ ProcessDetails = History
State: running owner:
Process Hame: chart_1 Id: 1501 _chart_1_chart_1 Version: 2
= &ﬂ:‘ &
il L S
il = Y
[T e L
Complete Acouire | Cancel |

3. The Process Status tab in this window displays the Work flow. Click Process
Details tab to view the process details.
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N Work Item Details
Process Hame : chart_1 Process Id: 1801 _chart_1_chart_1
Incident Hame : NRO1_Sept04 2008 Incident Id : 1400
Owner 2 Performer : &nalyst
Incident Owner : esecadm Status
Process Status  Process Details| Descriptioni
“esHacked ltrue ;J =
]
=
Comments : Al Aftachments : Add
(Comments and attachments will be added to 2ssociated Incident)
Complete | Acuirs | Cancel I

You can also add comment and attachments to the process. Attachments will appear in the

Incidents tab.

The Description Tab displays the Step Description and Process Description you entered

while creating workflow in iTRAC. For more information on iTRAC processes, see

Chapter 5 “iTRAC Workflows”.

m Work Item Details

Process Mame : TwoStep Simple Exanple Process Id:

Incident Mame : lestincident Incident Id :
Owner : Performer
Incident Owner : esecadm Status

Process Status rPrucess DEtaVDescriptionl

* Admin
: FUnfing

1_TwaStep Simple Example_Tvo Step Simple E:
100

Step Description

Process Description

his exmaple may be used to demonstrate the sticky owner behavior.

Thiz example congists of & simple workflow caongisting of two manual steps with unconditional transtions. & runtime t

Complete H Acguire ” Cancel ]
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Processing a Work Item

A Work Item can be run under any tab of the Sentinel Control Center.

A Work Item can be processed while still in a Group and not acquired by a user.
However, once a step is completed and the next step is of the same group, the step
will be acquired by the user.

After acquiring a Work Item steps in succession that belong to a Group and has been
acquired by a user, the Work Item will stay with the user.

If a single of succession of steps are with a user followed by a step of another group
and returns back to the original role, the step will not revert to the user. It will be
assigned to the group.

The two stages of processing a work item are

Accepting a work item
Completing a work item

Accepting a Work Item

6-4

To accept Work items:

1.

3.
4. The current step within a Work Item will be high-lighted in red.

In the Work Item Summary, click the yellow or green bar. A work item list for
the group or the current user will appear.

N Work Items | x|
User: _3 Group: IAnaI\;ST 'I rvner: IGroup ‘l Process: I:AII: vi

F TwvoStepSimpleExarmple

To assign an iTRAC process to you, high-light the process and click Acquire.

N Wwork Items [ x|
User: Ijr LI Group: IAnaI\;s{ Ll Cvyyrier: IGroup 'l Process: I<AII: vl

Process ; TwoStepSimpleExample
Step: Stept
Commplete  Acouive  Views Details

The Work List Summary will change from yellow to green.

Work kem Summary VWork Hem Summary
There are O items There iz 1 item
C3rau o
arvtied by me and 1 D i awyned by me and 0 |:| R
assigned to my groups. hle assigned to my groups. E Me
Wiewy weark tems Wienwy weork tems
Analyst | Anabyst | |
Work item assigned to a group (role) | Work item assigned to the user under
the Analyst role.

NOTE: When acquiring (accepting) a process, all other users in the same role
you are in will no longer see the process. You can place the process back to the
group by clicking Release.

Click View Details.
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5. To take action on the step, click the Process Details tab.

In the case of a manual step and depending on the type of variable (Integer, String,
Boolean and Float) assigned to that step, click the down arrow and select a decision.
If needed, you can add comments or add an attachment.

In all other cases, the steps are automatic.

6. While running a process, if the process disappears that means that it changed
groups.

7. Click Complete to complete the process.
Completing the Work Item

Completing the work item signals the completion of the task to the iTRAC server. The
updateable variables from the work item are processed by the server to move to the next
activity based on some criteria. The work item is removed from the worklist. A work item
has to be acquired before it can be completed.

To complete Work Items:

1. Click View work items link in Work Item Summary pane. Work items window

displays.
2. Click Complete.
m Process View Manager E]@
State Process Definition .. Incidert Cvner Incidert I Last Update Time
=l & WFERuntime...
= Twin StepSimpl...
S testingi... running TwoStep Simple Example 100 322007 10:24:34 AM

Ready .:,:' Refresh @ Manage YView - @ Switch View -

Work Item Management - Administration

The Administration function allows an administrative user to release a Work Item from a
specific user back to everyone in a role. This is beneficial in the event that a Work Item is
in already in process but the assigned user cannot complete the work.

To release a Work Item back to a role (Admin):

1. Login into Sentinel as a user with iTRAC — Work Item Management user rights.

2. Inthe Summary pane, click View work items.
Work Hem Summary

There are 0 tems
e
ovwvned by me and 1 D HobR

assigned to my groups. [:] Me
ey work Tems <« —

3. Inthe Work Items window, set the following:
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N ¥ork Items

Lser: Ijr1 LI Group: IAnaIys{ LI et I<AII> j Process: I<AII> LI

Process : blame chart
Step : HackedORnot

Complete Releaze  Wiew Details

= User: Name of the user that has acquired the process

= Group: Name of the Group that the user belongs to. In the above example,
the user belongs to the Analyst group.

= Owner: Select either <All> (all processes acquired or not), me (acquired
processes) or Group (un-acquired processes).

= Process: Name of the process.

In the above example, all processes acquired by jrl, who belongs to Group Analyst,
with all processes listed.
4. To release the Work Item, high light the Work item and click Release. Release
will change to Acquire (grayed out).
In this example, only a member of the Analyst group may acquire this Work Item.
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Analysis Tab

Topics included in this chapter:

Topic Page
Understanding Analysis 7-1
Top Ten Reports 7-2
Running a Report from Crystal Reports 7-4
Running an Event Query Report 7-4
Creating an Offline Query 7-5

Understanding Analysis

The Analysis tab allows for historical reporting. Historical and vulnerability reports are
published on a web server, these run directly against the database and they appear on the
Analysis and Advisor tabs on the Navigator bar.

Analysis also provides Offline Query and Crystal reports to view pre-defined reports. In
Offline Query you can save and generate the queries offline. This helps in optimizing
network usage as it relieves network from heavy processing when similar queries are
triggered. Offline Query helps you in ad hoc reporting and with Crystal Report you can
view predefined reports. You may also customize reports to meet your requirements.

NOTE: Sentinel is integrated with Crystal Reports® to generate and display
reports. The administrator must configure the location of the Crystal Enterprise
Server that publishes reports in the Reporting Configuration window of the
Admin tab. The navigator window on the Analysis tab shows a list of available
reports.

In order to run the report templates, you need to have Crystal Reports Enterprise
Edition installed and have your Sentinel Control Center configured to access that
server. For more information, see Crystal Reports for Windows or Crystal
Reports for Linux in Sentinel 6.0 Installation Guide.

NOTE: You must have the proper permission to use Analysis tab. If this
permission is not assigned, Analysis tab is not displayed.

Introduction to the User Interface

In Analysis, you may see the Create Reports and Offline Queries options.

You may navigate to these functions from:

Analysiz |

= The Analysis menu in the ;
Menu Bar u,)Q Create Report
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Mavigator o &
= The Navigation Tree in =1 Offine Queries
the Navigation Pane P el Offine Guery

= -] Historial Events
4 Histarical Evert Queries |

]

Create Report
= The Toolbar Buttons metpu

ENE]

Cupries

Top Ten Reports
The following are the Top 10 reports which are available in Sentinel 6:

= Top 10 Correlation Rules Triggered
= Top 10 Destination Host Names
= Top 10 Destination IP Addresses
=  Top 10 Destination Port Numbers
= Top 10 Destination User Names
=  Top 10 Destination Event Names
= Top 10 Destination Source Host Names
= Top 10 Destination Source IP Addresses
= Top 10 Destination Source to Destination IP Pairs
= Top 10 Destination Source User Names
= Top 10 Virus Names
= Event Count by Top 10 Assets
= Event Count by Top 10 Departments
= Event Count by Top 10 Taxonomy Level
= Incidents by Top 10 Assets
= Incidents by Top 10 Users
The Top 10 reports are enabled by default, and the following summaries are turned on to
enable the Top 10 reports:
o EventDestSummary
@ EventSevSummary
o EventSrcSummary
If Top 10 reports are not needed, you can disable these summaries, or you can enable

additional summaries in order to use them for reporting. If the summary service is not in
use, you may disable it.

To enable/disable Aggregation:

1. In Sentinel Control Center, go to Admin > Server Views.

2. Right-click DAS Aggregation and select Start/Stop to enable/disable
Aggregation.
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To enable/disable summaries:

1. In Sentinel Control Center, go to Admin > Reporting Data.

2. Highlight the Summary to enable/disable and click the status
(Active/Inactive) of that summary.

N Reporting Data M =] E3
SLIMMEry |
Surnrmary Mame Tirne Aftributes Source Status
EwertDestSum... [1 hour CUET DRSS .. | TransformedEw. .. Active
CUST ID.DE .. Ihactive
Ewert SewDestE... [1 hour CUET IDDE .. | TransformedEw. .. |hactive
Event SevDestP... |1 hour M MEEV.DEST F . | TransformedEw... Inactive
Ewert Sew Surnm... [1 hour “SJCUsST ID.SE L. | TransformedEy... Active
Ewert SrcSurmm... (1 hour CUET DRSS .. | TransformedEw. .. Active

3. Select Yes to confirm that you want to change the status of the summary.

To enable or disable EventFileRedirectService:

1. Atyour DAS machine, using text editor, open:
For UNIX:

$ESEC_HOME/config/das_binary.xml
For Windows:
%ESEC_HOME%\config\das_binary.xml

2. For EventFileRedirectService, change the status to on or off, as
appropriate. For example:

<property name="'status''>off</property>

3. Log into the Sentinel Control Center as the Sentinel Administrator.
4. Go to Admin > Servers View.

Analysis Tab
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'.' Servers Wiew ! EI E

| Starts [ o pestarts | Start T
-1 ProcessHealth
- ) cwitt-cesktop

@ Collector_Manager 1 0 61407 3:031
'@ Correlation_Engine 1 ] G407 3050

@ pas_Proxy 1 0
@ DS Ciery 1 a ar 407 5:05:
@ DaAS RT q n] SM4/07 3:082
@ Das_iTRac 1 a 54407 308

- @ UNIX Communicati.. 0 0
(@ Windows Commurni... 1 0 S 407 3.081
K | o
| Ready ”E‘}' Flefreshl EI Manage Wiews - Iz Switch Wiew -

5. Right-click DAS_Binary and choose Restart.

Running a Report from Crystal Reports

To run a report:

1. Click the Analysis tab.
2. In the Analysis Navigator, click a report from the available reports.

NOTE: To run any Top 10 reports, aggregation must be enabled and
“EventFileRedirectService” in DAS_Binary.xml must be set to on. For
information on how to enable aggregation, see Reporting Data section in Chapter
10 “Administration Tab”.

3. Click Analysis > Create Report or click Create Report.

4. Complete the information prompts and click OK. The report displays.

Running an Event Query Report

To create an Event Query report:

1. Click the Analysis tab.
2. Inthe Analysis Navigator, open the Historical Events folder.
3. Click Historical Event Queries.
4. Click Analysis > Create Report or click Create Report icon.
An Event Query window will open.
5. Set the following:
= time frame
= filter
= severity level
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= batch size (this is the number of events to view — events display from oldest
events to newer events)

6.
7.
8.

Offline Query

Click Begin Searching.

To view the next batch of events, click More results icon.

Rearrange the columns by dragging and dropping them and arrange the
sort order by clicking in the column heading.

When your query is complete, it is added to the list of quick queries in
the Navigator.

Offline Query is most often used to run queries against large amounts of data. Offline
Query will continue to run even after the user logs out of the Sentinel Control Center, if

necessary.

NOTE: You can view the result of your query only after it is completely
processed.

After the query has completely finished processing, the results are available to the user
who initiated the Offline Query and other Sentinel users with the same security filter.
When you attempt to browse or save the result as HTML or CSV, the data is transferred
from the server to the local machine running the Sentinel Control Center.

Creating an Offline Query

To create an Offline Query:

1.

-
N Add Offline Query

{Queryi[ Descrigtion

Click Analysis on the Menu Bar. The Offline Query window displays.
Alternatively, you can click Offline Query button on the Tool Bar.

In the Offline Query window, Click Add button located on the top left
corner of the screen. The Add Offline Query window displays.

X

Start Time
SH2M07 30642 P s
Eted Tirne :
S2M07 3:06:42 P b
Ok Cancel
3. Enter a Query Name. Select an existing filter to be used for generation of

offline query. For more information on the selection and creation of
filters see Chapter 2 “Active Views”.

Select the Start Date and End Date for which you want to generate an
offline query.

Enter the description in the Description Tab.
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6. Click OK. The Offline Query gets listed in the Offline Query window.

Viewing, Exporting or Deleting an Offline Query

To view, export or delete an Offline Query:
1. Click Analysis on the Menu Bar. The offline Query window displays.
Alternatively, you can click Offline Query button on the Tool Bar.

2. In the Offline Query window, select an offline query. You will have the
following options available:

= Browse: Click Browse to view the output of the Offline Query in the Active
Browser window.

= CSV: Click CSV to generate a Comma Separated Value file with the queried
information.

= HTML: Click HTML to generate an HTML file with the queried information.

= Delete: Click Delete to delete the Offline Query. Confirmation message alert
displays. Click Yes to delete.

= Details: Click Details to view the details of the Offline Query as entered
while adding the Query.
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Advisor Usage and Maintenance

Topics included in this chapter:

Topic Page

Understanding Advisor 8-1
Standalone Installation — Advisor Manual 8-3
Updating

Direct Internet Download — Advisor Manual 8-3
Updating

Running Advisor Reports 8-2
Changing the Scheduled Data Update Time 8-5

Understanding Advisor

Advisor is an optional subscription service that provides device-level correlation between
real-time events from intrusion detection and prevention systems and enterprise
vulnerability scan results. By providing normalized attack information, Advisor acts as an
early warning service to detect attacks against vulnerable systems. It also provides
associated remediation information.

NOTE: You must also have the optional Advisor license in order to view the tab
correctly. Otherwise you will see a notification that you are not licensed for
Advisor. In addition, access to the Advisor tab is controlled by the administrator
on a user-by-user basis.

The Advisor data feed is updated on a regular basis as new vulnerabilities are reported. It
contains two parts:

= Alert Data: Information relating to known security vulnerabilities and threats
= Attack Data: Normalization of intrusion detection signatures and vulnerability
scanning plug-ins

The following intrusion detection and intrusion prevention systems are supported by
Advisor:

= Cisco Secure IDS = |SS RealSecure Server Sensor
= Enterasys Dragon Host Sensor = |ISS RealSecure Guard

= Enterasys Dragon Network Sensor = Snort/Sourcefire

= ISS BlackICE PC Protection = Symantec ManHunt

= ISS RealSecure Desktop = Symantec Intruder Alert
= |SS RealSecure Network = McAfee IntruShield
The following enterprise vulnerability scanners are supported by Advisor:
= Database Scanner » Phalanx

= Foundstone = QualysGuard

= Internet Scanner » Retina

= nCircle IP360 = System Scanner

= Nessus = Wireless Scanner
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Viewing Advisor Data

Advisor data can be viewed in two ways: by right-clicking on an event with an attack
signature, or by running reports from the Advisor tab of the Sentinel Control Center.

NOTE: Until the initial datafeed is completely loaded, Advisor will not be fully
functional.

Viewing Advisor Data using right-click menu option

To View Advisor Data:

1. You may view using right-click menu options from:
= Active Views Tab
o Click Active Views tab.
= Incidents

o Click Incidents tab.
= Inthe Events tab, you will see the associated events.

= Analysis Offline Query

s Click Analysis Tab.
= Go to Offline Query and highlight a Query and click Browse.
= Event grid will display in active browser.

=  Analysis Historical Query

= Click Analysis Tab > Historical Query.
= You will see Event Grid in the Query tab and the Active Browser Tab.

2. Select and right-click an event or a set of events from the Event Grid.
3. From the right-click menu options, select Analyze > Advisor data.
4. A new window with Advisor data will appear.

NOTE: The right-click function will not be fully operational until the first
download of Advisor data has been fully loaded into the database.

NOTE: You can analyze advisor data only if the selected event are from the
intrusion detection systems (IDS's) supported by advisor.

NOTE: Data in Advisor database must be up-to-date for accurate results.

Running Advisor Reports

To create an Advisor report:

1. Click the Advisor tab.

2. Inthe Advisor Navigator, click a report template.

3. Click Advisor > Create Report.

4. Complete the information in the template and click View Report.

Maintaining Advisor

To be effective, the Advisor data must be updated on a regular basis. The Advisor data
feed can be configured to run regularly scheduled updates, or it can be updated manually.

For more information on creating regularly scheduled updates, see Configuring Advisor
while installation in Sentinel 6.0 Installation Guide
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Standalone Installation — Advisor Manual Updating

If you have chosen Standalone Installation of Advisor in the Sentinel installer, follow the

procedure given below to update Advisor data manually. The script advisor.sh (for UNIX)
and advisor.bat (for Windows) will update the database and then delete the attack and alert
downloaded files that were unzipped into the attack and alert directories.

To update Advisor Feed:

1.
2.
3.

Go to url https://advisor.esecurityinc.com/advisordata/.

Enter your username and password.

Go to the latest month under the attack and alert folders and download the zip

files.

Place the new alert and attack feed data files (zip files) on your computer.

NOTE: Do not place the zip file in the attack and alert directories.

Unzip the attack feed zip files to:

For Windows:

<location specified during

files>\attack

or
For UNIX:

<location specified during

files>/attack

Unzip the alert feed zip files to:

For Windows:

<location specified during

files>\alert

or
For UNIX:

<location specified during

files>/alert
Go to:
For Windows:
%ESEC_HOME%\bin
For UNIX:
$ESEC_HOME/bin
Run the following command:
For Windows:
advisor._bat
For UNIX:
./advisor._sh

install for Advisor

install for Advisor

install for Advisor

install for Advisor

data

data

data

data

NOTE: advisor.sh and advisor.bat will update the database and then delete the
attack and alert files that were unzipped into the attack and alert directories.
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Direct Internet Download — Advisor Manual Updating

If you have chosen Direct Internet Download of Advisor in the Sentinel installer, follow
the procedure given below to update Advisor data manually.

To update Manual Advisor Feed — Direct Internet Download:

1.

Go to:
For Windows:

%ESEC_HOME%\bin
For UNIX:
$ESEC_HOME/bin

Run the following command:
For Windows:
advisor.bat
For UNIX:
./advisor.sh

NOTE: advisor.sh and advisor.bat will update the database and then delete the
attack and alert files that were unzipped into the attack and alert directories.

Changing Your Advisor Server Password

For the Standalone installation, use the instructions below to request a new Advisor
password. The new Advisor Server password will be entered manually every time you
download updated Advisor data.

For the Direct Download installation, an extra step is required so that the Advisor Server
password will be encrypted and stored in a configuration file for automatic downloads.

To change your Advisor server password:

1.

Submit a password change to Novell Technical Support
(http://support.novell.com/phone.html?sourceidint=suplnav4_phonesup).

Novell will send you a new password.

Perform the following steps if you are using the Direct Download configuration
for Advisor. For UNIX login as Sentinel Administrator User or for Windows
login with administrative rights.

Go to:
For UNIX:

$ESEC_HOME/bin
For Windows:
%ESEC_HOME%\bin

Enter the following commands:
For UNIX:

./adv_change_passwd.sh <newpassword>
For Windows:
adv_change_passwd.bat <newpassword>
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Changing Your Advisor Server Email Configuration

To change your Advisor server email configuration:

1. For UNIX login as Sentinel Administrator User or for Windows login with
administrative rights.
2. Goto:

For UNIX:
$ESEC_HOME/config

For Windows:
%ESEC_HOME%\config

3. Open alertcontainer.xml and alertcontainer.xml in a text editor and make changes
to the highlighted areas shown below.

<property
name=""advisor._mail . from">FromNAME@domain.com</pro
perty>

<property

name=""advisor.mailto. list">toNAME@domain.com</pro
perty>

NOTE: To send messages to more than one address, enter email addresses as
comma separated, without spaces.

Changing the Scheduled Data Update Time

When installing Advisor in Direct Download mode, the administrator can choose to
update Advisor on a 6-hour or 12-hour schedule. By default, the data update times are:

=  Six Hour: 01:00, 07:00, 13:00 and 19:00
=  Twelve Hour: 02:00 and 14:00

To change the Advisor scheduled update times:

1. Login to your Advisor machine (for UNIX login as Sentinel Administrator User).
2. To edit your data feed times:

For UNIX: use the ‘crontab’ command

For Windows: use the "at' command
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Event Source Management

The topics included in this chapter:

Topic Page
Understanding Event Source Management 9-1
Introduction to the User Interface 9-2
Live View 9-9
Components of Event Source Hierarchy 9-13
Adding Components to Event Source Hierarchy 9-14
Adding Connectors/Collector Plug-ins 9-15
Deploying a Connector 9-20
Deploying an Event Source 9-20
Deploying Event Source Servers 9-20
Debugging Collectors 9-28
Event Source Management Scratchpad 9-35
Comparison between Sentinel 5.x and Sentinel 9-36

6.0

Understanding Event Source Management

Event Source Management (ESM) panel provides a set of tools to manage and monitor
connections between Sentinel and its event sources.

NOTE: You need to have appropriate permissions to access this tab. Only an
Administrator has controls to enable/disable access to the ESM panel for a user.

The Event Source Management tools available in the ESM panel include the following:

Graphical and tabular views of the configuration of connections to event sources with
the real-time status of these connections overlaid.

Configuration wizard to assist the user in adding and editing connections to event
sources.

Various other tools that allow the user to investigate the status of connections to event
sources, monitor the data flowing through them, and debug collectors.

Export and import configuration wizards that allow the user to export their
configuration to a file and later import it back.

Through ESM, you may:

Add/edit connections to event sources using configuration wizards.

View the real-time status of the connections to event sources.

Import/export configuration of event sources to or from Live View/Scratchpad.
Import/export Connectors and Collectors from or to a centralized repository
Monitor data flowing through the Collectors and Connectors

Debug Collectors
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Design, configure and create the components of the Event Source Hierarchy, and

execute required actions using these components. For more information, see “Live
View and Scratchpad”.

Collector Workspace and Collector Directory

Collector Workspace is the location where collectors that you create or you want to
modify using Collector Builder, are stored. The collectors are stored in
%ESEC_HOME%\data\collector_workspace

Collector_instances is the directory where the running collectors are stored. They are
stored on the system where Collector Manager is installed. The running collectors are
stored in %ESEC_HOME%\data\collector_mrg.cache\collector_instances

Introduction to the User Interface

The ESM Live View and Scratchpad are independent windows. This allows you to work
on other tabs in Sentinel simultaneously as you work on ESM.

The Event Source Management windows include:

= A Menu Bar with the ESM menus
= A Tool Bar which helps you execute the functions of ESM
= Several different types of frames to display ESM data

= Display Health Monitor frame with graph and table views where you can perform
your activities

N Event Source Management (Live View)

File “iew Tools Help

‘: ' Connect To Event Source ' ® C & g [T Higrarchic Left to Right w ' oD .(“? (e l @ @ '
Aftribute Filter o g .~ Graph | Table 4 b B

Search

Overviem

0,
+

S
Limit to: | ad Event Sources v,
1= Running

] m stopped

] Error

& Unknonn O
[[] % Reporter Time |5 Skewed

O0—
[ & warning Wbl Connectar
[] & Debug Maode

it g E
Sentinel (1)
Cohnhectors o B -
& 't! y i Y General Collectar (2)
B | i
Collectar Manager (DAS) 5 eps Event Source
Marne = e
Data Generstor LR Chidren 58
pLl Diata Generator Connector (1) Name =

=§ WHI Connector

=Ji Data Generatar Connector

=i Connectors

Event Source Palstte g i

Mame:
Ll AR AR AR

< > - & Children

Menu Bar
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The Menu Bar has File, View, Tools and Help options.
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N Event Source Management

File  “iew Toalz Help

EEX

The following are the options available in the each of the Menu Bar options which are

described in the document:
= File

= Export Configuration
s Import Configuration

o Save Preferences
o Close
= View
o Reset Layout
= Redo Layout
= Undo Layout
=  Tools

= Connect to Event Source

o Import plugin

= Help
= About
= Help

These options allow you to perform a set of actions mentioned below:

Tool Bar

Launch the wizard for
connecting to a new Event
Source

Import/Export & Reload
Event Source Management
Configurations and plugins

The tool bar contains several
tools for displaying objects in
ESM. You can zoom the
entire Graphical view in and
out, or zoom directly to a
selected region.

The Magnifying Glass allows
you to enlarge the text and
icons for a small portion of
the Graphical view without
affecting the overall zoom
level.

The Fit to Screen option
adjusts the ESM view to fit
the screen.

= o |
i . = Connect To Event Source i|

Export Cordizuration

e |
=
Troport Cu:urdiglm*nn
Eeload ESIV Data

QB ME
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You may select from several
different layouts to display
the objects in ESM.

You may also enable/disable # | Hierarchic Left ta Right v
animations during transition —

from one layout to the other
in the Graphical view of the
Health Monitor Display.

Beset to defanlt layont
You may reset to the default

settings too. t?‘ é ﬁ‘?lJ

Urdu*l_agm nut l
Redo Lagrout

Zoom

In ESM, you can use Magnifying glass to zoom into a region.

TIP:

To enable/disable magnifying glass in ESM, use the ”Local zooming using a
magnifying glass” button on the toolbar.

Hot Keys:

You can increase or decrease the magnification factor with the following key
combinations:

To increase or decrease the size of magnification glass cursor:
= Toincrease: Ctrl key + Backward scrolling of the Mouse wheel
» To decrease: Ctrl key + Forward scrolling of the Mouse wheel
To increase or decrease the zooming of the nodes:

= To Zoom in: Forward movement of the Mouse wheel
=  To Zoom out; Backward movement of the Mouse wheel

NOTE: Magnification glass is available only in the Graphical View of ESM
window.

Frames
You may see the following Frames in the Live View or Scratchpad window.
Attribute Filter

The Attribute Filter allows you to filter to display the components of ESM. You can
specify the components to be displayed based on the component name and status.
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Aftribute Fiker

0
oo

Search:

Limit to: | g Ewert Sources b
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[ ] Errar

[] E Unknown

|:| & Reporter Time |z Skewed

[ ] & wrarming

—

[+ attribute Fi.. | oo Hierarchy F.

= Text Filter: It allow you to filter the nodes that are displayed in the graphical and
tabular view based on the text they type in.

State Filter: It allows you to filter the nodes that are displayed in the graphical and
tabular view based on the current state of the node.

Hierarchy Filter
The Hierarchy filter sets the display based on the hierarchy you select in this frame. It

allows the user to filter the nodes that are displayed in the graphical and tabular view
based on the node hierarchy. All children and parents of selected nodes will be shown.

Hierarchy Fiter o &
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To set Hierarchy filter for displaying components:

1. In Sentinel Control Center, click the Event Source Management in the menu bar
and select Live View or Scratch Pad.

2. Click the Hierarchy Filter frame.
3. Select the Hierarchy Level to display the components.
Connectors
Connectors are plug-ins in Sentinel. Importing a Connector would implement the

connector mechanism in the system. Connectors frame allows you to Add, Remove, and
Refresh connectors and Add auxiliary file in the system.
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SMMP Connectar
File
Dieta Generstor
Syslog
Process

=4 Connectors | f5- Scripts

Add Add Connectors to the system.

Delete Delete Connectors.

Refresh Refreshes the list.

Add Add Auxiliary Files. For more
Auxiliary information, see “Add Auxiliary Files”
Files

To add Connector Plug-ins:
1. In Sentinel Control Center, click the Event Source Management in the menu bar
and select Live View or Scratch Pad.
2. Click the Script or Connectors frame. You can plug-in connectors from here. For
more information, see “Add Plug-In”.
Scripts

Collectors are plug-ins in Sentinel. The Collector Script plug-in adds the ability to parse
raw data from an event source. Scripts frame allows you to import plugins, remove
collectors, refresh the list of collectors and add auxiliary files in the system.

Scripts o &

8] @
. T

Marme

HCSC_OS390-RACF W2 zip355
Microsoft _indowes_ 2000 _nikd1_52
T1_155x_SITE_02x5_JDBC_Bwa2
Snort

General

=d- Cu:unneu:tu:ué\hf ‘- Scripts

@ Add Add Scripts to the system.
32| Delete Delete Collectors.
3| Refresh Refreshes the list.
i 1| Add Auxiliary Add Auxiliary Files. For more
Files information, see “Add Auxiliary Files”.
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To add Collector Plug-ins:

1. In Sentinel Control Center, click the Event Source Management in the menu bar
and select Live View or Scratch Pad.
2. Click the Script or Connectors frame. You can plug-in collectors from here. For
more information, see “Add Plug-In”.
Event Source Palette

This frame displays the list of Devices or Event Sources supported by the existing
Collectors in the Central Repository.

Event Source Palette o &

fame
il Microzoft Windows 20000CP2003
L GMU SMORT 20
Ll 155 Real Secure 2.x

4 b

Children

This frame displays names of immediate children nodes of a parent (main) node when you
click the parent node. This frame is useful to manage children of nodes which have been
contracted in the Graphical View. To perform any action in ESM, right-click a component
and select from options listed. For more information, see “Right-click Menu”.

Children o o
Marme =

'131'. Syslog Server ALL4EE(TCR)

&

T & Microzaft_indowes_wrh1_J5_B00
T & T1_GMUx_SHRT_0200_SLOG...

L
& Microzoft_SCQLServer_3_J35 600

B Status aw Chidren

Status Details

This frame displays the status details of a selected component in the Health Monitor
Display frame.

Available status information includes the current state, the number bytes processed, the
number of records sent, the number of Sentinel™ Events sent, and various other status and
statistical information.

NOTE: The status information will vary based on the type of component that is
selected.
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Status Details
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Overview

The overview frame allows you to quickly move across the graphical view. This is
particularly useful when there are a lot of objects in the screen.

Oweryiew

10

Plug-in Repository

A plug-in is a package of code that provides additional functionality to Sentinel and the
most common plug-ins are Collector Scripts and Connectors. Implementing these features
as plug-ins allows Novell to deliver enhancements to our event collection system without
the need to deliver a new version of the Sentinel platform.

= Collector Script: The Collector Script plug-in adds the ability to parse raw data from
an Event Source. This is similar to the Collector Script in Sentinel 5, however in
Sentinel 6 the plug-in also provides additional meta-data to enable the ESM panel to
prompt the user for parameter values as well as enable ESM to automatically choose
supported connection methods that work well with the Collector Script. This meta-
data is added to the Collector Script plug-in by the plug-in developer.

= Connector: In Sentinel 6, all Connectors are pluggable. A Connector plug-in contains
both the implementation of the connection mechanism as well as the GUI screens
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needed to configure the connector. This allows for a user to easily add additional
Connectors to Sentinel.

» Hot Fixes and New Functionality: In the future, some Sentinel enhancements and
defect fixes may be available as plug-ins.

= Once you import a plug-in into Sentinel, it is centrally stored in the Plug-in
Repository. The appropriate Sentinel components on other machines will
automatically start using the plug-in.

Auxiliary Files

Some plug-ins such as database Connectors, require one or more auxiliary files in order to
function. Auxiliary files are any such files that can not be included with the standard plug-
in files such as user-specific configuration file or third party libraries that require specific
licenses.

To add an Auxiliary File to a specific plug-in:

1. Select the plug-in to which the Auxiliary file will be added and then click Add
Aucxiliary File.

2. A wizard will guide users through the process of importing the Auxiliary file.

Live View

The ESM panel provides the main user interface to Event Source Management. You can
view configuration data in Graphical or Tabular view.

Graphical ESM View

The Graphical view of ESM is the default view in Event Source Management. In
Graphical view, you can view the status of a collector and access the configuration
settings of Collectors and collector related objects as a graph of connected nodes.

A Graph | Table

Data Generator Cannector Data Generator Event Source

W@

General Data Generatar Event Source

/S %'3\ a

Sentinel CollectorManager (DAS)

@ :\%’ \\{1‘3 Data Generatar Connector

Data Generatar Event Source

%

4 rps Event Source
Data Generator Gonnectar 5 ms Event Source

General Collector ‘JE<_\§E<_1-E

By default, the Health Monitor Display frame opens in the Graphical View. The data can
be displayed in seven different layouts. The default layout in graph is the “Hierarchic Left
to Right” layout. You can change between these layouts by selecting the layout format
from the drop-down list in the Tool Bar.
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HCWO st # | Hierarchic Left to Right v
ﬂ Compact Tree Layout
Hierarchic Left to Right =

Hierarchic Right to Left
Hierarchic Layout

Hierarchic Layout (Descending)
Balloon Layout

Tree Layout

TIP:

Click in the Graphical ESM view and use “+” or “-”sign to zoom in or zoom out.
Alternatively use mouse wheel to zoom in and zoom out.

In the Graphical View, the lines connecting the components are color-coded to indicate
data flow.

= Green Line: Indicates data is flowing between the components.

= Grey Line: Indicates the connection is not live and there is no data flow.

= Blue dashed Line: Indicates the logical relation of Event Source Servers to their
associated Collector Managers and Event Sources.

The terminology used for nodes are:

= Parent Node: A Node from which child nodes originate

= Immediate Children: The sub nodes that are logically and functionally linked to a
Parent Node.

= Collapsed/Expanded nodes: To improve the manageability and performance of the
Graphical display, Sentinel automatically contracts any node with 20 or more
immediate children. This is especially useful for Connectors such as Syslog or Novell
Audit that have the ability to automatically configure a large number of event sources.

TIP:

Collapsed Nodes are identified by a “-” sign on the node and Expanded Nodes by
“+7 sign.

Double-click a node to expand or collapse.

In collapsed state, a node displays the number of immediate children next to the node; for
example, WMI Connector (3) [Collector name (Number of immediate children)]. The
“Children” panel of a contracted node shows the immediate children of that node, each of
which can be managed in the same way as nodes in the Tabular ESM View.

NOTE: Event Source Server node do not have “+” or “-” sign after its name even
if it contains children.

Double-clicking on a parent node will change the state from collapsed to expanded and
vice versa. Double-clicking on a node with no children displays the status details for that
node. If an additional node is added to an expanded parent with over 20 children the node
will be contracted automatically. If an additional node is added to a manually expanded
parent with over 20 children the node will not be contracted automatically.

The parent node may take several minutes to expand if the parent node has a large enough
number of child nodes to potentially cause the Ul to become unresponsive; an alert
message displays on the user interface to warn you about the delay in response. Click Yes
to continue.
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Expand Selected Node? - x|

- Are ol sure you Stil want 1o expand the selected node?

o Expanding the salectad node may cause the display o become unresponsive

[ Do not show this message sgain

(=] o |

If you chose not to show this message again, the preferences are saved on that machine
and any user logging into Sentinel from that machine will not get an alert again.

Tabular ESM View

The components visible in the graphical view of ESM can also be viewed in tabular
format. In Tabular view, you can view the status of a collector in a table and access the
configuration settings of Collectors and Collector related objects.

< Grap; Tahle
Marne: Corfigured Status=!  Actual Status Connection Info Errar
= @ sentinel on on

=] @ Collector Manager (DAS) on on

= Bq Genersl Collector
[z “aiy Data Generstor Connectar
‘um 5 rps Event Source
Bl fg General
[z “aiy Data Generstor Connectar
‘um Data Generator Event Source
‘up Data Generstor Event Source
[z “uiy Data Generstor Connectar

Generating data at S0 record (=) per second.

SEEEEEEEE
293333383

The columns in the ESM Tabular View are:

Configured Status: The On state the object is configured to be in. This is the state
that is stored in the database and do not necessarily match the actual On state of the
object. For example, the two states will not match if a parent object is turned off or if
there is an error.

Actual Status: The On state of the object as being reported by the actual running
Collector Manager.

Connection Info (populated for Event Sources only): A textual description of the
Event Source connection.

Error: A textual description of an error that occurred in the running object.

TIP:
Use the Table/Graph tabs to change to Tabular/Graphical views.

Right-click Menu

The Health Monitor Display View provides a set of right-click menus that will help you
execute a set of actions, as described below:

NOTE: The right-click actions available depend on the kind of object you clicked
on.

Status Details: You can view all information known about the status of the selected
object.
Start: You can set the object to be running.

NOTE: The selected object will only start up once the parent nodes are running.
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= Stop: You can stop the running object.

= Edit: You can modify the editable information (Filter information, Object name and
S0 on) with this option.

= Debug: You can debug the collector. You must stop the running collector before you
debug it.

= Move: You can move the selected object from its current parent object to another
parent object. You can move objects between the views that is live view to scratchpad
and vice versa.

= Clone: You can create a new object that has its configuration information pre-
populated with the settings of the currently selected object. This allows you to quickly
create a large number of similar Event Sources without having to retype in the same
information over and over again. You can clone objects between the views, that is live
view to scratchpad and vice versa. Cloning an object will Copy all the settings except
the “Run” status. New objects created using the Clone command will always be in the
Stopped state after creation..

= Remove: You may delete a selected object from the system.

= Contract: Contract the child nodes into this node. This option is only available on
parent nodes that are currently in an expanded state.

= Expand: Expand the child nodes of this node. This option is only available on parent
nodes that are currently in a contracted state.

= Add Collector: It allows you to open an “Add Collector” wizard that guides you
through the process of adding a collector to the selected Collector Manager.

= Add Connector: It allows you to open an “Add Connector” wizard that guides you
through the process of adding a connector to the selected Collector.

= Add Event Source: It allows you to open an “Add Event Source” wizard that guides
you through the process of adding an event source to the selected Connector.

= Open Raw Data Tap: You can view the live stream of raw data from an Event
Source or flowing through the selected object.

= Open Active View: You can open Active View window that only displays events that
have been generated by data from or flowing through the selected object.

= Zoom: You can zoom in the graphical view display on the selected object.

= Show in Tabular/Graphical View: You can switch over to the other view (to tabular
view if on graphical view, or to graphical view if on tabular view) and automatically
selects the object that is selected in the current view. When switching to graphical
view, it also zooms in on the selected object.

» Raw Data Filter: It allows you to filter the raw data flowing through the selected
node. The raw data filter is available on Collectors, Connectors, and Event Sources. If
a filter is specified to drop data, the data to be dropped will not be passed to the parent
node and, therefore, will not be converted into events.

= Import Configuration: You can import the configuration of ESM objects.

= Export Configuration: You can export the configuration of ESM objects

= Add Event Source Server : It allows you to add Event Source Server to the selected
Collector Manager

= Add Collector Manager: In Scratchpad mode, you can add a Collector Manager to
the scratchpad by using this option. In the Live view, Collector Manager objects are
created automatically as each Collector Manager connects to the Sentinel system.

When you select multiple objects in the ESM panel and right click. The following options
are available:

= Start: To start all the objects
= Stop: To stop all the objects
= Remove selected objects: To remove the selected objects along with its children

TIP:
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Press “Shift” and click the object to select multiple objects.

Components of Event Source Hierarchy

ESM displays the information on the Collectors and other components in a hierarchy

-

[ L

usll
-

-

specific to ESM.

}—P. —b.,_.,_ — b —bLi

EE

NOTE: ESM allows you to add Collector, Event Source and Connector.

Sentinel

Collector Manager

Collector

Connector

Event Source

Event Source Server

The single Sentinel icon represents the main Sentinel™
Server that manages all events collected by the Sentinel
system.

The Sentinel object is installed automatically through the
Sentinel installer.

Each Collector Manager icon represents another instance
of a Collector Manager process. Multiple Collector
Manager processes can be installed throughout the
system. As each Collector Manager process connects to
Sentinel the object will be created in Sentinel
automatically.

The term Collector refers to a deployed instance of a
Collector Script which includes the specification of the
Collector Script to use as well as the parameter values the
Collector should run with. Collector Scripts define the
parsing logic for a specific device type.

The term Connector refers to a deployed instance of a
Connector plug-in which includes the specification as well
as the parameter values the Connector should run with.
The Connector plug-in defines the method of collecting
data, such as Database, Flat File, WMI, and so on.

Each Event Source represents a configured Event Source

connection, including the Collector Script, the Connector

type, and configuration parameters. An Event Source can

be thought of as an individual application or device that is
generating event data to be collected into Sentinel.

Each Event Source Server icon represents a configured
Event Source Server. An Event Source Server is a
Sentinel process that collects data from specific event
source types and passes it on to associated Event Sources.
Common Event Source Server types include Syslog and
Novell Audit..

Component Status Indicators

=

Indicators are used to represent various states as follows:

Stopped

Indicates that the component is stopped.
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Running Indicates that the component is running.
Warning Indicates that a warning is associated with the component.

At this time, this warning indicator is primarily used to
show when the configured state and actual state of a
component differ. (that is, a component is configured to be
running, but the actual state of the component is stopped.)

Error Indicates that an error is associated with the component. See

the individual component’s status display for details about
the error.

Reporter Time is Skewed  Indicates when the time of a component differs from the

main server’s time. (The difference is greater than a
predefined time threshold.)

Debug Indicates that the component is in “Debug” mode. Only a

Collector can be in Debug mode.

Unknown This indicator is displayed when the status of the object in

the ESM panel is not yet known.

To set Attribute filter for displaying components:

1.

2.
3.
4.

In Sentinel Control Center, click the Event Source Management in the menu bar
and select Live View or Scratch Pad.

Click the Attribute Filter frame.
Enter the Search and Limit to criteria.
Check Running and/or Stopped checkbox to specify the status of the components.

To hide components based on type:

1.

2.
3.
4.

In Sentinel Control Center, click the Event Source Management in the menu bar
and select Live View or Scratch Pad.

Click the Attribute Filter frame.
Enter the Search and Limit to criteria.
Select the component type by which to limit the view.

Adding Components to Event Source Hierarchy

Collectors, Connectors and Event Sources may also be added to the system through the
right-click menus on the main ESM display.

Collectors

To run the Collectors and generate the Events as per your requirements, you need to:

9-14

Download Collectors from Novell Collector Download page

(http://support.novell.com/products/sentinel/collectors.html).

Import and Deploy Collectors

= After downloading Collectors, import and deploy the Collectors.

Generate Events

= Start (Right-click the collector and select Start) the Collector to generate Events.

Debug Collectors

s For any errors in the output of a Collector, select the Collector, right-click and
select Debug.

o For more information, see “Debugging Collectors”.
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= Edit Collectors
= To troubleshoot any misbehavior of a Collector, you can edit the Collector. To
edit Collectors, copy the Collector Script to a machine that has Collector Builder
installed.
= For more information on editing Collectors, see Sentinel 6.0 Collector Builder
User Guide.
= Re-Import and deploy Collectors

Adding Connectors/Collector Plug-ins

NOTE: When you use the Sentinel Control Center to browse to locate a file on
the Desktop of the Collector Manager, clicking Desktop will take you to the
Desktop of the user running the Collector Manager, usually SYSTEM. Extra steps
may be necessary to navigate to the correct user’s desktop.

To add a Connector plug-in:

1. Click Tools on the Menu Bar and select Import plugin... Import Plugin wizard
displays.

=
Import Plugin Wizard

Plugin Import Type
Specify whether toimpart plugin from & plugin package or a directary.

@' Import Collectar Script or Connectar plugin packae file [ zip

(:} Irmppart Callectar Script from directary

l Back: ” Mt l[ Cancel ]

2. Select Import Collector Script or Connector plugin package file (.zip). Click
Next.

3. Browse to a location of the Connector Plug-in package file and click OK. Click
Next.

NOTE: If the file imported is not in the format specified for the collector scripts
or for the connector plug-in package, system displays an error message.

4. Plug-in details window displays. Select the Deploy Plug-in option to deploy the
plug-in from this window. For more information, see “Connect to Event Source.”
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M Edit Connector
Configure Connector |

[ Description
Give this Connector & name and select the options you wish o rumwith

[ General

éName: iData Genergtor Connectar
[k Rurn

Iid i2C228C4D-29?D-1 022930 E-001321 B3204
éPIugin: Data Gernerator Detail= I

I Alert if no data received in specified time period

[ Send
{ I~ Limit Data Fate

Set Fiter... i

v Sawe Raw Data to-afile 1C:'¢emp\testrawdata.t>d Browse...

Ok 1 Cancel 1

5. Click Finish.

NOTE: When you add a plug-in into Sentinel, it is placed in the Plug-in
Repository, which enables Sentinel components on other machines to start using

the plug-in without having to add the plug-in separately.

To add a Collector plug-in:

1. Click Tools on the Menu Bar and select Import plugin. Import Plugin wizard
displays.

# i
Import Plugin Wizard @

Plugin Import Type
Specify whether to import plugin from a plugin package or a directory.

@' import Collector Script or Connectar plugin package file [z

{} Import Collector Script from directory

[ Back ” i[> l [ Cancel

2. You may choose from the two options given in this screen. Click Next.

3. If you chose first option, browse to a location of the Collector Script file and click
OK. Click Next. If you chose second option, you are directed to the collector
workspace. Select a Collector Script directory and click Next.

4. Collector Script Detail window displays.
a.  Click the button next to id field to generate UUID.
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b. The name and author details are displayed. Edit the details as per your
requirement. Enter the Version number.

c. Browse and attach the help file.

NOTE: If the help file is not in the plug-in directory, the system prompts to copy
the help file to the plug-in directory before import. Click Yes.

d. Enter description and click Next. Supported Devices window displays.

NOTE: You must specify at least one device.

Click Add. The Supported Devices window displays.
Enter vendor, name, version, description and click OK. Click Next.

NOTE: Use Edit button to edit the details of a device or use delete button to
delete a device from the list.

5. Plug-in details window displays. Check the Deploy Plug-in option to deploy the
plug-in from this window. For more information on deployment procedure, see
“Connect to Event Source.”

6. Click Finish.
Updating Connector/Collector Plugins

If a new version of a Connector or Collector is released, you can update the Sentinel
system and any deployed instances of the Connector or Collector.

NOTE: When you use the Sentinel Control Center to browse to locate a file on
the Desktop of the Collector Manager, clicking Desktop will take you to the
Desktop of the user running the Collector Manager, usually SYSTEM. Extra steps
may be necessary to navigate to the correct user’s desktop.

To update a Connector or Collector plug-in:

1. Click Tools on the Menu Bar and select Import plugin... Import Plugin wizard
displays.

r o
Import Plugin Wizard @

Plugin Import Type
Specify whether ta import plugin from a plugin package or & directory.

@ Import Collector Script or Connector pludin package file (zin

O Import Collector Script from directory

[ Back “ et ][ Cancel ]

2. You may choose from the two options given in this screen. Click Next.

3. Browse to a location of the Connector or Collector Plug-in package file and click
OK. Click Next.

NOTE: If the file imported is not in the format specified for the collector scripts
or for the connector plug-in package, system displays an error message.
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4. When updating an already-imported Connector or Collector, you will be given the
option of updating the existing plugin, going back and selecting a different
plugin, or canceling the import. Assuming you want to continue, click Next.

Import Plugin Wizard x|

Replace Existing Plugin?
A diﬁer%versiun of the same plugin already exists in the Plugin Repository. Choose what

1o do wittrthe existing plugin.

~Detailz of Plugin in Repository

Mame File
Type COMMECTOR
Wersion Gr2

Release Date 8/3M07 2:52 PM
Description Reads data from a file.

K —

~Detailz of Plugin Being Imported

Mame File
Type COMMECTOR
“ersion Br2

RPelease Date  S/307 2:52 P
Description Reads data from a file.

K] I—

Click Mext to replace the existing plugin with the one being imported, or click Back to zelect a
different plugin package.

Mext | Cancel |

5. Plug-in details window displays. Check the Update Deployed Plugins option to
update any currently deployed plugins that use this Connector or Collector.

=

Import Plugin Wizard §|

Plugin Details
Details of the plugin to be imparted are shown below . Click Finish to import the pludgin,

Description

Marne Syslog

Type COMMECTOR

Author Mowell Engineering

Wersion Gr2

Release Date 21007 11:45 Ak

Supported OF Platforms

Id 900 C3770-5 09 0-1029-B4 48001 321 BCOB3

Description Connector to Sysloy Devices.

|:| Update Deployad Plugins Wigw Deployed Plugins (4]

Checlk the box to immedistely updste deployed pluging sfter the import is complete. Even if the
box iz not checked, plugineg will updste autornatically the nesd time they restart.

’ Eack ” Firish ][ Cancel ]

6. Click View Deployed Plugins to view the Plugins deployed in ESM Live View.
The number in parentheses represents the number of instances of this plugin that
are currently deployed and configured. The Deployed Plugins window displays
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the Affected Connectors/Event Sources/Event Source Servers or Affected
Collectors. These are the components whose configuration is affected due to
adding already existing Connectors/Collectors in ESM.

Affected Event Sources/Connectors/Event Source Servers

| Deployed Plugins

Affected Event Sources(2)

Event Source Connectar

Syslog Ev...

[]
S Swslog Bu. -@ Syslog Co... EE. Sourcefire... ‘1_ Collector ..

Callector

Sourcefire... Collector ..

Colector Ma...

Affected Event Source Servers(1)

Ewert Saurce Server

Callector Mansger

= : * Syslog Server ALLT4BS(TCF) m Callector Manager(DAS) dtapp. ..

Affected Connectors(1]

Connector Collector

)
- Syslog Connector

Sourcefire Snort 2.

Collector Manager

f | Collector Manage. ..

Affected Collectors

I

Deployed Plugins

Affected Collectors(1)

]

Collector

AH-LDAP Collector

Collector Manager

m Callector Manager (DAY dtapp. ..

Click Finish.

NOTE: When you add a plug-in into Sentinel, it is placed in the Plug-in
Repository, which enables Sentinel components on other machines to start using
the plug-in without having to add the plug-in separately.

Deploying a Collector

To add a Collector:

1.

In the main ESM display, locate the Collector Manager to which the new

Collector will be associated.

Right-click the Collector Manager and select the Add Collector menu item.
Follow the prompts in the Add Collector Wizard.

Click Finish.
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NOTE: Collector Script enables the ESM panel to prompt you for parameter
values as well as enable ESM to automatically choose supported connection
methods that work well with the Collector Script.

Deploying a Connector

To add a Connector:

1. Inthe main ESM display, locate the Collector to which the new Connector will be
associated.

2. Right-click the Collector and select the Add Connector menu item.

3. Follow the prompts in the Add Connector Wizard.

4. Click Finish.

Deploying an Event Source

To add an Event Source:

1. Inthe main ESM display, locate the Connector to which the new Event Source
will be associated.

2. Right-click the Connector and select the Add Event Source menu item.

3. Follow the prompts in the Add Event Source Wizard.

4. Click Finish.

Deploying Event Source Servers

Certain Event Source Connectors (such as the Syslog Connector) require a process to
collect data from the actual data source. These processes are called “Event Source
Servers”. They collect data from the data source and then “serve” it to the Event Source
Connector. Event Source Servers must be added and associated to any Event Source
Connectors that require a server.

To add an Event Source Server:

1. Inthe Live View, right-click the Collector Manager and select Add Event Source
Server. Select Required connector window displays.
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Select Connector

Select the connector this Ewent Source Serwer should run.

Installed Connectors: [ Install More Connectors:... ]

Mame Wersian

Novell Avd

Description:
Connector for Mowell 2udit Platform Agents.

I Mext ][ Cancel ]

NOTE: To start the Add Event Source Server Wizard, locate the Collector
Manager on which the Event Source Server process will run.

2. Select a connector that would support your device and click Next. If you do not
have any connectors in the list that would support your device, click Install More
Connectors. For more information on installing connector, see “Add Plug-in”.

3. Configure the various parameters for the server with reference to the connector
selected (For example, syslog connector, NAudit connector, HTTPS connector
and so on.). The configurable parameters will be different for the different
Connector types. Click Next.

4. Enter a Name for the Event Source Server. If you would want this server to be
running, select the “Run” checkbox.

5. Click Finish. In the Health Monitor Display frame, the Event Source Server
added here will appear with a dashed blue line showing the Collector Manager to
which it is associated to.

NOTE: This “Add Event Source Server Wizard” can also be initiated from
within the “Add Connector” wizard if a compatible Event Source Server has not
yet been added.

Connect to Event Source

There are several methods to configure an event source. Event sources can be deployed by
right-clicking on an existing Collector Manager, Collector, or Connectors.

To deploy an event source, you need the following components:

=  Collector Script: Collector scripts may be downloaded from Novell web site
(http://support.novell.com/products/sentinel/collectors.html), copied from a previous
Sentinel implementation (4.x or 5.x), or built using Collector Builder

= Connector: Connector may be downloaded from Novell web site
(http://support.novell.com/products/sentinel/collectors.html)

= Configuration information for the event source
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Collector Scripts and Connectors built by Novell can be found on the Novell web site
(http://support.novell.com/products/sentinel/collectors.html).

To connect to the Event Sources:

1.

Click Tools on the Menu Bar and select Connect to Event Source. Alternatively,
you may also click the Connect to Event Source button on the Tool Bar. Connect
to Event source window displays.

r i

Connect To Event Source f‘$_<|

Select Event Source ]
Which evert source do you wart to connect ta? i?ﬁ
o

Select the Event Source that you want to connect and collect data from. if the Event Source is not
listed below, select "Impart” to import & caollectar script that supports the desired Event Source.

Supported Event Sources:

Wendor Mame Wersion

I Met l [ Cancel ]

NOTE: Event Source types for which you currently have compatible Collector
parsing scripts will be listed here.

Select an Event Source from the list to which you want to connect to and collect
data from. You may click Add More to import an Event Source. Click Next.
Select Collector Script window displays.

NOTE: You can open “Select Collector Script” screen by double clicking or
dragging a selected event source from the “Event Source Palette” window.
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=

Connect To Event Source [z

Select Collector Script .
Which collector script do you wart use? ig.
|

Select the parsing script that will be used to convert the raw data from the Event Source into
Sentinel events.

() view Compstible Parsers Only (3 View & Parsers
Installed Scripts: Install More Scripts ...
Luthor Mame Wersion

Mowell Engingering _

Description:
Populates the base meszage with the value in =_RxBuffer String.

’ Back: ][ et ][ Cancel l

Select a collector script from the list. You may also install additional collector
scripts (click Install More Scripts) that support your Event source, if it is not
listed here (For more information on installing a collector script, see “Add Plug-
in”. Click Next. Select Connection Method window displays.

-
Connect To Event Source [‘5_<|
Select Connection Method ]
Which connector do you want use? ih;.

@ Wiew &)l Connection Methods

Installed Connectors: [ Intall More Connectors... ]

Versian

ata Generator

Description:
Generates test data at & specified rate. This connector does nat reguire a data source.

[ Back ][ Mexdt ][ Cancel ]

Select a connection method from the list. You may also install additional
connectors by clicking on the Install More Connectors button. For more
information, see “Add Plug-in” to install connectors. Click Next. Event Source
Management window displays.
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=
Connect To Event Source

Event Source Management

@ Create a new Collector and Connector

connection.

O Use an exizting Collector

Saurce connection.

O Use an existing Connectar

Source connection.

Howw will your Evert Source Connection be managed?

Select this option to creste & new Collector and & new Connector to manage the Evert Source

Select this option to use an existing Collectar and to create a new Connector to manage the Event

Select this option to use an existing Collector and an existing Connector to manage the Evert

X

[ Back [ Mex

]I Cancel l

You may create a new Collector and Connector, may use an existing Collector or
Connector. Select an option and click Next.

NOTE: Based on the existing Collectors and Connectors in your system that is
compatible with your new Event Source, one or more of these options may be

unavailable.

= Create a new Collector and Connector: Select this option to create a new
Collector and Connector to manage the Event Source connection.

a. After you select this option and click Next, Select Collector Manager

window displays.

b. Select the Collector Manager you want to use and click Next. Configure
Collector Property window displays.

-
Connect To Event Source g\
Configure Collector Property
Select the options you wish this Collectar to run with ?.‘-
Corfigure Parameters
Alert Unknown Everits VES -
Defaut Reporter Mame LOGF_RN
Defaut Sensor Mame LOGF_SN
Defaut Severity 2) Mediurm (3)
Evert Source Deta Systern Type incows
Evert Source Missing Year VES
Evert Source Time Zone +0000
Ewvert Source Time uses 24 Hour Cl.. yes
Execution Mode releasze
IP T Courtry Mapping aff
M3SP Customer D
Taxonomy Flename
Tranzlate IP and hosthane na
Linlenounir Fuants Sesarit: (8N Hictky (4% hs
(Marne)
(De=cription)

c. Configure the parameters available and click Next. Configure Collector

window displays.
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d. Enter the name of the collector and configure the options.

@ N

Connect To Event Source §|
Configure Collector
Specify & name for this Collector and select the options you wish this Collector to run {"‘3 _
with. *
Mame: | General
[1® Pun
] 4F5ESEB0-2936-102A-B562-005056 CO0005
Plugin: General
Blert i no deta received in specfied fime period
Tire Period (zecondz): 60
Send repested alerts every time period
Limit Data Fate
Maximum Records Per Second: -
Trust Evert Source Time Set Fitter...
o J e ]

s Check the Run checkbox if you want to run your collector automatically.

o Click Details button to see plug-in details.

@ You may set alerts (with repeated option) if no data is received in a specific
period.

s You may limit the data rate as maximum number of records per second.

= You may set filter through Set Filter button.

= You can check Trust Event Source Time to display the Device Time (time when
the event occurred) instead of Event Source Time (time when the event was
reported to console).

NOTE: If Trust Event Source Time option is selected, then all data flowing
through the Collector will have there Event Source Time trusted even if the Event
Sources do not have this option selected.

Click Next. The Configure Connector window displays.

r |
N Edit Connector @
Description
Give this Connector & name and select the options you wish to run with
General
Mame: | File Connector
[ Pun
Iod 92723960-2EC2-102A-30F0-00 CO9F455F 23
Piugin: File
[ lert if no data received in specified time period
[ Limit Data Rate
Set Fitter ..
|:| Save Raw Data to a file
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o

o

e. Enter the name of the connector and configure the options.

Check the Run checkbox if you want to run your connector automatically.
Click Details button to see plug-in details.

You may set alerts (with repeated option) if no data is received in a specific
period.

You may limit the data rate as maximum number of records per second.
You may set filter through Set Filter button.

Click Next. The Event Source configuration screens displays.

o

=]

Use an existing Collector: Select this option to use an existing Collector and
to create a new Connector to manage the Event Source connection.

a. After you select this option and click Next, the Select Collector window
displays.

b. Select the Collector you want to use and click Next. The Configure
Connector window displays.

c. Enter the name of the connector and configure the options

Check the Run checkbox if you want to run your connector automatically.
Click Details button to see plug-in details.

You may set alerts (with repeated option) if no data is received in a specific
period.

You may limit the data rate as maximum number of records per second.
You may set filter through Set Filter button.

Click Next. The Event Source configuration screens displays.

@

Use an Existing Connector: Select this option to use an existing Collector
and an existing Connector to manage the Event Source connection.

a. After you select this option and click Next, The Select Connector
window displays.

Connect To Event Source rg|
Select Connector
Which Connector do you want to use? %u
_rs'
Connector Collectar Collectar Manager
e Data Generator Connector |5 = Collector Manager (DAS]
et Data Generator Connector E}m General Collector ﬁ Collector Manager (DAS)
at Data Generator Connector E}m General ﬁ Collector Manager (DAS)
’ Eack " Mesxt l [ Cancel ]

b. Select the connector you want to use and click Next.

6. The Records Per Second window displays.
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7. Set the number of records to be transferred per second and click Next. The
General window displays.

@ 2

Connect To Event Source E|
General
Specify general properties of this Ewent Source. ?-—-}
General
Mare: | Data Generator Event Source F Ruh
Plugin Details
Plugin: Data Generator

Alert if no data received in specified time period
Time Period (zeconds): 60
Send repeated alerts every time period
Limit Data Rate

Maximum Records Per Second: 0O
Trust Event Source Time Set Fitter...
T

= Enter Name of the Event Source.
= Check the Run checkbox if you want to run your Event Source automatically.
= Click Details button to see plug-in details.

» You may set alerts (with repeated option) if no data is received in a specified
time interval.

* You may limit the data rate as maximum number of records per second.

* You can check Trust Event Source Time to display the Device Time (time
when the event occurred) instead of Event Source Time (time when the event
was reported to console).

= You may set filter through Set Filter button. In the filter window, add/edit the
filters and click OK.

8. Click Next. The Summary window displays.

= Click Test Connection to test the event source. Test Event Source window
displays with “Data” and “Error” tabs. The Error tab displays the error
message if there is any error in the configuration of event source.

= After a few seconds, a sampling of raw data should be received from the
Event Source and displayed in the “Data” tab.

= Use the “Start” and “Stop” buttons to start or stop the test.

= Use the “Maximum Rows” component to control the max number of raw data
records to obtain at once.
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=
N Test Event Source: Data Generator, Event Source

3

-

op hdaximum Rows:
« Data | Error

Raw Data
=_RxBuffer String =_SIP

| EST GETE GENEFaTEn a1 UL/ ~U4~1 /52005 ~F I~ 13 | WIN SEverny U. U2 A

Test data generated at 2007 ~04~1 7~03:26:.37~FPM~|ST with sewverity 5. 10.00.2158

Test data generated at 2007 ~04~1 7~03:26 537~PM~ 15T with sewverty 3. 10.00.78

Test data generated at 2007 ~04~1 7~03:26 537~PM~ ST with sewerity 1. 10.0.0.209

Test data generated at 2007 ~04~1 7~03:26:.37~FPM~|ST with sewverity 5. 10.0.0.25

Test data generated at 2007 ~04~1 7~03:26 537 ~PM~ 15T with sewverity 4. 10.0.0.69 v

4

¥

Raw Data Details

Marme Walle

| [ ]
You can test the event source in the Test Event Source window. It displays the data in
the Data tab and errors in the Errors tab. You can select maximum rows to be

displayed and can start and stop the test.

9. Click Finish on successful test of the Event Source.

NOTE: The Collector parsing script will be executed on the same system as the

Collector Manager that you choose here.

Debugging Collectors

9-28

In the Debugging Collector window, the left column on the debugger displays the
commands for the current script state. The highlighted command is being executed.

The right column on the debugger displays the script’s variables and their current value.
The variable list will expand as all the script’s variables are used. The variables are color
coded to show new variables in blue, changed variables in red, and variables whose value

has not changed since the last “Step” as black.
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Debug Collector: Microsoft_Windows 2000 k1_520 *

b

_ggervems rUpInadIannlnad 1 F B

Current Script State: | 1 Current Script: | logfazd

4
. Commmands o Variable M. Walue
# | |lz_RxBuffer String ™
™ STATE 1: Setup ®/ i_FxBufferLencth 0

H TEMPLATE INFORMATI...

Termplate_Mame: L

Template_Wersion: 520

Template_Date: Fe..

5
* Agent Setup Informstion *f
EREAKPOINTG
} COPY[xTemplate"LOGF™)

COPY(z_AertUnknownEve...
TOLOWERE_AlertUnknow...
STOMUM", i_Unknown_...
COPY(=_Generic_RN"LO. .
COPY(z_Generic_SM"LO .
COPYz_Default_Severity"...
STOMNUME_Defaulk_Sewveri...
TPy s TranslsteHostPe "

Debug Start Time: Tue May 15 16:10:19 |ST 2007

Last Update: Tue May 15 1610023 15T 2007

The Events tab displays the events generated using this Collector and the
Upload/Download tab will allow you to upload/download another Collector Script file to
make modifications.

The debugger has the following four controls:

[.. Run Run the script until the next breakpoint is
encountered.

ib Step Into Step one instruction at a time.

ii Pause Pause the running script.

Stop Stop the script.

NOTE: The Command list and the Variable list will not be displayed in the
debugger when the Script is “Running”. To see the Command list and the
Variable list, the debugger must be “Stepping”, “Paused” or “Stopped”.

You can view events as well as upload and download the collector’s script from the
Events tab and Upload/Download tab.

NOTE: Multiple Sentinel Control Center users may connect to the same
debugging session. And for this reason, a Collector will remain in “Debug” mode
until one of the users specifically presses the debugger’s “Stop” button.

To debug a Collector:

1. Inthe main ESM display, locate the Collector that to run Debugging.
2. Right-click the Collector and select Debug.
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3. Inthe Debug Collector window, select a variable from the list of variables in the

right pane, click Run Debug p" button.
4. After debugging all the variables, close the Debug window.
5. Start the Collector to generate the Events.

Debugging Using Raw Data

Occasionally when debugging, it may be helpful to view Connector output data. In
addition to viewing raw data from the Connector using the Raw Data Tap right-click
option for nodes in the Sentinel Control Center, Sentinel also includes an option to save
the raw data from a Connector to a file for further analysis.

To save raw data from a deployed Connector to a file:
1. Right-click the Connector node and select Edit. The Edit Connector dialog

appears.
=
N Edit Connector,
Description
Sive this Connector & name and select the optiohs wou wizh to run with
General
Mame: | File Connector
[]& Pun
Id 92723960-2EC2-102A-80F0-00C09F4658F 23
Plugin: File | Details |
|:| Alert if ho data received in specified time period
[ Limit Data Rate
Set Fitter...
[] save Raw Datato a file

2. Check Save Raw Data to a file.

3. Enter (or browse to) a path on the Collector Manager machine where the raw data
will be saved.

IMPORTANT:

The account running the Sentinel service on the Collector Manager machine must
have permissions to write to the file location.

Export Configuration

Export configuration helps you export the configuration of ESM objects along with their
collector script and the connector plugins.
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NOTE:You can export any object in the ESM panel. Depending on the object
selected, all its children and parent should be displayed in the Select Data window

of Export Configuration wizard.

To export your configurations:
1.

Go to Menu Bar and click File > Export Configuration or right click an object in

the ESM panel and select Export Configuration. Export Configuration window

displays.

r -
Export Configuration [g|

Select Data

Select the nodes to export.

select all_| [ Desslect

= ‘i?& Sertingl

=[] Iy . Switha:164.99.193.263

=1 'q Process Connector
Iri Process Event Source
]

L]

ugt
ul

Snort
=] 'q File Connectar
g [ e Evert source

: "
=) EE. Ti_|55%_SITE_02x6_JDBC_Bw&20

[ mext

] [ Cancel ]

2. Check the data to export and click Next. Select Collector Scripts window

displays.

Export Configuration [g|

Select Collector Script

Select collector scripts to export,

Select Al | [ Deselect a1l

Collector Script

General

WiErsion

Description

Dependernts

Populstes the base message with the value in
=_ RxBuffer String.

3; General Collector

_Q; General Collector

[

Back

I

Ml l [ Cancel ]

3. Select the Collector scripts from the list to export. You may select or deselect all.
Click Next. Select Connectors Plug-in window displays.
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[ |
Export Configuration

(X

Select Connector Plugins
Select connector plugins to export.
Select Ml | [ Deselect
Conhector Wersion
|Dats Generstor A
[ Back H Mext ] [ Cancel ]

4. Select the Connector Plug-ins from the list to export. You may select or deselect
all. Click Next. Specify Export File window displays.

r |

Export Configuration E|
Specify Export File
Specify the file to save export dats to,
File Mame: | [ Browse...

NOTE: If you want to view the description and dependents of a particular plugin
in the above screens, select that plugin from the table.

5. Browse a location to save the configuration and click Next.

NOTE: You can save the configurations only to a zip file.

6. Summary page with the details of the configurations and plugins selected to
export displays.
7. Click Finish to export. The file is exported in zip format.
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Import Configuration

Import configuration helps you to import the configuration of ESM objects exported to a
zip file along with the plug-ins.

Enable/Disable Import Configuration

The import configuration option is enabled

= in Live view, when you select the Collector manager/Collector/Connector/
= in Scratch pad, when you select any node other then the Event source

Import Configuration in Live View and Scratchpad is disabled if you

select “Sentinel” or “Event Source” nodes (only in Live View)
do not select any node (only in Live View)

select an Event Source node in child view of Graphical View
select multiple nodes

To import your configurations:
1. Click File on the Menu Bar and select Import Configuration. You may also click

. . = . .
the Import Configuration button on the Tool Bar. Import Configuration
window displays.

NOTE: You can also import configuration by right clicking on the object in the
ESM panel. Depending on the object you have selected in the ESM panel, the
node along with its child nodes are displayed in the Select Data window of Import
Configuration wizard.

2. Browse and select the configurations file and click Next. Select Data screen
displays.

Select Nodes
Select the noces to impart.

| sekect 8l | [ Deselect 4

L}
::.T1_ISSx_SITE_DQxS_.JDBC_B\fSQD
[ 1]

=) [V = .-.'- Process Connector

= d Process Evert Source

[ Back H Mesd ][ Cancel ]

NOTE: Configurations must be saved to a zip file to import.

3. Check the data to import and click Next. Select Collector Script window displays.
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5. Click Next. Select Connector Plugins window displays.

=

Import Configuration

Select Collector Script

Select collectar scripts to import.

Select Al | | Deselect 4

Collector Script Wersion
& General

Description Dependerts

Populstes the base message with the value in
=_RBuffer String.

Thiz zoript is the same version of & script that has already been imported into the repostory.

[ Back " Mext ] [ Cancel

4. Select the collector script from the list to import.

NOTE: Color indicator is displayed in Select Collector Scripts and Select
Connector Plugins screens to indicate whether the plugin is already present in the
repository or not. If the plugin does not present in the repository, then the color is
displayed as red and if same version of plugin exists then the color is green else it
is orange.

Import Configuration

Select Connector Plugins

Select the connector pluging for importing Connectars.

Select Al | | Deselect 4l

Connectar Script ersion
& Data Generstor

Description Dependernts

Generates test data at a specified rate. This ‘wr Data Generator Connector
conhector does hot require & data source. \wx Data Generator Cormector

Thiz =cript is the same version of a script that has already been imported into the repository.

’ Back: " et l [ Cancel

6. Select the connector plugins from the list to import.
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NOTE: To view the description and dependents of a particular plugin in the
above screens, select that plugin from the table. If there are any collectors or
connectors in the ESM panel which will get affected on importing the plugin then
“Affected Collectors" or "Affected Connectors” screens will be displayed.

7. Click Next. Summary page with the details of the configurations and plugin
selected to import displays.

8. Click Finish.

Save Preferences

To save your preferences for next login:

1. Click File on the Menu Bar and select Save Preferences.

Close
To close ESM:

1. Click File on the Menu Bar and select Close.

Reset Layout

To reset to default settings:
1. Click View on the Menu Bar and select Reset Layout. Alternatively, you may also
click the Reset button on the Tool Bar.

Undo Layout

To undo layout changes:
1. Click View on the Menu Bar and select Undo Layout. Alternatively, you may also
click the Undo Layout button on the Tool Bar.

Redo Layout

To redo layout changes:

1. Click View on the Menu Bar and select Redo Layout. Alternatively, you may also
click the Redo Layout button on the Tool Bar.

Event Source Management Scratchpad

Scratchpad is the ‘Design Mode of the Health Monitor’. Through Scratchpad you can
design and configure:

Collector Managers
Collectors

Event Sources
Connectors

Event Source Servers

You may right-click the Sentinel icon and add the components. For more information, see

“Adding components to Event Source Hierarchy”.

NOTE: You cannot view the status of any object in the design mode as they are
not connected to an instance of a real Collector Manager.
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Comparison between Sentinel 5.x and Sentinel 6.0

The following Sentinel 5 components have been rolled up into ESM. Along with the
Sentinel 5 component name, there is a hint at where to find the related functionality in

ESM.

Components

Build / Edit
Collector

Import Collector

Deploy Collector

Debug Collector

Storage location
for files for
collectors in
development

Storage location
for files for
running collectors

Collectors Scripts

Port
Configurations
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Sentinel 5.x
Building, Modifying or editing
a Collector was possible in
Collector Builder in 5.x
Importing a Collector is not
applicable in 5.x

Deploy Collector was possible
in Collector Builder in 5.x

A debugging interface that
enabled a user to step through

the parsing logic in a Collector.

This interface was available in
Collector Builder in Sentinel
5.X

%ESEC_HOME%\wizard\Ele
ments

on Collector Builder machine

%ESEC_HOME%\wizard\Ele
ments

on Collector Manager machine

Collector Scripts were
managed from Collector
Builder in Sentinel 5.x

The configuration of the
connection to the event source
as well as the Collector to
parse the data from the event
source. Port Configurations
were managed from Collector
Builder in Sentinel 5.x

Sentinel 6.0
Building, Modifying or editing
a Collector is possible in
Collector Builder in 6.0

You can import a Collector
from Sentinel Control Center
in 6.0

Deploy Collector is possible in
Sentinel Control Center in 6.0

In ESM, this is now done
through the ESM panel in
Sentinel Control Center. To
debug a collector in ESM, right
click the Collector node you
would like to debug and select
the “Debug” option.

%ESEC_HOME\data\collector
_workspace

on Collector Builder machine

%ESEC_HOME%\data\collect
or_mgr.cache\collector_instanc
es

on Collector Manager Machine

In Sentinel Control Center,
Collector Scripts are plug-ins
in 6.0. A Collector Script plug-
in must be added to the plug-in
repository before it can be
deployed as a Collector.
Collector parameters are now
set when deploying a Collector
in ESM.

In ESM, this configuration is
now managed in the ESM
panel in Sentinel Control
Center. The connection
mechanisms are now plug-ins,
which must be added to plug-in
repository before being
deployed as Event Sources.



Collector Health
Status View

WORKBENCH_
HOME directory

A real-time view of the status
(For example, on, off, events
per second and so on) of Port
Configurations configured
across all Collector Managers.
This view was available in the
Sentinel Control Center in
Sentinel 5.

The WORKBENCH_HOME
directory which was available
in Sentinel 5.x and prior
versions no longer exists.

In ESM, status information is
now viewable in both graphical
and tabular format of the ESM
panel in Sentinel Control
Center.
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Administration

The topics included in this chapter:

Topic Page
Understanding Admin Tab 10-1
Introduction to User Interface 10-2
Archive Configuration Tab 10-2
Server Views 10-6
Filters 10-7
Configure Menu Options 10-12
DAS Statistics 10-17
Mapping 10-21
Color Filter Configuration 10-18
Event Configuration 10-29
Reporting Data 10-35
User Configurations 10-40

Understanding Admin Tab

In Admin tab you can configure filters and reports. In User Manager you can create users
and you can assign rights to the users.

The Admin Tab allows you to access:

= “Archive”
= “Reports”

= “Views”

= “Filters”

= “Menu Options”

= “DAS Statistics”

= “Events File Information”
= “Color Filter”

= “Mapping”

=  “Events”

=  “Reporting Data”

= “Users”

NOTE: You need to have appropriate permissions to access this tab. Only an
Administrator has controls to enable/disable access to the features of Admin for a
user.
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@

N Novell Sentinel Control Center - logged in as esecadm

Adlwizar

Admin - Help

1 Fiter Configuration
1 User Configuration

work List o
Wiork fem Summary
There are 2 tems

G
owned by me and 5 D e
assigned to my e
groups.
Wigw work tems
Ldmin ]

File Options  Windows  Evert Source Managemert  Sctve Viens  Correlstion noidents TTRAD Analvais
: L6 i = L =
k] Hel==lml E] HEPR RSN A@ICR WA wey|
Maigatar o i Ative Views™ ‘ Correlation Incickents s.'? iTRACT™™
;- Reporting Corfiguration ® Server View Manager
# Reporting Data
# Event Configuration Auto Restarts
# Global Filter Corfiguration -1 ProcessHeah
# Color Fiter Corfiguration l‘;! B} ctaponscs
# Mapping Configuration \Q pcp et
Fo-# Menu Corfiguration . Qeciorivana0ey
-® Das Stafistics ’@ Carrelation Engine
(=] Server Views - @ Das_smoregetion
I (@ DAS_Brary

- DAS_Proxy

- DAS_Guery

- Das_RT

- DAS_TRAC

- @ RuleLg Checker

- @) UNIX Communicati
- Windows Communi

di Aratysis |

LX)

Start Time Up Time:

3MEM0T 95751 AM
31607 9:57:29 AM
31607 9:57:29 AM
31607 9:57:29 AM
3HG07 9:57:30 AM
3HGM07 9:57:29 AM
3HGM0T7 95731 AM
3HG07 9:57:30 AM
3HGM7 95753 AM

Rurning Bh 1352
Bh139:14
Bh139:14
Bh139:14
Bh1313
Bh13:14
Bh13:12
Bh1313
Bh 13:50

Running
Running
Running
Funning
Funning
Funning
Funning
Running
MNOT_INITIALIZED

3HG07 9:66:44 AM Running

Bh18:58

Introduction to

User Interface

@ Pefresh IZ Manage Wiew ~ IZ Switch Wiew -

In Admin Tab, you can see Server views, Filter Configuration and User Configuration in

the Admin Navigator.

You may navigate to these functions from:
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The Admin menu
in the Menu Bar

Adriin | Help

Reporting Configuration
Feporting Data

Event Configuration
Global Fitter Configuration
Calor Fiter Configuration
Mapping Configuration

Menu Configuration

7 OGS E G

Fitter Corfiguration

Uzer Configuration
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Mavigator o &

...... # Reporting Configuration
------ # Reporting Data

------ # Event Configurstion

------ # Global Fiter Corfiguration
------ #® Color Fitter Corfiguration
------ # Mapping Corfiguration
------ #® Menu Corfiguration

------ #® Daz Statistics

fErs Wi

= The Navigation
Tree in the
Navigation Pane

=- _| Flrter Corfiguration
Lo Fitter Manager
=] User Corfiguration
o |lser Manager
o Aptive User Sessions
L Role Manacer

Color Filter Configuration

Reporting Configuration Servers View
T Event Cnnﬁguratmn Menufu:m.figur&tinn T
= The Toolbar : - - |
Buttons |'il? J@.@-“J%‘I’Q ‘:i|l

¥ L J ¥ .
ReportingData | Mapping Configuration | User Configuration

Flobal Filter Configuration  Filter Configuration

Archive Configuration Tab

Archive Configuration Tab allows you to enter directory path for archiving of the
partitions.

To open Archive Configuration:

1. Click Admin on the Menu Bar and select Archive Configuration. Alternatively,
click Archive Configuration button in the Tool Bar.

M Archive Configuration ™ [=] B3

rArchive Canfiguration

Directary Path: ||

Heep Days: |

Figld Seperator: |

Fead Comnmit Size: |

Write Carmmit Size: I

Mz File Size: I

Archive Unit: I

Save Cancel
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NOTE: Archive Configuration can be enabled from User Manager. Only an
Administrator has controls to enable/disable access to this feature.

Reporting Configuration Options for Analysis and
Advisor Reports

10-4

To configure the URL for Analysis and Advisor Reports:

1.
2.

Click Admin tab.

In the Admin Navigator, click Reporting Configuration.

For Crystal Enterprise Server running on Windows:

= |Inthe Analysis URL box, enter the URL for the Crystal Enterprise Server
and click Refresh.

http://<hostname_or_IP_of web_server>/GetReports.as
p?APS=<hostname>&user=Guesté&password=&tab=Analysi
s

NOTE: <hostname_or_IP_of web_server> must be replaced with the IP address
or hostname of the Crystal Enterprise Server.

NOTE: The URL above will not work properly if the APS is set to the IP
Address. It must be the host name.

= |Inthe Advisor URL box, enter the URL for the Crystal Enterprise Server and
click Refresh.

http://<hostname_or_IP_of web_server>/GetReports.as
p?APS=<hostname>&user=Guest&password=&tab=Advisor

NOTE: <hostname_or_IP_of web_server> must be replaced with the IP address

or hostname of the Crystal Enterprise Server.

NOTE: The URL above will not work properly if the APS is set to the IP
Address. It must be the host name.

NOTE: For more information, see Crystal Reports for Windows in Sentinel 6.0
Installation Guide.

For Crystal Enterprise Server running on Linux (SUSE and Red Hat):

= Inthe Analysis URL box, enter the URL for the Crystal Enterprise Server
and click Refresh.

http://<hostname_or_IP_of web_server>:<web_server_p
ort_default_8080>/esec-
script/GetReports. jsp?APS=<hostname>&user=Guest&p
assword=&tab=Analysis

NOTE: <hostname_or_IP_of_web_server> must be replaced with the IP address

or hostname of the Crystal Enterprise Server.

NOTE: The URL above will not work properly if the APS is set to the IP
Address. It must be the host name.

NOTE: <web_server_port_default_8080> must be replaced with the port of the
Crystal web server is listening on.
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3.

= |Inthe Advisor URL box, enter the URL for the Crystal Enterprise Server and

click Refresh.

http://<hostname_or_IP_of web server>:<web_server_p

ort_default_8080>/esec-

script/GetReports. jsp?APS=<hostname>&user=Guesté&p

assword=&tab=Advisor

NOTE: <hostname_or_IP_of_web_server> must be replaced with the IP address

or hostname of the Crystal Enterprise Server.

NOTE: The URL above will not work properly if the APS is set to the IP

Address. It must be the host name.

NOTE: <web_server_port_default_8080> must be replaced with the port of the

Crystal web server is listening on.

NOTE: For more information, see Crystal Reports for Linux in Sentinel

Installation Guide.

N Reporting Configuration
~Reporting Options

Analysis URL:

I [=] B3

Advizor URL:

o Retfresh |

I Use external broveser
£ lze defautt browser

£ Uzethe followving commands to launch = browser:

o Refresh I

Render reports using |HTRL with frames =

Browses, | Tiesto |

Save | Cance| |

The external browser option allows you to use your default or another browser. When
using a browser other than the default browser, your command line must be followed

by a %URL%. For example:

C:\Program Files\Internet Explorer\IEXPLORE.EXE

%URL%

Wait for the Refresh button to turn green and click Save. You will have to logout

of the Sentinel Control Center and login again.

Administration
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Server Views

Through Server view you can Start/Stop/Restart the processes that get installed on the

product installation. Server Views allows you to monitor the status of all Sentinel Server

processes across the system. The following are the Sentinel Server processes:

= Collector_Manager
= Correlation_Engine
= DAS_Aggregation

= DAS_Binary
=  DAS_Proxy
=  DAS_Query
= DAS_RT

= DAS_IiTRAC

= Unix Communication Server
=  Windows Communication Server

NOTE: Windows Communication Server and Unix Communication Server will
run for their respective platform.

' Server Yiew Manager

Starts Auto Restarts Start Time State Up T... “ersion
=) ProcessHeatth -~
= () ctctapp0aa
@ Collector _Manager 1] HIEI07 10:26:23 AM Running 26:03= 6.000
@ Correlation_Engine 1] HIEI07 10:26:23 AM Running 26:04z 6000
@ Das_sggregation 0 MOT_INITISLIZED 6.0.0.0
@ Das_Binary 0 MOT_INITISLIZED 6.0.0.0
@ Das_Proxy il MOT_IMITIALIZED G000
@ Das_cuery 0 MOT_IMITIALIZED 6.0.0.0
@ Das_RT 0 MOT_INITISLIZED 6.0.0.0
@ DAS_ITRAC 1] MOT_IMITIALIZED 6000
@ LM Carnrupicti... ] MOT_INITIALIZED 6.0.0.0
@ Windows Commuri... 0 MOT_INITISLIZED 6.0.0.0
~ o oo ] v
Ready »\? Refresh B Manage View - @ Switch Wiew -

= Start, stop or restart processes: These actions can be taken on a process by right

clicking on the process entry.

NOTE: The options in the right click actions on the Windows Communication
Server and Unix Communication Server are not enabled because stopping these
Communication Server would result in losing contact with all of the processes.

The terms Starts and AutoRestarts, in the context of the Server View, are defined as
follows:

= Starts: The number of times the process was started, for whatever reason. This
includes starts initiated by the user through the GUI or done automatically.

= AutoRestarts: The number of times the process was automatically restarted. Since
this only applies to purely automatic restart scenarios, it does not apply to restarts

initiated by a user. This field is helpful for determining if the process exited (For
example, due to an error) and was automatically restarted by Sentinel Watchdog.

Monitoring a Process
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To Monitor a Process:
1. Click the Admin tab.
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Click Servers View. Alternatively, in Navigator click Servers View > Servers View.
You can also click Servers View icon.

Q

2. Expand the server view. All the processes will list as shown in the above image.

Creating a Servers View

To Create a Servers View:

1. Click the Admin tab.

Click Servers View. Alternatively, in Navigator click Servers View > Servers View.
You can also click Server View icon.

Q

2. To create a new view, on the bottom right corner click Manage View drop down
arrow. Click Add View.

= Enter your Option Name

= To arrange which fields you want to be shown, click Fields

= To group different attributes, click GroupBy

= To sort by different attributes, click Sort

= To filter, click Filter

» To change the display values of the processes shown in the servers view,
click Leaf Attribute

3. Click Save.

Starting, Stopping and Restarting Processes

To Start, Stop and Restart Processes:

1. Click the Admin tab.

Click Servers View. Alternatively, in Navigator click Servers View > Servers View.
You can also click Servers View icon.

2. Expand the servers view. All the processes will list as shown in the above image.

Select a process, right-click > Actions > select a function (Start, Restart or Stop).
- @ DAS_sggregation 1

@ DAS_Query 1 Restart
- @ DAS_RT 1
- (@ DAS TRAC 1

NOTE: You cannot stop the Windows Communication Server and Unix
Communication Server using this feature.

Filters

Filters allow you to process data based on specific criteria for events in real-time and for
users of the system. Filters enable you to manage data seen in the Sentinel Control Center.
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The Filter Engine drives the Real Time Event windows by maintaining the data structure
for each security filter. Filters prevent users from viewing unauthorized events and drop
events that users don’t wish to see. Filters are created in the Admin tab of the Sentinel

Control Center.

NOTE: The following are invalid filter name characters: $# . * & : <>.

There are three types of filters:

= “Public Filters”
= “Prjvate Filters”
= “Global Filters”

Public Filters

Public filters are system-owned. Public filters can be used as security filters or display
filters. Security filters are based on user permissions. Display filters determine which
events are depicted in the real time event tables, charts and graphs.

M Filter Manager I =]
CWvner Filter Mame Expression String
PUEBLIC Operating_System_Events  [fiter( e DeviceCategory = "03" )
PLBLIC Databasze _Everts fitter(| & DeviceCategory = "DBE" )
PUBLIC DS _Everts fitteri e DeviceCategary = "IDS" )
PUBLIC High_Sewverity filtter( & Severity == 3)
PUBLIC Firewall_Events fitter e DeviceCategary = "FA™ )
PUEBLIC Loy _Severity fitter( & Severity == 2
PUBLIC Correlation fitter( [ &.ZensorType = "C" J1or [ e SensorType = "W 1]
PUBLIC Exploit_Detection fitter e \Vulnerakility =1
PUBLIC External_Events fitter( [ &.SensarType = "" 1 and [ e SensorType = "F" 1)
PUBLIC ALL filtter(1=11
PUEBLIC Scan_Events fiter( & DeviceCategary = "SCAN" )
PUBLIC Severe_lnternal fitter( [ &.SensorType = "I" 1 ahd [ e.Severity == 3]
PUBLIC Internal_Events fitter( e SensorType ="" ]
-Manage Filter Configuration
Add | Elome | [elete | [retals |

Private Filters

Private filters are user-owned. Private filters are display filters and are shareable if you
have the View Private Filters permission.

Global Filters
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Global filters are classified as Public Filters. Global filters are processed at the Collector
Manager sequentially for each event until a match is found. Global filter evaluation stops
for that event and the matched global filter action is taken for that event. The order of
evaluation of global filters is top to bottom, as shown in the Console. They can be enabled
or disabled as needed.

Global filters do the following:

= Enable a global action on events, such dropping events, routing events to the database
only or routing events to the database and the Sentinel Control Center or Routing
events only to GUI or Sentinel Control Center

=  Are processed by Collector Manager

= Are configured in the Admin tab under the Global Filter Configuration option where
they can be enabled and disabled
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Drop events

Can route events to the database only

Can route events to the database and to the Sentinel Control Center
Can route events only to Sentinel Control Center

Through the Global Configuration window, you can:

“Create Global Filter”
“Rearrange a Global Filter”
“Delete a Global Filter”

M Glohal Filter Configuration ! EI
Fitter Marme Active Action Expression Add
PLIELIC: High_Seserity . [clrop
Delete
I__lp
[y
Default Action:
Idatabase ahd guili
rManage Global Fiter Configuration —
Save | Cancel | ‘

Creating a Global Filter

To Create a Global Filter:

Click the Admin tab.

Click Admin > Global Filter Configuration or select Global Filter Configuration
in the navigation tree.

1.
2.

N o ok w

In the Global Configuration window, click Add.

In the new blank row, click Filter Name column.

Select a filter and click Select or Add (if you need to create a filter).

In the Active column, click Active box.

In the Action column, select the action that the global filter will have on events

that pass this global filter. If an event does not meet any of the active global
filters, then the default action determines how the event is handled.

You can set the Default Action box to one of the following:

drop: Events will not go to the Sentinel Control Center or the Sentinel Server
database

database: Events will be sent directly to the database, bypassing the Sentinel
Control Center

database and gui: Events will be sent to the Sentinel Control Center and
Sentinel Server database

gui only: Events will be sent to the Sentinel Control Center.

Continue adding filters until you are finished.
Click Save.
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Rearranging Global Filters

To Rearrange Global Filters:

1. Inthe Global Configuration window, Select a filter and click Up or Down to
move it to a different location on the list.

2. Click Save.
Deleting a Global Filter

NOTE: When deleting a Global Filter, you will not get a confirmation message.

To delete a global filter:

1. Inthe Global Configuration window, Select a filter from the list and click Delete.

2. Click Save.

Configuring Public and Private Filters

Configuring Public and Private filters allow you to:

= “Add a Filter”
= “Clone a Filter”
= “Modify a Filter”

= “View the Details of a Filter”
= “Delete a Filter”

N Filter Manager M [=] 3
Cwvner Fitter Marne Expression String
PUBLIC Operating_System_Eventz  [fiter e DeviceCategary = "0O=" )
PUELIC Database_Events fiter( e DeviceCategory = "DBE" )
PUBLIC D= _Everts fitteri & DeviceCategory = "IDE" )
PUBLIC High_Sewverity fitter e Severity == 3]
PUEBLIC Firessall_Evernts fiter( & DeviceCategary = "PA™ )
PUBLIC Loy _Severity fitter( & Severity == 21
PUELIC Correlation fiter( ( e.SensorType = "C" Jor [ eSensorType = "W 1)
PUBLIC Exploit_Detection fitter( & Vulnerakility =1 3
PUBLIC External_Eventz fitter( [ e.SensarType I="1" 1 and [ e SensorType I="P" 1]
PUBLIC ALL filtter(1=11
PUBLIC Scan_Evernts fitter e DeviceCategary = "SCAN" )
PUELIC Severe_lnternal fitter( [ e.SensorType ="I" Y and [ e Severity == 31
PUBLIC Irternal_Everits fitter & SenzorType ="" ]
~Mahage Filker Configuration
Aldd | Clorme | [relete | Cetails |

Adding a Filter

To add a public and private filter:

1. Click Admin > Filter Manager or select File Manager under the Filter
Configuration folder in the navigator; Click Add.

2. Select an Owner ID (public or private [user owned]).
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9.

N Filter Details 1 [=] I

rFitter Properties

Oavner 1D PLIBLIC u
PLEBLIC Uze free form editor |
es adm

Fitter Marme:
adm k

alue2

Mlatoh if-
= pll conditions are met (and)

" One or more conditions are met (or)

Expression string:

ilterd) j
=

Save | Cancel |

Enter a Filter Name.
The table editor is the default selection for editing the contents.

NOTE: Optionally, you can click Use free form editor to display a free form

editor. The free form editor allows you to create complex expressions not possible
with the table editor. However, once the expression is modified with the free form

editor, the table editor cannot be used with the expression.

Select the criteria for the following columns:

= Property

= Operator

»  Value columns.

Your choices display in the Expression string box.
In the Match if box, click either:

= All conditions are met (and)

= One or more conditions are met (or)

To create another filter expression, click Create a New Filter Expression (+) to
add another row to the filter expression table.

To remove a filter expression, select a filter expression from the table and click
Remove the Selected Expression (-).

Click Save.

To Clone a Public and Private filter

Cloning is a convenient way to duplicate a filter to assure consistency of criteria among a
group of filters or users.

To clone a public and private filter:

1.

Open the Filter Manager window.

Administration
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ANl A

Click Clone.

Enter a new filter name.

Change any the original filter’s criteria.
Click Save.

Modifying a Public and Private Filter

To modify a Public and Private filter:

1.
2.
3.

4.

Open the Filter Manager.
Select a filter and click Details.

Change any of the criteria as desired. You will not be able to change the Owner
ID and the Filter Name.

Click Save.

Viewing the Details of a Public and Private Filter

To view a public or private filter:

1.
2.

Open the Filter Manager window.
Select a filter and click Details.

Deleting a Public and Private Filter

To delete a Public and Private filter:

1.
2.
3.

Open the Filter Manager window.
Select a filter and click Delete.
A confirmation window will open. Click Yes in delete confirmation dialog.

Configure Menu Options

NOTE: To use this feature, you must have the user permission Menu
Configuration.

Use the Menu Configuration window to create the menu items that appear on the Event
menu, which displays on any table displaying an event (for example, Event Real Time
window, Snapshot window, Incidents Events window and so on.) when you select one or
more events and right click. Sentinel has the following default Menu Configuration items
that you can clone, activate or deactivate:

Ping: Ping the destination IP of the selected event

nslookup: Perform an nslookup on the Source IP of the selected event

traceroute (tracert on Microsoft SQL 2005): Perform a traceroute from the Source
IP of the selected event to the Sentinel Server

Whois?: Perform an ARIN Whois? lookup on the Source IP of the selected event

NOTE: The configured menus may be placed at $SESEC_HOME/config/exec
(UNIX) / %ESEC_HOME%\config\exec (Windows). Symbolic links on UNIX
are not supported.

Menu Configuration allows you to:

10-12

“Adding an Option to the Menu Configuration Menu”
“Cloning a Menu Configuration Option”

“Modifying a Menu Configuration Option”

“Viewing a Menu Configuration Option’s Parameters”
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“Activating or Deactivating a Menu Configuration Option”
“Rearranging Event Menu Options”

“Deleting a Menu Configuration Option”

“Editing Your Menu Configuration Browser Setting”

N Menu Configuration = =]
Active fenu Lakel Description
W [lgle] Pirg the Destingtion IP of the selected evert.
W@ rislookup Perform an nslookup on the Source [P of the selected evert.
L tracert Perform a tracer from the Source IP of the selected evert.
W Whoiz? Perform an ARIN YWhois? lookup on the Source IP of the selected event.
J | 2
Manage Menu Configurstion - ]
Add | [etails | Clone | Delete Lip | D | Browser ... |

Adding an Option to the Menu Configuration Menu

NOTE: If you renamed a tag, such as renaming CustomerVar24 to PolicyName,
you must use the new name when setting parameters.

To add an option to the Menu Configuration menu:

1.

2.
3.
4

Click Admin tab.

In the Admin Navigator, click Admin > Menu Configuration.
Click Add.

In the Menu Configuration dialog box, enter:

=  Name

= Description

= Action: Either Execute Command or Launch Web Browser

= Use browser: If you chose the Action “Execute Command” and your
Browser settings are setup to “Use External Browser” (For more information,
see “Editing Your Menu Configuration Browser Settings” for editing
Browser settings), you have the option to select Use browser. Selecting this
option will cause the output of your command to be displayed using the
Menu Configuration Browser settings for your Sentinel Control Center.

= File Type: If you chose the Action “Execute Command”, your Browser
settings are setup to “Use External Browser”, and you selected the option
“Use browser”, you have the option of setting the File Type for the output of
this command.

=  Command /URL

NOTE: For UNIX, the script/application must be located in the
$ESEC_HOME/config/exec directory. For any script or application only enter the
command. Any path entered will be ignored.

NOTE: For Windows (Correlation), the script/application must be located in one
of the directories listed in your Windows Environmental Variables. Any path
entered will be ignored.
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NOTE: For Windows (non-Correlation), entering a path is optional. Entering a
command without a path will default to %hESEC_HOME%\ bin and all other
paths specified in your environmental variables.

= Parameters: Parameter must be enclosed by the percent sign (For example,
%EventName%)

NOTE: For a list of available tags you can use when specifying parameters, click
Help on the Menu Configuration dialog box or see Sentinel Meta-tags in Sentinel
6.0 User Reference Guide.

Click OK. The new option is added to the list of menu items in the Menu
Configuration window.

For an example, highlight any of the default menu items and click Details. The
following is an nslookup configuration.

Menu ltem

Mame: Insloukup|

Descripkion: IPerfnrm ah nslookup on the Source P of the selected event.

Ackion: IExecute Carnrmate LI

Ise browser I

File bype I

Carmmand | URL: |nslnnkup

Parameters: I%SuurceIP%

Cloning a Menu Configuration Option
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To clone a Menu Configuration option:

1.
2.
3.

Open the Menu Configuration window.
Select a menu item from the table and click Clone.
In the Menu Configuration dialog box, edit:

= Name
= Description
= Action

= To use a browser or not. For information, see “Add a browser feature to your
Menu Configuration Option”.

=  Command/URL
= Parameters
= Select an action:

o Execute Command
o Launch Web Browser.

NOTE: For a list of available tags you can use when specifying parameters, click
Help on the Menu Configuration dialog box or see Sentinel Meta-tags in Sentinel
6.0 User Reference Guide.

Click OK. The new option is added to the list of menu items in the Menu
Configuration window.

Sentinel User's Guide


http://www.novell.com/documentation/sentinel6

Modifying a Menu Configuration Option

To modify a Menu Configuration option:

1. Open the Menu Configuration window.
2. Double-click a menu option.
3. Type your desired changes and click OK.

Viewing Menu Configuration Option Parameters

To view the parameters for a Menu Configuration menu option:

1. Open the Menu Configuration window.
2. Highlight a menu item and click Details.

Activating or Deactivating a Menu Configuration Option

To activate or deactivate a Menu Configuration option:

1. Open the Menu Configuration window.

Select a menu option, right-click and select either Activate or Deactivate.
traceroute -
Whois? Aud
Lauch Esecu| Details
Clone
Delete
Up
Down

Deactivate

Rearranging Event Menu Options

To move an Event menu option up or down:

1. Open the Menu Configuration window.
2. Select a menu option and click Up or Down.

Deleting a Menu Configuration Option

To delete a Menu Configuration option:

1. Open the Menu Configuration window.

2. Select a menu option and click Delete.
= Click Yes to delete the menu option
= Click No to retain the menu option

Editing Your Menu Configuration Browser Settings

This option allows you to send your Menu Configuration Option output to an external
browser. The external browser can be any application. It is not restricted to Internet
Browsers. By changing the file extension you can launch whatever application is
associated with that extension. For example, txt is usually associated with Notepad. You

can also choose to launch a specific program, for example you can have a txt file be
opened by wordpad or other editor.
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To Edit your Menu Configuration Browser Settings:

1. Open the Menu Configuration window.
2. Click Browser.

M Menu Configuration E

[T Use external browser

0% llze default browser

) l=se the follotwing commands todaunch s browser:

d | i
Browse.. | Test. |
Diefault extension |htm|

Ok | Cancel Help |

If you check the 'Use external browser' box, you have the option to do one of the

following:

= 'Use default browser': Uses the default browser set in that particular
machine. For example, in windows, “Internet Explorer”.

= 'Use the following commands to launch a browser": Allows you to specify
a specific application to launch. When using a browser other than the default
browser, your command line must be followed by a %URL%. For example:

C:\Program Files\Internet Explorer\IEXPLORE.EXE
%URLY%

The following is an example where the output of the Menu Option will launch into
Internet Explorer.

= A

N HMenu Confhiguration E
Use external browser

(:) Uze default browser

'@ Usze the following cormmands to launch a browser:
CAProgram Filesinternet ExplarenEXPLORE.EXE % URL%

I Browse. .. II Test.. I

Default extenszion | ktml

I Ok I I Cancel I I Help I

3. After you set your configuration, click OK.
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DAS Statistics

This feature is for internal monitoring of your system. It is not intended for the average
user. DAS Statistics monitors the following:

= DAS Binary
=  DAS_Query
= DAS_r1t

= Collector_ Manager
= Correlation _Engine
» DAS_ITRAC

Statistics are broken down as follows:

= Service: Name of service such as DAS_Query

= Time: Time since the last update

= num: Number of requests processed for this entry

=  WaitTime: Average wait time in seconds for a request before its processing starts
= Runtime: Average time to process a request (in seconds)

= #wait: Average size of the wait queue

= #run: Average size of the run queue

The information is divided into 3 sections:

* Requests
= Services
=  ThreadPools

Under Requests it keeps all the requests by channel (such as services.CorrelationService).
Under services it does the same by service. Sometimes it provides a breakdown by
appending "'<category>" under the name, such as Services.CorrelationService or
Services.RemoteObjectService.EMap.getMapPK.

Under Services, all the remote method calls from user defined services (your XML
services) are all under services.RemoteObjectService. Under that it puts the name of the
service (EMap) in the above example and if asked, the name of the method (getMapPK in
the above).

When a request is received by a server, such as DAS Query, a task is created and
scheduled. The task is then assigned to a thread pool for execution. There can be more
than one thread pool and a thread pool can service multiple services. For that reason, a
request may have to wait for an available thread even if the service is not heavily used. If
the statistics indicate that the wait time for a request is large and the number of requests
for that service is low, check the information about the thread pools.

The numbers next to an entry are the sum for all its children. So requests 15 means that
there are 15 requests for all requests method calls. Under that, requests.configurations 1
means that 1 of the 15 are to configurations, requests.esecurity.correlation.config 2 means
that 2 of the 15 are to esecurity.correlation.config and so on.
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N Das Statistics = [=] E3
] as mn
Service Time I Mae Mum Wait (zec) Run (sec) #iaiting | #Running |
DAZ_RT-0049ES5C-DD... [9:00:00 AM -
ThreadPoals 931 0.000 0.211 0.0 0.1
ThreadPools Det... |7 0.005 0.096 0.0 0.0
ThreadPools Def... |7 0.005 0.096 0.0 0.0 —
ThreadPools RIE... |5 0.009 37.498 0.0 0.1
ThreadPools RIE... |5 0.009 37.498 0.0 0.1
ThreadPools RiTi... 547 0.000 0.Ms 0.0 0.0
ThreadPools RiTi... |4 0.000 0136 0.0 0.0
ThreadPools RiTi... |0 0.0 0.0
ThreadPools RiTi... |4 0.000 0.000 0.0 0.0
ThreadPools RiTi...|539 0.000 0.014 0.0 0.0
ThreadPools. Tim... 372 0.000 0.0 0.0 0.0
ThreadPools. Tim... |G 0.000 0.000 0.0 0.0
ThreadPools. Tim... |G 0.000 0.075 0.0 0.0
ThreadPools.Tim... 360 0.000 0.000 0.0 0.0
requests 371 0.0 0.006 0.0 0.0
requests.esecuri..|[7 0.044 0.095 0.0 0.0
requests.ewizar... (364 0.000 0.004 0.0 0.0
=ervices 371 0.001 0.006 0.0 0.0
=ervices EvertSt...|384 0.000 0.004 0.0 0.0 LI

The information can be useful because it shows what is going on. The number of requests
is especially useful, you can see where they are all going or concentrated. The #waiting is
useful because it shows how busy the server is. That number should be small. If it is large,
new requests (even for simple tasks) will have to wait for potentially slow ones. This is
not a good situation. The average run time is very important because it shows which
requests are actually taking all the time, as opposed to waiting for others.

Color Filter Configuration

10-18

The Color Filter Configuration allows you to assign background and text colors to events
in the Sentinel Control Center based on filter criteria. The background and text colors
assigned to a filter apply to all Sentinel tables, including active views, event tables
associated with Incidents, offline queries and historical event queries.

On applying a color filter, all the event tables will be updated.

N Color Filter Configuration

Fitter Name Text Colar Background Calor Example

Manage Color Fitter Configuration

Sawe Cancel

The Color Filter GUI displays a listing of all the color filters that are defined in the order
in which they should be applied. If an event meets the criteria for more than one of the
color filters, the topmost color filter configuration will be applied. For example, the
following filter configurations are created and attached to color filter configuration:

= Color filter configuration 1: sev=2 (with background color red and text color
yellow)

= Color filter configuration 2: sev>1 (with background color white and text
color black)

Any event with severity=2 will meet the criteria for both color filters, but since the sev=2
color filter configuration is at the top, all the events with sev=2 will be coded as per color
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filter configuration 1. All the other events with sev>1 (For example, sev=3, 4, 5 and so on)
will follow color filter configuration 2.

Adding Color Filter

To add a color filter:

1. Click Color Filter Configuration in the navigation pane or click the Color Filter
Configuration button.

2. Click Add. A new Color Filter Configuration row will be created as shown below.

| Fitter Mame Text Color Background Color

Example

IExampIe

3. Click Filter Name drop down list. The Filter Selection window displays.

4. From the list, select a filter to which you want to apply the color filter
configuration and click Select or click Add to create a new filter. For more
information on configuring filters, see “Configuring Public and Private Filters”.

Fitter Marme
rTst

Expression String
fitter ( e WizardPort = "rT=tCol2" )

regex in BT view

fitter [ e.Evert Mame match regesx "Log") )

EwentSource_S0B7 ..

fiter( &.Reserved\var24 = "o0B70272-AD4F-1029-536F3-0015FES...

Collector 91894524

fiter( e.Reservedvarl = "3189A084-A02F-1029-ACED-O015FE...

EwentSource 9201,

fiter( e.Reservedvar2d = "9201 C791-AA2C-1029-B4DCO0MEFE...

EwentSource 7202,

EwentSource_BDFS ...

fitter(1=11

fiter( &.Reservedvar2d = "72C2E4F-A4AC-1029-B417-0013FES...

fiter( &.Reservedvar24 = "BOFS61 AD-A280F-1029-55EAD015FE...

Ewert Source_0BDD...

fiter( &.Reservedvyar24 = "0BD DEDE0-A361-1029-5306-0015FES. ..

Scan_Everts

fitter [ e.Device Category ="SCAN" )

EwertSource_ES7E...

fiter ( &.Reservedvar24 = "E37E0542-AE32-1029-9F97-0015FES. ..

Collector_E37EDS41 ...

fiter [ &.Reservedvar2? = "E37E0SH -AE3A-1029-BE61 -0018FES...

Collector_0BDDEDE...

fiter( &.Reservedvar22 = "0BEDDEDE0-A561-1029-8ACE-0018FE...

Collector_9201C793..

fiter( &.ReservedVvar2? = "9201 C7I3-AA2C-1029-9707-0015FES...

Marnage Fiter Corfigurstion

5. In the Color Filter Configuration window click Text Color. The Pick a Color

[ ad || cone || peete || Detais || seiect |

window displays. Select a color from the Swatches Tab. Alternatively, click HSB
or RGB tab and enter the HSB or RGB color value in the respective tab. Click OK.
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e 5

Swatches | HSE | RGE

Recent:

Presvigs
n - . Sample Text Sample Text .
. . . Sample Text Sample Text

[ ok |[ cancel || Reset |

6. Inthe Color Filter Configuration window, click Background Color. The Pick a
Color window displays. Select a color from the Swatches Tab. Alternatively,
click HSB or RGB tab and enter HSB or RGB color value in the respective tab.
Click OK.

7. Click Save.

NOTE: The order of the color filter configuration row in the Color Filter
Configuration window matters. In the case where more than one color filter
definition applies to an event, the formatting for the topmost color filter takes
precedence.

Deleting Color Filter

To delete a color filter:

1. Click Color Filter Configuration in the navigation pane.
2. Select a Color Filter Configuration row and click Delete.

Setting Color filter priorities

To set priority for a color filter:

1. Click Color Filter Configuration in the navigation pane or click the Color Filter
Configuration button.

2. Select a color filter configuration row.

3. Click Up or Down button to set the priority.

NOTE: The Up and Down button will be active only when there is more than one
color filter configuration row available in the Color Filter Configuration window.
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Mapping

NOTE: In order to do Mapping, your configuration.xml file must be pointing to a
Communication Server that has DAS_Binary and DAS_Query connected to it.
This will normally be the case, by default, as long as the Communication Server
and DAS processes are running.

The Mapping tab allows you to:

= Add new map definitions
= Edit map definitions

= Delete map definitions

= Update map data

Mapping works together with the Referenced from Map Data Source option under Event
Configuration. You can map by using a string or number range.

To view maps in the GUI:
1. Navigate to Admin tab and select Mapping Configuration from the

N

navigation pane or click Mapping Configuration button

N Mapping Configuration [_ O]
hMaps

4 Map=

SIE A AGED ITEMS Add
f—af haset
!—;J’ AzzetToRegulation Edit
!—;J’ AttackSignatureMormalization
!—;J’ [pToCourtry Delete
I—;J’ l=Exploitviiatchiist T

pdate

The main Mapping GUI displays a listing of all of the maps that have been defined for the
system.

NOTE: Maps under UNMANAGED ITEMS folder cannot be edited or deleted.

Adding Map Definitions

To add a map definition:

1. Navigate to Admin tab and select Mapping Configuration from the navigation
pane or click Mapping Configuration button.

2. Click Add.
3. If you are creating a new map folder, click New Dir. Enter a folder name.

NOTE: If this is your first map definition, it is recommended that you create a
new map definition folder. Creating a map definition under the UNMANAGED
ITEMS folder will not allow you to edit or delete your map definition.
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Ensure that the folder you want to enter your map definition into is selected. (that
is, the folder indicates that it is open).

Enter your Map Name.
Click Next.

NOTE: The Map Type field box is disabled.

Select either Local File or Remote File.

= Local File: Allows you to browse for your file on your local file system (on
the machine where SDM was launched from).

= Remote File: Allows you to choose from existing map source data files on
the server where DAS is running. Seven files that may already exist on the
server (if Advisor is installed and Vulnerability data was uploaded) are Asset,
AssetToRegulation.csv, IpToCountry.csv, taxonomy.csv,
CustomerToHierarchy.csv, attackNormalization.csv and
exploitDetection.csv. Remote file points to %ESEC HOME%\data\map_data
(Windows) or $SESEC_HOME/data/map_data (UNIX)

N New Map Definition

- Source Data File:

File Mame: |Remnte Fileslattack.csy

" Local File i Remote File

. Data Preview {The first 500 rows are shown):

| e e ety
FealSecure Deskiop bind-fdmax-dos 10142 ii

FealSecureapache-tormcat-file-contents 101426 |

FealSecure Guard isa-nethios-bypass-policy, 101427

FealSecurewordpress-blogheader-sgl-injection, 101428

Securebet_Provider, HTTF Client [14all.cai] Probe -HNG 101324

FealSecure Deskiop csm-server-ho, 1071429

BElackICE, mirc-dde-gain-privileges 101431 |

IEllach‘lCE,-3ugar—s.ales—mnuu:edefau:tﬁ!e—ﬂ|e-inciuue,1!]'.430 -] |

>|

(L 4] |

= Back Mext = | Cancel |

Select your map definition file. Click Next.

NOTE: For map files that contain more than 500 lines, you will not see all the
lines in the SDM.

In the New Map Definition window, set the following:

= Delimiter (pipe, comma, semicolon and so on) of data in rows of the map
data source file

= Start at row — The number of rows to skip from the top of the map data
source file.

= Column names
= Column types — The currently supported column types are:

s String - A string is a group of characters used as a single object by a
computer. A string may consist of a single letter, word or number. The word
FINANCE or IP Address 192.168.2.40 might be a string. A string can also
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consist of a combination of words, spaces, and numbers. The street address of
1313 LION DOG TOWER could be a string.

s Number Range - A number range (NumberRange) is a range of numbers. For
example, 10 to 200 would be represented as 10-200. To use the range map
functionality, a map definition must have exactly one key column and the key
column must be of type NumberRange. If there are any other key columns, or
the key column is of a different type, the mapping service will not consider

the map a range map.

= Active columns — When a column is marked as active, the data in the column
will be distributed to processes using maps. All key columns must be active.
Only non-key columns that are active can be select as the Map Column under
the Events tab.

= Key columns - A key is a unique identifier for the row of data in the map
data. If more than one column is selected as a key, the overall key of the map
will include all of the columns selected as keys.

= Column filtering - A row can be explicitly included or excluded based on
matching criteria for a particular column. This can be used to exclude rows
from the map source data that are not needed or will interfere with your
mapping.

As you configure each setting and filter, the data table will automatically update to

allow you to preview your data and ensure your data is being parsed as expected.

M New Map Definition
rColumn Definition: -
| - Delimiters:

™ Fipe

" Semicolon

8 Other:l_
: Stanatrnw:l 03:

| The first 500 rows are shown

| Columrn 1 I Column 2 | Column 3 |
Mame: DS Mt Mame fr Attack Mame Eitack D 3
Type: =tring =tring =tring
Key: r r |
Active: v | ™
Rowe O RealSecure Deskiop oracle-dbmzsystem-bo 01001
R 1 RealSecure Guard openzsl-asnt -parser-dos1 01003
Ry 2 BlackICE erak-icevwarp-file-dele. 101002 :J

Colurmn Filtering |

= Back Finish | Cancel |

9. Once you finish configuring all parameters and filters for the definition, click

Finish.

10. If you chose Local File in step 7 above, you will be prompted to upload your file

to the Remote Files virtual folder located: %ESEC_HOME%\data\map_data.
Enter a file name and click OK.
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Adding a Number Range Map Definition
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To use the range map functionality, a map definition must have exactly one key column
and the key column must be of type NumberRange. If there are any other key columns, or
the key column is of a different type, the mapping service will not consider the map a
range map.

To create a range map, select a single column to be the key of the map and select
NumberRange as the type of the column. The format of the data in a column of type
NumberRange must be “m-n”, where m is the minimum number in the range and n is the
maximum number in the range (that is, 10-200). The maximum number in the range is not
included in the range (that is, [m,n)). This means a range of 10-200 will only key off
numbers equal to 10 to 199. An example set of data is with the first column as the key:

1-2,AA

2-4,AA

4-12,BB

10-20,BB

30-31,BB

100-200,AA

110-120,CC

~The first 500 rows are shown
I Column 1 I Column 2

Mame: Fange alue
Tvpe: umberRange Gtring
Key: 7 O
Active: =l =l
Fow 0 1-4 i
Fow 1 4-20 BB
Faw 2 30-31 BB
Fow 3 100-110 A,
Fow 4 110-120 oC
Faw 5 120-200 o)

The example table gets transformed to:

FROM TO:

i-z,aa | ] 1-4, 44
2-4, 88
4-1Z,BE / 30-31,EB
10-Z0,EE 100-110, 248
30-31,EE /110—120,00
lEIEI—ZEIEI,AA/ 120-200, 24
110-120, oC

An example event configuration on the above map may look like:
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Customeryar3z ~Data Source

Customeriars3  External
Customeriarsd

Customervarss ¥ Referenced from Map

Customeryarst

Custommeryara? Map Name: IJMEDSIREHQBMEP ;!
Custorneriar3s

Customeriardd Map Column; i\-‘alue :"

SARE key Configuration:

HIPAA Map Key Field Event Tag I |
GLEA Cuskomeryarg7? i
FISM&A I

Where CustomerVar97 is expected to contain a numeric value (or is of a type that can be
converted to a numeric value, such as an IP or Date).

When performing lookups into the example range map, the value in CustomerVar97 will
take the range map and search for the range that the value belongs in (if any). Some
examples and their results are:

CustomerVar97 = 1; CustomerVar89 will be set to AA
CustomerVar97 = 4; CustomerVar89 will be set to BB
CustomerVar97 = 300; CustomerVar89 will not be set

Internally, Sentinel converts IP addresses and dates to an integer for tags of the type IPv4
and Date.

IPv4 tags are:

= DestinationIP (dip)
= SourcelP (sip)

Date tags are:

=  CustomerVarll to CustomerVar20 (cv11 to cv20)
= DateTime (dt)

= ReservedVarll to ReservedVar20 (rv11 to rv20)
= DeviceEventTime

= SentinelProcessTime

= BeginTime

= EndTime

For more information on meta-tags, see Sentinel Meta-tags in Sentinel 6.0 User Reference
Guide.

For example, for the table below, column 1 is humerical range equivalent to an IP range of
10.0.0.0 to 10.0.2.255.

167772160-167772415,AAA
167772416-167772671,BBB
167772672-167772927,CCC

Using the same setup as the previous example, if:

= the Event Tag is set to DestinationIP and key column set to column 1 (range)
= Map Column to column 2 (value). The output values for CustomerVar89.
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~The Firsk 500 rows are shown
I Column 1 I Column 2

Mame: range wealue
Tyvpe: MumberR.ange SEring
Key: ™ r

Ackive: ™ ™

Raows O 167772160-167772415 Aa0

Row 1 167772416-167772671 EEE

Row 2 16777267 2- 167772027 e

Al G

OIS T T Oy

[Daka Source

_uskorner'ar3?

_uskorner'ar3s i External

Customeryarad

iz oL bINCLA + Referenced from Map

SAREOR

HIP AL Map Mame: IJ’ Mapsfe-Security/gwerky Ll
GLEA

FISMA Map Colurmn: Ivalue vl

S Key Configuration:

SIPCountry L - -

DIPCounkry 1Map Key Field Event Tag
_uskorner'ary? DestinationIP

If an event contains a destination IP of 10.0.1.14 (equivalent to numerical value of
167772430), the output for column CustomerVar89 within the event would be BBB.

Sentinel supports the following number ranges:

» Range from negative number to negative number (for example, "-234--34")

= Range from negative number to positive number (for example, "-234-34")

= Range from positive number to positive number (for example, "234-236")

= Single number range (negative) (for example, "-234"). In this case, the min and the
max will both be -234.

= Single number range (positive) (for example, "234"). In this case, the min and the max
will both be 234.

= Range from negative number to max number (for example,"-234-"). In this case, the
min will be -234 and the max will be (263 - 1).

= Range from positive number to max number (for example,”234-"). In this case, the
min will be 234 and the max will be (2763 - 1).

NOTE: In all cases, the min must be less than or equal to the max (for example,
"-234--235" is NOT valid).

Editing Map Definitions
To edit a map definition:

1. Navigate to Admin tab and select Mapping Configuration from the navigation
pane or click Mapping Configuration button.

2. Expand the folder of interest.

3. Highlight a map definition and click Edit.
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NOTE: The editing function is disabled for map definitions that are under the

UNMANAGED ITEMS folder.

N Edit Map Definition
r'Column Definition: -
| - Delimiters:
& Comma  Pipe
" Tah " Semicalon
" Other; |
Start at row; 0=
| ~The first 500 rows are shown
Calum 1 Colurmt 2 | Calumn 3
rlarne: Device AttackSionature Mormalizedattackld A_l
Type: =tring Stritg Murber -
Key: v ¥ r
Active: i 1 v
Ry 0 FealZecure Desktop mozila-netzcape-nonas. 101000
Ry 1 FealZecure Desktop oracle-dbmssystem-bo 101004 =
— - — - - N ' Fl ' la =
|l | _>l_I
Column Filtering
]2 Cancel |

The edit function allows you to:

= et your delimiters
= set which row to start your map
* rename your columns

4. After making your changes, Click OK.
Deleting Map Definitions

To delete a map definition:

= activate or deactivate a column
= set your column keys
= column filter

1. Navigate to Admin tab and select Mapping Configuration from the navigation
pane or click Mapping Configuration button.

2. Expand the folder of interest.

3. Highlight the map definition to be deleted.

4. Click Delete.

NOTE: Map definitions under the UNMANAGED ITEMS folder cannot be

deleted.

Updating Map Data

Updating allows you to replace the map source data file of a map on the server running
DAS with another file. Your new map source data file must have the same delimiter,
number of columns, and overall structure as the existing map data source file in order for
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the map to function properly after the update. The new map source data file should only
differ from the existing file by the values that appear in the columns. If the new map
source data file has a different structure than the existing file, use the “Edit” feature to
update the map definition.

Map updates may be performed on demand from the Sentinel Control Center. To set up an
automated process to update map data, it is possible to run an equivalent process from the
command line.

To update map data from the Sentinel Control Center:

1. If you haven’t already, create a file containing the new map source data. This file
can be generated (for example, from a data dump script), created manually from
scratch, or be an edited version of the existing map data source file. If needed,
you can obtain the existing map data source file from the location:

For Windows:
%ESEC_HOME%\data\map_data

For UNIX
$ESEC_HOME/data/map_data

2. Navigate to Admin tab and select Mapping Configuration from the navigation
pane or click Mapping Configuration button.

3. Expand the folder of interest. Highlight the mapping to be updated. Click Update.

@ Map Data Update: Maps/New Folder,/'vuln_attack ﬂ

-Source Data File:

File Mame: | Browse |

~Daka Preview: -

P I Current |

I Colurmn 1 I Colurn 2
Marne: Column 1 Colurnn 2
Twpe: Skring SEkring
ke ¥ "
Ackive: = i
a i3]
[+ Backup Existing Data On Server Ik Cancel |

4. Select the new map data source file by clicking Browse and selecting the file with
the new map data. After selecting the file, the data from the new map data source
file will appear under the New tab. The map data you are replacing will be under
the Current tab.

5. Uncheck or leave the default setting for Backup Existing Data On Server.
Enabling this option results in a backup of the existing map data source file being
put in the %ESEC_HOME%\bin\map_data (Windows) or
SESEC_HOME/data/map_data (UNIX) folder. The prefix of the name of the
backup map data source file will be the name of the existing map data source file.
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The end of the filename will contain a set of random numbers followed by the
.bak suffix. For example: vuln_attacks10197.bak.

6. Click OK.

7. The data from the new map data source file will be uploaded to the server,
replacing the contents of the existing map data source file. After the source data is
completely uploaded, the map data will be regenerated and distributed to map
clients (For example, Collector Manager).

To update map data using the command line:

1. If you haven’t already, create a file containing the new map source data. This file
can be generated (for example, from a data dump script), created manually from
scratch, or be an edited version of the existing map data source file. If needed,
you can obtain the existing map data source file from the location:

For Windows:
%ESEC_HOME%\data\map_data

For UNIX
$ESEC_HOME/data/map_data

2. Log into the Sentinel database.

3. Find UUID for the map in the MD_CONFIG table (refer to the CONFIG_ID
column for the appropriate map listed in the VALUE column).

4. On the Sentinel Server machine, log in as esecadm.
5. Run the following command:
On Windows:
map_updater.bat <uuid> <source path> [nobackup]
On UNIX:
map_updater.sh <uuid> <source path> [nobackup]

NOTE: On Windows, if the map data is in a directory including a space (For
example, Program Files), it may be necessary to place double quotes around the
new data file path.

6. The data from the new map data source file will be uploaded to the server,
replacing the contents of the existing map data source file. After the source data is
completely uploaded, the map data will be regenerated and distributed to map
clients (for example, Collector Manager).

Unless the optional -nobackup argument is added, the previous map data will be saved in a
backup file on the server. Enabling this option results in a backup of the existing map data
source file being put in the %ESEC_HOME%\bin\map_data (Windows) or
$ESEC_HOME/data/map_data (UNIX) folder. The prefix of the name of the backup map
data source file will be the hame of the existing map data source file. The end of the
filename will contain a set of random numbers followed by the .bak suffix. For example:
vuln_attacks10197.bak.

Event Configuration

NOTE: In order to use the Event Configuration, your configuration.xml file must
be pointing to a Communication Server that also has DAS_Binary and
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DAS_Query connected to it. This will normally be the case, by default, as long as
your Communication Server and DAS processes are running.

Event Mapping

10-30

Event Mapping is a mechanism that allows you to add data to an event by using data
already in the event to reference and pull in data from an outside source. The outside data
source is a map, which is defined using the “Mapping Tab”. The data already in the event
that should be used as the reference into the map and the data to be pulled from the map
into the event are specified using the Events Tab.

Since virtually any data set can be made into a map, Event Mapping is useful for
incorporating into the event stream data from elsewhere in your organization. Some
opportunities Event Mapping provides are:

= Regulatory Compliance monitoring

=  Policy compliance

= Response prioritization

= Enable security data to be analyzed related to business operations
= Enhance accountability

When an Event Mapping is defined, it is applied system-wide to all events from all
Collectors. Additionally, Sentinel will automatically distribute map data to all processes
that perform event mappings as well as keep the map data in these processes up-to-date.
For these reasons, Event Mapping provides significant capabilities to support enterprise
deployments.

Event Mapping comprises of four main parts:

= Controller: Stores all map information

= Distributor: Automatically redistributes modified maps to those processes that
registered for the map

= Monitor: A monitor to detect changes in map source data

= Generator: Generates maps from source data

One application of Event Mapping is Sentinel's Asset Data functionality. For example,
asset information is collected and stored in the Sentinel Database asset schema and is
represented by a Physical Asset Entry. Soft assets, such as services and applications, are
represented by an entry that is linked to a Physical Asset. The primary automated update
mechanism for asset data is through an asset Collector reading data from a scanner such as
Nmap. The asset Collector automates the retrieval of asset information by reading asset
data from the scanner and populating the asset schema tables with this data. For Event
Mapping, asset information is mapped from the destination IP and source IP.

There are two types of data sources:

= External: A Collector populates that value in the event tag.
= Referenced from Map: Data is retrieved from a map to populate the tag.
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~Daka Source

esecT axonomyLeveld
Reservedyarsd _I

SourceMacAddress
SourceebworkIdentity
SourcefssetCategary

SourceEnvironmentIdentity

Map Mame: I.ﬂsset _ﬂ

rn: I.ﬂssetName LI

SourceAssetialue Key Configuratior: :
SourceCriticalicy Map key FEB\ l,\ Event Tag |
SourceSensitivity PhysicalfssetMame \QEZILII’EEIP) |

In the above illustration, the SourceAssetName tag is populated from the map called Asset
(which has asset.csv as its map data source file). The specific value for SourceAssetName
is taken from the AssetName column from the Asset map. The Physical AsssetName
column is set as the key. When the SourcelP tag of the event matches one of the source IP
values in the Physical AsssetName column of the map, the row with the matching key is
used to intersect the AssetName Column. For instance, in the below example IP
198.168.1.100 corresponds to AssetName Finance35.

NOTE: When a column is set as a key, it will not appear in the Column drop
down field.

(PhysicalAssetName CustomerlD MacAddres§

1598, T T2 ey

195.168.1|95
193163 SourceAssetName

harkdtingd2
FrogramMgrmtd3
Finan

You may have more than one column set as a key as you do not want the map to be a
Range Map (Range Maps can only have one key column, with that column type set to
NumberRange). For instance (with column type set to String) the Attackld tag has the
DeviceName (name of the security device) and DeviceAttackName columns set as keys
and uses the NormalizedAttackID column in the AttackNormalization map for its value.
In a row where the DeviceName event tag matches the data in Device map column and the
DeviceAttackName matches the data in the AttackSignature map column, the value for
Attackld is the value in the NormalizedAttackID column. The configuration for Event
Mapping just described is:

|

Reservedyar2t -Data Source
ReservedyarZ? CC e
ReservedyarZs
Recervedyar?g {+ Referenced From Map
Map Mame:  |AttackSignatureMormalization
Devicellame e I ] ‘—!
DeviceCategary Map Column: INDrmaIized.ﬂ.ttackIdj
EventContext _ x
SourceThreatlevel Key Configuration: |
SourcellserConkext Map key Ficld l Event Tag I
DataZonkext Device Devicelams
SourceFunction AktackSignature Devicedttackhams |
PR =T T =T Tt = et = e o
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Key Key Attackld entry

jan: Backdoor SubSeven
3 Trojan: Backdoor. SubSeven
4 5Yn Microsystems Solaris rwall Elevated H

s A Pin Microsystems Solaris rwall Elevated B
EFPC UDP rwalld re un Microsystems Solaris rwall Elevated H
wi TTWET O access 2 Microsoft Exchange Server Arbitrary Code
RealSecure | SMTP_Exchange “erb Do 12 Microsoft Exchange Server Arbitrary Code

To Configure Event tags (columns) to use Mapping:

1. Navigate to Admin tab and click Event Configuration in the navigation pane or
click Event Configuration button.

2. Highlight an event tag entry from the Event Columns list.

NOTE: The original Event Tag name appears above the Label field. In addition,
the description of the event column is provided.

Event Columns:

3. Click Referenced from Map to configure the event tag to be populated with data
from a map. Click External to keep whatever value the Collector put in the event
tag (if any).

4. Click the Map Name field down arrow.

Daka Source

" External

% Referenced from Map

Map Mame: | Asset LI
of hsset

of' AssetToReqgulation

key Configuratid _F attacksignatureMormalization

M3 " IpToCauntry E
PhysicalfssetMil g IsExploitwatchlist

Map Column:

Select one of the following default maps or a map you have created:

= Asset: Contains the data from the map data source file asset.csv. The
asset.csv is automatically generated from asset data from Sentinel Database
when an asset Collector is run. This file could be populated manually instead,
if desired.

= AssetToRegulation: Contains the data from the map data source file
AssetToRegulation.csv. This file must be populated manually.

= AttackSignatureNormalization: Contains the data from the map data source
file attackNormalization.csv (IDS signatures). The attackNormalization.csv
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file is automatically generated from Advisor
when an Advisor feed is completed.

data from Sentinel Database

= IpToCountry: Contains the data from the map data source file
IpToCountry.csv. This file must be populated manually.

= IsExploitWatchlist: Contains the data from

the map data source file

exploitDetection.csv (vulnerabilities and threats). The exploitDetection.csv

file is automatically generated from Advisor

and Vulnerability data from

Sentinel Database when either an Advisor feed is completed or a

vulnerability Collector is run.

5. Click the Map Column field down arrow and select a Map Column name.
Depending on your Map Name choice in the previous step, these values will vary.

Map MNarne: i.ﬁ.sset _:l

Map Column;  |Assetiame ;]

Map Mame: IIsEprnitWatchlist :_'

Map Column: I_EHIST_ vl

ke Configur ati Custamerld e -Key Cnnfiguratim

M |

Plom o |:i.:.|.-r\\lc'\I I

MacAddress
Physicaldsseth Tr— IP
wsicaldsse kb iiodkidentity Fource

AssetCakegory
ErvironmentIdentity
Assethalue

Criticality -

Map Mame: !F'.ttackSignatureNnrmalizatiu:unll

Map Calumn: iNDrmaIized.ﬁ.ttackId:_I

ety eyt [ormalizedattackld k

MA-EXIST_

= EXIST_: This is a special Map Column th
Map Column is selected, a “1” will be put in
map data. If the key is not in the map data, a

at exists in every map. If this
the event tag if the key is in the
“0” will be put in the event tag.

= All other choices: Names of active columns within the map definition that
are not set as a key (for example, Customerld column in Asset or
NormalizedAttackld column in AttackNormalization)

6. Inthe Key Configuration, for each row in the table select the event tag in the
Event Tag column that will be matched against the map key column specified in
the corresponding Map Key Field column. The rows in the Key Configuration

table will depend on the Map Name selected.

NOTE: A key is a unique identifier for the row of data in the map data.

Key Configuration:

Map Key Field I Event Tag I

P SourcelP

MormalizedAttackld

Reservediar25
Reservediar 26
Reservediar2?
Reservediar23
Reservediar29

Anpl | BkbackId
P JDeviceMarne

Device_akegqary - E
| - L == =

7. Click Apply.
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NOTE: Clicking Apply saves the changes you made for the currently selected
event column in a temporary buffer. If you don't click Apply, when you select a
different event column the changes you made to the previously selected event
column are lost. Changes won’t be saved to the server until you click Save.

8. If you would like to edit the Event Mapping of another Event column, repeat the
steps above. Remember to click Apply after editing the Event Mapping of each
Event column.

9. Click Save.

NOTE: Clicking Save will save your changes to the server. The save function
saves all changes stored in the temporary buffer (when you clicked Apply).

Renaming Tags

The Event Configuration window also allows you to assign names to existing event tag
labels. For example, you can rename the label for event tag Ct2 to City. Doing this will
result in the event tag that formally appeared in Sentinel Control Center as “Ct2” to now
appear as “City”. Some places where event tags appear in Sentinel Control Center are
filters, correlation rules, and Active Views.

Renaming Tags does not change the name of the variable in Collector scripts, however.
Therefore, even if the event tag labeled Ct2 is renamed to City, the variable that must be
used in a Collector script to reference this meta-tag will still be s_CT2.

Below is a before and after illustration of this feature in an Active View.

10-34

' EVE @ b 06 10:26:56 ; 0 _jOofx
: L el DestinstionlP Evertharme Ct2 “ulherability J" Criticalit
190.168.12.21 Failed _login-administrator Shuri 0 A_l
2 190.168.12.24 apache-chunked-encoding-bo | Shuri 1 —i
H 190.165.12.24 xlight-pazs-bo Shri 0
2 190.1658.12.24 Reject Shuri a
(X B 06 10:30:4 0 iy ]
:urceIP DestinationlP Eventiarne City “ulnerahility .J" Criticalit
190.168.12.21 Failed_login-administrator Shur —— g ~|
2 190.165.12.24 apache-chunked-encoding-bo |Shuri 1 —
2 190.165.12.24 xlight-pass-ba Shuri 0
" 190.165.12.24 Fgject Shuri 0

To rename an event column:

1. Click Event Configuration in the navigation pane or click the Event Configuration
button.

NOTE: The original Event Column name appears above the Label field. In
addition, the description of the event column is provided.

2. Highlight an event column entry.
3. Enter a new value for your Event Column in the Label field.
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& Sentinel Database Manager =]
File “igw Database
.&buutl F‘ar‘t'rtinnsl Tablespaces! Mapping Everts ! Reparting Data!
Event Columns: Tag
F

Mes.sage _I Tag ct2
DeviceAttackMame
Rtz — |Lakel |city
i1

Description:

) =
Rt k:‘w\trmg) el
Ml it —Mata Soree —
4. Click Apply.

NOTE: Clicking on Apply saves the changes you made for the currently selected
event tag in a temporary buffer. If you don't click Apply, when you select a
different event tag, the changes you made to the previously selected event tag are
lost. Changes won’t be saved to the server until you click Save.

5. Click Save.

NOTE: Clicking Save will save your changes to the server. The save function
saves all changes stored in the temporary buffer (when you clicked Apply).

6. Inorder for changes to be visible in Sentinel Control Center, running Sentinel
Control Centers must be closed and reopened.

Reporting Data

NOTE: In order to use Reporting Data, your configuration.xml file must be
pointing to a Communication Server that has DAS_Binary and DAS_Query
connected to it. This will normally be the case, by default, as long as the
Communication Server and DAS processes are running.

The Reporting Data tab is a Summary Management Interface for Sentinel. This tab allows
you to enable and disable Summaries. Enabling a summary allows aggregation to start
computing the counts for that particular summary.

A summary is a defined set of attributes that make up the key for which to compute the
number of unique occurrences (event count) by each hour time period (event time). In the
case of the EventSevDestPortSummary, when active, it saves the count of events for each
unique combination of destination port and severity for an hour time frame. These saved
computations of the event data allow for quicker summary reporting and querying. These
reports are used by Crystal Reports. For more information, see Crystal Reports for
Windows and Crystal Reports for Linux in the Sentinel 6.0 Installation Guide. Certain
summaries will need to be active in order for the summary reports to be accurate.

Aggregation is the process of calculating the running count for all active summaries as
events flow through the system. These running counts are saved to the database in the
respective summary tables.

Summaries Benefits:

= Greatly reduced event data set

= Conformed dimensions that allow the ability to drill-down, roll-up and drill-across on
event data

= Summary reports run much faster with pre-computed summaries
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Aggregation Benefits:

=  Only processes active summaries
= Does not affect event insertion into the real time database.

Reporting Data tab allows you to:

= enable/disable any predefined summaries

» view attributes of each summary

= see the validity of a summary for a timeframe

= query which eventfiles need to be run so that the summary is complete

The following are all summaries already defined in the system. It lists the summary name,
database table name and it’s attributes in a brief description about the summary.

= Summary Name = Table/Description

= EventSrcSummary = EVT_SRC SMRY_1

= This summary sums the event count by source
ip, source asset information, source port,
source user, taxonomy, event_name, resource,
Collector, protocol, severity and event time by

= EventDestSummary = EVT DEST _SMRY_1

= This summary sums the event count by
destination ip, destination asset information,
destination port, destination user, taxonomy,
event_name, resource, Collector, protocol,
severity and event time by hour.

= EventSevDestTxnmySummary = EVT_DEST_TXNMY_SMRY_1

» This summary sums the event count by
destination ip, destion asset information,

= EventSevDestEvtSummary » EVT_DEST_EVT_NAME_SMRY_1

= This summary sums the event count by
destination ip, destination event asset,
taxonomy, event name, severity and event time
by hour.

= EventSevDestPortSummary = EVT_PORT_SMRY_1
= This summary sums the event count by
destination port, severity and event time by
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, hour. .
= EventSevSummary = EVT _SEV_SMRY_1
= This summary sums the event count by severity

and event time by hour.

To disable/enable Summary:

1. Click Reporting Data in the navigation pane or click Reporting Data button.

2. Todisable a summary, click Active in the Status column until it changes to say
InActive.

3. To enable a summary, click InActive in the Status column until it changes to say
Active.
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To view information for a Summary:

Source I Skatus
FormedEvent InActi
FormedEwvent In.ﬂ.cti:&
FormedEwvent Infctive
FormedEwvent Infctive
FormedEwvent Infctive
FormedEwvent Infctive

To enable Aggregation for Top 10 reports for Crystal Reports:

Enable the following three summaries:
o EventDestSummary
o EventSevSummary
o EventSrcSummary

Enable EventFileRedirectService in the das_binary.xml located:

For UNIX:

$ESEC_HOME/config/das_binary.xml

For Windows:

%ESEC_HOME%\config\das_binary.xml

NOTE: To enable the summary you have to set the property "Status” to ON for
EventFileRedirect in das_binary.xml

1. Click Reporting Data in the navigation pane or click the Reporting Data button.
2. Click the “...” button in the Attributes column to see the attributes that makes up
a summary.
Attributes
IME.ENT CMNT L SLmmary NamelE'-.fer'ltL‘-estSummarv
= L
CUST ID.DES" L | Attribite | Aftribute Type |
ZUST IDLDES ... 1 CUST_ID attribute -
SEW.DEST POl L. 2 RSRC_ID attribute
CUST 10 SEM. s ] DEST_EVT_ASSET_ID sttribte
TLST 1D FLSRY Lbas 4 DEST_IP aﬁrfbute
2 DEST_PORT attribute
& DEST_USR_ID sttribte
7 T MY _ID attribute
[ SEY attribute
] AGENT_ID atribute
10 ENT_MAME_ID attribute
11 PRTCL_ID attribute e
12 E%T_TIME sttribte - |

To check the Validity of a summary:

1.
2.

ok |

Click Reporting Data in the navigation pane or click the Reporting Data button.

Select Status.

3. Choose the summary or summaries you wish to query.
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M Summary Status

- Summary Matme
v
r
r
r
r

EventDest=umrmary

EverntSevDestTxnmySummary
EvertSevDestEvtSummary
EventzevDestPortSummary
Evert=evIummary
Event=rocSummary

.

~Time Interval

Between /42005 |

Showe Event | Showy Graph | Cancel |

4. Select atime interval.
5. Click Show Graph.

6. The green bars signify that the summary is complete for that time frame. The red
sections signify that the summary is missing data during that time period.

L SOOERIEETE e

EwventDestSummany £ AR SRS — —

Summaries

i s i i rh i
Qnﬁe Bo,'ﬁ‘ oof Bcﬁ? ot oo
of of o 0 o o
R L L RS Y
g g g S o o
Time
A ] i3

i

NOTE: To complete summaries, see “Run EventFiles for a Summary”.

To query the Eventfiles for a summary:

1. Click Reporting Data in the navigation pane or click the Reporting Data button.
2. Select Status.
3. Choose the summary or summaries you wish to query.

10-38 Sentinel User's Guide



N Summary Status
PR T
ﬂ .
»
=
»
=

LAY
Evert=evDestTnmy Summary
Event=evDestEviZummary
Event=zevDestPort=ummary
Evert=evIummary
Event=roSutmmaty

-

E-Time Interval

| [prerans

Showe Event | Showe Graph | Cancel |

Betwveen |3/4/20105

Select a time interval.
Click Show Event.
The Eventfiles needed to complete the summary display in a list format.

NOTE: To complete summaries, see “Run EventFiles for a Summary”.

| M Processed Summary Status E

Summary File Mame Mir Everit Titne Wax Event Time Process

EventDestSummary

events_20060905...

/5006 §:92:21 AM

/5006 9:03:31 AM

=

EvertDestSummary

everts_20050905...

/2006 9:22: 46 Ak

5006 9:52:47 Ak

il

EventDest=ummary

everts_20060905...

95006 9:52: 46 Ak

SI06 9:53: 27 A

EventDestSummary

events_20060905...

/5006 10:12:23 AM

SI06 10:42:23 AM

EvertDestSummary

everts_20050905...

/2006 10:42:33 AM

45006 11:12:30 &AM

EventDest=ummary

everts_20060905...

95006 11:12:40 A

5006 11:42:37 AM

EventDestSummary

events_20050905...

/506 11:42:47 AW

ISM0E 121244 PM

EvertDestSummary

everts_20050905...

92006 12:1 254 P

2006 12: 4252 PR

=R =N R = R T S IR

EventDest=ummary

... 90506 12:42:54 Phd

35006 1:12:50 P

b

Process

S o (e

Cloze |

To run Eventfiles for a summary:

N o gk~ wbhE

Click Reporting Data in the navigation pane or click the Reporting Data button.
Select Status.
Choose the Summary or Summaries you wish to query.
Select a time interval.
Click Show Event.
The Eventfiles needed to complete the summary display in a list format.
Check the Eventfiles that you would like to run so that the summary is complete.

=

Min Even...

Max Eve...

Process

. [Man Jan ...

Mon Jan ...

v

+ [Man Jan ...

Mon Jan ...

+ [Man Jan ...

+ [Man Jan ...

Man Jan ...
Man Jan ...

v
v

8. Click Process.
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User Configurations

You must have the user permission in order to work in the User Configuration window.

User configuration allows you to:

“Create a User Account” = “Terminating an Active Session”
“Modify a User Account” = “AddaiTRAC Role”
“View Details of a User Account” = “Delete iTRAC Role”

“Clone a User Account” = “Viewing details of an iTRAC Role”
“Delete a User Account”

The installer will create the following default users on the Sentinel Server:

Oracle and Microsoft SQL 2005 Authentication:

esecdba: Schema owner (configurable at install time).
esecadm: Sentinel administrator user (configurable at install time).

NOTE: For UNIX, the Installer also creates the operating system user with the
same user name and password.

esecrpt: Sentinel Reporter User, password as the admin user.
ESEC_CORR: Sentinel Correlation Engine users, used to create incidents.
esecapp: Sentinel application username for connecting to the database.

Windows Authentication:

Sentinel DB Administrator: Schema owner (configurable at install time).

Sentinel Administrator: Sentinel administrator user (configurable at install time).
Sentinel Report User: Sentinel Reporter user, password as the admin user.
Sentinel Application DB User: Sentinel application username for connecting to the
database

Opening the User Manager Window

To open the User Manager window:

1.

Click the Admin tab.

2. Click Admin > User Configuration.

Creating a User Account

10-40

NOTE: In order to meet stringent security configurations required by Common
Criteria Certification, Sentinel requires a strong password with the following
characteristics:

1. Choose passwords of at least 8 with characters in length that includes at least
one UPPER CASE, one lower case, one special symbol (1@#$%"&*()_+), and
one numeric (0-9).

2. Your password may not contain your e-mail name or any part of your full
name.

3. Your password should not be a *common™ word (for example, it should not be
a word in the dictionary or slang in common use).

4. Your password should not contain words from any language, because
numerous password-cracking programs exist that can run through millions of
possible word combinations in seconds.
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5. You should choose a password you can remember and yet is complex. For
example, Msi5!'YOId (My Son is 5 years old) OR IhliCf5#yN (I have lived in

California for 5 years now).

To use this feature, you must have the user permission User Management. User

permissions are fairly detailed. For more information, see Sentinel Database Users, Roles

and Access Permissions in Sentinel 6.0 User Reference Guide.

NOTE: The Sentinel Database Administrator, Sentinel Administrator, Sentinel
Application User, and Sentinel Report User are created during installation. For
more information about these users, see Sentinel User Accounts in Sentinel 6.0

User Reference Guide.

To create a user account:

1. Open the User Manager window.

Click Add a new User,

Il:':: .ﬁ.di &dd a new User ﬁ

or high-light any user, right-click > Add User.

M User Manager

Firsthame

& users Add Uzer

aLL

Clane User
Delete User
Uzer Details

Lock Uszer

Unlock Lser

3. Under Authorization, enter:

User Name
Password
Confirm Password

Security Filter - To select a filter, click in the down arrow. The Filter

Selection window opens. Highlight a filter or click Add to create a filter for

this user account.

NOTE: After assigning a security filter to a user, you cannot delete that filter.

Click Select

NOTE: It is strongly encouraged as a best practice a minimum password length

of 8 characters that includes alphanumerics.

(Optional) Under Details, enter:

First Name
Last Name
Department
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=  Phone

= Email
4. Click the Permissions tab and assign user permissions.
5. Click the Roles tab and select the role for the user.
6. Click OK.

NOTE: Oracle does not allow the creation of users named the same as one of the
Oracle Reserved words. Also, Sentinel does not allow you to use these names.

Modifying a User Account

To use this feature, you must have the User Management permission.

NOTE: The Sentinel Database Administrator, Sentinel Administrator, Sentinel
Application User, and Sentinel Report User are created during installation. For
more information about changing passwords for these users, see Sentinel User
Accounts in Sentinel 6.0 User Reference Guide.

To modify a user account:

1. Open the User Manager window.

2. Double-click a user account or right-click > User Details.
3.  Modify the account.

4. Click OK.

Viewing Details of a User Account

To use this feature, you must have the User Management permission.

To view user account details:

1. Open the User Manager window.
2. Double-click a user account or right-click > User Details.
3. Review the details of the user account and close the window.

Cloning a User Account

To clone a user account:

1. Open the User Manager window.

2. Select a user account ID, right-click > Clone User.

3. Change the user information and the user permissions.
4. Click Save.

Deleting a User Account
To use this feature, you must have the User Management permission.

To delete a user account:

1. Open the User Manager window.
2. Select a user account ID, right-click > Delete User.
3. A Delete box displays. Click Yes to Delete the User.
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Terminating an Active Session

To terminate an active session:

1.

2.
3.
4

Open the Active User Sessions window.
Highlight an active session you wish to terminate.
Right click > Kill Session.

You will be prompted for a termination message. This option is provided so that
you can inform the user why you are killing the session.

Adding an iTRAC Role
To add an iTRAC Role:

1.
2.

Open the Role Manager window.
Click Add a new Role,

i i.ﬁ.dd a new Role 1

or right-click > Add New Role.

Deleting an iTRAC Role
To delete an iTRAC Role:

1.
2.

Open the Role Manager window.
Select a role, right-click > Delete Role.

Viewing Details of a Role

To view role details:

1.
2.

Open the Role Manager window.
Select a role, right-click > Role Details.
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Sentinel Data Manager

Topics included in this chapter:

Topic Page
Understanding Sentinel Data Manager 11-1
Starting the SDM GUI 11-1
SDM Command Line 11-8

Understanding Sentinel Data Manager

The Sentinel Data Manager (SDM) is a tool by which users can manage the Sentinel
Database. The SDM allows users to perform the following operations:

=  Monitor Database Space Utilization

* View and Manage Database Partitions

= Configure Auto-Archives

= Configure Auto-Addition of Partitions

Monitor Database Space Utilization, View and Manage Database Partitions and Configure

Auto-Archives operations can be accessed using the Sentinel Data Manager GUI or using
a command line interface to SDM.

NOTE: Event Mapping, Summary Data and Reporting data are SDM
functionalities which are moved from SDM to Sentinel Control Center in Sentinel
6.X.

Starting the SDM GUI

There are several prerequisites to run the SDM GUI on a machine:

= |f using an Oracle database, the Oracle JDBC driver must be downloaded and placed in
the $ESEC_HOME/lib (UNIX) or %ESEC_HOME%\lib (Windows) directory. As of the
print date of this document, this file could be found at the following URL.:
http://otn.oracle.com/software/tech/java/sqlj_jdbc/index.html. This file, typically called
ojdbc14.jar, will be installed by default on the machine that hosts the Sentinel DAS
component.

= The user must know the following information:

Name and password for the Sentinel Database User (esecdba by default)

Database host server

Database (instance) name

o [u] o o

by default for SQL Server)
To start SDM GUI on UNIX:

1. Login to the UNIX box as a member of the esec group (for example: esecadm).
2. Goto$ESEC_HOME/sdm
3. Enter the following command line:

Port used for database communications (1521 by default for Oracle and 1433
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./sdm

To start SDM GUI on Windows:

1. Click Start > All Programs (Win XP) or Program Files (Win2000) > Sentinel >
Sentinel Data Manager.

NOTE: To run the SDM from the command line, see the “SDM Command Line”.

To connect to the Database:
1. Log into the machine with SDM installed.

NOTE: If the Sentinel Database Administrator account uses Windows
Authentication, you must log into the SDM machine using the Sentinel Database
Administrator account.

2. Start the SDM GUI using the appropriate procedure (for Windows or UNIX).
3. Select the database type (Oracle or MSSQL).

4. Specify the Database instance name used during the Sentinel database
installation. .

5. Specify the Database Host (hostname or IP address).
6. Specify the port used for database communications.

7. If using SQL Server authentication, specify the Sentinel Database Administrator
username and password.

NOTE: If you choose Windows Authentication, you will be authenticated to the
MS SQL database as the user you are currently logged into Windows as (that is,
single sign-on).

For Oracle:
# Connect to Database
SErver
: !Oracle vl
Database Hast Part
[EsEC |rriy_database 1521
Lzernanme Passwiord
;esecdba I
¥ Save connection settings
Conneck |
For Windows:
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@ Connect to Database
SErver
GEE !MSSQL v}
Database Host Port
[EsEC |y _database 1433

™ Use Windows Authentication

% Use 5L Server Authentication

Lzername Passwiord
!esecdba I

¥ Save connection settings

Conneck I

NOTE: If you select to save your connection settings, the settings are saved to
the local sdm.connect file. By default the sdm.connect file is located in
$ESEC_HOME/bin directory or %ESEC_HOME%\bin folder. Next time you
start the GUI, the connection settings will be re-populated from the sdm.connect
file. This file can be used when running SDM from the command line.

8. Click Connect. The SDM is now ready for use..

Partitions Tab

The Sentinel database is partitioned by time to simplify maintenance and improve the
performance of the database. The Partitions tab in the SDM allows users to view and
manage database partitions for the tables that hold event data, correlated event data, and
summary data.

To view partitions in the GUI:

1. Click the Partitions tab.
2. Select the table in the dropdown list you would like to see.

SDM displays the partitions of the currently selected Database Table.

Each row in the Segments table displays the related Database Table, Time Range, Status
and Name of the partition.

The Status of each of the partitions shown in the Segments table will have one of the
following states:

Online Partition with data that is available for access

Online Current Partition to which events are currently getting inserted

Online Archived Partition with data that has been archived but is still
accessible because the partition has not been dropped

Offline Archived Partition with data that has been archived and then
dropped from the database

Online Archived Partition with data that has been archived, dropped from

Imported the database, and then re-imported into the database

NOTE: If you delete a partition without archiving it, it is deleted from the
partition list in the GUI.
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@ Sentinel Database Manager

File “iew Database

=] B3

Aot Partitions I Tablespaces! Mappingl Ever'itsi Reparting Data!

Manage Data Segments

Tahle

[Bevents =]

Segments

Tahle Position Start Date End Ciate Status  Mame

& events 1 G206 6:54:04 PM  6M1 4006 7:00:00 PM Crline  EVEMTS_P_2006061 4120000 ﬂ
W events 2 G 4/06 7:00:00 PM 61506 7:00:00 PM Crline  EVEMTS_P_20080615190000
@ events 3 GM5/06 7.00:00 PM  6M G606 7:00:00 PM Crline  EVEMTS_P_2006061 6120000
W events 4 GAME/A0E6 7:00:00 PM 647006 7:00:00 PM Crline  EVEMTS_P_2006061 7190000
@ events 5 G706 7:00:00 PM 6806 7:00:00 PM Crline  EVEMTS_P_200606151 20000
. EVENMTS & GMEME6 7:00:00 PM - 6419506 7:00:00 PM Online  EVENTS_P_2006061 9130000
! FWFhTS 7 REGMA 700NN PR RENNA 70000 Pha Cirline  FYWERITS. B 2N0RNE2M1 an‘nn

Al l Deletel .&.rchivel Importl Releasel

Ald |1 Partition per DAY "i far the next ED "l dayis)

Al | Save

| 7| | conrectesto EsEC

At the bottom of the Partitions tab, there are several smaller tabs that allow the user to
perform the following operations:

Add empty partitions to the database

Delete partitions from the database

Archive data from partitions to flat files in a specified, pre-existing directory
Import Partitions

Drop Partitions

Many of these operations can be executed automatically in the database using stored
procedures, but this tab allows the administrator to perform these tasks manually.

To manage partitions:

1. Click the Partitions tab.
2. Select the table in the dropdown list.

NOTE: Sentinel partitioned tables are organized into 2 groups. One is the
EVENTS table group, which includes EVENTS and CORRELATED_EVENTS;
the other is the summary table group, which includes all summary, or aggregate,
tables. If any one of the tables in the group is selected then the changes will apply
to all the tables in the group.

3. Select the tab in the bottom of the window that relates to the operation that you
would like to perform — Add, Delete, Archive, Import or Release.

To add partitions:

1. Select the Add partitions tab.
2. Specify the number of days over which to add the partitions.
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NOTE: You can specify the number of partitions in Partition Configuration in
SDM GUI.

3. Click Add.

To delete partitions:

1. Select the Delete partitions tab.
2. Specify the number of days for which older partitions will be deleted.
3. Click Delete.

To import partitions:

1. Select the Import partitions tab.
2. Select the partition in the Segment table into which the data will be imported.

NOTE: You can specify the input directory in the “Archive Destination” field in
Partition configuration tab in SDM GUI.

3. Click Import.

To release imported partitions:

1. Select the Release partitions tab.
2. Select the partition in the Segment table that will be released.
3. Click Release.

Archiving

Events, correlated events, and aggregation (or summary) tables can all be archived using
SDM. There are several requirements for archiving:

= The directory to which the partitions are archived must already exist on the database
server (not the machine running SDM); SDM does not create the directory.

= On UNIX systems, archiving cannot be to the /root directory.

= On UNIX systems, the oracle user must have permissions to write to the archive directory.

= On Windows systems, owner of the SQL Server Agent service must have permissions to
write to the archive directory.

To archive partitions:

1. Select the Archive partitions tab.
2. Specify the number of days for which older partitions will be archived.

NOTE: You can specify the archive directory in the “Archive Destination” field
in Partition configuration tab in SDM GUI.

3. Click Archive.

Oracle Archive Partitions Tab:

Add | Delete | Archive | Import | Release

Add for the next 1 W | day(s)

| agd || Refresn
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Microsoft SQL Archive Partitions Tab:

Sidd | Deletel .E\.rchi\u'el Impartl F-lelea&el

2dd for the next F "l day =]

A Refresh

Tablespaces Tab
The Tablespaces tab in the SDM allows users to view the current database space
utilization, including:

= Total space allocated for each tablespace
= Space used by each tablespace
= Space available (free) for each tablespace.

NOTE: All the tablespaces are set to Autogrow.
& Sentinel Database Manager, Q@Ef

File Wiew Datahaze

@

oot | Parttions | | Parttion Corfiguration

% Database tablespace usage

Tahlespaces

Mame Tatal Used Free Usage
Hlos 1o0m  sm sm Hew
B esento A000M 2280 377 iy £,
E esentoz S00M M 492M 1%
B Esenmx 1000M  44n  o5en (I 4%
B esenmae S00M  10M  43omM 2%
= rrimary 200M  16M 183M 8%

B sent_apvis.. 200M  11am siM H 9%

B sewt apwis.. 1oom  B7m 32w DE7%

B SENT_SMRYD 20000 47W 19520 R
B sEnT_sMRyv f000mM oM 999N | 0%

LEGEND

-

B Used space

[) | connectedto ESECEETA

Color coded bar graphs help to visualize the total space allocated for each tablespace and
the percent used of each tablespace.

NOTE: On Microsoft SQL Server, “tablespace” usage represents “filegroup”
usage.

Partition Configuration

The Partition Configuration tab in the SDM allows you to set parameters to auto-archive
partitions. It also allows you to auto-add partitions.
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To configure auto-archive parameters:

1. Click the Partition Configuration tab. The Partition Configuration window
displays.

File ‘View Database

About || Partitions | Tablespaces | Partition Configuration

Table Group EVEMT_SMRY b
Partition Configurstion
Partition Interval g “ [HOUR “ | per partition
Days Onling a0
Archive destination: Itrchive (oh database server)
Offline Operation: archive V] drop

Job Schedule
[] Joks Enabled

Job Properties

A hdin: 7
A Mae: 14
Archive Chunk: 5
SAVE
Properties have been updated successfully b Conrectedto ESECFET

2. Select the table group from the drop-down list.
3. Enter the following partition configuration information:

= Partition Interval: Specify the number of partitions that should be created
per day or per hour.

= Days Online: Number of days of data to keep online in the database.

= Archive destination: Specify the destination to store the automatically
archived data and the manually archived data.

= Offline operation: Choose archive and/or drop the data.

NOTE: Data that is dropped without archiving cannot be retrieved using SDM.
You should almost always choose the archive option.

4. Specify the Job Schedule parameters:

= Check Jobs Enabled checkbox if its not selected. By default the Jobs Enabled
checkbox will be checked if you have selected this feature during installation.

= Schedule adding partitions and offline operation parameters. Click Save.
=  Click History to view the Job History.
5. Enter the Job Properties:

=  Add Min: Minimum number of days of partitions for future data that should
exist in the database at any time

= Add Max: Maximum number of days of partitions for future data that should
exist in the database at any time

= Archive Chunk: Minimum number of days of partitions that would account
to total number of days of partitions for Archive.
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NOTE: If the fewer than Add Min days partitions exist in the database, partitions
are added until there are enough partitions for Add Max days. Archiving also is
done in chunks of days so that these database operations are not necessary every
day.

6. Click Save.

SDM Command Line

The SDM command line functions can be used instead of the GUI. The command line can
be used to create a batch file or cron job for SDM operations, but Novell recommends
using auto-archiving instead. Auto-archiving can be configured on the Partition
Configuration tab of the SDM GUI.

The first step to using the SDM command line is to create a file that stores the connection
properties for the database.

“General Syntax”

“Start SDM GUI”

“Save Connection Properties”
“Add Partitions”

“Drop Partitions”

“View Partitions”

“Archive Data”

“Delete Data”

“Listing Files to Import”
“Import Data”

“Delete Import Data”
“Viewing Sentinel Database Space Usage”
“Update Map Data”

General Syntax of the SDM command

[path to SDM] —action [actionname] [action-specific
flags] [path to database connection fTile]

The specific flags for each action are described below.

Starting SDM GUI

startGui (DEFAULT)

-action startGui [-connectFile <FilePath>]

Saving Connection Properties for Sentinel Data Manager

11-8

The saveConnection command saves the database connection details to a specified file.
These connection details are necessary for all other SDM command line operations.

If you have run the SDM GUI with “Save connection settings” selected, the
saveConnection command is not necessary. You can use the sdm.connect file located in
%ESEC_HOME%\sdm for Windows or $ESEC_HOME/sdm for UNIX.

The saveConnection command uses the following flags:

-action saveConnection

-server <oracle or mssql2005>

-host <database host IP Address or host name to connect to>

-port <database port number to connect to [Oracle default: 1521/SQL Server

default: 1433]>
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-database <database name/SID>

-driverProps <Properties File>

-dbuser <database username>

-password <database password>

-winAuth Used for Windows authentication. When using this option, -user and —
password are not needed.

-connectFile <filenameToSaveConnection>

The application saves all the above connection details along with the encrypted password
to the sdm.connect file. All other SDM command line commands will refer to the
specified file. This step should be completed first time you use the SDM command line on
a machine and every time you want to change the connection details the application uses.

To run saveConnection:
Execute the command as follows:

-action saveConnection -server <oracle/mssql2005> -
host <hostlpaddress/hostName> -port <portnum> -
database <databaseName/SID> [-driverProps
<propertiesFile] {-user <dbUser> -password <dbPass>
| -winAuth} -connectFile <filenameToSaveConnection>

The following example will save connections for a host with an IP address of
172.16.0.36 at port 1521 (default for Oracle, for SQL Server, default is 1433).

=  Oracle Example:
./sdm -action saveConnection -server oracle -host

172.68.0.47 -port 1521 -database esec -user esecdba
—-password XXXXXX -connectFile sdm.connect

= SQL Server Example (using SQL Server Authentication)

sdm -action saveConnection -server mssql -host
172.16.0.36 -port 1433 -database esec -user esecdba
—-password XXXXXX -connectFile sdm.connect

= SQL Server Example (Windows Authentication):

sdm -action saveConnection -server mssql -host
172.16.0.36 -port 1433 -database esec —winAuth -
connectFile sdm.connect

This will save the connection details to the sdm.connect file. All the rest of the
commands will take this filename as input to connect to the designated database and
to perform their actions.

Adding Partitions

This action (addPartitions) adds the required number of partitions in the following tables
according to the partition configuration settings:

Oracle:

EVENTS

CORRELATED_EVENTS

EVT _DEST _EVT_NAME_SMRY _1
EVT _DEST _SMRY_1
EVT_DEST_TXNMY_SMRY_1
EVT _PORT_SMRY_1

EVT _SEV_SMRY _1

o o o o o o o
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s EVT_SRC_SMRY_1
SQL Server

= EVENTS
CORRELATED_EVENTS
EVT_DEST_EVT_NAME_SMRY_1
EVT _DEST _SMRY_1
EVT _DEST_TXNMY_SMRY _1
EVT_PORT_SMRY_1
EVT _SEV_SMRY _1
EVT_SRC SMRY_1

NOTE: Partitions are added in database both for Events and Correlated events if
you select any one of these two. Partitions will be added for all the summary
tables if you select any one of them.

o o o o [u} o o

If you are configured to have 10 days worth of partitions, every time you run
addPartitions it checks to see if you have 10 days of partitions ahead. If you have enough
partitions for next 10 days it will not do anything. If not, it will add the required number of
partitions for 10 days.

This action uses the following flags:

-action addPartitions
-connectFile <filePath>
-tableName <table name>
-keepDays <days to add>

To run addPartitions:
Execute this command as follows:

-action addPartitions -connectFile <filePath> -
tableName <table name> -keepDays <days to add>

= Oracle Example:

./sdm -action addPartitions -connectFile
sdm.connect -tableName EVENTS -keepDays 10

=  SQL Server Example:

sdm -action addPartitions -connectFile sdm.connect
-tableName EVENTS -keepDays 10

Dropping Partitions

11-10

This action (dropPartition) drops all the partitions older than the flag keepDays from the
following tables:

Oracle:
EVENTS
CORRELATED_EVENTS
EVT_DEST_EVT_NAME_SMRY_1
EVT_DEST SMRY_1
EVT _DEST_TXNMY_SMRY 1
EVT_PORT_SMRY_1
EVT_SEV_SMRY_1

= EVT_SRC SMRY_1
SQL Server

= EVENTS

[u] o o o o o o
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CORRELATED_EVENTS
EVT_DEST_EVT_NAME_SMRY_1
EVT_DEST _SMRY_1
EVT_DEST_TXNMY_SMRY_1
EVT_PORT _SMRY 1
EVT_SEV_SMRY_1
EVT_SRC_SMRY_1

To prevent unintentional loss of data, this action does not drop any partitions that are not
archived. If you want to delete unarchived partitions, use the forceDelete flag.

o [u} o o o o o

WARNING:

If - forceDelete is used, the deleted data cannot be recovered, so use this option
with caution.

This action uses the following flags:

-action dropPartitions

-keepDays <number of days to keep>

-forceDelete <either “true” or “false”>

(optional) This defaults to false if not specified, meaning that only the partitions
that are older than keepDays and are already archived will be
dropped.

If set to true, all partitions older than keepDays will be dropped, even
if they have not been archived.

-connectFile <filePath>

-tableName <table name>

NOTE: Sentinel partitioned tables are organized into 2 groups. One is the
EVENTS table group, which includes EVENTS and CORRELATED_EVENTS;
the other is the summary table group, which includes all summary, or aggregate,
tables. If any one of the tables in the group is specified by the —tableName
parameter, the dropPartition operation is applied to all tables in that group.

To run dropPartition:
Execute this command as follows:

-action dropPartitions -keepDays
<numberofDaysToKeep> -tableName <table name> [-
forceDelete <true/false>] -connectFile <filePath>

The following examples drops all the partitions older than 30 days making sure all the
partitions are archived. All partitions that were skipped (not removed) because they
have not been archived are listed when the operation completes.

=  Oracle Example:

./sdm —action dropPartitions —keepDays 30 —
tableName CORRELATED_EVENTS —forceDelete false —
connectFile sdm.connect

= SQL Example:
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sdm —action dropPartitions —keepDays 30 —tableName
CORRELATED_EVENTS —forceDelete false —connectFile
sdm.connect

Viewing Partition Summaries

This action (ViewPartitions) displays the partition summary of the following supported
tables:

Oracle:
EVENTS
CORRELATED_EVENTS
EVT DEST EVT _NAME _SMRY 1
EVT_DEST_SMRY_1
EVT _DEST_TXNMY_SMRY _1
EVT _PORT_SMRY_1
EVT_SEV_SMRY_1

= EVT_SRC SMRY_1
SQL Server

= EVENTS
CORRELATED_EVENTS
EVT _DEST EVT NAME_SMRY 1
EVT DEST SMRY _1
EVT _DEST_TXNMY_SMRY _1
EVT PORT _SMRY_1
EVT SEV_SMRY _1
EVT _SRC _SMRY _1

NOTE: You need to have SDM installed in order to view the partition summary.

[u] o o o o o o

o o o o o o o

This command uses the following flags:

-action viewPartitions
-tableName <table name>
-connectFile <filePath>

To View Partition Summaries:
Execute this command as follows:

-action viewPartitions -tableName <table name> -
connectFile <filePath>

The following example, displays the list of partitions of the EVENTS table and status
of each partition.

=  Oracle Example:

./sdm —action viewPartitions —tableName EVENTS —
connectFile sdm.connect

»  SQL Server Example:

sdm —action viewPartitions —tableName EVENTS —
connectFile sdm.connect

Archiving Data

11-12

Run this action (archiveData) after you set your archive configuration (this can be
configured in Partition Configuration tab in SDM GUI). This action archives the data from
the given table name according to the archive configuration. It archives data from:
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= Oracle:

o EVENTS

= CORRELATED_EVENTS
= SQL Server

o EVENTS

= CORRELATED_EVENTS

NOTE: Sentinel partitioned tables are organized into 2 groups. One is the
EVENTS table group, which includes EVENTS and CORRELATED_EVENTS;
the other is the summary table group, which includes all summary, or aggregate,
tables. If any one of the table in the group is specified by the —tableName
parameter, the archiveData operation is applied to all tables in that table group.

This command uses the following flags:

-action archiveData

-connectFile <filePath>

-tableName <table name>

-keepDays <numberOfDaysToKeep>

To run archiveData:
Execute this command as follows:

-action archiveData -connectFile <filePath> -
tableName <table name> -keepDays
<numberOfDaysToKeep>

The following examples archive events and correlated events from the EVENTS and
CORRELATED_EVENTS tables according to the value set during archive
configuration (using the archiveConfig command).

=  Oracle Example:

./sdm -action archiveData -connectFile sdm.connect
—tableName EVENTS —keepDays 30

=  SQL Server Example:

sdm -action archiveData -connectFile sdm.connect —
tableName EVENTS —keepDays 30

Deleting Data

This action (deleteData) deletes the data older than a specified number of days from the
given table name. It deletes data from:

= Oracle:

EVENTS

CORRELATED EVENTS

EVT _DEST_EVT _NAME_SMRY_1
EVT_DEST SMRY_1

EVT _DEST _TXNMY_SMRY _1
EVT _PORT _SMRY_1

EVT _SEV_SMRY _1

EVT SRC SMRY 1

o o o o o o o o

=  SQL Server
o EVENTS
= CORRELATED EVENTS
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EVT_DEST EVT_NAME_SMRY_1
EVT_DEST_SMRY_1
EVT_DEST_TXNMY_SMRY_1
EVT_PORT_SMRY_1
EVT_SEV_SMRY_1
EVT_SRC_SMRY_1

[u} o o o o o

NOTE: This action does not drop any partitions that are not archived. If you want
to delete unarchived partitions, the optional flag forceDelete has to be specified
with a value of true.

If forceDelete is used:

false or not drops only the partitions older than keepDays and those that are

specified archived

true drops all the partitions older than keepDays including unarchived
partitions

This command uses the following flags:

-action deleteData

-keepDays <number of days to keep>
[-forceDelete]  <either true or false>
-connectFile <filePath>

-tableName <table name>

To run deleteData:
Execute this command as follows:

-action deleteData -keepDays <numberofDaysToKeep>
[-ForceDelete <true/false>] -connectFile <filePath>
-tableName <table name>

=  Oracle Example:

The following example drops partitions from all tables older than 13 days making
sure all dropped partitions are archived. In the end, a list is generated of any partitions
that were not deleted if they have not been archived.

./sdm -action deleteData -keepDays 13 -forceDelete
false -connectFile sdm.connect —tableName EVENTS
= SQL Server Example:

The following example drops the partitions from all tables older than 13 days making
sure all dropped partitions are archived. In the end, it lists any partitions that were not
deleted if they have not been archived.

sdm -action deleteData -keepDays 13 -forceDelete
false -connectFile sdm.connect —tableName EVENTS

Listing Files to Import

This action (filesTolmport) is used to list the files needed to import the data between the
given dates into the following supported tables:

= SQL Server
o HIST_EVENTS
o HIST_CORRELATED_EVENTS
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NOTE: The tables are imported in Oracle with the same name they are archived
with.

If these files have been moved to another location since the original archiving operation
(F, moved to tape), they must be restored to a directory accessible from the database
server with their original file names.

This command uses the following flags:

-action filesTolmport
-tableName <table name>
-startDate <mm/dd/yyyy hh24:mi:ss>
-endDate <mm/dd/yyyy hh24:mi:ss>

-connectFile <filePath>

NOTE: hh24 is hours represented in 24 hour format. For example, 1:15:00 p.m.
is 13:15:00 and 3:00:00 a.m. is 03:00:00.

To run filesTolmport:
Execute this command as follows:

-action filesTolmport -tableName <table name> -
startDate <mm/dd/yyyy hh24:mi:ss> -endDate
<mm/dd/yyyy hh24:mi:ss> -connectFile <FilePath>

The following example lists all files containing data between dates “09/25/2007
00:00:00” (Sep 25" midnight) and “09/26/2007 00:00:00” (Sep 26" midnight) that
have been previously archived.

»  Oracle Example:
./sdm —action filesTolmport -tableName Events —

startDate 09/25/2007 00:00:00 —endDate 09/26/2007
00:00:00 —connectFile sdm.connect

»  SQL Server Example:

sdm —action filesTolmport -tableName Events —
startDate 09/25/200\7 00:00:00 —endDate 09/26/2007
00:00:00 —connectFile sdm.connect

The following example lists all the files containing the data between dates
“09/25/2007 16:00:00” (Sep 25" 4 PM) and “09/26/2007 18:00:00” (SEP 26, 6 PM)
that has been archived earlier and can be imported back.

=  Oracle Example:

./sdm —action filesTolmport -tableName Events —
startDate 09/25/2007 16:00:00 —endDate 09/26/2007
18:00:00 —connectFile sdm.connect

= SQL Server Example:

sdm —action filesTolmport -tableName Events —
startDate 09/25/2007 16:00:00 —endDate 09/26/2007
18:00:00 —connectFile sdm.connect

Importing Data

This action (importData) imports data between the given dates into the Sentinel database
s0 it can be used for historical reporting or other purposes. The data is imported into the
following tables:
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= SQL Server
s HIST_EVENTS
o HIST_CORRELATED _EVENTS

NOTE: The tables are imported in Oracle with the same name they are archived
with.

If the data has already been imported or there is no archived data is found between the
specified dates, it returns a notification.

The application imports data from each file into a table and builds the historical view on
all the historical tables. The report view joins on the original table and historical view. All
Sentinel reports use the report view and thus will see any imported data.

This command uses the following flags:

-action importData

-tableName <table name>

-startDate <mm/dd/yyyy hh24:mi:ss>
-endDate <mm/dd/yyyy hh24:mi:ss>
-connectFile <filePath>

NOTE: hh24 is hours represented in 24 hour format. For example, 1:15:00 p.m.
is 13:15:00 and 3:00:00 a.m. is 03:00:00.

NOTE: The files to be imported must exist in the directory with their original file
names.

To run importData:

Place all the files you wish to import in a specific directory (that is, dirPath -
<directory to import files from>) and execute the following command

-action importData -startDate <mm/dd/yyyy
hh24:mi:ss> -endDate <mm/dd/yyyy hh24:mi:ss> -
tableName <table name> -connectFile <filePath>

The following example imports the archived files from the tmp directory containing
the data between dates “09/25/2007 00:00:00” (Sep 25 midnight) and “09/26/2007
00:00:00” (Sep 26 midnight).
=  Oracle Example:

./sdm —action importData —startDate 09/25/2007

00:00:00 —endDate 09/26/2007 00:00:00 -tableName
Events —connectFile sdm.connect

=  SQL Server Example:

sdm —action importData —dirPath c:\tmp —startDate
09/25/2007 00:00:00 —endDate 09/26/2007 00:00:00 -
tableName Events —connectFile sdm.connect

Deleting Imported Data

This action (dropImported) deletes the imported data between the given dates from the
following supported tables:

= SQL Server
s HIST_EVENTS
o HIST_CORRELATED _EVENTS
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NOTE: The tables are imported in Oracle with the same name they are archived
with.

If there is no data imported between two specified dates, it returns a notification.

This command uses the following flags:

-action droplmported

-startDate <mm/dd/yyyy hh24:mi:ss>
-endDate <mm/dd/yyyy hh24:mi:ss>
-tableName <table name>

-connectFile <filePath>

NOTE: hh24 is hours represented in 24 hour format. For example, 1:15:00 p.m.
is 13:15:00 and 3:00:00 a.m. is 03:00:00.

To run droplmported:
Execute this command as follows:

-action droplmported -startDate <mm/dd/yyyy
hh24:mi:ss> -endDate <mm/dd/yyyy hh24:mi:ss> -
tableName <table name> -connectFile <filePath>

The following example deletes the imported data between the given dates from the
above mentioned tables.

» Oracle Example:

-/sdm —action droplmported —startDate 09/25/2007
00:00:00 —endDate 09/26/2007 00:00:00 -tableName
Events —connectFile sdm.connect

»  SQL Server Example:

sdm —action droplmported —startDate 09/25/2007
00:00:00 —endDate 09/26/2007 00:00:00 -tableName
Events —connectFile sdm.connect

Viewing Sentinel Database Space Usage
In Tablespace Management, the command line option allows you to:
= View Sentinel database space usage

This action (dbstats) displays the Sentinel database usage for all Sentinel tablespaces in
Oracle and Sentinel filegroups in MS SQL.

This command uses the following flags:

-action dbstats
-connectFile <filePath>

To view Sentinel Database Space Usage (Command Line):
Execute the following command:
-action dbStats -connectFile <filePath>

The following example displays the tablespaces of Sentinel database with their total
space, used space and free space available.

=  Oracle Example:
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./sdm —action dbStats —connectFile sdm.connect

=  SQL Server Example:
Sdm —action dbStats —connectFile sdm.connect

Update Map Data

11-18

This action allows you to replace the map source data file of a map on the server running
DAS with another file. Your new map source data file must have the same delimiter,
number of columns, and overall structure as the existing map data source file in order for
the map to function properly after the update. The new map source data file should only
differ from the existing file by the values that appear in the columns. If the new map
source data file has a different structure than the existing file, use the Edit feature to
update the map definition.

This command uses the following flags:

-action updateMapData
-map <mapName>
-file <fileName>
-backup <true/false>
(Optional)

-connectFile <filePath>

To run updateMapData:

Execute this command as follows:

-action updateMapData -map <mapName> -file
<fFileName> [-backup <true/false> (DEFAULT: true)] -
connectFile <filePath>

=  Oracle Example:

./sdm -action updateMapData -map Maps/rMap -file
D:\EDLocal_Updated.csv -connectFile D:\sdm.connect

= SQL Server Example:

sdm -action updateMapData -map Maps/rMap -Ffile
D:\EDLocal Updated.csv -connectFile D:\sdm.connect
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Utilities

Topics included in this chapter:

Topic Page
Introduction to Sentinel Utilities 12-1
Starting and Stopping Sentinel Server 12-1
Starting the Communication Server in Console Mode 12-5
Stopping the Communication Server in Console Mode 12-6
Configuring Sentinel 12-8
Updating Your License Key 12-10

Introduction to Sentinel Utilities

This chapter allows you to understand the utilities provided by Sentinel. You can use these
utilities for the following purposes:

For starting or stopping certain Sentinel services.
For modifying Sentinel configuration.

To determine the version of a Sentinel library.
For troubleshooting activities.

For configuring Sentinel email.

Starting and Stopping Sentinel Server

A Sentinel Server is made up of the following components:

= Communication Server
= Correlation Engine
= DAS

=  Collector Manager

Any combination of the above components may be installed in a particular Sentinel
Server.

In a distributed installation of Sentinel, it is likely that there will be more than one
machine with a Sentinel Server running on it. In this case, all of the Sentinel Servers work
together to provide the complete Sentinel functionality.

NOTE: At most one Communication Server and DAS component can be
installed across all Sentinel Servers in a distributed Sentinel installation. On the
other hand, multiple instances of Correlation Engine and Collector Managers are
allowed.

When a Sentinel Server is started or stopped, all components installed in that Sentinel
Server are also started or stopped. To start or stop a particular component on a Sentinel
Server, use the Servers View under the Admin tab in Sentinel Control Center.

You may need to start or stop a Sentinel Server due to the following routine maintenance:

Utilities 12-1



= Upgrades
= Patches
= Hotfixes

Starting a Sentinel Server

To start the UNIX Sentinel Server:

1. Log into the machine where the Sentinel Server you wish to start is installed as
the Sentinel Administrator operating system user (by default esecadm)

2. Go to the $ESEC_HOME/bin directory.

3. Run the following command:

./sentinel.sh start

To start the Windows Sentinel Server:

1. Click Start > Settings > Control Panel.
Double-click Administrative Tools.
Double-click Services.

In the Services window, highlight Sentinel.
Right-click >Start or click Start in the tool bar.

oA W

Stopping a Sentinel Server

To stop the UNIX Sentinel Server:

1. Log into the machine where the Sentinel Server you wish to stop is installed as
the Sentinel Administrator operating system user (by default esecadm)

2. Go to the SESEC_HOME/bin directory.

3. Run the following command:

./sentinel _sh stop

To stop the Windows Sentinel Server:

1. Click Start > Settings > Control Panel.
Double-click Administrative Tools.
Double-click Services.

In the Services window, highlight Sentinel.
Right-click >Stop or click Stop in the tool bar.

Os W

Sentinel Scripts

Depending upon which components are installed, the $ESEC_HOME/bin (on UNIX) or
%ESEC_HOME%\bin (on Windows) directory may contain some or all of the scripts
below. The operational scripts are appropriate for use during normal operations of
Sentinel. The troubleshooting scripts should only be used when troubleshooting an issue.

Operational Scripts
The scripts below can be used during the normal operation of Sentinel.

Script File: Description:

= adv change passwd.bat Resets the encrypted Advisor password stored in the
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adv_change_passwd.sh

Advisor configuration files. For more information, see
section Resetting Advisor password (Direct Download
Only) of Advisor Configuration in Sentinel 6.0
Installation Guide.

advisor.bat
advisor.sh

Starts the Internet download and processing of Advisor
feed data. This script is scheduled to run automatically
when Advisor is installed.

AnalyzePartitions.sh

Runs the analyze partitions action on the Sentinel
Database. This script is only available for Sentinel
Database running on Oracle. For more information, see
section Analyze Partitions in the Supported Platforms and
Best Practices in Sentinel 6.0 Installation Guide..

BackuplncidentData.bat
BackuplncidentData.sh

Used to backup Incident related data before running the
delete incident utilities. For more information, contact
Novell Technical Support
(http://support.novell.com/phone.html?sourceidint=suplna
v4_phonesup).

control_center.bat
control_center.sh

Launches the Sentinel Control Center graphical user
interface.

dbconfig.bat
dbconfig

Configures the database connection settings stored in the
DAS container xml files. For more information, see
section Reconfiguring Database Connection Properties of
Sentinel Data Access Service in Sentinel 6.0 Installation
Guide.

dbHealthCheck.sh

Displays Sentinel Database heath information. This script
is only available for Sentinel Database running on Oracle.
For more information, see section Database Health Check
for Oracle in the Supported Platforms and Best Practices
in Sentinel 6.0 Installation Guide.

extconfig.bat
extconfig

Resets any of the encrypted 3" Party Integration
passwords stored in the das_query.xml file. For more
information, see either the section Resetting the Remedy
Password in the Remedy Help Desk Operations or section
Resetting the HP OpenView Passwords in HP OpenView
Service Desk Integration, both of them are in the 3rd
Party Integration Guide.

keymgr.bat
keymgr.sh

Generates a random encryption key to be used to encrypt
messages in transport over the iISCALE message bus. For
more information, see the section Changing the
Communication Encryption Key of Communication Layer
(iISCALE) in Sentinel 6.0 Installation Guide.

mailconfig.bat
mailconfig.sh
mailconfigtest.bat
mailconfigtest.sh

Configures and tests the configuration of SMTP e-mail
server settings. For more information, see “Configuring
Sentinel E-mail”.

register_trusted_client.bat
register_trusted_client.sh

Registers the Sentinel installation as a trusted client of the
Communication Server on the machine where this script is
run. This script is used when manually configuring
Collector Manager to connect to Sentinel through the
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proxy. For more information, see section Collector
Manager in Communication Layer (iISCALE) in Sentinel
6.0 Installation Guide.

= sdm.bat Launches the Sentinel Data Manager application. For

= sdm more information, see Chapter 11, “Sentinel Data
Manager”.

= sentinel.sh Starts or stops the Sentinel Server. For more information,

= sentinel.bat see “Starting and Stopping Sentinel Server”.

= softwarekey.bat Resets the Sentinel license key. For more information, see

= softwarekey.sh “Updating Your License Key”.

versionreader.bat
versionreader.sh

Displays the version information stored in a Sentinel jar
file. For more information, see “Sentinel .jar Version
Information”.

Troubleshooting Scripts

12-4

The scripts below are useful when troubleshooting an issue you are experiencing. They
provide finer grain control of certain components in Sentinel, allowing you to drill down
to the root cause of the issue. Starting and Stopping Sentinel Server

NOTE: These scripts should not be used during normal operation of Sentinel.

Script File:

Description:

collector_mgr.bat
collector_mgr
correlation_engine.bat
correlation_engine
das_aggregation.bat
das_aggregation
das_binary.bat
das_binary
das_cmd.bat
das_cmd
das_itrac.bat
das_itrac
das_query.bat
das_query
das_rt.bat

das rt

Starts the associated Sentinel Server process. These
scripts are useful when troubleshooting a problem with a
Sentinel Server process that is not running properly and
when no helpful error message is written to the log file.
Before running one of these scripts, make sure the
associated process is not already running on that machine.

event_file_info.bat
event file info

Displays information about an event file that will be
processed by DAS Aggregation.

list_broker_connections.bat
list_ broker connections

Displays all of the active connections to the iISCALE
message bus.

runalert.bat
runalert.sh
runattack.bat
runattack.sh

Starts the Internet download and processing of either the
alert or attack Advisor feed data. The advisor.bat/.sh
script will run both of these scripts during normal
operation.
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= setadvenv.bat Used by the Advisor scripts to set some local environment

" setadvenv.sh variables.

= setenv.sh Used by many of the Sentinel script to set some local
environment variables.

= start_broker.bat Starts the message bus component of the Communication

= start broker.sh Server. This script is useful if you are having problems

starting the message bus (Sonic). For more information,
see “Starting the Communication Server in Console

Mode”.

= StartSQLAgent.bat Starts the SQL Server Agent Service and configures it to
run automatically. This script is run automatically by the
installer.

= stop_broker.bat Stops the message bus component of the Communication

= stop_broker.sh Server. For more information, see “Stopping the

B Communication Server in Console Mode”.
= stop_container.bat Stops a particular Sentinel Server process. This is useful
= stop_container.sh when you need to restart a particular Sentinel Server

process without stopping the entire Sentinel Server. Please
note that the Sentinel Server watchdog will automatically
restart the process once it is stopped.. For more
information, see “Restarting Sentinel Containers”.

» uninstallAt.bat Removes the Advisor feed download and processing
» uninstallcron.sh scheduled jobs. This script is run automatically by the
uninstaller.

Starting the Communication Server in Console Mode

These scripts start the Communication Server on the command line in console mode.
These scripts are useful for debugging the Communication Server without requiring you to
run the rest of Sentinel Server.

NOTE: During normal operations, you should not use these scripts. Instead,
follow the procedures in the section “Starting a Sentinel Server”. If you use these
scripts on Windows, for example, the service will only run as long as the
Command Prompt window remains open.

To start the Communication Server (Windows):

1. Either go or navigate through Windows Explorer to:
%ESEC_HOME%\bin

2. Either double-click (through Windows Explorer) or execute the following file:
start_broker.bat

To start the Communication Server (UNIX):

1. Login as Sentinel Administrator operating system user (default is esecadm).

2. Goto:
$ESEC_HOME/bin
3. Enter:

./start_broker.sh
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Stopping the Communication Server in Console Mode

These scripts stop the Communication Server on the command line in console mode.
These scripts are useful for troubleshooting the Communication Server without forcing
you to stop the rest of Sentinel Server.

NOTE: During normal operations, you should not use these scripts. Instead,
follow the procedures in the section “Stopping a Sentinel Server”.

To stop the Communication Server (Windows):

1. Either go or navigate through Windows Explorer to:
%ESEC_HOME%\bin

2. Either double-click (through Windows Explorer) or execute the following file:
stop_broker.bat

To stop the Communication Server (UNIX):

1. Login as user Sentinel Administrator operating system user (default is esecadm).
2. Goto:

$ESEC_HOME/bin
3. Enter:
./stop_broker.sh

Restarting Sentinel Containers
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The following procedures describe how to restart a Sentinel Server process from the
command line.

NOTE: During normal operations, you should not use these scripts. Instead, use
the Servers View in the Admin tab of Sentinel Control Center.

Below are the names of the Sentinel Server processes that can be restarted using the
procedure described below. The name must be used in the command line exactly as shown
below.

Name: Description:
= Correlation_Engine Processes Correlation Rules.
= Collector_Manager Process raw event source data and sends events.

= DAS_Aggregation Calculates event data summaries that are used in reports.

= DAS Binary Performs event database insertion.

= DAS IiTRAC Provides the server-side functionality for the Sentinel iTRAC
functionality.

= DAS_Proxy Provides the server-side of the SSL proxy connection to
Sentinel Server

= DAS_Query Performs general Sentinel Service operations including Login
and Historical Query.

= DAS RT Provides the server-side functionality for Active Views.

To restart a Sentinel Server process (Windows):
1. Goto:
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%ESEC_HOME%\bin
2. Enter:
-\stop_container.bat <host machine> <process name>

For example:
\stop_container.bat localhost DAS RT
To restart a Sentinel Container (UNIX):

1. Login as user Sentinel Administrator operating system user (default is esecadm).

2. Goto:
$ESEC_HOME/bin
3. Enter:

./stop_container.sh <host machine> <process name>

For example:
./stop_container.sh localhost DAS RT

Version Information

Executable Version Information

Sentinel has a command line option to display the version information of the following
executable:

= agentengine

To display Sentinel executable version information (UNIX):

1. Goto:
$ESEC_HOME/bin
2. Enter:

./<process> -version

For example:
./agentengine —version

To display Sentinel executable version information (Windows):

1. Goto:
%ESEC_HOME%\bin
2. Enter:

-\<process> -version

For example:

-\agentengine —version

Sentinel .dll and .exe File Version Information

The following procedure describes how to gather the version information of Sentinel .dll
and .exe files:
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To obtain Sentinel .dll and .exe file version information:

1. Goto %ESEC_HOME%.

2. Within the bin and lib directory, right-click either a .dll or .exe file and select
Properties.

3. Click the Version tab.

4. In the Item Name pane, select Product Version. The version number of the file
will appear in the Value pane.

Sentinel .jar Version Information

The following procedure describes how to gather the version information of Sentinel .jar
files:

To obtain Sentinel .jar file version information:

1. Log into the machine where Sentinel is installed as the Sentinel Administrator
operating system user (default is esecadm) on UNIX or as an Administrator on
Windows.

2. Goto:
For UNIX:

$ESEC_HOME/bin
For Windows:
%ESEC_HOME%\bin

3. At the command line, enter:
For UNIX:

-/versionreader.sh <path/jar file name>
For Windows
\versionreader.bat <path/jar file name>

Configuring Sentinel E-mail
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Sentinel email configuration settings are stored in the execution.properties file during
installation. This file can be edited after installation. This file is on the machine where
DAS is installed and is located:

For Windows:
%ESEC_HOME%\config

For UNIX:
$ESEC_HOME/config

There are two scripts (*.sh for UNIX and *.bat for Windows) that change and test the
email settings within the execution.properties file. The mailconfig.* script changes the
email settings and the mailconfigtest.* script tests the email settings. The bolded areas are
the email settings that can be changed.

The properties within execution.properties are:

mail.authentication.user=<domain\\user>
correlated events retry wait=5000
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mail.smtp.host=<SMTP_HOST> The SMTP host that will be used to
send email.

mail.events.max=1000 Maximum number of events that will
be sent in an email that is
automatically triggered by the
correlation engine. Its purpose is to
limit the size of emails for correlated
events that have a very large set of
trigger events.

correlated events retry count=10

mail.address.from=<SMTP_FROM_ADDR> The email address that appears in the

From field of the email sent from
DAS.
mail.authentication.password=<password> password for

mail.authentication.user.

The mailconfig.sh and mailconfig.bat scripts use the following arguments:

-host SMTP host name or IP address

-from From field of the email

-user The mail authentication user

-password Password for the mail authentication user

NOTE: Do not enter your password after the —password argument. You will be
prompted for a new password after you enter the command. The console output
will be masked by asterisks (*).

The mailconfigtest.sh and mailconfig.bat file use the following arguments:

-to Destination email address

To set email properties in the execution.properties file:

1. On the machine where you have DAS installed, go to:
For UNIX:

$ESEC_HOME/bin
For Windows
%ESEC_HOME%\bin

2. Execute mailconfig as follows:
For UNIX:

./mailconfig.sh -host <SMTP Server> -from <source
email address> -user <mail authentication user> —
password

For Windows:

mailconfig.bat -host <SMTP Server> -from <source
email address> -user <mail authentication user> -
password

UNIX example:
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-/mailconfig.sh -host 10.0.1.14 -from
my name@domain.com -user my_user_name —password

Windows example:

mailconfig.bat -host 10.0.1.14 -from
my_name@domain.com -user my_user_name —password

After entering this command you will be prompted for a new password.
Enter your password:**x*ixiix

Confirm your password:****x*ix*

NOTE: When using the password option, it must be the last argument.

To test your email settings in the execution.properties file:

1. On the machine where you have DAS installed, go to:
For UNIX:

$ESEC_HOME/bin
For Windows
%ESEC_HOME%\bin
2. Execute mailconfigtest as follows:
For UNIX:
-/mailconfigtest.sh -to <destination email address>
For Windows:
mailconfigtest._bat -to <destination email address>

If your mail is sent successfully, you will get the following on screen output and e-

mail received at the destination address.
Email has been sent successfully!

Check the destination e-mail mailbox to confirm receipt of email. The subject line and

content should be:
Subject: Testing e-security mail property

This 1s a test for e-security mail property set up.
IT you see this message, your e-security mail
property has been configured correctly to send
emails

Updating Your License Key

If your Sentinel license key has expired and Novell has issued you a new one, run the
software key program to update your license key.
To update your license key (UNIX):

1. Log into the machine where the DAS component is installed as the Sentinel
Administrator operating system user (default is esecadm).

2. Goto $ESEC_HOME/bin
3. Enter the following command:
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./softwarekey.sh

4. Enter the number 1 to set your primary key. Press enter.

To update your license key (Windows):

1. Log into the machine where the DAS component is installed as a user with
administrative rights.

2. Goto %ESEC_HOME%\bin
3. Enter the following command:

\softwarekey.bat

4. Enter the number 1 to set your primary key. Press enter.
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Quick Start

Topics included in this chapter:

Topic Page
Active Views Tab 13-1
Exploit Detection 13-2
Asset Data 13-3
Event Query 13-3
Creating Incidents 13-4
iTRAC 13-6
Analysis Tab 13-14
Simple Correlation 13-15

Security Analysts

NOTE: This document assumes your Security Administrator has built the
necessary filters and configured Collectors for your system.

Active Views Tab

In the Active Views tab, you can monitor events as they happen, performing queries on
these events. You can monitor them in a table form or through a 3-D graphical
representation.

To get a Real-Time events started:

1. Go to the Active View tab.

2. Click Active Views > Create an Active View, select a filter from the Filter drop-
down menu and click Select.

Bckive Yiews | Incidents  (TRAC  Analysis &
Step 1. Event Collection Parameter Setup
Properties Define the display properties by selecting the Event Attriaute o use on the Z =\ VA
Axis of the chart, the fitter to apply snd whether or not to display events, b
E Create Active View ; _ Event Atribute (7 Axis) —
iz | o Advisol
N ISeveritv ;I
\% Event Query [Create Active View
[ Fitter E
Display Everts?
IYES Ll
= Back I Next = I Firiisty Cancel
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Crvner Fitter Matne Expression String
PUBLIC Operating_System_... [Filter] e.DeviceCategory = "035")
PUBLIC Database_Events filter; e.DeviceCategory = "DB" )
PUBLIC IDS_Events filter{ e.DeviceCategory = "IDS" )
PUBLIC High_Severity Filters & Severity »=3)
PUBLIC Firewall_Events filter{ e.DeviceCategary = "FW" )
PUBLIC Lowe_Severity Filker{ &.Severity <=2}
PUBLIC Correlation filter{ { e.SensorType ="C" ) or { &,SensorType = "W" ) )
PUBLIC Exploit_Detection Filterg e vulnerability = 1 )

PUBLIC

External_Events

Filter{ { e.SensarType |="T" } and { e.5ensarType I="F" 1}

PUBLIC Scan_Events filters e.DeviceCategary = "SCAN" )

PUBLIC Severe_Internal Filkerf { e.SensorType ="T" J and { e.Severity ==3))
PUBLIC i filter{ e.\WizardPort = "wmi"

PUBLIC Inkernal_Events filters &.SensorType = "1" )

~Manage Fitter Configuration

Add | Clone | Delete | Details | Select |

4 PUBLIC:ALL, Severity{1)

Filter PUBLIC:ALL, Attribute Severity
30 Second Display Interval, 15 Minute Display Time

Click Finish. If you have an active network, you may see something similar to:

=10l

09:37:30  08:40:00 084230 094500 094730 08:50:00

Top Values for Last 5 Minutes
09:47:30 - 09:52:30

Rank | Sewerity | Count/Rate |
1. Oz 2526
2 ] 1850
3 [ 1006
4. 4 Y56
4. =1 5

Time
_‘I _’I Interval Walues  Top values |
: Severity DiateTime SourcelP DestinationlP Eventilame

@ 2005,05,03 f 09:52:29 EDT 190.168.12.21 190.168.12.21 Program_execution_started I:l
3) 2005,05.03 [ 09:52:29 EDT 206,158.21.6 190.168.12.21 Failed_login-administrator —
13) 2005.05.03 [ 09:52:29 EDT 208.152.25.22 190.168.12.24 'WEB-I13.asp_chunked I
(3 2005.05.03 [ 09:52:29 EDT 208.152.25.22 190.168.12.24 HTTP_IIS_ASP_Header Ow... fi
13 2005.05.03 [ 09:52:29 EDT 208.152.25.22 190.168.12.24 Reject I
@ 2005.05,03 [ 09:52:29 EDT 2058.152.25.22 190.165.12.24 Port_scan I
@ 2005.05,03 f 09:52:29 EDT 208.152.25.22 190.168.12.21 Port_scan I
' 2005.05,03 [ 09:52:29 EDT 159.165.10.22 159.165.10.23 Attempted_telmet 'LI

K1 3
950 of 19443 Update: 2005.05.03 { 09:52:30 &M EDT received: 50 (of 196) T

NOTE: To display a 3-D graph without real time events, click the Display Events

down arrow and select No.

Exploit Detection

To view any events indicating a possible exploitation, you must have the following:

13-2

Advisor Feed
Intrusion detection
Vulnerability scanning

Sever'rt'fl Vulnerabil'rt':.f;;f |

Attackld -

@ 0

& [o

Within an event, the values in the vulnerability field convey the following:

When the Vulnerability field equals 1, the asset or destination device is possibly

exploited.

When the vulnerability field equals 0, the asset or destination device is indicated as

not being exploited.

When the Vulnerability field is blank, the exploit detection feature of Sentinel is not

enabled.
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To view events that indicate a possible exploitation, create an Active View with a filter
where Vulnerability equals 1. For example, if you have Nmap and have run the Nmap
Collector, you can view asset information on the exploited asset or any asset.

For more information on how exploit detection works and which Intrusion Detection
Systems and Vulnerability Scanners are supported, see Chapter 1, “Sentinel Control
Center”.

Asset Data

To view Asset information for any event, right-click an event or events > Analysis > Asset
Data, a window similar to the one below will appear.

Asset
Report
Hardware MAC Address  04:23:A3:44:65:87
Name Value UNENDWHN
Type DESKTOP Criticality UNENDWHN
Vendor R EMOWH Sensitivity R EMOWH
Product Environment  LINKNOWN
Version Location UNKMOWN
Hetwork IP Hostname
192, 163.0,10
devbox10
Software Name Type Vendor Product Version
Contacts Order  Mame Role Email Phone Number
OwnerFirstName 10 OwnerLastName 10 ASSET_OWNER OwnerEmail10 OwnerPhoneNumber10
MaintainerFirsthlame 10 ASSET_MAINTAINERMain tainerEmail 10 MaintainerPhonsNumberi0
MaintainerLastMame 10
BusinessUnit10 BUSINESS_UNIT
LineOfBusiness 10 LINE_OF_BUSINESS
Division10 DIVISION
Department 10 DEPARTMENT
Location Room 09
Rack 10
Address HQ
1921 Gallows Rd
Suite 700
Wienna WA 22182 USA
Hardware MAC Address  04:23:A3:44:65:78
Name Value Assetialue
Type DESKETOP Criticality Criticality
Vendor Wendaor Sensitivity Sensitivity
Product ProductMame Environment Environmentldentity
Version Productiersion Location Networkl dentity
Hetwork IP Hostname
192 163,01

Event Query
Example Scenario — Telnet Event:

During monitoring, you see numerous telnet attempts from source IP 189.168.10.22.
Telnet attempts could be an attack. Telnet potentially allows an attacker to remotely
connect to a remote computer as if they were locally connected. This can lead to
unauthorized configuration changes, installation of programs, viruses, and so on.

You can Event Query to determine how often this possible attacker has attempted a telnet;
you can setup a filter to query for this particular attacker. For example, you know the
following:
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= Source IP: 189.168.10.22 = Event Name: Attempted_telnet
= Destination IP: 189.168.10.23 = Sensor Type: H (Host Intrusion Detection)
= Severity: 5

To Perform an Event Query:

1. Inthe Sentinel Control Center, click Event Query (magnifying glass icon) and
click the Filter drop-down menu.

2. A window with a list of filters displays. Click Add; enter a filter name of telnet
SIP 189 168 10 22. In the field below the Filter, enter:

= SourcelP =189.168.10.22 = SensorType =H
= EventName = Attempted_telnet = DestinationIP = 189.168.10.23
= Severity =5 = Match if, select All conditions are met (and)

3. Click Save. Highlight your filter and click Select.

4. Enter your time period of interest; click Search (magnifying glass icon). The
results of your query will appear. If your Event Query makes a match, you will
get a result similar to the following illustration.

Filker: Severity: B From: From: B To: @ To: Bakch size:

JPUBLIC tenet 5P 183 _185_10_22 * | lEzrs Elpszzor =] Fers  slpesror =] oo =] = | b 4 |

: Severity DateTime SourcelP DestinationlP | EwventMame
5 2005.05.03 / 09:25:24 EDT 159,163,10,22 159,165,10,23 Attempted_telnst DLI
' 2005.05.03 [/ 09:25:22 EDT 189.168,10.22 189,168, 10,23 Aktempted_telnet 0|
5 2005.05.03 / 09:25:20 EDT 159,1658,10,22 159,168,10,23 Attempted_telnst 0
' 2005.05.03 f 09:25:158 EDT 189.168,10.22 189,168, 10,23 Attempted_telnet 0
5 2005.05.03 / 09:25:16 EDT 159,1658,10,22 159,168,10,23 Attempted_telnst 0
‘ 2005.05.03 [/ 09:25:14 EDT 189.168,10.22 189,168, 10,23 Attempted_telnet 0
' 2005.05.03 f 09:25:12 EDT 189.168,10.22 189,168,10.23 Attempted_telnet 0
‘ 2005.05.03 f 09:25:10 EDT 189.168,10.22 189,168, 10,23 Attempted_telnet 0
' 2005.05.03 [/ 09:25:08 EDT 189.168,10.22 189,168,10.23 Attempted_telnet 0
] 2005.05.03 f 09:25:06 EDT 189.1658,10.22 159,165, 10,23 attempted_telnet 0>

4 I I ¥
|* Batch received, click Maore for additional resulks, Complete through 5/3/05 9:25:24 'i 22% | Count: 100

If you want to see how often in general this user is attempting a telnet, remove
DestinationlP, SensorType and Severity from your filter or create a new filter. The
results will show all the destinationIPs this user is attempting to telnet to.

If any of your events are correlated events, you can right-click > View Trigger Events
to find what events triggered that correlated event.

NOTE: Correlated events will have the SensorType column populated with a C.

More Information about Attacks

Another event of interest could be excessive FTP events. This can also be a remote
connection, allowing for transferring, copying and deleting of files.

Below is a short list of attacks of interest. Types of attacks are an extensive list. For more
information about network/host attacks, there are many resources available (that is, books
and the internet) that explain different types of attacks in detail.

= SYN Flood = Packet Sniffing = Smurf and Fraggle
= ICMP and UDP Flood = Denial of Service = Dictionary Attack

Creating Incidents

NOTE: To perform this function you must have user permission to create
Incidents.
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This is useful in grouping a set of events together as a whole representing something of
interest (group of similar events or set of different events that indicate a pattern of interest
such as an attack).

NOTE: If events are not initially displayed in a newly created Incident, it is most
likely due to a lag in the time between display in the Real Time Events window
and insertion into the database. If this occurs, it may take a few minutes for the
original events to finally be inserted into the database and display in the incident.

To create an Incident;

NOTE: It is possible to create an incident that does not contain any events.
Events can always be added to Incidents.

1. InaReal Time Event Table of the Visual Navigator or a Snapshot Real Time
Event Table, select an event or a group of events and right-click and select Create

Incident.
N PUBLIC:ALL @ 2/9/07 12:30:05 P Snapshot
Severity Reporter Mame DateTime EwertMarne SourcelP
4 ezecSleshd 380712 ventsInBoundary ...

E) =aritha.applabs net 3807 12 Show Details pr
E) ezecSleshd 380712 iew in Active Browser ger Stopped
13) saritha.applabs net 390712 bR
Investigate L —
\3) ezecSleshd A7 12 ning Existing Data
12)  |esecslez6d 35907 12 Analyze P ldin
2] |esectlessd 3907 12 ion
E) ezecSleshd 380712 o Ot
E) esecSlestd 380712 . hing Existing Data
2)  |esecslessd 3807 12 Creste Incident din
2 |esecSlesfd 3907 12 - ian
3 |esecSlestd 3907 12 ) U (RS A0ut
2 |esecSleshd N7 12 ping Diata
[7] 3007 11
E) ezecSleshd 38007 11 IR Bource
a 20007 11 traceroute

2 |esectlestd 34907 1 \ithois? or
=

In the Incident Window are the following tabs:

= Events: Shows which events make up the incident

= Assets: Show affected assets

» Vulnerability: Show related asset vulnerabilities

= Advisor: Asset attack and alert information

» iTRAC: Under this tab, you may assign an iTRAC Process
= History: Incident history

= Attachments: You may attach any document or text file with pertinent
information to this incident

= Notes: You may enter any general notes you would need to refer regarding
this incident.

In the Create Incident dialog box, enter:

= Title = Category

= State = Responsible
= Severity = Description
= Priority = Resolution

Click Create. The incident is added under the Incidents tab of the Sentinel Control
Center.

Quick Start 13-5



ITRAC

Instantiating a Process

13-6

An iTRAC process may be instantiated in the iTRAC server by associating an iTRAC
process to an incident the following methods:

= Associate an iTRAC process to the incident at the time of incident creation

= Associate an iTRAC process to incident after an incident has been created

= Associate an iTRAC process to an incident as an action when deploying a correlation
rule

For more information on association a process to an incident, see Chapter 3, “Correlation
Tab” and Chapter 4, “Incidents Tab”.

Example Scenario — Creating a Simple Two Tiered iTRAC Process for a
Possible Network Attack

NOTE: To perform all of the scenarios in the iTRAC section, iTRAC scenario
sections must be followed in the order presented.

This discusses how to make a simple two tiered iTRAC Process. The process is flow of
steps that can be taken in the event there is a possible attack on your system.

The example process is:

= Asks the question (in the first step —a manual step [Decide if Hacked]), from a
preliminary look has the network been attacked? This leads to a Decision Step.

NOTE: All Decision Steps provide different execution paths depending on the
value of the variable defined in the previous step.

= |f there has been an attack, go collect necessary data to determine if there has been an
attack. If there is no attack, send an email out to the supervisor that there is not an
attack.

= The Collect Data step is to review the data to make a better determination if there has
been an attack.

= |f there has been an attack, take measures to prevent another attack and send an email
out to the supervisor that proper measures have been taken. If there is no attack, send
an email out to the supervisor that there is not an attack.

MatHachad
T 5\—)_@
iy - Dazizien o MlotHachsd -
'e)—‘“mg—‘“ % MotHached End
Hached - Hached or Mo >
strt  Decide HHached Hachad? @ 7
G e Hached Happened - Proper heasures Tahen Y
ollectDia ached or Mo iy Ly
PraventFuurs Atchs Meazures Taken

End

To Create an iTRAC Process

1. Click the iTRAC tab.
In the navigation pane, click iTRAC Administration > Template Manager.
In the Template Manager window, click Add.

The iTRAC Process Builder will open with a Process Details Window. Enter the
name iTRAC Tutorial. Optionally, add a description.

M wd

Sentinel User Guide




& Process Details

~Details

Mame ITRAC Process Tutorial

Description & simple twa tier iTRAC Process for a possible sttack. -

=

(8134 | Cancel |

From the Step Palette pane, drag and drop three Manual Steps, two Mail Steps,
and two Decision Steps. Rename and the attributes to the steps as follows by
right-clicking and selecting Edit Step.

»= Manual Step-0 to Decide If Hacked
o set Role to Analyst
o click Associate
= click Add
= enter Hacked in the Name field
= inthe Process Variables window select the Variable Type as String
= enter default value of yes

Decide If Hacked = Process Yariables I
Manual Ste
b [ =] Mame IHacked
iz assighed to a role. Variables may be associsted with & & [ 3

manual step to get input from users

Mame  [pecis f Hacked wariable Type |STRING LI =

General | Description
| i | DefaultValue |yes

Fole

Associste Varisbles Description
-3 Assaciate @ Dot f—:' Freview Initial evaluation of event(s) to determing if there has been an attack |
=| Hacked
Name
Type
Default
I© READ-ONLY

e) | Cancel | il ﬂl
= under the Description tab, (optional) enter Initial evaluation of event(s) to
determine if there has been an attack
o click OK

= highlight the newly created association, continue to click OK until the
step is renamed

= Manual Step-1 to Collect Data
= set Role to Analyst
= click Associate
= highlight Hacked, click OK

s under the Description tab, (optional) enter To further evaluate after
collecting of events to determine if there has been an attack.
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s click OK, the step should be renamed
Manual Step-2 to Prevent Future Attacks
= set Role to Analyst

= under the Description tab, (optional) enter Take measures to stop the
attack (firewall, router or other intrusion protection method). Also, if

possible, determine how the attacked was done.

s click OK, the step should be renamed
Mail Step-3 to Not Hacked

= inthe To field, (since this is for tutorial) enter your email address. When
this step completes it will send you an email

= inthe From field, enter a ‘made up’ address such as me@nowhere.com
= inthe Subject field, enter We have not been hacked.

= Under the Body tab, (optional) enter This email is generated from a

tutorial (simulation) iTRAC process.

Not Hacked
Wail Step LN
Edail will be sent to configured addresses A [ 3
Narne [Not Hacked
General | Bady |
To !yuurema\laddress@nuduma\n.nal
From Ime@me com
Subject & Have Mot Been Atacked (simulation)
oK I Cancel |
o click OK

Mail Step-4 to Prevent Future Attacks

Mot Hacked
Mail Step ‘C’
EMail will be sert to configured addresses = >
Narne Mot Hacked
Seneral  Body |
[This emaill is genersted from from a tutorisl (simulation) ITRAC process.\
Ok I Cancel

@ inthe To field, enter your email address
o inthe From field, enter a *‘made up’ email address
o inthe Subject field, enter Proper Attack Measures Taken

= Under the Body tab, (optional) enter This email is generated from a

tutorial (simulation) iTRAC process.

Decision Step-5 to Hacked? (optional) Under the Description tab, (optional)

enter a description such as Preliminary decision as to if there has been an

attack or not.
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Hacked? [x] Hacked? [<]
N

Decision Step Decision Step B

? (P
iz uzed o creste decision points for conditional transitions b / [ 3 iz uzed to creste decision points for conditional transtions 3 / [ 3

Name IHacked? MName IHacked?

Genera\| Descmpt\on} Genersl  Description

Preliminary decision as to if there has been an attack or not

ﬂl QK | Cancel

= Decision Step-6 to Hacked or Not. (optional) Under the Description tab, you
may enter a description such as Decision as to if there has been an attack or
not.

6. Right-click Start and select Add Start Transition. Select destination to step
Decide If Hacked.

7. Right-click Decide If Hacked and select Add Transition. Select and enter the
following:

=  Name, enter Decision
= Type, select unconditional
= Destination: Hacked?

Transitions E I

Mame IDecisiDn

Type  |Unconditional

Saource |Decide .. 'I

Description

= Click OK
8. Right-click Hacked? and select Add Transition. Select and enter the following:
=  Name, enter Not Hacked
=  Type, select else
= Destination: Not Hacked
= Click OK

NOTE: A decision step provides different execution paths depending on the
value of the variable defined in the previous step. A Decision Step may have
more than two transitions.

9. Right-click Not Hacked and select End Transition.
10. Right-click Hacked? and select Add Transition. Select and enter the following:
= Name, enter Hacked
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11

12.

13.

14.

= Type, select Conditional
= Destination: Collect Data
= Click Set > EXP
@ Select Variables and Values
= Select Attribute Hacked
s Select Condition equals
= Enter Value of yes

= Click OK until the transition is complete

Right-click Collect Data and select Add Transition. Select and enter the
following:

=  Name, Hacked or Not?
=  Type, Unconditional
= Destination, Hacked or Not

Right-click Hacked or Not and select Add Transition. Select and enter the
following:

= Name, Not Hacked
=  Type, Else
= Destination, Not Hacked

Right-click Hacked or Not and select Add Transition. Select and enter the
following:

= Name, Hack Happened

=  Type, Conditional

= Destination, Prevent Future Attacks

= Click Set > EXP

Select Variables and Values

Select Attribute Hacked

Select Condition equals

Enter Value of yes

=  Click OK until the transition is complete

Right-click Prevent Future Attacks and select Add Transition. Select and enter the
following:

o

o

o

o
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name  [Hacked|
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Type  |Conetional = '(: Flaions
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|
oK I Cancel I
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Clear |
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(s]:4 | Cancel |




= Name, Proper Measures Taken
=  Type, Unconditional
= Destination, Measures Taken

15. Right-click Measures Taken and select Add End Transition.

HMotHacked
T,
-/~4)-@
A - Diacizion B HotHacked -’
'd—i-m—"-- L MotHached End
Hacked Hached or Mo -
swrt  Decide HHached Hached? Y T
Hazhed Happanad - Propar Messures Tahen &
CollectDan Hached or Mot iy _:_f
PrevantFunrs Attchs Manzuras Tahen

End

16. Click Save. Your new process should appear in the Template Manager.

Example Scenario — Running an iTRAC Process for a Possible Network
Attack

The following example assumes the following:

A process named iTRAC Process Tutorial has been assigned to your role (analyst)

NOTE: This is a process created in Section. Example Scenario — Creating a
Simple Two Tiered iTRAC Process for a Possible Network Attack.

All steps within the process belong to the Analyst group

NOTE: By assigning steps to other roles, would mean having to log out and then
log in as a user assigned to that role and accept the process. For simplicity, the
following example is assigned to one role.

To run this process, this process will has to first be assigned to an incident.

To Start or Terminate a Process:

1.
2.
3.

Click the Incident tab.

Click Incidents > Create Incidents.

Enter the following:

= Title: iTRAC Tutorial

= Category: Other

= Responsible: assign this Incident to yourself
Click the iITRAC tab, select iTRAC Process Tutorial.
Click Create.

NOTE: Since this is a tutorial Incident and not a true Incident, it can be deleted
without negatively affecting your Sentinel setup.

From anywhere in the Sentinel GUI, click the Analyst group (yellow bar) under
View work items.

Wiew work tems

Bnalyst |

NOTE: Your bar may already be partially green indicating that you have
accepted (acquired) an iTRAC Process.

All of the processes assigned to the Analyst role will be displayed.
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N Work Items [ %] I

User: |EErEsl Sroup: |Ana|yst LI Cner: IGroup LI Process: [<All= - |
S FTPHIT Command Example
53 ITRAC Tutarial iTRAC Process Tutorial

To accept a Work Item, highlight iTRAC Tutorial and click Acquire.

N work Items | x| I
User: Ianalysﬂ LI Sroup: |Analyst LI Chner IGrUup LI Process |<AII> LI
5 FTPHIT Command Example

#1 ITRAC Tutorial Process: iTRAC Process Tutorial
Step: Decide F Hacked

Complete Ac%%lre Wiew Details

If the View Work Item list bar was yellow as illustrated above, it will change with an
addition of a green bar.

Wieww worlk tems

snast [

Click the green bar under View work items. In the Work Items window, click
View Details.

Nworttems @
Uszer: Ianalysﬂ LI Sroup: |Ana|yst LI Cher: IMe LI Process: [<All> LI

* iTRAC Tutorial Process: ITRAC Process Tutorial
Step: Decide F Hacked

Complete  Releaze \ﬁe%Details

& poszible sttack 07 0607 Hacked_~nalyst

M Work Item Details | X|

Process Name :iTRAC Process Tutorial Process Id : 2D8_iTF!AC_Pmcess_Tutnrial_iTR.l\\C_Proca!
Incident Mame :iTRAC Tutorial Incident Id : 307

Owner :analystl Performer : &nalyst

Incident Owner : analystl Status * FUnAing

Process Status

Process Details| Deseription |

L Zoomin Sk Zoomout -ﬂi Zoom Selected Feszet s.,? Process Details - History
State: running Owner Name: analystl
Ir:rnce_siR[f'a'e(‘:ﬁmtmn Instance Id: Process Definition
gl : 208_TRAC Process_Tutorial_iTRAC_Process_ Tutorial Version: 1
Process Tutorial
Mol Hachad
— i, -
T " Mol Hechsd -
a_p.;lp Ep [repra—— =
= _ Hachad 5 Hachad o Mol 7 _.?>
e e o Hachad Haprered "~ P o W Fakan . @
Fiwanl Fulue Mk Nexmaws Fabhmn Ed

0 Please review variables before completing Felease | Cancel |

The red highlighted step indicates what step this process is currently in.

10. To start the steps within this process, click the Process Details tab.
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11.

12.
13.

14.

15.

N Work Item Details E3
Process Mame :iTRAC Process Tutorial Process Id : 208_{TRAC_Process Tutorial _iTRAC_Proce
Incident Mame :iTRAC Tutarial Incident Id : 307 [
Owner s analystl Performer : &nalyst
Incident Owner : analyst Status * PLUIRRiFG
Frocess Status  Process Details | Descriptinn|
=l
Hacked Iyes
=l
Comments: Add. | Attachments: A I
fCommants and stachmerts will ke added to associsted incidant)
L« | H s | ]
@ Please review variables before completing Complete Release | Cancel |

For this manual step the variable yes is entered. Entering another value such as no or
else (no attack) will result in going to an email that will send an automatic email and
complete the process. Let say that initial assessment is that there is an attack, with the
hacked variable equal to yes, click Complete (to complete this step, not complete the
process).

In the Work Items window, highlight the process and click View Details. The
Collect Data step should be highlighted in red. As before, this is a manual step.

Hacked

=1
> @
Collect Data,

Click the Process Details tab.

Again, the variable page will appear. In the previous step of the iTRAC Process,
Collect Data is a step to further determine by analyzing the event(s) of interest if
an attack has occurred. Let’s say that an attack has occurred. Leave the default
value of yes. If this were a real attack, it would be beneficial to add clear notes
and/or attachments as to the information about this attack. Click Complete.

In Work Items window, highlight the process and click View Details. The Prevent
Future Attacks step should be highlighted in red. As before, this is a manual step.

In this manual step, measures should be taken to harden the network to prevent
future attacks. Once this is done, as before it would be beneficial to add clear
notes and/or attachments as to the information about this attack. Click Complete.

The next step is an automatic email step indicating that proper anti-attack measures
have been taken. The iTRAC Process will be removed from the Work Items window.

Also, if you go to the Process View window it will indicate as Complete or if you
double-click this process, it will indicate as complete.
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= Propsr Waasures Taken i
i -o—9

&nt Fumirg Amacks MWoazures Taken Ena

|Refresh| Crested || State: completed |

=- iTRAC Process Tutorial {

- & ITRAC Tutorial

foompleted

Report Analyst

NOTE: Assumption, your Security Administrator has configured your Crystal
Enterprise web server and published a list of available reports.

Analysis Tab

13-14

The Analysis tab allows for historical reporting. Historical and vulnerability reports are
published on a Crystal web server, these run directly against the Sentinel database. These
reports can be useful to track and investigate activity over a large time frame, for instance
a week or a month. These reports can also be used as a high level reporting method to
your supervisors. If your reporting web server is installed, look in the navigator bar to see
what reports are available.

NOTE: Your reports may be different, Sentinel Crystal Reports are ‘living’
reports. They are under constant updating.

For example, if you are responsible for generating reports to upper management within
your organization. Chances are you will run Source Destination Reports. These are Top 10
Source to Destination IP Pairs on hosts names, ports, IPs and users. To run this report, do
the following:

To run a Crystal Report:
1. Expand Top 10 and highlight Top 10 Source to Destination IP Pairs and click
Create Reports (magnifying glass).

2. Enter Sentinel Report User (for SQL authentication and Oracle) as the username
or your Windows Authentication username and enter your password.

3. Under Report Type, select one of the following:
= Specific Date Range
=  Prior Day
= Daily Report
= Weekly Report
= Monthly Report

NOTE: Other reports may have additional parameters such as resource name and
severity range.

4. Click OK. The following is a sample monthly report.
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Top 10 Source to Destination IP Pairs: Monthly
Report Description: This repart displays the Top 10 Source |P - Dectination IP pairs hased on total event count far the selected
severity and date range.07-01-2007 12:00:00 AM - 07-08-2007 11:59:50 PM
Source and Destination IP Pairs
32
28
24
2 20
3 16
3 F H
£ 1z — -
@
T - — — — —
04 — —a—
0o
.
Q(J:\ Qt.;'\ QPP' QG- c:'-gl( 0‘9 Q?ﬁ'l' a'?}‘ 0¢D 1‘:??
o 2% g ) o Al Y o o o
R q." o o o - h," A2 e R
é S © ¢ & g @ ¢ 8
o Yl “Q‘fp “_0‘} o o “‘;.) o o o
o B Q - & A & A 2 &
SIP - DIP Pairs
Source IP Destination IP Mumber of Occumences
1000167 10029 3
10.0.061 0.2 2
10.0.0.118 10.0.0.7 2
10.0.0.54 10.0.0,32 2
10.0.081 10.0.0,36 2
10.0.0.57 10.0.0.37 2
10.0.0.205 10.0.0.44 2
10.0.0.245 100051 2
10.0.0.87 100060 2
10.0.0.82 10.0.0.65 2

5. You can export this file as a Word, pdf, rtf, Excel or as a Crystal Report by

clicking Export (envelope).

E Crystal Reports (RPT)

i

Crystal Reports (RPT)

Adobe Acrobat (POF)
|| Microsoft Excel 97-2000 (KLS)
hicro=soft Excel 97-2000 - Data O

Microzoft Word (RTF)
Microzoft Word - Editable (RTF)
Rich Text Format (RTF)

Aly (¥LS)

Similar to the Security Analyst, if you have an event or events of interest within your
reports, you can run an Event Query under the Analysis tab. To run a query, highlight

Historical Events > Historical Eve

nt Queries and click Create Reports (magnifying

glass). For more information, see section Security Analyst - Event Query Sample

Scenario.

Administrators

Simple Correlation

Correlation is the process of analyzing security events to identify potential relationships
between two or more events. Correlation allows quick association of priority attacks based

on common elements of event data
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The following example is written for the Data Generator Connector that comes installed
in Sentinel as a test event generator.

NOTE: Anytime the Data Generator Connector is running, it will be putting data
into your database. Having a correlation rule fire that is associated with the Data
Generator Connector will additional data to your database.

To Create a Simple Correlation Rule:

1. Click the Correlation tab and highlight Correlation Rule Manager in the
navigation bar.

2. Inthe Correlation Rule Manager window, click Add.

3. Click Simple to create a simple rule.

4. Select Fire if All (in the drop-down menu).

Fire if Im vl of the following conditions are met:

5. Enter the following:
= SourcePort = 10025 = DestinationPort = 25

Fire if IAII vl of the following conditions are met:

[ Destinstionport |- o
ISDurcePor’( L’ l= ﬂ 100256
Click Next.

6. To have this rule fire as many times as possible, select Continue to perform
actions every time this fires.

After rule fires:

¥ Cantinue to perfarm actions every time this rule fireg

Click Next.

7. In the General Description window, enter a name. Recommend a name and
description that indicates that this is tutorial rule and may not be germane to the
network.

MName

iTutDriaI_SnurceF‘nrt_DestinatiunF'urt
Mamespace

|C|:|rrelati|:|n Rules j

Description

I'I'his is & tutarial correlation rule.|

Click Next.
8. Select not to create another rule, click Next.

To Deploy the Simple Correlation Rule:

1. Click the Correlation tab and highlight Correlation Rule Manager in the
navigation bar.

2. Click Tutorial_SourcePort_DestinationPort (this is the name of the rule from the
previous example) > Deploy Rule.
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M Correlation Rule Manager

E,'}l Aplc] Folder: ICorreIation Rules VI |7 List correlation rules in sub-folders: Manage Folders 1}

P [=1 E3

7T Tutorial_SourcePort_DestinationPort

Thiz iz a tutorial carrelation rule.

Tutorial telnet attermnt SIP 189 165 10 23

Wiew/Edit Deplﬁy Bule Delete

3. (optional) In the Deploy Rule window, you can add an action. This allows you to:

= Configure Correlated Event
= Add to Dynamic List

= Remove from Dynamic List
Action

Configure Correlsted Event

Configure Correlated Evert h
Aodd to Dynamic List

Femowve from Dynamic List
Execute a Command

Send Ermail
Create Ihcident

M Correlation Rule Manager

8 Add  Folder: | Correlation Rules

Execute a Command
Send Email
Create Incident

Click Next. The rule will indicate deployed by the color green.

To view what events triggered your correlated event

1. Right-click the correlated event and select View Trigger Events to see how many

events (could be more than 1) triggered this correlation rule.

I SourcePort Destination Port

Senszor Type Severity

Hoozs 25

10025

M |7 i3
Show Details

Wigw in Active Browser
Investiate k
Analyze b

| Wigww Trigger Events . |
&0

| .} Active Browser |

Ewent 1d:

Correlati

N Correlsted Events For 5FOBG700-0FA9-102A-8612-000D56C73354 1 =] E3

ISFEIBB?EID-UFAS-‘I 02A-561 2000086 C7 3354

an rule: Batch size:
ITutDriaI_E.ourcePor‘l_DestinatmnPDH |1|jc| LI Ql X|

[: SourcePort | DestinationPort SensarType | Sewerity Ewert Time SourcelP
10025 25 8] (3) 7907 8:13:42 PM 10.0.0.156
<] 2
| -4 Search complete. Count: 1
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Sentinel Architecture

Sentinel is a security information and event management (SIEM) solution that automates
the collection, analysis and reporting of system network, application and security logs to
help organizations manage IT risk.

This section provides you the functional and technical architecture of Sentinel.

Sentinel Features

Sentinel allows you to monitor and manage a variety of functions. Some of the main
functions include:

= Real time views of large streams of events

= Reporting capabilities based on real time and historical events

= Managing users and what they are able to see and do by permission assignment
= Managing access to events to different users

= Organizing events into incidents for efficient response management and tracking
= Detecting patterns in events and streams of events

= Anintuitive and flexible rule-based language for correlation

= Rules compiled for high performance

= Scalable, multi-threaded, distributable and extensible architecture

Sentinel processes communicate with each other through a Message-Oriented Middleware
(MOM).

Functional Architecture

Sentinel is composed of three component subsystems, which form the core of the
functional architecture:

= “iSCALE Platform” - An event-driven scalable framework

= “Event Source Management” - An extensible framework built to manage and monitor
connections between Sentinel and third-party event sources using Sentinel Connectors
and Sentinel Collectors.

= “Application Integration” - An extensible application framework

Sentinel treats both “services” and “applications” as abstract service end-points that can
readily respond to asynchronous events. Services are “objects” that do not need to
understand protocols or how messages get routed to the peer services.

Architecture Overview

The Sentinel system is responsible for receiving events from the Collector Manager. The
events are then displayed in real-time and logged into a database for historical analysis.

At a high level, the Sentinel system uses a relational database and is comprised of Sentinel
processes and a reporting engine. The system accepts events from the Collector manager
as its input. The Collector manager interfaces with third-party products and normalizes the
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data from these products. The normalized data is then sent to the Sentinel processes and
database.

Historical analysis and reporting can be done using Sentinel's integrated reporting engine.
The reporting engine extracts data from the database and integrates the report displays into
the Sentinel Control Center using HTML documents over an HTTP connection.

Events from security
devices, example:
-1DS

-Firewalls

-0/1s
- Routers
- Web Servers

- Databases

- Switches

- Mainframe Wizard Collector Manager Sentinel Advisor
- Anti-Virus

Collect ———p» Normalize ———p» Real-time analysis ————» Reporting

ISCALE Platform

Sentinel’s iISCALE™ architecture is built using a standards-based, Service-Oriented
Architecture (SOA) that combines the advantages of in-memory processing and
distributed computing. iISCALE is a specialized message bus capable of handling high
data volumes.

Message Bus

A-2

The iISCALE Message Bus allows for independent scaling of individual components while
also allowing for standards-based integration with external applications. The key to
scalability is that unlike other distributed software, no two peer components communicate
with each other directly. All components communicate through the message bus, which is
capable of moving thousands of message packets per second.

Leveraging the message bus’ unique features, the high-throughput communication channel
can maximize and sustain a high data throughput rate across the independent components
of the system. Events are compressed and encrypted on the wire for secure and efficient
delivery from the edge of the network or collection points to the hub of the system, where
real-time analytics are performed.

The iISCALE message bus employs a variety of queuing services that improve the
reliability of the communication beyond the security and performance aspects of the
platform. Using a variety of transient and durable queues, the system offers unparalleled
reliability and fault tolerance. For instance, important messages in transit are saved (by
being queued) in case of a failure in the communication path. The queued message is
delivered to the destination after the system recovers from failure state.
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The iISCALE platform employs a data-driven or event-driven model that allows
independent scaling of components for the entire system based on the workload. This
provides a flexible deployment model since each customer’s environment varies: one site
may have a large number of devices with low event volumes; another site may have fewer
devices with very high event volumes. The event densities (that is, the event aggregation
and event multiplexing pattern on the wire from the collection points) are different in
these cases and the message bus allows for consistent scaling of disparate workloads.

iISCALE takes advantage of an independent, multi-channel environment, which virtually
eliminates contention and promotes parallel processing of events. These channels and sub-
channels work not only for event data transport but also offer fine-grain process control
for scaling and load balancing the system under varying load conditions. Using
independent service channels such as control channels and status channels, in addition to
the main event channel, allows sophisticated and cost-effective scaling of event-driven
architecture.

Sentinel Event

Sentinel receives information from devices, normalizes this information into a structure
called a Sentinel Event, or Event for short and sends the event for processing. Events are
processed by the real time display, correlation engine and the backend server.

An event comprises of more than 200 tags. Tags are of different types and of different
purposes. There are some predefined tags such as severity, criticality, destination IP and
destination port. There are two sets of configurable tags: Reserved Tags are for Novell
internal use to allow future expansion and Customer Tags are for customer extensions.

Tags can be repurposed by renaming them. The source for a tag can either be external,
which means that it is set explicitly by the device or the corresponding Collector or
referential. The value of a referential tag is computed as a function of one or more other
tags using the mapping service. For example, a tag can be defined to be the building code
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for the building containing the asset mentioned as the destination IP of an event. For
example, a tag can be computed by the mapping service using a customer defined map
using the destination IP from the event.

Mapping Service

Map Service allows a sophisticated mechanism to propagate business relevance data
throughout the system. This facility aids scalability and provides an extensibility
advantage by enabling intelligent data transfer between different nodes of the distributed
system.

Map Service is a data propagation facility that gives the ability to cross-reference
Vulnerability Scanner data with Intrusion Detection System signatures and more (for
example, asset data, business-relevant data). This allows immediate notification when an
attack is attempting to exploit a vulnerable system. Three separate components provide
this functionality:

= Collection of real time events from an intrusion detection source;

= Comparing those signatures to the latest vulnerability scans; and

=  Cross referencing an attack feed through Sentinel Advisor (an optional product
module, which cross-references between real-time IDS attack signatures and the
user’s vulnerability scanner data).

Map Service dynamically propagates information throughput the system without
impacting system load on the system. When important data sets (that is, “maps” such as
asset information or patch update information) are updated in the system, the Map Service
propagates the updates across the system, which can often get to be hundreds of
megabytes in size.

iISCALE’s Map Service algorithms handle large referential data sets across a production
system processing large real-time data volumes. These algorithms are “update-aware” and
selectively push only the changes or “delta data sets” from the repository to the edge or
system perimeter.

Streaming Maps

Map Service employs a dynamic update model and streams the maps from one point to
another, avoiding the build up of large static maps in dynamic memory. The value of this
streaming capability is particularly relevant in a mission-critical real-time system such as
Sentinel where there needs to be a steady, predictive and agile movement of data
independent of any transient load on the system.

Exploit Detection (Mapping Service)

Sentinel provides the ability to cross-reference event data signatures with Vulnerability
Scanner data. Users are notified automatically and immediately when an attack is
attempting to exploit a vulnerable system. This is accomplished through:

= Advisor Feed

= |ntrusion detection

»  Vulnerability scanning
=  Firewalls

Advisor provides a cross-reference between event data signatures and vulnerability
scanner data. Advisor feed has an alert and attack feed. The alert feed contains
information about vulnerabilities and threats. The attack feed is a normalization of event
signatures and vulnerability plug-ins. For more information on Advisor installation, see
Advisor Configuration in Sentinel Installation Guide.

The supported systems are:
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Intrusion Detections Systems = Vulnerability Scanners
= Cisco Secure IDS = eEYE Retina

= Enterasys Dragon Host Sensor = Foundstone Foundscan
= Enterasys Dragon Network Sensor = |SS Database Scanner
= Intrusion.com (SecureNet_Provider) = ISS Internet Scanner

= ISS BlackICE = |SS System Scanner

= ISS RealSecure Desktop = |ISS Wireless Scanner
= |SS RealSecure Network = Nessus

= ISS RealSecure Server = nCircle IP360

= |ISS RealSecure Guard = Qualys QualysGuard

= Snort Intrusion Protection System
= Symantec Network Security 4.0 (ManHunt) = |SS Proventia

= Symantec Intruder Alert Firewalls

= McAfee IntruShield = Cisco 10S Firewall

You will require at least one vulnerability scanner and either an IDS, IPS or firewall from
each category above. The IDS and Firewall DeviceName (rv31) has to appear in the event
as hi-lighted in gray above. Also, the IDS and Firewall must properly populate the

DeviceAttackName (rt1) field (for example, WEB-PHP Mambo uploadimage.php access).

The Advisor feed is sent to the database and then to the Exploit Detection Service. The
Exploit Detection Service will generate one or two files depending upon what kind of data
has been updated.

Advisor and Vulnerability

Scan information Exploit Detection
Advisor Feed Service (DAS)
Alert Feed
7
Database g‘
Allac Faad y Exploit Detection Map Files
i Exploit Detection
1
map has I H H
Event Configuration changed | Mapping Service Mapping Service
register (DAS)
IDS Collector get map 1]
Vulnerability Event Router
Collector Info

" Events Database
/ Collector Manager L)

Firewall Collector

The Exploit Detection Map Files are used by the Mapping Service to map attacks to
exploits of vulnerabilities.

Vulnerability Scanners scan for system (asset) vulnerable areas. IDS' detect attacks (if
any) against these vulnerable areas. Firewalls detect if any traffic is against any of these
vulnerable area. If an attack is associated with any vulnerability, the asset has been
exploited.

The Exploit Detection Service generates two files located in:
$ESEC_HOME/bin/map_data

The two files are attackNormalization.csv and exploitDetection.csv.

The attackNormalization.csv is generated after:
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= Advisor feed
= DAS Startup (if enabled in das_query.xml, disabled by default)

The exploitDetection.csv is generated after one of the following:

= Advisor feed
»  Vulnerability scan
= Sentinel Server Startup (if enabled in das_query.xml, disabled by default)

By default, there are two configured event columns used for exploit detection and they are
referenced from a map (all mapped tags will have the scroll icon).

*  Vulnerability
= Attackld

Severity I “ulnerahility J | Attackld qr

@

i) 0

When the vulnerability field (vul) equals 1, the asset or destination device is exploited. If
the vulnerability field equals 0, the asset or destination device is not exploited.

Sentinel comes pre-configured with the following map names associated with
attackNormalization.csv and exploitDetection.csv.

Map Name csv File Name
= AttackSignatureNormalization | = attackNormalization.csv
= IsExploitWatchlist = exploitDetection.csv

There are two types of data sources:

= External: Retrieves information from the Collector
» Referenced from Map: Retrieves information from a map file to populate the tag.

The Attackld tag has the Device (type of the security device, for example, Snort) and
AttackSignature columns set as Keys and uses the NormalizedAttackID column in the
attackNormalization.csv file. In a row where the DeviceName event tag (an IDS device
such as Snort, information filled in by Advisor and Vulnerability information from the
Sentinel Database) is the same as Device and where the DeviceAttackName event tag
(attack information filled in by Advisor information in the Sentinel Database through the
Exploit Detection Service) is the same as AttackSignature, the value for Attackld is where
that row intersects with the NormalizedAttackID column.

T

ReservediarZs -Diata Source
ReservedYarZ? FE e
ReservedYarZs
Reservedyarza {* Referenced from Map

Map Mame: aktacksignatureMormalization
DeviceMarne p I ] ‘—!
Devicelategary Map Calumn: [MormalizedAttackld = |
EventZontext ) 2
SourceThreatlevel Key Configuration:
SourcellserContext Map Key Field | Event Tag
DakaConktext Device Devicelams
SourceFunction AtkackSignature DieviceAttackMarne
S v e iner sbine s T ek F
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Key Key Attackld entry

NormalizedAttackld

fn Microsystems Solaris rwall Elevated R
n Microsystems Solaris rwall Elevated H
Fun Microsystems Solaris rwall Elevated H

i Micrusuﬂ Exchange Server Arbitrary Code
RealSecure  |SWTP E}{change YWerb Do3 12 Microsoft Exchange Server Arbitrary Code

The Vulnerability tag has a column entry “_EXIST_", which means that map result value
will be 1 if the key is in IsExploitWatchlist (exploitDetection.csv file) or 0 if it is not. The
key columns for the vulnerability tag are IP and NormalizedAttackld. When an incoming
event with a DestinationlIP event tag that matches the IP column entry and an Attackld
event tag that matches the NormalizedAttackld column entry in the same row, the result is
one (1). If no match is found in a common row, the result is zero (0).

Criticality Label: !\-‘ulnerability
DateTime = .
SourcelP el . |
R0 he vulnerability of the asset identified in this event.
DestinationIP :
EventID
SourcelD ~[ata Source
'izardPort & B
WizardAagent
Besoiica % Referenced from Map
SubResource : :
Map Mame:  |IsExploitvatchlist -
Eventhame B I B ‘—I
sensortlams Map Colurmn: |_EXIST_ vl
SensorType : :
EventTime Key Configuration: |
Protocal Map key Field Event Tag |
SourceHastMame IF [restinationIP
SourcePort rormalizedattackld atkackld
|t Fimakiomkd I TN

Event Source Management

Sentinel 6 delivers a centralized event source management framework to facilitate data
source integration. This framework enables all aspects of configuring, deploying,
managing and monitoring data collectors for a broad set of systems, which include
databases, operating systems, directories, firewalls, intrusion detection/prevention
systems, antivirus applications, mainframes, Web and application servers, and many more.

Using adaptable and flexible technology is central to Sentinel’s event source management
strategy, which is achieved through interpretive Collectors that parse, normalize, filter and
enrich the events in the data stream.

These Collectors can be modified as needed and are not tied to a specific environment. An
integrated development environment allows for interactive creation of Collectors using a
“drag and drop” paradigm from a graphical user interface. Non-programmers can create
Collectors, ensuring both current and future requirements are met in an ever-changing IT
environment. The command and control operation of Collectors (for example, start, stop)
is performed centrally from the Sentinel Control Center. The event source management
framework takes the data from the source system, performs the transformations and
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presents the events for later analysis, visualization and reporting purposes. The framework
delivers the following components and benefits:

= Collectors: Parse and normalize events from various systems

= Connectors: Connect to the data source to get raw data

= Taxonomy: Allows data from disparate sources to be categorized consistently

= Filtering: Eliminates irrelevant data at the point of collection, saving bandwidth and
disk space.

= Business relevance: Offers a way to enrich event data with valuable information

= Collector builder: An Integrated Development Environment (IDE) for building
custom collectors to collect from unique or proprietary systems

= Live view: User interface for managing live event sources.

= Scratch pad: User interface for offline design of event source configuration.

Application Integration

Time

A-8

External application integration through standard APIs is central to Sentinel. For example,
when dealing with a third party trouble-ticketing system, Sentinel 6 can open an initial
ticket in its own iTRAC workflow remediation system. Sentinel then uses bi-directional
API to communicate with the other trouble ticketing systems—for example, Remedy®
and HP OpenView’s ServiceDesk® -allowing straightforward integration with external
systems.

The API is Web Services-based and therefore allows any external systems that are SOAP-
aware to take advantage of pervasive integration with the Sentinel system.

The time of an event is very critical to its processing. It is important for reporting and
auditing purposes as well as for real time processing. The correlation engine processes
time ordered streams of events and detects patterns within events as well as temporal
patterns in the stream. However, the device generating the event may not know the real
time when the event is generated. In order to accommodate this Sentinel allows two
options in processing alerts from security devices: trust the time the device reports and use
that as the time of the event, or, do not trust the device time and instead stamp the event at
the time it is first processed by Sentinel (by the Collector).

Sentinel is a distributed system and comprises several processes that can be in different
parts of the network. In addition, there can be some delay introduced by the device. In
order to accommodate this, the Sentinel processes reorder the events into a time ordered
stream before processing.

The following illustration explains the concept of Sentinel Time.
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If Event Time is older than 5 minutes
from Wizard Time (correct time),
events will be directly routed to the
database

If time difference is greater than 1
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displays. Default time is 30 seconds
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-

i

Ghobal Filter

v

Re-order Buffer |
-

Y

Sentinel Server

" By default Event Time is set to Wizard
time. Ideal time would be device time.
Ideally it is best set Event Time to
Device Time if Device Time is
available, accurate and property
parsed by the Collector,

.

Correlation Engine

P Database

Correlation Re-order Buffer

3. If Event Time is more than 30
seconds older than Server time,
corredation engine will not process the
evenls,

By default, Event Time is set to Collector Manager time. Ideal time would be

device time. Therefore it would be best to set Event Time to Device Time if
Device Time is available, accurate and properly parsed by the Collector.

A configurable time buffer that reorders events and updates real time displays.
Default time is 30 seconds before and after server time.

Correlation Re-order buffer, if event time is more than 30 seconds older than

Server time, correlation engine will not process the events.

events will be directly routed to the database.

System Events

If event time is older than 5 minutes from Collector Manager Time (correct time),

System Events is a means to report on the status and status change of the system. There
are three types of events generated by the internal system, they are:

= |Internal Events

= Performance Events

= Audit Events

Internal Events

Internal Events are informational and describe a single state or change of state in the

system. They report when a user logs in or fails to authenticate, when a process is started
or a correlation rule is activated.

Performance Events

Performance Events are generated on a periodic basis and describe average resources used
by different parts of the system.
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Audit Events

Audit Events are generated internally. Each time an audited method is called or an audited
data object is modified, audit framework generates audit events. There are two types of
Audit Events. One which monitors user actions for example, user login/out, add/delete
user and another which monitors system actions/health, for example, process start/stop.

Some of these events used to be called Internal Events (mainly for system actions/health
monitoring). So the functionality of Audit Events is similar to Internal Events. Audit
Events can be logged into log files, saved into database, and sent out as Audit Event at the
same time. (Internal Events are only sent out as events.).

All System Events populate the following attributes:

= ST (Sensor Type) field: For internal events it is set to ‘I’ and for performance events
itis setto “P’

= Event ID: A unique UUID for the event

= Event Time: The time the event was generated

= Source: The UUID of the process that generated the event

= Sensor Name: The name of the process that generated the event (for example,
DAS_Binary)

= RV32 (Device Category): Set to ‘ESEC’

= Collector: ‘Performance’ for performance events and ‘Internal’ for internal events

In addition to the common attributes, every system event also sets the resource,
subresource, the severity, the event name and the message tags. For internal events, the
event name specific enough to identify the exact meaning of the event (for example,
UserAuthenticationFailed). The message tags add some specific detail; in the above
example the message tag will contain the name of the user, the OS name if available and
the machine name). For performance events the event name is generic describing the type
of statistical data and the data itself is in the message tag.

Performance events are sent directly to the database. To view them, do a quick query.

For more information, see “Appendix B, System Events for Sentinel”.

Processes

The following processes and Windows service communicate with each other through
iISCALE - the message-oriented middleware (MOM).

= Sentinel Service (Watchdog)
= Data Access Service (DAS)

s DAS Query: Performs general Sentinel Service operations including Login
and Historical Query.

o DAS Binary: Performs event database insertion.
= DAS RT: Provides the server-side functionality for Active Views.
= DAS Aggregation: Calculates event data summaries that are used in reports.

s DAS ITRAC: Provides the server-side functionality for the Sentinel iTRAC
functionality.

= DAS Proxy: Provides the server-side of the SSL proxy connection to
Sentinel Server.

= Correlation Engine (correlation_engine)
= Collector Manager
= |SCALE
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The following is the architecture for Sentinel Server.

Data Controller
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Sentinel Service (Watchdog)

Watchdog is a Sentinel Process that manages other Sentinel Processes. If a process other
than Watchdog stops, Watchdog will report this and will then restart that process.

If this service is stopped, it will stop all Sentinel processes on that machine. It executes
and reports health of other Sentinel processes. This process is launched by the "Sentinel"
Windows Service or the "sentinel™ UNIX service.

Data Access Service (DAS) Process

The Data Access Service (DAS) process is Sentinel Server's persistence service and
provides an interface to the database. It provides data driven access to the database

backend.

DAS is a container, composed of five different processes. Each process is responsible for
different types of database operations. These processes are controlled by the following

configuration files:

= das_binary.xml: Used for event and correlated event insertion operations

= das_query.xml: All other database operations

= activity_container.xml: Used for executing and configuring activity service
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= workflow_container.xml: Used for configuring the workflow (iTRAC) service
= das_rt.xml: Used for configuring the Active Views function within the Sentinel
Control Console

DAS receives requests from the different Sentinel processes, converts them to a query
against the database, processes the result from the database and converts it that back to a
reply. It supports requests to retrieve events for Quick Query and Event Drill Down, to
retrieve vulnerability information and advisor information and to manipulate configuration
information. DAS also handles logging of all events being received from the Collector
Manager and requests to retrieve and store configuration information.

Correlation Engine Process (correlation_engine)

The Correlation Engine (correlation_engine) process receives events from the Collector
Manager and publishes correlated events based on user-defined correlation rules.

Collector Manager

Collector Manager services, processes and sends events.

iISCALE

Message-oriented middleware (MOM) that provides the communication platform for all
other Sentinel processes.

Logical Architecture
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Sentinel is composed of three logical layers:

= “Collection and enrichment layer”
= “Business logic layer”
= “Presentation layer”

The collection/enrichment layer aggregates the events from external data sources,
transforms the device-specific formats into Sentinel format, enriches the native events
source with business-relevant data and dispatches the event packets to the message bus.
The key component orchestrating this function is the Collector, aided by a taxonomy
mapping and global filter service.

The business logic layer contains a set of distributable components. The base component
is a Remoting service that adds messaging capabilities to the data objects and services to
enable transparent data access across the entire network and Data Access service that is an
object management service to allow users to define objects using metadata. Additional
services include Correlation, Query Manager, Workflow, Event Visualization, Incident
Response, Health, Advisor, Reporting and Administration.
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The presentation layer renders the application interface to the end user. A comprehensive
dashboard called the Sentinel Control Center offers an integrated user workbench
consisting of an array of seven different applications accessible through a single common
framework. This cross-platform framework is built on Java™ 1.4 standards and provides a
unified view into independent business logic components — real-time interactive graphs,
actionable incident response, automated enforceable incident workflow, reporting,
incident remediation against known exploits and more.

Each of the layers are illustrated in the figure above and subsequently discussed in detail
in the following sections.

Collection and Enrichment Layer

Event Source Management (ESM) provides tools to manage and monitor connections
between Sentinel and third-party event sources. Events are aggregated using a set of
flexible and configurable Collectors, which collect data from a myriad of sensors and
other devices and sources. User can use pre-built Collectors, modify existing Collectors or
build their own Collectors to ensure the system meets all requirements.

Data aggregated by the Collectors in the form of events is subsequently normalized and
transformed into XML format, enriched with a series of metadata (that is, data about data)
using a set of business relevance services and propagated to the server-side for further
computational analysis using message bus platform. The Collection and Enrichment layer
consists of the following components:

= Connectors and Collector
= Collector Manager and Engine
= Collector Builder

Connectors and Collectors

A Connector is a concentrator or multiplexed adapter that connects the Collector Engine
to the actual monitored devices.

Collectors are the component-level aggregator of event data from a specific source.
Sentinel primarily supports remote “Collector-less” connections to sources; however,
Collectors can be deployed on specific devices where a remote approach is less efficient.
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Collectors are controlled from the Sentinel Control Center, which orchestrates the
communication between the Collectors and the Sentinel platform for real time analysis,
correlation computation and incident response.

Collector Manager and Engine

Collector Manager manages the Collectors, monitors system status messages and performs
event filtering as needed. Main functions of the Collector Manager include transforming
events, adding business relevance to events through taxonomy, performing global filtering
on events, routing events and sending health messages to the Sentinel server.

A Collector Engine is the interpreter component that parses the Collector code.

Collector Builder
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Collector Builder is a standalone application that is used to build, configure and debug
Collectors. This application serves as an integrated development environment (or IDE)
that allows the user to create new Collectors to parse data from source devices using a
special-purpose interpretive language designed to handle the nature of network and
security events.

ESM introduces a new hierarchy of deployment objects that allow users to group multiple
connections into sets. The hierarchy is as follows:
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The Event Source, Event Source Server, Collector, and Connector are configuration
related objects and can be added through the ESM user interface.

= Event Source: This node represents a connection to a specific source of data, such as
a specific file, firewall or Syslog relay, and contains the configuration information
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necessary to establish the connection. The health of this node represents the health of
the connection to the data source. This node will send raw data to its parent Connector
node.

= Event Source Server: This node represents a deployed instance of a server-type
Connector plug-in. Some protocols, such as Syslog UDP/TCP, NAudit and others,
push their data from the source to a server that is listening to accept the data. The
Event Source Server node represents this server and can be configured to accept data
from protocols that are supported by the selected Connector plugin. This node will
redirect the raw data it receives to an Event Source node that is configured to receive
data from it.

= Collector: This node represents a deployed instance of a Collector Script. It specifies
which Collector Script to use as well as the parameter values with which the Collector
should run. This node will send Sentinel events to its parent Collector Manager node.

= Connector: This node represents a deployed instance of a Connector plugin. It
includes the specification of which Connector plug-in to use as well as some
configuration information, such as “auto-discovery.” This node will send raw data to
its parent Collector node.

Common Services

All of the above-described components in this Collection and Enrichment layer are driven
by a set of common services. These utility services form the fabric of the data collection
and data enrichment and assist in filtering the noise from the information (through global
filters), applying user-defined tags to enrich the events information (through business
relevance and taxonomy mapping services) and governing the data Collectors’ functions
(through command and control services).

Taxonomy:

Nearly all security products produce events in different formats and with varying content.
For example, Windows and Solaris report a failed login differently.

Sentinel’s taxonomy automatically translates heterogeneous product data into meaningful
terms, which allows for a real-time homogeneous view of the entire network security.
Sentinel Taxonomy formats and filters raw security events before adding event context to
the data stream. This process formats all the security data in the most optimal structure for
processing by the Sentinel Correlation engine, as you can see in the following diagram.
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Business Relevance:

Sentinel injects business-relevant contextual data directly into the event stream. It includes
up to 135 customizable fields where users can add in asset specific information such as
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business unit, owner, asset value, geography. Once this information is added into the
system, all other components can take advantage of the additional context.
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Exploit Detection: Exploit Detection enables immediate, actionable notification of
attacks on vulnerable systems. It provides a real-time link between 1DS signatures and
vulnerability scan results, notifying users automatically and immediately when an attack
attempt to exploit a vulnerable system. This dramatically improves the efficiency and
effectiveness of incident response.

Exploit Detection provides users with updates of mappings between IDS and vulnerability
scanner product signatures. The mappings include a comprehensive list of IDS and
vulnerability scanners, Users simply upload vulnerability scan results into Sentinel.
Exploit Detection automatically parses them and updates the appropriate IDS Collectors.
It uses the embedded knowledge of vulnerability status to efficiently and effectively
prioritize responses to security threats in real time.

When an attack is launched against a vulnerable asset, Exploit Detection alerts users with
the corresponding severity level of the exploited vulnerability. Users can then take
immediate action on high-priority events. This takes the guesswork out of alert monitoring
and increases incident response efficiency by focusing reaction on known attacks against
vulnerable assets.

Exploit Detection also enables users to map or “un-map” signatures and vulnerabilities to
tune out false positives and negatives and to leverage custom signatures or vulnerability
scans.

Business Logic Layer
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The kernel of the Sentinel platform consists of a set of loosely-coupled services that can
run in a standalone configuration or in a distributed topology. This service-oriented
architecture (SOA) is called iISCALE. Specifically, Sentinel’s SOA comprises a set of
engines, services and APIs working together for linear scaling of the solution against
increasing data load and/or processing workload.

Sentinel services run in specialized containers and allow unparalleled processing and
scaling because they are optimized for message-based transport and computation. The key
services that make up the Sentinel Server include:

= “Remoting Service” = “Incident Response”
= “Data Access Service” = “Reporting”

= “Query Manager Service” = “Advisor”

= “Correlation Service” = “Health”

= “Workflow Service” = “Administration”

= “Event Visualization”
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Remoting Service

Sentinel’s Remoting Service provides the mechanism by which the server and client
programs communicate. This mechanism is typically referred to as distributed object
application.

Remoting Service provides the following capabilities:

= Locate remote objects: This is achieved through metadata that describes the object
name or registration token, although the actual location is not required, since the
ISCALE message bus allows for location transparency.

= Communicate with remote objects: Details of communication between remote
objects are handled by the iISCALE message bus.

= Object streaming and chunking: When large amounts of data need to pass back and
forth from the client to the server, these objects are optimized to load the data on
demand.

= Callbacks: Another pattern and layer of abstraction built into the Remoting Service
that allows for PTP remote object communication.

= Service monitoring and statistics: This provides performance and load statistics for
usage of these remote services.

Data Access Service

Data Access Service (DAS) is an object management service, which allows users to define
objects using metadata. DAS manages the object and access to objects and automates
transmission and persistence. DAS also serves as a facade for accessing data from any
persistent data store such as databases, directory services or files. The operations of DAS
include uniform data access through JDBC and optionally high-performance event insert
strategies using native connectors (that is, OCI for Oracle 9i and ADO for Microsoft SQL
Server).

Query Manager Service

The Query Manager Service orchestrates drill-down and event history requests from the
Sentinel Control Center. This service is an integral component for implementing the
paging algorithm used in the Event History browsing capability. It converts user-defined
filters into valid criteria and appends security criteria to it before events are retrieved. This
service also ensures that the criteria do not change during a paged event history
transaction.

Correlation Service

Sentinel’s correlation algorithm computes correlated events by analyzing the data stream
in real time. It publishes the correlated events based on user-defined rules before the
events reach the database. Rules in the correlation engine can detect a pattern in a single
event of a running window of events. When a match is detected, the correlation engine
generates a correlated event describing the found pattern and may create an incident or
trigger a remediation workflow through iTRAC. The correlation engine works with a rules
checker component which computes the correlation rule expressions and validates syntax
of filters. In addition to providing a comprehensive set of correlation rules, Sentinel’s
correlation engine provides specific advantages over database-centric correlation engines.

= By relying on in-memory processing rather than database inserts and reads, the
correlation engine performs during high steady-state volumes as well as during event
spikes when under attack, the time when correlation performance is most critical.

= Correlation volume does not slow down other system components, so the user
interface remains responsive, especially with high event volumes.
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= Distributed correlation: Organizations can deploy multiple correlation engines, each
on its own server, without the need to replicate configurations or add databases.
Independent scaling of components provides cost-effective scalability and
performance.

= The correlation engine can add events to incidents after an incident has been
determined.

Users are encouraged to measure a metric called Event Rules per Second (ERPS). ERPS is
the measure of the number of events that can be examined by a correlation rule per
second. This measure is a good performance indicator as it estimates the impact on
performance when two factors intersect: events per second and number of rules in use.

= Dynamic Lists: Dynamic lists are distributed list structures that may be used for
storing elements and performing fast lookups on those elements. These lists can store
a set of strings such as IP addresses, server names or usernames. Examples of
dynamic lists include:

o Terminated user list

@ Suspicious user watch list

s Privileged user watch list

= Authorized ports and services list
o Authorized server list

= Inall cases, correlation rules may reference named dynamic lists to perform lookups
on list members. For example, a rule may be written to identify a file access event
from a user who is not a member of the Authorized Users list. Additionally,
correlation actions integrate with the dynamic list module to add or remove elements
from a list. The combination of lookups and automated actions on the same list
provides a powerful feedback mechanism used to identify complex situations.

Workflow Service (iTRAC)

The Workflow Service receives triggers on incident creation and initiates workflow
processes based on pre-defined workflow templates. It manages the lifecycle of these
processes by generating work items or executing activities. This service also maintains a
history of completed processes that may be used for auditing incident responses.

Event Visualization

Active Views™, the interactive graphical user interface for event visualization, provides
an integrated, security management dashboard with a comprehensive set of real-time
visualization and analytical tools to facilitate threat detection and analysis. Users can
monitor events in real time and perform instant drill-downs from seconds to hours in the
past. A wide array of visualization charts and aids allow monitoring of information
through 3D bar, 2D stacked, line and ribbon chart representation and others. Additional
valuable information can be viewed from the Active Views dashboard, including
notification of asset exploits (exploit detection), viewing asset information and graphical
associations between pertinent source IPs and destination IPs.

Because Active Views uses the iISCALE architecture, analysts can quickly drill down for
further analysis because Active Views provides direct access to the real-time memory-
resident event data, which easily handles thousands of events per second without any
performance degradation. Data is kept in memory and written to the database as needed
(Active Views can store up to 8 hours of data in memory with typical event loads). This
uninterrupted, performance-oriented real-time view is essential when under attack or in
steady-state.
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Incident response through iTRAC

Sentinel iTRAC transforms traditional security information management from a passive

“alerting and viewing” role to an “actionable incident response” role by enabling
organizations to define and document incident resolution processes and then guide,

enforce and track resolution processes once an incident or violation has been detected.

Sentinel comes with “out-of-the-box™ process templates that use the SANS Institute’s
guidelines for incident handling. Users can start with these pre-defined processes and

configure specific activities to reflect their organization’s best practices. iTRAC processes

can be automatically triggered from incident creation or correlation rules or manually

engaged by an authorized security or audit professional. iTRAC keeps an audit trail of all

actions to support compliance reporting and historical analysis.

Sentinel Architecture
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A worklist provides the user with all tasks that have been assigned to the user and a
process monitor provides real-time visibility into process status during a resolution
process lifecycle.

iTRAC’s activity framework enables users to customize automated or manual tasks for
specific incident-resolution processes. The iTRAC process templates can be configured
using the activity framework to match the template with an organization’s best practices.
Activities are executed directly from the Sentinel Control Center.

iTRAC’s automation framework works using two key components:

Activity container

It automates the activities execution for the specified set of steps based on input rules
Workflow container

It automates the workflow execution based on activities through a work-list.

The input rules are based on the XPDL (XML Processing Description Language) standard
and provide a formal model for expressing executable processes in a business enterprise.
This standards-based approach to the implementation of business-specific rules and rule
sets ensures future-proofing of process definitions for customers.

The iTRAC system uses three Sentinel 6 objects that may be defined outside the iTRAC
framework:

= Incident: Incidents within Sentinel 6 are groups of events that represent an actionable
security incident, associated state and meta-information. Incidents are created
manually or through correlation rules, and can be associated with a workflow process.
They can be viewed on the Incidents tab.

= Activity: An Activity is a pre-defined automatic unit of work, with defined inputs,
command-driven activity and outputs, such as automatic attachment of asset data to
the incident or generation of an e-mail. Activities can be used within workflow
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templates, triggered by a correlation rule, or executed by a right-click when viewing
events.

= Role: Users can be assigned to one or more Roles for example, Analyst, Admin and
so on. Manual steps in the workflow processes may be assigned to a Role.

Sentinel 6 workflows have four major components that are unique to iTRAC:

= Step: A Step is an individual unit of work within a workflow; there are manual steps,
decision steps, command steps, mail steps, and activity-based steps. Each step appears
as an icon within a given workflow template.

= Transition: A Transition defines how the workflow will move from one state
(Activity) to another and can be determined by an analyst action, by the value of a
variable or by the amount of time elapsed.

=  Templates: A Template is a design for a workflow that controls the execution of a
process in Sentinel iTRAC. The template consists of a network of manual and
automated steps, activities and criteria for transition between them. Workflow
templates define how to respond to an incident once a process based on that template
is instantiated. A template may be associated with many incidents.

= Processes: A process is a specific instance of a workflow template that is actively
being tracked by the workflow system. It includes all the relevant information relating
to the instance, including the current step in the workflow, the associated incident, and
the results of the steps, attachments and notes. Each workflow process is associated
with one and only one incident.

act
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Reporting Service

The Reporting service allows for reporting, including historical and vulnerability reports.
Sentinel comes with out-of-the-box reports and enables users to configure their own
reports using Crystal Reports. Some examples of reports included with Sentinel are:

= Trend analysis

= Security status of lines of business or critical assets
= Attack types

= Targeted assets

= Response times and resolution

=  Policy compliance violations
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Advisor

Sentinel Advisor, an optional module, cross-references Sentinel’s real-time alert data with
known vulnerabilities and remediation information, bridging the gap between incident
detection and response. With Advisor, organizations can determine if events exploit
specific vulnerabilities and how these attacks impact their assets. Advisor also contains
detailed information on the vulnerabilities that attacks intend to exploit, the potential
effects of the attacks if successful and necessary steps for remediation. Recommended
remediation steps are enforced and tracked using iTRAC incident response processes.

Health

The Health service enables users to get a comprehensive view of the distributed Sentinel
platform. It aggregates health information from various processes that are typically
distributed on various servers. The health information is periodically displayed on the
Sentinel Control Center for the end user.

Administration
The Administration facility allows for user management and settings setup facilities
typically needed by application administrators of Sentinel.

A-22 Sentinel User Guide



Common Services

All of the above described components in this business logic layer of the architecture are
driven by a set of common services. These utility services assist in fine-grain filtering
(through Filter Engine) of events to users, continuous monitoring of system health
statistics (through Health Monitor) and dynamic updates of system wide data (through
Map Service). Together, these utility services form the fabric of the loosely-coupled
services that allow for unparalleled processing and scaling over the message bus-based
transport for real-time analytics and computation.

Presentation Layer

The presentation layer renders the application interface to the end user. The Sentinel
Control Center is a comprehensive dashboard that presents information to the user.

The presentation of event is possible through Active Views which displays the events in a
tabular form or by using different types of charts. Table Format displays the variables of
the events as columns in a table. Sorting of information is possible in the grid by clicking
on the column name.
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Graphical Format displays events as graphs. Stacked Bar 2D, Bar 3D, Line and Ribbon
graphs are available for proper representation of information in graphical format.
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Active Browser

Active browser facility helps in viewing the selected events. In Active browser, the events
are grouped according to the metatags. In these metatags various sub-categories are
defined. The numbers in the parentheses against these sub-categories display the total
number of event counts corresponding to the value of the metatag.
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In active browser, the query manager service retrieves a list of events taken from any part
of the system and performs a statistical analysis of these events to break them down into
ranges of values for each desired attribute of the event. Using single clicks through a Web
browser interface, the user can choose ranges to quickly drill down on a large set of
events. Then individual event details can be viewed or exported to an html or csv file.
Additional event attributes for analysis can be added dynamically at any time, and the
interface provides an interactive way to drill down on events in a given time range.
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System Events for Sentinel

In the description tables below, words in italics surrounded by <...> are replaced by

relevant values in the real messages.

Authentication Events

Failed Authentication

When a user authentication fails, the following event is generated.

Tag Value
Severity 4
Event Name AuthenticationFailed
Resource UserAuthentication
SubResource Authenticate
Message Authentication of user <name> with OS name
<domUser> from <IP> failed

No Such User Event

When a user attempts to login into the application and authentication succeeds but the user
is not an Sentinel user, the following event is generated.

Tag Value
Severity 4
Event Name NoSuchUser
Resource UserAuthentication
SubResource Authenticate
Message No existing user with name <name> found

Duplicate User Objects

When there is an unexpected second active user object, this should not happen, the
following event is generated. This is an internal error.

Tag Value
Severity 4
Event Name TooManyActiveUsers
Resource UserAuthentication
SubResource Authenticate
Message Error in user table : Multiple users with the
name <name> found

Locked Account

When a locked user account is attempting to login, the following event is generated.

Tag

Value

Severity
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Tag Value
Event Name LockedUser
Resource UserAuthentication
SubResource Authentication
Message Attempt to login using locked account <acct>

User Sessions
User Logged Out

When a user logs out, the following internal event is generated.

Tag Value
Severity 1
Event Name UserLoggedOut
Resource UserSessionManager
SubResource User
Message Closing session for <user> OS name

<osName> from <IP> was on since <date>;
currently <num> active users

User Logged In

When a user logs in, the following internal event is generated.

Tag Value
Severity 1
Event Name UserLoggedIn
Resource UserSessionManager
SubResource User
Message User <user> with OS name <osName> at
<IP> logged in; currently <num> active users

User Discovered

If the server restarts, it loses the session information. It will then reconstruct the session
when it receives messages from active users. When it discovers a connected user, the

following internal event is generated.

Tag Value

Severity 1

Event Name UserLoggedIn

Resource UserSessionManager

SubResource User

Message Discovered active user <user> with OS name
<osName> at <IP> logged in; currently
<num> active users

Event

Error Moving Completed File

When an event file is completed it is moved to the output directory. If that move fails the

following internal event is generated.
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Tag Value
Severity 3
Event Name MoveArchiveFileFailed
Resource <DAS name>
SubResource ArchiveFile
Message Error moving completed archive file <fname>
to <dir>

Error inserting events

When inserting events into the database fails the following internal event is generated.

Tag Value
Severity 5
Event Name InsertEventsFailed
Resource EventSubsystem
SubResource Events
Message Error inserting events into the Database—the

events may be permanently lost. Please check
the Database and backend server logs
<Exception>

Opening Archive File failed

When opening an archive file for storing the events for aggregation fails, the following

internal event is generated.

Tag Value
Severity 3
Event Name OpenArchiveFileFailed
Resource <Das name>
SubResource ArchiveFile
Message Error opening archive file <name> in <dir>

Writing to Archive File failed

When opening an archive file for storing the events for aggregation fails, the following

internal event is generated.

Tag Value
Severity 3
Event Name WriteArchiveFileFailed
Resource <Das name>
SubResource ArchiveFile
Message Error writing newly received events to
aggregation archive file <fname>

Writing to the overflow partition (P_MAX)

An event is sent approximately every 5 minutes notifying the user when events are being
written to the overflow partition (P_MAX). When this occurs, the administrator needs to
use SDM and add more partitions otherwise performance will start degrading.

Tag

Value

Severity
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Event Name

InsertintoOverflowPartition

Resource EventSubSystem
SubResource Events
Message Error: currently inserting into the overflow

partitions (P_MAX), add more partitions

Event Insertion is blocked

If DAS is writing into the overflow partition and the user attempts to add partitions SDM
will send a request to DAS to temporarily stop inserting events into the database. When
this happens DAS will send internal events every time it attempts to insert events into the

database.
Tag Value
Severity 4
Event Name EventlnsertionlsBlocked
Resource EventSubSystem
SubResource Events
Message Event insertion is blocked, waiting <num> sec

Event Insertion is resumed

When event insertion is resumed after being blocked, the following event is sent.

Tag Value
Severity 2
Event Name EventlnsertionResumed
Resource EventSubSystem
SubResource Events
Message Event insertion has resumed after being blocked

Database Space Reached Specified Time Threshold

When event insertion is resumed after being blocked, the following event is sent.

Tag Value
Severity 0
Event Name DbSpaceReachedTimeThrshld
Resource Database
SubResource Database
Message Tablespace <string> has <num> MB left and

growing <num> bytes per second and will run
out space within the time threshold specified
<num> seconds

Database Space Reached Specified Percent Threshold

When event insertion is resumed after being blocked, the following event is sent.

Tag Value
Severity 0
Event Name DbSpaceReachedPercentThrshld
Resource Database
SubResource Database
Message Tablespace <string> has current size of
<num> MB with a max size of <num> MB
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Tag

Value

and has reached the percentage threshold of
<num> %

Database Space Very Low

When event insertion is resumed after being blocked, the following event is sent.

Tag Value
Severity 5
Event Name DbSpaceVeryLow
Resource Database
SubResource Database
Message Tablespace <string> has current size of

<num> MB and has reached the physical
threshold of <num> MB

Aggregation

Error inserting summary data into the database

If an error is encountered while writing aggregation data into the database, the following

internal event is generated.

Tag Value
Severity 4
Event Name SummaryUpdateFailure
Resource Aggregation
SubResource Summary
Message Error saving summary batch to the database for
summary <summaryName>

Mapping Service

Error initializing map with ID

This internal event is generated from the client side of the mapping service (the one that is
part of the Collector Manager). This error is generated when the Collector Manager
attempts to retrieve a map that does not exist. This should not happen but may happen if

maps are created and deleted.

Tag Value
Severity 4
Event Name ErrorNoSuchMap
Resource MappingService
SubResource ReferentialDataObjectMap
Message Error initializing map with id <ID>: no such
map

Refreshing Map from Cache

This internal event is generated from the client side of the mapping service (the one that is
part of the Collector Manager). When the Collector Manager is told to refresh the map
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because it has been modified or its definition has changed it sends an internal event. This
means that its cache is up to date and is refreshing the map from cache.

Tag Value
Severity 1
Event Name LoadingMapFromCache
Resource MappingService
SubResource ReferentialDataObjectMap
Message Loading from cache v<version> of map
<mapName> (ID <id>)

Refreshing Map from Server

This internal event is generated from the client side of the mapping service (the one that is
part of the Collector Manager). When the Collector Manager is told to refresh the map
because it has been modified or its definition has changed it sends an internal event. This
means that the map was either not in the cache or the version in the cache was not up to
date and the Collector Manager is retrieving the map from the server.

Tag Value
Severity 1
Event Name RefreshingMapFromServer
Resource MappingService
SubResource ReferentialDataObjectMap
Message Refreshing from server map <name> with id
<ID>

Timeout Refreshing Map

Error

B-6

This internal event is generated from the client side of the mapping service (the one that is
part of the Collector Manager). When the Collector Manager is told to refresh the map
because it has been modified or its definition has changed it sends an internal. This means
that the Collector Manager attempted to retrieve the map from the server and the server
never acknowledged the request and timed out. This error is considered transient and the
Collector Manager will retry.

Tag Value
Severity 4
Event Name TimeoutRefreshingMap
Resource MappingService
SubResource ReferentialDataObjectMap
Message Request timed out while refreshing map
<name>: <exception>

Refreshing Map

This internal event is generated from the client side of the mapping service (the one that is
part of the Collector Manager). When the Collector Manager is told to refresh the map
because it has been modified or its definition has changed it sends an internal event. This
means that there was some unexpected non-transient error while trying to refresh a map.
The Collector Manager will wait 15 minutes and will try again. If this happens during
initialization the initialization will proceed and this map will be ignored until it can be
successfully loaded.

Tag Value

Severity 4
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Event Name ErrorRefreshingMapData

Resource MappingService

SubResource ReferentialDataObjectMap

Message Error refreshing map <mapName>: <exc>

Loaded Large Map

This internal event is an information event sent by the mapping service informing that a
large map was loaded to the Collector Manager. A map is considered large if the number

of rows exceeds 100,000.

Tag Value
Severity 0
Event Name LoadedLargeMap
Resource MappingService
SubResource ReferentialDataObjectMap
Message Finished loading map <name> with id <ID> and
<num> entries and total size <#>Kb in <##>sec

Long time to load Map

This internal event is an information event sent by the mapping service informing that
loading a map took an unusually long time (greater than one minute).

Tag Value
Severity 0
Event Name LongTimeTolLoadMap
Resource MappingService
SubResource ReferentialDataObjectMap
Message It took <##>sec to load map <name> with id
<ID> and <num> entries and total size <##>Kb

TimedoutWaitingForCallback

When the Collector Manager needs to refresh a map it sends a request to the backend.
This request contains a callback. The backend generates the map and when it is ready it
sends the map to the Collector Manager using the callback. If it takes too long for the
response to arrive (more than ten minutes) the Collector Manager will submit a second
request assuming the first was lost. When this occurs, the following internal event is

generated.
Tag Value
Severity 2
Event Name TimedoutWaitingForCallback
Resource MappingService
SubResource ReferentialDataObjectMap
Message Map <name> timed out waiting for callback
with new map data--retrying

ErrorApplyingincrementalUpdate

This event is sent when the mapping service fails to apply an update to an existing client

map.
Tag Value
Severity 4
Event Name ErrorApplyinglncrementalUpdate
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Resource MappingService
SubResource ReferentialDataObjectMap
Message The error <error> occurred while applying
updates to map <mapName> (ID <mapld>)
v.<version>. Rescheduling a refresh to
complete map update.
OutOfSyncDetected

This event is sent when the mapping service detects that a map is out of date. The
mapping service will automatically schedule a refresh.

Tag Value
Severity 2
Event Name OutOfsyncDetected
Resource MappingService
SubResource ReferentialDataObjectMap
Message Map <mapName> detected the map data is out-

of-sync, probably due to a missed update
notification--scheduling a refresh

Event Router

Event Router is Running

Event router is the main component of the Collector Manager (the one that performs the
maps, applies global filters and publishes the events). This internal event is sent when the
event router is ready during initialization. When the Collector Manager is restarted,
another event will be sent when it is ready.

This event is not sent until the event router successfully loaded all the global filters and

map information.

Tag Value
Severity 1
Event Name EventRouterlsRunning
Resource AgentManager
SubResource EventRouter
Message Event router completed its initialization in
<mode> mode

Event Router is Initializing

This event is sent when an event router starts its initialization. The event router starts
initializing when it has established a connection with the backend (DAS Query).

Tag Value
Severity 1
Event Name EventRouterlnitializing
Resource AgentManager
SubResource EventRouter
Message Event router is initializing in <mode> mode

Event Router is Stopping

This event is sent when a request is received by the event router to stop during shutdown.
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Tag Value
Severity 2
Event Name EventRouterStopping
Resource AgentManager
SubResource EventRouter
Message Event router is stopping

Event Router is Terminating

This event is sent when a request is received by the event router to stop during shutdown.

Tag Value
Severity 2
Event Name EventRouterTerminating
Resource AgentManager
SubResource EventRouter
Message Event router is terminating

Correlation Engine

Correlation Engine is Running

The correlation engine process can be idled by the user. Its running state determines
whether the active process is processing events or not. The process starts in the idle
(stopped) state and waits to retrieve its configuration from the database. This event is sent
when the engine changes state from stopped to running.

Tag Value
Severity 1
Event Name EngineRunning
Resource CorrelationEngine
SubResource CorrelationEngine
Message Correlation Engine is processing events.

Correlation Engine is Stopped

This event is sent out when the engine changes state from running to stopped.

Tag Value
Severity 1
Event Name EngineStopped
Resource CorrelationEngine
SubResource CorrelationEngine
Message Correlation Engine has stopped processing
events.

Rule Deployment is Started

This event is sent out when an engine successfully loads a rule deployment. This message
is sent out regardless of the engine running state.

Tag Value
Severity 1
Event Name DeploymentStarted
Resource CorrelationEngine
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SubResource

Deployment

Message

deployment <name> started

Rule Deployment is Stopped

This event is sent out when an engine successfully unloads a rule deployment. This
message is sent out regardless of the engine running state.

Tag Value
Severity 1
Event Name DeploymentStopped
Resource CorrelationEngine
SubResource Deployment
Message deployment <name> stopped

Rule Deployment is Modified

This event is sent out when an engine successfully reloads a rule deployment. This
message is sent out regardless of the engine running state.

Tag Value
Severity 1
Event Name DeploymentModified
Resource CorrelationEngine
SubResource Deployment
Message Deployment <name> modified
WatchDog

Controlled Process is started

Watchdog is run as a service. Its main purpose is to keep Sentinel processes running. If a
process dies, Watchdog will automatically restart that process. This event is sent out when
a process is started.

Tag Value
Severity 1
Event Name ProcessStart
Resource WatchDog
SubResource Process
Message Process <ProgramName> spawned (<pid>)

Controlled Process is stopped

This event is sent out when a process is stopped. The severity is set to 5 if the process was
set to respawn (that is, it is not expected to die). The severity is set to 1 if the process was

set to run once.

Tag Value
Severity 1/5
Event Name ProcessStop
Resource WatchDog
SubResource Process
Message Process <ProgramName> exited with code
<exit_code>
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Watchdog Process is started

As the Watchdog process starts, the following internal event is generated.

Tag Value
Severity 1
Event Name ProcessStart
Resource WatchDog
SubResource WatchDog
Message WatchDog Service Starting

Watchdog Process is stopped

When the Watchdog service is stopped, the following internal event is generated.

Tag Value
Severity 5
Event Name ProcessStop
Resource WatchDog
SubResource WatchDog
Message WatchDog Service Ended

Collector Engine/Manager

Port Start
Collector Manager sends this event when a port is started.
Tag Value
Severity 1
Event Name PortStart
Resource AgentManager
SubResource AgentManager
Message Processing started for port_<port id>
Port Stop
Collector Manager sends this event when a port is stopped.
Tag Value
Severity 1
Event Name PortStop
Resource AgentManager
SubResource AgentManager
Message Processing stopped for port_<port id>

Persistent Process Died

Collector Engine sends this event when the persistent process connector detects its

controlled process has died.

Tag Value
Severity 5
Event Name PersistentProcessDied
Resource AgentManager
SubResource AgentManager
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| Message | Persistent Process on port <port id> has died.

Persistent Process Restarted

Collector Engine sends this event when the persistent process connector is able to restart
the controlled process that had died.

Tag Value
Severity 1
Event Name PersistentProcessRestarted
Resource AgentManager
SubResource AgentManager
Message Persistent Process on port <port id> has
restarted.

Event Service
Cyclical Dependency

Event Service sends this event when it detects a cycle in the Event Definition (in
dependencies among tags due to referential map assignments). Check the event
configuration in SDM and resolve the dependency.

Tag Value
Severity 5
Event Name CyclicalDependency
Resource EventService
SubResource ObjectAttrinfos
Message Cyclical dependency detected in event
transformations. Check event configuration.

Active Views

Active View Created

DAS_Binary sends this event when an Active View is created.

Tag Value

Severity 1

Event Name RtChartCreated

Resource Real TimeSummaryService

SubResource ChartManager

Message Creating new Active View with filter <filter>
and attribute <attribute> for users with security
filter <security filter>. Currently <n> Active
View(s) Collecting.

Active View Joined

DAS_Binary sends this event when a user connects to an existing Active View.

Tag Value
Severity 1
Event Name RtChartJoiningExistingData
Resource Real TimeSummaryService
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Tag

Value

SubResource

ChartManager

Message

Joining existing Active View with filter <filter>
and attribute <attribute> for users with security
filter <security filter>. Currently <n> Active
View(s) Collecting.

Idle Active View Removed

DAS_Binary sends this event when a non-permanent Active View is removed due to

inactivity.
Tag Value

Severity 1

Event Name RtChartlnactiveAndRemoved

Resource Real TimeSummaryService

SubResource ChartManager

Message Removed idle Active View with filter <filter>
and attribute <attribute> for users with security
filter <security filter>. Currently <n> Active
View(s) Collecting.

Idle Permanent Active View Removed

DAS_Binary sends this event when a permanent Active View is removed due to
inactivity. Permanent Active Views are ones saved in user preferences and timeout after

several days of inactivity by default.

Tag Value
Severity 1
Event Name RtPermanentChartRemoved
Resource Real TimeSummaryService
SubResource ChartManager
Message Removed idle permanent Active View with

filter <filter> and attribute <attribute> for users
with security filter <security filter>. Currently
<n> Active View(s) Collecting.

Active View Now Permanent

DAS_Binary sends this event when it detects an Active View as newly permanent. This
check happens periodically, so it may be several minutes after an Active View is saved to

preferences before this event is generated.

Tag Value
Severity 1
Event Name RtChartlsNowPermanent
Resource Real TimeSummaryService
SubResource ChartManager
Message Active View with filter <filter> and attribute

<attribute> for users with security filter
<security filter> is now permanent.
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Active View No Longer Permanent

DAS_Binary sends this event when it detects a formerly permanent Active View that is no
longer permanent. This check happens periodically, so it may be several minutes after an
Active View is removed from preferences before this event is generated.

Tag Value

Severity 1

Event Name RtChartNotPermanent

Resource Real TimeSummaryService

SubResource ChartManager

Message Active View with filter <filter> and attribute
<attribute> for users with security filter
<security filter> is no longer permanent.
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Summary

Event Name Severity | Source SubResource Component
AuthenticationFailed 4 UserAuthentication Authenticate Authentication
NoSuchUser 4 UserAuthentication Authenticate Authentication
TooManyActiveUsers 4 UserAuthentication Authenticate Authentication
LockedUser 4 UserAuthentication Authenticate Authentication
UserLoggedOut 1 UserSessionManager User User Session
UserLoggedIn 1 UserSessionManager User User
UserLoggedIn 1 UserSessionManager User User
MoveArchiveFileFailed 3 DAS Name ArchiveFile Event
InsertEventsFailed 5 EventSubSystem Events Event
OpenArchiveFileFailed 3 DAS Name ArchiveFile Event
WriteArchiveFileFailed 3 DAS Name ArchiveFile Event
SummaryUpdateFailure 4 Aggregation Summary Aggregation
InsertIntoOverflowPartition 5 EventSubSystem Events Event
EventinsertionlsBlocked 4 EventSubSystem Events Event
EventinsertionResumed 2 EventSubSystem Events Event
EventRouterlsRunning 1 AgentManager EventRouter EventRouter
EventRouterlnitializing 1 AgentManager EventRouter EventRouter
EventRouterStopping 2 AgentManager EventRouter EventRouter
EventRouterTerminating 2 AgentManager EventRouter EventRouter
ErrorNoSuchMap 4 MappingService ReferentialDataObjectMap Mapping
LoadingMapFromCache 1 MappingService ReferentialDataObjectMap Mapping
RefreshingMapFromServer 1 MappingService ReferentialDataObjectMap Mapping
TimeoutRefreshingMapData 4 MappingService ReferentialDataObjectMap Mapping
ErrorRefreshingMapData 4 MappingService ReferentialDataObjectMap Mapping
LoadedLargeMap 0 MappingService ReferentialDataObjectMap Mapping
LongTimeTolLoadMap 0 MappingService ReferentialDataObjectMap Mapping
TimedoutWaitingForCallback 2 MappingService ReferentialDataObjectMap Mapping
ErrorApplyingincrementalUpdat | 4 MappingService ReferentialDataObjectMap Mapping
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Event Name Severity | Source SubResource Component
e

OutOfSyncDetected 2 MappingService ReferentialDataObjectMap Mapping
EngineRunning 1 CorrelationEngine CorrelationEngine

EngineStopped 1 CorrelationEngine CorrelationEngine

DeploymentStarted 1 CorrelationEngine Deployment

DeploymentStopped 1 CorrelationEngine Deployment

DeploymentModified 1 CorrelationEngine Deployment

ProcessStart 1 WatchDog Process

ProcessStop 1/5 WatchDog Process

ProcessStart 1 WatchDog WatchDog

ProcessStop 5 WatchDog WatchDog

PortStart AgentManager AgentManager

PortStop AgentManager AgentManager

PersistentProcessDied 5 AgentManager AgentManager

PersistentProcessRestarted 1 AgentManager AgentManager

SortDependencies 5 EventService ObjectAttrinfo EventService
DbSpaceReachedTimeThrshld 0 Database Database Event
DbSpaceReachedPercentThrshid | 0 Database Database Event
DbSpaceVeryLow 5 Database Database Event
RtChartCreated 1 Real TimeSummaryService ChartManager Active Views
RtChartJoiningExistingData 1 Real TimeSummaryService ChartManager Active Views
RtChartlnactiveAndRemoved 1 Real TimeSummaryService ChartManager Active Views
RtChartPermanentAndRemoved | 1 Real TimeSummaryService ChartManager Active Views
RtChartlsNowPermanent 1 Real TimeSummaryService ChartManager Active Views
RtChartNotPermanent 1 Real TimeSummaryService ChartManager Active Views
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